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About FlashPro

FlashPro is Microsemi's programming software tool for SmartFusion, IGLOO, ProASIC3, Fusion devices.
You will be able to navigate easily through the FlashPro software because of its similarities with other
Microsemi software tools.

Note: FlashPro3 is not supported on Windows 8.1.

The FlashPro software includes the following features:
e Supports modification of I/O states during programming
e Supports automatic construction of chain from scan chain operation
e Supports importing non-Microsemi BSDL files for automatic chain construction
e Supports direct multiple Microsemi device chain programming and serialization
e Supports single device STAPL files generation
e Supports single device SVF files generation
e Supports single device IEEE 1532 files generation
e Supports Chain STAPL file generation
e Supports Chain SVF file generation
e Supports a single GUI to drive multiple FlashPro5/4/3/3X programmers for parallel programming
e Supports 1.2V programming for IGLOO devices

Note: Parallel programming via FlashPro (USB/LPT1) or FlashPro Lite programmers is not supported.

e Supports device serialization for parallel programming
e Aredesigned GUI, which features a project manager to manage the programming files and data
e Enhanced In-System Programming (ISP) Support

An optional In-House Programming (IHP) service is available if you are purchasing Microsemi devices in
volume. Contact Microsemi for more information.

For step-by-step instructions on how to use these features, see the FlashPro Tutorial.

If you arrived here by pressing the F1 key in FlashPro, use the Search tool in help for more information on
specific content, or click the Help button embedded in any dialog box or GUI for context-specific help.

Installing FlashPro Express Software

See the FlashproExpress Installation Instructions on the Microsemi website for information on how to install
FlashproExpress software and relevant system requirements.

View the detailed Install Instructions and System Requirements at the Flashpro Express software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashproexpress#overview

Programming Tool Model Overview

The FlashPro software is designed for use in the operation, user design, and production programming flows.

Design Debug

The figure below illustrates the programming design flow when an engineer is in debug mode. In the
programming design flow, the new Programming files (STAPL/ PDB) are generated for a design change and
are sent to the FlashPro software for testing and debugging the design.

Note: FlashPoint is integrated into Designer; therefore, the STAPL file is generated from Designer.
FlashPro v6.2 and greater can be used to export STAPL files from PDB files created by FlashPoint
(Designer).
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Figure 1 - Programming Design Flow

Operation/Production Planning

The figure below shows an illustration of the operation flow. In this illustration, the production coordinator
generates the programming files (STAPL/PDB) with or without serialization and/or security settings (see
Programming application note for further information). The production coordinator loads the programming
file in the FlashPro software to set up the configurations for production programming, such as Serialization
options, Action selections, and Procedure selections, etc.

FlashPoint
[Designer) Single Device STAPL

FlashPro
STAPL / PDE File Software FlashPro3 ProASIC3/E

JTAG

T
5

Configuratien File

Programming
Stations

Figure 2 - Operation Flow

The production coordinator may want to generate different configuration files for each programming station
(depending on the logistics and serialization options). For example, if the Programming file contains 10,000
serial data and the production coordinator decides to split the serial data designation to one thousand for
each programming station, then ten configuration files will be generated (one for each of the ten
programming stations). However, if you are not using serialization, you only need one configuration file.

The production coordinator can test the configuration files with one or more FlashPro5/4/3/3X programmers
before sending it to the production programming floor. If PDB files are used in the production flow, warning
icons may appear on the FlashPro/FlashPoint GUI because the automatic audit cannot find the source file
on the production environment; the PDB file contains the valid programming data. If STAPL files are used,
loaded STAPL files will be audited on execution of an action to determine if the original STAPL file has been
modified. If it has not been modified, the action will continue to run. If it has been modified you will be
prompted to reload the modified STAPL file, or to continue running the current action. If you select to reload
the modified STAPL file, all previous programming settings will be refreshed and will need to be performed
again.
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Programming Tool User Model Overview - SmartFusion Only

Operation/Production Programming

The figure below shows an illustration of the production programming flow. The operator imports the
configuration file and begins programming the devices by clicking the Run button. The operator's interaction

with FlashPro should be limited.
At the end of a programming session, the serialization log file (if applicable) and the programming log file are
sent back to the production coordinator for record keeping.

:'l
FlashPro » FlashPro3 JTAG ProASIC3/E
Software

Send to
Production Coordinator
for record keeping

Configuration File

Serialization Log Programming Log

N

Figure 3 - Production Programming Flow

Yy v

Express Configuration Programming (IGLOO, ProASIC3 and Fusion devices only)

The figure below illustrates the Express Configuration Programming Flow. In this flow, you can program the
security setting into the IGLOO, ProASIC3 and Fusion family device directly from the FlashPro software.

Note: FlashPoint is integrated into the FlashPro v6.0 and later software.

ITAG

FlashPro ProASIC3/E

Software

I FlashPro3

PDB Flle with
Security Settings

Figure 4 - Express Configuration Programming Flow

Programming Tool User Model Overview - SmartFusion Only

The FlashPro software is designed for use in the operation, user design, and production programming flows.

Design Debug

The figure below illustrates the programming design flow when an engineer is in debug mode. In the
programming design flow, the new files (FDB, UFC, EFC) are generated for a design change and are sent to

the FlashPro software for testing and debugging the design.

FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
. . when clicked. View the online help included with software to enable all linked content.
& Microsemi

Single Device
STAPL/FDE

2 e ]
FlashPaint

{Designer) Export/ Load

e Save

FlashiPro ITAG

Softwiara || FlashPro 4/3/3% SimartFusion

SmartDeslgn T —
(M55) ———.

Figure 5 - SmartFusion Programming Design Debug Flow

Operation/Production Planning

The figure below shows an illustration of the operation flow. In this illustration, the production coordinator
generates the programming files (STAPL/PDB) with or without serialization and/or security settings (see
Programming application note for further information). The production coordinator loads the programming
file in the FlashPro software to set up the configurations for production programming, such as Serialization
options, Action selections, and Procedure selections, etc.
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Figure 6 - SmartFusion Operation Flow

The production coordinator may want to generate different configuration files for each programming station
(depending on the logistics and serialization options). For example, if the Programming file contains 10,000
serial data and the production coordinator decides to split the serial data designation to one thousand for
each programming station, then ten configuration files will be generated (one for each of the ten
programming stations). However, if you are not using serialization, you only need one configuration file.

The production coordinator can test the configuration files with one or more FlashPro5/4/3/3X programmers
before sending it to the production programming floor. If PDB files are used in the production flow, warning
icons may appear on the FlashPro/FlashPoint GUI because the automatic audit cannot find the source file
on the production environment; the PDB file contains the valid programming data. If STAPL files are used,
loaded STAPL files will be audited on execution of an action to determine if the original STAPL file has been
modified. If it has not been modified, the action will continue to run. If it has been modified you will be
prompted to reload the modified STAPL file, or to continue running the current action. If you select to reload
the modified STAPL file, all previous programming settings will be refreshed and will need to be performed
again.

Operation/Production Programming

The figure below shows an illustration of the production programming flow. The operator imports the
configuration file and begins programming the devices by clicking the Run button. The operator's interaction
with FlashPro should be limited.
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SmartFusion2 Programming

At the end of a programming session, the serialization log file (if applicable) and the programming log file are
sent back to the production coordinator for record keeping.

[
JTAG

FlashPro
Software ¥ | | FlashPro4/3/3x SmartFusion

Configuration File

Send to
Production Coordinator
for record keeping

Y v

Serialization Log Programming Log

e L oF

Figure 7 - SmartFusion Production Programming Flow

Creating a New PDB for SmartFusion
The figure below illustrates the new SmartFusion programming flow. In this flow you can program the
security, FPGA Array, FlashROM and Embedded Flash Memory (NVM) for SmartFusion.

FlashPro JTAG ;
e FlashPro 4/3/3X |____| SmartFusion

Security Only (no file)

FDE
EFC
UFC

l

FlashPro FDB

Figure 8 - Creating a New PDB for SmartFusion

SmartFusion2 Programming

SmartFusion2 programming is executed from within Libero SoC.
See the Libero SoC help for information on SmartFusion2 programming, including programming
authentication error codes and programming error codes.
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Supported Families

Microsemi's Libero SoC software supports the following device families and their derivatives.
Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
PolarFire N/A New FPGA family that delivers the lowest power at

mid-range densities, and is optimized for cost while
providing high end features.

SmartFusion2 | N/A Address fundamental requirements for advanced
security, high reliability and low power in critical
industrial, military, aviation, communications and
medical applications.

IGLOO2 N/A Low-power mixed-signal programmable solution
RTG4 N/A Microsemi's new RTG4 family of radiation-tolerant
FPGAs

SmartFusion | SmartFusion SmartFusion intelligent mixed-signal FPGAs are the
only devices that integrate an FPGA, ARM Cortex-M3,
and programmable analog, offering full customization
and IP protection.

Fusion N/A Mixed-signal FPGA integrating ProASIC3 FPGA
fabric, programmable analog block, support for ARM®
Cortex M-M1 soft processors, and flash memory into a
monolithic device.

IGLOO IGLOO The ultra-low-power, programmable solution

IGLOOe Higher density IGLOO FPGAs with six PLLs and
additional 1/O standards

IGLOO nano The industry’s lowest power, smallest size solution

IGLOO PLUS | The low-power FPGA with enhanced I/O capabilities

ProASIC3 ProASIC3 The low-power, low-cost, FPGA solution

ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and
additional 1/0 standards

ProASIC3 Lowest cost solution with enhanced I/O capabilities

nano

ProASIC3L The FPGA that balances low power, performance,
and low cost

Automotive ProASIC3 FPGAs qualified for automotive

10 FlashPro User's Guide
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Installing FlashPro Software and Hardware

ProASIC3/EL

Device Family Description
Family Derivatives
ProASIC3 applications
Military Military temperature A3PE600L, A3P1000, and

A3PE3000L

RT ProASIC3

Radiation-tolerant RT3PE600L and RT3PE3000L

Installing FlashPro Software and Hardware

See the FlashPro Installation Instructions on the Microsemi website for information on how to install
FlashPro software/hardware and relevant system requirements.

View the detailed Install Instructions and System Requirements at the FlashPro software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashpro#overview

Starting FlashPro

You can start the FlashPro software from Programs > Microsemi FlashPro vx.x >
FlashPro. If you installed the program in a folder other than FlashPro, choose that folder from the

Programs menu.

The figure below shows the FlashPro GUI. From this GUI, you can create a new project by clicking the New
Project button or open an existing project by clicking the Open Project button.

You can also access the above features from the menu bar. You can access all the other features after you
open or create a new project.

FlashPro User's Guide
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FlashPro Interface

The main FlashPro interface consists of two views, one for Single Device Programming and the other for
Chain Programming (see figure below). The GUI consists of a Flow window, Device Configuration Window
(for single or chain programming), Log window and a Status bar. The Log window displays programming
information, error messages, and warning messages. The Status bar displays your programming mode
(chain programming or single device programming) and file status.
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Figure 9 - FlashPro for Single Device File Programming

Note the different options in the Flow window for the Chain Programming GUI and the Single Device
Programming GUI. In addition to the different Flow window options, the Chain Programming GUI view
consists of the Chain Configuration window which displays the devices in your chain.
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Figure 10 - FlashPro for Chain Programming

Creating a New Project

With the FlashPro software, you have the option of choosing either the Single STAPL file or Chain
programming mode. You make this choice through the New Project dialog box (see figure below). By
choosing the Chain Programming mode, you are enabling chain programming. The Single STAPL file
Programming mode functions with the same programming capabilities as the FlashPro software v4.2.
To create a new project:

1. Click the New Project button or from the File menu choose New Project.

2. From the New Project dialog box, type in the name of your project in the Project Name field.

New Project E
Project Name:
f projz]

Project Location:
I CiiDocuments and Settingsifarley Browse. .. |

Programming mode

& Single device
" Chain

OF I Cancel | Help |

Figure 11 - New Project Dialog Box
3. If necessary, change the default location of your project in the Project Location field.
4. Choose your Programming mode (Single device or Chain).
5. Click OK. The FlashPro GUI displays (see figure below).

FlashPro User's Guide 13
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Figure 12 - FlashPro GUI

Note: You can switch between the two programming modes from Tools > Mode. From there, you can

choose either Single

Opening a Project

Device Programming or Chain Programming.

You can open a project from the File menu or by clicking on the Open Project button in the flow window.

To open a project:

1. From the File menu, choose Open Project. The Open Project dialog box appears.

2. Find your project file or type in your project file name in the File name field.

3. Click Open.

Saving a Project

Click the Save button on the toolbar, or from the File menu choose Save Project to save your project.

If you want to save your project under a different name/path, from the File menu choose Save Project As
and save your project with the new name.

Parallel Programming wi

th FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple
programmers. In parallel programming, all targeted devices are programmed with the same programming
file (STAPL). The targeted device or chain configuration that is connected to each programmer must be

identical.

The FlashPro software together with the FlashPro5/4/3/3X programmers supports parallel programming via
a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a USB v2.0 port.

FlashPro5/4/3/3X requires a self-powered hub.
Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device

programming time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

Note: FlashPro (USB/LPT1) or FlashPro Lite programmers do not support parallel programming.

14
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Serialization with FlashPro

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel
programming.

> FlashPro3 w ProASICIE
H > FlashPro3 3 ProASIC3/E
/ E
H
U
H / E
U r
B
H
U
B [—
> FlashPro3 3 ProASICE
H
" > FlashPro3 ¥ ProASIC3/E
B M/
-

Figure 13 - Connecting a FlashPro5/4/3/3X Programmer
An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming
works best with the vendor's latest driver installed and with the matching hubs.

Serialization with FlashPro

You can use the FlashROM in the ProASIC3 device for serialization. For each target ProASIC3 device,
different FlashROM contents are generated.

Serial Programming enables you to program a sequence of ProASIC3 devices in serial with an identical
FPGA program and with different serialization data. Serialization data can consist of different FlashROM
content and/or AES key values. To learn how to activate the serialization feature, see Skip Serial Data or
Reuse Serial Data.

There are two different STAPL formats that support serial programming, multiple actions to multiple serial
data and single action to multiple FlashROM.

Multiple Actions to Multiple FlashROM Serial Data

This format supports a generic STAPL player because the STAPL player does not provide a mechanism for
Serial Programming. One programming action is created to target different serial data. See examples below:

- PROGRAM_1 programs the FPGA Array and the first serial data.

FlashPro User's Guide 15
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- PROGRAM_2 programs the FPGA Array and the second serial data.

Single Action to Multiple FlashROM Serial Data

This format is created when the target programmer is FlashPro, Sculptor II, or BP auto programmer, where
the newly innovated Microsemi Serial Programming mechanism is supported. One programming action will
program multiple serial data in serial.

FlashPro and SVF

SVF (Serial Vector Format) is an industry standard file format that is used to describe JTAG operations. Like
STAPL files, SVF files are used for describing the in-system programming algorithm for SmartFusion,
IGLOO, ProASIC3 and Fusion family devices. Unlike STAPL files, SVF files support only one ACTION or
programming flow per file, due to language limitations. In addition, the SVF specification does not support
message display and flow control, such as conditional statements or loops.

As a result, Microsemi tools (Designer and FlashPro software) generate a set of SVF files corresponding to
the equivalent STAPL ACTIONS that are applicable to the silicon features selected.

For example, for a typical STAPL file that has the following ACTIONS: ERASE, ERASE_ALL, PROGRAM,
PROGRAM_ARRAY, VERIFY, VERIFY_ARRAY, DEVICE_INFO, READ_IDCODE, and
VERIFY_DEVICE_INFO, a set of corresponding SVF files are generated and hamed: ERASE.sVf,
ERASE_ALL.svf, PROGRAM.svf, PROGRAM_ARRAY.sVf, etc. These files are generated in a folder,
<Programming File Name>_svf, created during generation. The diagram below demonstrates the
differences between the STAPL and SVF files that are created.

STAPLFILE SVF FOLDER
PROGRAM PROGRAM. swf
ERASE

ERASE.swf
VERIFY

WERIFY suf
PROGRAM_ARRAY
ERASE ARRAY PROGRAM_ARRAY syf
VERIFY ARRAY ERASE ARRAY. 5w
DEVICE INFO

VERIFY_ARRAY.svf

Figure 14 - STAPL vs SVF files
Note: DEVICE_INFO.svf file is not generated because SVF files do not support messsage display or flow

control.
Table 2 - SVF Outline
SVF File Array | FROM NVM Security | Previously

(Flash | Settings | Programmed
Memory Device?
System
Builder)

ERASE X X YES or NO

ERASE_ALL X X X YES or NO

ERASE_ARRAY X YES or NO
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FlashPro and the 1532 File Format

SVF File Array | FROM NVM Security | Previously

(Flash | Settings | Programmed

Memory Device?

System

Builder)
ERASE_FROM X YES or NO
ERASE_SECURITY X YES or NO
PROGRAM X X YES or NO
PROGRAM_ARRAY X YES or NO
PROGRAM_FROM X YES or NO
PROGRAM_NVM X YES or NO
PROGRAM_SECURITY X YES or NO
VERIFY X X X YES or NO
VERIFY_ARRAY X YES or NO
VERIFY_FROM X YES or NO
VERIFY_NVM X NO
ENC_DATA_AUTHENTICATION | X YES

STAPL Actions not Available with SVF

The following STAPL actions are not available with SVF: DEVICE_INFO, VERIFY_DEVICE_INFO,
READ_IDCODE

FlashPro and the 1532 File Format

1532 is an IEEE industry standard file format that is used to describe JTAG operations. Like STAPL files,
1532 files are used for describing the in-system programming algorithm for SmartFusion, IGLOO, ProASIC3
and Fusion family devices. 1532 programming file generation will generate two files (*.isc, *.bsd) within a
folder.

The folder will be created with the following name <Programming File Name>_1532. The *.bsd file contains
the IEEE 1532 programming algorithm. The *.isc file contains the programming data to be programmed into
the device.

IEEE 1532 programming files will only be exported in FlashPro for SmartFusion devices when an FDB has been properly

imported.

STAPL to 1532 Action Mapping

The IEEE 1532 standard requires using default ACTION names in order to function with 1532 compliant
players. The table below describes the STAPL to 1532 ACTION name mappings.

Note: 1532 ACTIONSs can have a data member parameter to allow reuse of the same ACTION name for
different features.

Note:

FlashPro User's Guide 17



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
. . when clicked. View the online help included with software to enable all linked content.
& Microsemi

Table 3 - STAPL to 1532 Action Name Mapping

STAPL Action

1532 Action
ERASE_FROM ERASE(FROM)
PROGRAM_FROM PROGRAM(FROM)
VERIFY_FROM VERIFY(FROM)
PROGRAM PROGRAM
PROGRAM_ARRAY PROGRAM(ARRAY)
ERASE_ARRAY ERASE(ARRAY)
ERASE ERASE
ERASE_ALL ERASE(ALLDATA)
VERIFY VERIFY

VERIFY_ARRAY

VERIFY(ARRAY)

READ_IDCODE

READ(IDCODE)

ENC_DATA_AUTHENTICATION

VERIFY(ENCDATA)

PROGRAM_SECURITY PROGRAM(SECURITY)
DEVICE_INFO READ
VERIFY_NVM VERIFY_NVM

VERIFY_SECURITY

VERIFY(SECURITY)

PROGRAM_NVM

PROGRAM_NVM

18
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Single STAPL/PDB File Basic Tutorial

Introductory Programming Tutorials

Single STAPL/PDB File Basic Tutorial

This section provides step-by-step instructions to familiarize you with the basic features of the FlashPro
software, specifically how to program a device. For more detailed step-by-step instructions and help with
advanced features of the software, please see specific topics in the online help.

Note: This tutorial assumes that you have already installed the latest version of FlashPro software and have
started the program.

First, create a new project and name it Tutorial. If FlashPro is launched through the Libero SoC, a new
project will be created automatically and a PDB or FDB file loaded, if available.

To Create a Project:
1. Click the New Project button in FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.

Mew Project &|

Projeck Marne:

Projeck Location:

| Erowse. ..

Programming mode

+ Single device
" Chain

Ik | Cancel Help

Figure 15 - New Project Dialog Box
3. If necessary, change the default location of your project in the Project Location field.
4. Select the Single device Programming mode

5. Click OK. The FlashPro GUI displays (see figure below). The Programmer List Window updates with
your programmer information.
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T FlashPro - [dddd] * (=13

File Edt “iew Tools Programemers Configuration Customize Help

DM ? % i EE 4 & &Hdh |6 0

New Project D Configure Device |
_> Ei _> PROGRAM T
Open Project =" Wiew Programmers % |

dy

*

» Programmer Programmer Port Programmer Programmer
Hame Type Status Enabled

k=l

E‘ Refresh/Rescan for Programmess

X Software Version: 9.1.2.0 -~

I loriver : 3.0.0 buila 1

programmer '30964' : FlashProd

Ready ik anlprogramming_designs|fsfidesignertimpliidddd pdb_ SINGLE

Created nevw project 'Vilkiran\programming designshfsf\designer)impli)dddd fp\dddd.pro’

PDE file 'Vi\kiran\programming designshfsfhidesignec’ impll)dddd.pdb' has been loaded successfully.
DESIGN : dddd: CHECESUM : 7CZF; PDE_VERSION : 1.6

Checking for software updates...

Bescanning for Programmers...

All A Emrors } Wammings | Info [

Figure 16 - FlashPro Main Window

Loading and Configuring a Programming File

Once you have created your project and connected your programmer, you are ready to load your PDB or
STAPL file.
To load a Programming file:
1. Click the Configure device button. The Single Device Configuration window displays in FlashPro .
2. Click the Browse button to find your Programming file.
3. From the Load Programming File dialog box, select your Programming file and click Open.

The Single Device Configuration Window updates to list your Programming file information and the actions
available with your Programming file in the Action list box (see figure below). Program is the default action
displayed in the Action list box.

Note: Note: Microsemi recommends using the default settings.

Programming file

dddd.pdb Browse..,
Madify...

DATE_MODIFIED Thu Feb 03 15:58:14 2011 -~ Mode: ¢ Basic & Advanced
PDB_FILE_NAME Vilkiram\programming designs)fsfl\desic
CREATOR Designer Version: 9.1.2.0 Aclion
DESToH adad PROGRAM =
g CHECKSUM 7C2F
; PDE_VERSION 1.6 Procedurss..
'E IDCODE 0353A1CF
% |IDHASK OFFFFFFF
o |FAMILY FUSION
“g DEVICE AFS1500 b4
< >
ke
ri Chain Parameter. ..
o

Figure 17 - Single Device Configuration Window

This tutorial gives instructions on how to program a device. For an explanation on the other actions
available, see Programming File Actions.
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Single STAPL/PDB File Basic Tutorial

Now that you have loaded your PDB file, programming a device is the next step.

To program a device:

1. From the Action list, select Program (see figure below).

x [ Programming file

dddd.pdb Browse. .,
ModiFy. ..
DATE_MODIFIED Thu Feb 03 15:58:14 2011 ~ Mode: ¢ Basic @ Advanced
FDE_FILE NAME Vilkiran\programming designs\fsfidasig i
CREATOR Designer Versiom: S.1.2.0 Action
MODIFIED
3 |pEszcw dddd |PROGRAM =l
CHECKSUM 7FCZF
E FDE_VERSION l.8 Procedures...
§ |IDCODE 0353A1CF
'3 IDHASE OFFFFFFF
g |FAMILY FUSION
"g DEVICE AFS1500 L
< >
k]
E Chain Parameter. ..
o

Figure 18 - Selecting Program from the Action List box
2. Click the Procedures button (see figure below).

Action

|PROGRAM |

Figure 19 - Procedures Button

The Select Action And Procedures dialog box appears, showing the procedures for the Programming action
(see figure below). Microsemi recommends using the default settings.
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Select Action And Procedures E]

Action:

PROGRAM v

Procedures I:
M W_INITIALIZE
CHECK_AND_BACKUP_CALIB
DO_ERASE
DO_PROGRAM
DO_VERIFY_BOL
DO_PROGRAM_RLOCK
DO_VERIFY_PGM_RLOCK
DO_PROGRAM_NWVM_3

IEESESNEE

Restore Default Procedures

Help OK Cancel

Figure 20 - Select Action and Procedures Dialog Box
3. Click the Restore Default Procedures button.

4. In FlashPro click the Program button to program your device.

The Programmer List Window updates the Programmer Status column with Run Passed indicating
that you have successfully programmed the device (see figure below).

Note: The status indicator updates during programming to show the programming progress, then it will
change to a pass or fail result when the operation is complete.

Programmer Programmer Port Programmer Programmer
Mame Type or Status Enabled
1103375 FlazhPro3 ush03375 (USE1.1]  RUM PASSED [

Figure 21 - Successfully Programmed Device
5. View the Log window and take note of the details about your programmed device.
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Single Microsemi Device with Serialization Tutorial

This tutorial provides step-by-step instructions on how to program a single Microsemi Device with

Serial

ization. Before you begin this tutorial, make sure you have already installed the FlashPro software and

that you are familiar with the basic features of using the FlashPro software.

First, create the file generator using FROM for device serialization. You must have access to the Libero IDE
v8.0 or later software to complete this step.

To Configure the FROM data for serialization:

1.
2.

ook ow

Generate FROM via the Catalog.

From the Properties section in the FlashROM Settings dialog box, select Auto Inc or Read From
File region. For the Auto Inc region, specify the step value. You will not be able to modify this value in
the FlashPoint software.

Complete the normal design flow and finish place and route.
Select Program FlashROM .
Click Browse to find the UFC file.

Check the FPGA Array box and click Next. The FlashROM Settings window appears (as shown in the
figure below).

FlashROM Settings - Step 2 of 2 (%
|FIashROM regions: Region_7_10 LI
Program Properties:

page Mame Fegion_7_10

v Start page T
Start ward 10

v Length B
Cantent Static

¥ State Fired

W Type HEX
Walue 123123

v

v

I~

v

FlashROM STAPL file type
’V # Single STAPL file For all devices " One STAPL file per device
Murmber of devices to program: 100 Target Programmer. .. |
Help | Back I Iext I Firish | Cancel |

7.

Figure 22 - FlashROM Settings- Step 2 of 2
Select the FROM page you want to program and data value for the configured regions.

Note: The generated STAPL file contains only the data that targets the selected FROM page.

8.

Modify properties for the serialization by specifying the Start and Max values. For the Auto Inc region,
specify the Start and Max values. For the Read From File region, select the file name of the custom
serialization file.

Select the FlashROM programming file type you want to generate from the two options below:

o Choose single STAPL file for all devices: generates one programming file with all
FROM values.
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Choose one STAPL file per device: generates a separate programming file for each
FROM value.

10. Enter the number of devices you want to program and generate the required programming file.

11.

Click the Finish button.

You have completed the steps to enable device serialization. Now you are ready to program a device using

Device Serialization in FlashPro.

To program a device using device serialization:
1. Click the New Project button in the FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.
3. Check the Single STAPL file option from the Programming Mode area.
4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro GUI appears (see figure below).

¥ FlashPro - [dddd] * (=13

Ele Edt ‘iew Tools Frogrammers Configuration Customize Help

DM ? |a% @i HE &9 & D5 pa |6 0

New Progect D

Configure Device & I

=
View Programmers %l

— = mow T

IDCODE D353A1CF

| €

[T O T
dddd.pdb Browse..,
; Madify. ..
2 Mode:  Basic % Advanced
| [DATE_MODIFIED Thu Feb 03 15:58:14 2011 - . asic
FDB_FILE_NANE Vilkiram\prograuming designe)fsfide: Action
CREATOR Designer Version: 9.1.2.0
MODIFIED |FRUGF|N~| ;'
"g DESICH dddd
CHECK:STH TCZF
3 PDE_VERSION 1.6 Eiocedies
x|
£

Software Versiom: 9.1.2.0

Deiver : 3.0.0 build 1

programver '30964' : FlashProd

Created nev project 'V:iikiram)programming designsifshdesigner’ impli’idddd_fphdddd.pro®

PDB file 'V:ikiran\programming_ designs)fsf)designer’impll)dddd.pdd’ has been loaded successfully.
DESIGN :

dddd; CHECESUN :
Checking for software updates...

Rescanning for Programmers...

TCIZF; FDB_VERSION : 1.6

All A Emmors A Wamnings p Info [

[ G Vilkiranprogramming_designsifsfidesignerlimlt\dddd.pdb STNGLE

Figure 23 - FlashPro Main GUI
The Programmer List Window updates with your programmer information.

6. Click the Configure STAPL File button to load the STAPL file. The Single STAPL Configuration

Window appears in the FlashPro GUI.
7. Click the Browse button to find your STAPL file.

8. From the Load STAPL File dialog box, find your STAPL file and click Open. The Single STAPL
Configuration Window updates to list your STAPL file information and the actions available with your

STAPL file in the Action list box (see figure below).
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x [~ Programming File
y [ Seriakzation
. pdb Browse...
Modify...
DATE MODIFIED Sat Jan Z9 19:38:14 Z011 tad
PDE_FILE_NAME V:\kiram\programming designsisf_seride Action
CREATOR FlashPro Version: 5.1.2.0
MODIFIED FlashPro Version: 9.1.2.0 Ipﬁnﬁw ﬂ
é DESIGH
§ |CHECKsUM 0000
[ PDB_VERSION 1.6 Procedues...
'! IDCODE OSALZLCF
IDMAZK ODFFFFFF
FANTILY PAZSOCE v
L4 >
£
a Chain Parameter... Inspect Device
#

Figure 24 - Single STAPL Configuration Window with STAPL File Uploaded

9. From the Single Device Configuration Window in FlashPro, check the Serialization box and click
the Select Serialization Indexes button.

The Serial Settings dialog box appears (see figure below).

3

Serial Settings

[ B B B ) I R PR S

v Wiew unused data
v Wiew used data
v Yiew skipped data

Filker: | *

v Log serial data: |Regiu:un_6_3

Help

— All

N

El

Cancel |

o]

Figure 25 - Serial Settings Dialog Box

10. From the Serial Settings dialog box, click All to select all the serial data.
11. Click OK. The Serialization Indexes text box updates (see figure below).
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W Serialization
Senalization

Action; |P'F|E|I3F|,£'-.M ﬂ Procedures. .

| i Select Senalization Indexes.. |

Senal Indexes | State | Frogrammers |

Jnuzed
Jruzed
Jnuzed
Jnuzed
Jnuzed
dnuzed
dnuzed
ruzed
ruzed
1] Jruzed

P S I R O T R A P TR S )

Mext Senalization Data: 1

Figure 26 - Single STAPL File Configuration Window- Serialization Indexes Update
12. Click the Program button to program your device using serialization.

Chain Programming Tutorial

This tutorial demonstrates how to directly program an APA300 device that is part of a heterogeneous JTAG
chain. The example in this tutorial uses one APA300 device and three non-Microsemi devices configured as
shown in the figure below.

Note: This tutorial is performed in Advanced Mode. You can change your display mode to Advanced Mode
from the Preferences dialog box.

DO Device 4 Device 3 Device 2 Devica 1
m — DI TDO oI TDO TDI TDO DI TDO| |

TMS TS TMS TM5, r TMS
TCK TCK Non-Actel | — Tck Non_Actel ‘ — Tck MNon-Actel "TCK APAZ00

Figure 27 - APA Device Tutorial Example
First, create a new project.

To create a new project:
1. Click the New Project button in FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.
3. Select the Chain option in the Programming Mode.
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Chain Programming Tutorial

x]

Mew Project

Project Mame:

| Tutarial|

Project Location:
| A Ackelpri Tukarial Browse, .. |

Pragramming mode

" Single device
* Chain

Ik | Cancel Help

Figure 28 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro GUI appears (see figure below).

¥ FlashPro - [Tutorial]

File Edt View Tools Programmers Configuration Customize Help

D= 7 || s sd R MM EE W

Mew Project ﬁj

» — — =

Open Project (= Yiew Programmers -
=]
x
Programmer Programmer Progi Prog o ¥
Hame Type Port Status Enabled Device / Action

2
5=
=
H
g
T
g
E Refresh/Rescan for Programmers
g
o
x| Software Version: 5.0.0.40
| Created new project 'C:ihctelpriifpro_tutorialitutorial.pro’
Software Version: &.0.0.40
Created new project 'CibictelpriiTutorialhTutorial.pro’
all /{‘ Errors ;’\ ‘Warnings }\Info .'"
Ready Mo devices in chain (CHAIN

Figure 29 - FlashPro Main GUI
Note: The Programmer List Window updates with your programmer information.

6. From the Menu bar, click Programmers > Scan Chain (or select the programmer in the Programmer
List Window, right-click and choose Scan Chain).

Scan Chain shows how the devices are ordered in the chain in the Log window (see figure below). In
this example, APA300 is the first device and will be programmed first in the chain since it is connected
directly to TDO.
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x| prograwmer '30175' @ Bcakh Chain...

r- programmer '30175' @ Found 32 instruction register hits.
prograwmer '30175' @ Checking IDCODE=S. ..
programmer '30175' 1 Dewvice 1: 11A0831CF Mfr: Actel Part: APAIOO
prograwmer 30175 @ Dewvice Z: Unknown
programmer '30175' : Dewvice 3: Unknown
prograwmer 30175 @ Dewvice 4: Unknown
prograwmer '30175' @ 3cakh Chain PASIED.

Figure 30 - Log Window Scan Chain Order
| Add Actel Device "A or

7. From the Chain Configuration window, click either

Add Norn-Actel Dewvice
buttons to add devices to the chain. In this example, click the Add
Microsemi Device button because the APA300 is the first device in the chain.

The Add Microsemi Device dialog box displays (see figure below).

Add Actel Device [X]

Programming File: | J

" Device

Device: | J

Marne |

Help Ik | Zancel

Figure 31 - Add Microsemi Device Dialog Box
8. Select the File radio button and click the Browse button to find your programming file.
9. Select the Device radio button, then choose the APA300 device from the Device drop-down.

10. Inthe STAPL File field, load the APA300.stp file by using the Browse button *'* to locate the file.
11. Inthe Name field, keep APA300 as the default name.
12. The APA300 device is added to the Chain Configuration Window (see figure below).

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Showe Chain Editing

Device Hame File

1 | APAZOOD [ | &FAS00 0 CriManualstestdesignerimpl WA PA300 sty E]I
2 | Mon Actel [ |Device 2

Figure 32 - Chain Configuration Window: Device One

12. Click the Add Non-Microsemi Device button to add the non-Microsemi device. The Add Non-
Microsemi Device dialog box appears (see figure below). You can load the BSDL file or enter the IR
length and Max TCK Frequency of the device. In this tutorial, you will enter the IR length and Max TCK
frequency for this device.
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Add Mon-Actel Device

X

" File
ESDL file: |

(* Data

IR, length: z
Max TCK Freq.: |1 MHz

Marme: | Dervice 2

el o |

Cancel

Figure 33 - Add Non-Microsemi Device Window
14. For this device, enter 8 in the IR length field and keep the Max TCK freq default to 1MHz.
15. Name the device, "Device 2” and click OK. The second device now appears in the Chain Configuration
Window (as shown in the figure below).
x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Showe Chain Editing

Device Hame

1 APA300
2 | Mon Actel

File

& |APA300
]| Device 2

O CManualstestidesignerimpl! PAZ00 stp

]|

16.
17.

Figure 34 - Chain Configuration Window: Device Two
Repeat step 15 for Device 3 and Device 4.

Check the Enable Device box for the APA300 device. After you add all the devices in the chain, the
Chain Configuration Window should look like the figure below.

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Shaowe Chain Editing

Device Hame File
1 | APAZ00 [l APAZOO O CManualstestidesignerimpl WAPA300 stp [=]
2 | Mon Actel [ |Device 2
3 | Mon Actel [ |Device 3
4 | Nondctsl

Figure 35 - Chain Configuration Window: All Devices in the Chain
18.

After you have added all of the devices to the chain in the correct order, click the Run button to
program the chain.
19. When programming is complete, the results are listed in the Log window (see figure below).
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programner '30175' ; device 'ALPAI00' ; VERIFYING PROGRAMMED BITS...
programoer '30175' : device 'ALPA3I00' : VERIFYING NON-PROGEAMMED EBITS...
programer '30175' @ dewvice 'APAI00' @ Finished: Tue Jul 18 18:09:592 2006 [Elapsed time 00:03:00)
programmer '30175' @ device 'APAI00' : Executing asction PROGRALAM PASSED.
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Figure 36 - Programmer List Window: Programming Complete

SmartFusion Programming Tutorial

You can program your SmartFusion device without using the Libero SoC by using an EFC or UFC file from
standalone SmartDesign, or using an FDB file from standalone Designer.
To program a SmartFusion device without using the Libero SoC:

1. Start FlashPro and click New Project to create a new project. Specify your Project Name, Project
Location and Programming Mode.

2. Click Configure Device.

3. Single Mode: Click the Create button to create your new PDB programming file. The create PDB
dialog box appears (as shown in the figure below).

Create PDB g|

Device: | AZF200M3F =]

Package:

Mame: | smartfusion_0113

Location: | Ciactelpritsmartfusion_0113

[o]4 | Cancel |

Figure 37 - Create PDB Dialog Box

Chain Mode: Click Add Microsemi Device and choose a SmartFusion device from the drop-down
menu. Click the Create PDB button in the Chain Configuration Window. The Create PDB dialog box
appears.

4. Specify your PDB parameters. Click OK to continue. The FlashPoint SmartFusion Programming File
dialog box appears.

5. Specify your security settings and select which silicon features you want to program. Click the Import
button for your EPGA Array, FlashROM and Embedded Flash Memory files to add them to your PDB
file.

You must have a FDB file to program your FPGA Array, a UFC file to program your FlashROM, and a
EFC file to program your Embedded Flash Memory.

Click the Modify buttons if you wish to modify your FlashROM or Embedded Flash Memory files
before you save your PDB file.

6. (Optional) Specify your I/O States During Programming.
7. Click Save PDB to save your new PDB file.

If you make changes to your Security, /0O States During Programming, EFC, UFC or FDB file, click Modify
in FlashPro to open and re-save your PDB with the updated files and settings.

See Reprogramming a Secured Device for information on programming a secured SmartFusion device.
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Modifying Memory Contents and Programming a Device Tutorial

This tutorial provides step-by-step instructions on how to load a Program Database (PDB) file, modify the
memory contents, and program the device.

Before you begin this tutorial, you should have a design with an EFMB client in it with a generated
programming file for this design. You will first create a new project and title it "tutorial.” If FlashPro is

launched through Libero SoC, a new project will automatically be created and a PDB file will be loaded, if
available.

Creating a new project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you

would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB File
Basic Tutorial.

Loading and Configuring a PDB File
Once you have created your project and connected your programmer, you are ready to load your PDB file.
To load a PDB file:

1. Click the Configure Device button. The Single PDB Configuration window appears in FlashPro.
2. Click the Browse button to find your PDB file.
3. From the Load PDB File dialog box, find your PDB file and click Open.

Modify Embedded Flash Memory Block Content
Now, you are ready to modify the Embedded Flash Memory Block content.

To modify Embedded Flash Memory Block content:
1. Click the PDB Configuration button to open FlashPoint.

FlashPoint - Programming File Generator - Step. 1 of 3

Silicon Featurels) bo be programmed:
6 [V Security settings
W FPa4 Array
W FlashRoOM
Criginal FlashROM configuration File:

Embedded Flash Memory Blocks (EFME);

Program :I:;:; LE(I;?:;“ Onginal Configuration File
1 = firrwsare A h_. 1 F:\Flash_Memary_Block. efc W odify,..

[ Programming previously secured device(s)

Modify IO States During Programming. . .

Silicon signature {mazx length is & HEX chars):

Help Mext Finish Cancel

Figure 38 - Program File Generator

FlashPro User's Guide 31



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
. . when clicked. View the online help included with software to enable all linked content.
& Microsemi

2. Check the Program box.

3. Click the Modify button to import Embedded Flash Memory Block configuration and memory content
file. The Modify Embedded Flash Memory Block dialog box appears

Modify Embedded Flash Memory Block E‘
Block narme: Firrnwarel i _INST
Black location: 1
Block configuration File: D:hprode0auditinyrn_sl_newinvm_sll_new.efc

Block content:

Select All Clignts Unselect All Clients

Start ) JTAG Protection
Program [Client Type | Client Name | Address [, LNt [ pieyent [ Prevent | Original Memory Content File
(hex) b Read Write
1 =3 Analog Syste  asbh M4 MNA I ~
2 =2 CFI Data cfiDl ata Mid MN/&, I = Di:hprodBOauditsnvm_simpletinput_m Impart content...
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Figure 39 - Modify Embedded Flash Memory Block Content Dialog Box

4. Click the Import Configuration File button to import the Embedded Flash Memory Block configuration
and memory content from the EFC file. This will populate the client table below. All clients that belong
to this block will be selected by default.

5. Click the Import content button if you want to change the client memory content.
6. Click OK.
7. Click Finish.
Note: FlashPoint audits original configuration and memory content files and warns you if the files cannot be

located or if they have been updated. These files are not required as the last updated configuration
and memory content is stored in the PDB.

~

The original configuration file has changed.
Click on the Modify button to view the details,

al Configuration File

ctelpriFlashProtFusion Viewhsm  padify,.

Figure 40 - Audit Warning

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Modifying FlashROM Contents and Programming a Device Tutorial

This tutorial provides step-by-step instructions on how to load a Program Database (PDB) file, modify the
memory contents, and program the device.

Before you begin this tutorial, you should have a design with an EFMB client in it with a generated
programming file for this design. You will first create a new project and title it "tutorial.” If FlashPro is
launched through the Libero SoC Project Manager, a new project will automatically be created and a PDB
file will be loaded, if available.

Creating a new project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you
would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB File
Basic Tutorial.
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Modifying FlashROM Contents and Programming a Device Tutorial

Loading and Configuring a PDB File

Once you have created your project and connected your programmer, you are ready to load your PDB file.

To load a PDB file:
1. Click the Configure Device button. The Single Device Configuration Window displays in FlashPro
(see figure below).

x|~ Programming file
To continue,

lnad existing programming File Browse...
or create new FDB file

e [Cwmsavie

Single Device Configuration indow

Figure 41 - Single Device Configuration Window

2. Click the Browse button to find your PDB file. From the Load Programming File dialog box, find
your PDB file and click Open. .

Modify FlashROM Content
Now you are ready to modify the FlashROM content.
1. Click the PDB Configuration button. This opens FlashPoint.
2. Select FlashROM under Silicon feature(s) to be programmed (see figure below).

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featurels) to be programmed:
ﬂ IV Security settings
¥ FPGA Array
Iv Flashrom
Criginal FlashROM canfiguration File:

Embedded Flash Memory Blocks (EFMED:

Program EII:;:; LE:;:::;n Original Configuration File
1 Ird firrwsareh /M .. 1 F:\Flagh_Memary_Block. efc Madify...

[ Programming previousky secured devicels)

Modify I/C States During Pragranmming. ..

Silicon signature {max length is & HEX chars):

Help et Firish Cancel

Figure 42 - FlashPoint Programming File Generator
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3. Click the Browse button to select the *.ufc FlashROM configuration file by and navigating to the
configuration file. This file is normally present in the SmartGen subfolder of the Libero SoC project, in a
folder with the FlashROM IP block's name.

4. Click Next.

5. Select the FlashROM pages you want to program (see figure below).

FlashROM regions: Region_0_0 LI
Program Propetties:
page I amne Region_ 00
v Start page 0
Start word a
v Length 16
Caontent Static
¥ State Fixed
I Type HE=
Walue F14FEFF4F840 941861
I~ SESEEDO1104080
=2
=2
v

Help | Back I Iext I Firish Cancel

Figure 43 - FlashROM Settings Dialog Box

6. Click Finish.

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Programming Only Security Settings Tutorial

This tutorial provides step-by-step instructions on how to program only the security settings into a device.
No design or PDB file is needed to follow this tutorial.

First create a new project and name it tutorial. If FlashPro is launched from the Project Manager, a new
project will automatically be created and a PDB file will be loaded, if available. For this tutorial you always
need to create a new project.

Creating a New Project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you
would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB file
basic tutorial.

Configuring the Security Settings
Once you have created your project and connected your programmer, you are ready to load your PDB file.
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Programming Only Security Settings Tutorial

To configure the security settings:
1. Click the Configure Device button. The Single Device Configuration window appears in FlashPro
(see figure below).

x| [~ Programming file
To continue,

load existing prograrmming File Browse. ..
or create new PDB file

e |

Single Device Configuration Window

Figure 44 - Single Device Configuration Window
2. Click Create. This opens the Create PDB dialog box, as shown in the figure below.

Create PDB §|

Device: | j
Package: | ﬂ

Mame: | |

Lacation: |

K | Cancel |

Figure 45 - Create PDB Dialog Box

3. Select the desired device and package (if available) from the drop down list, and specify the filename
and location. Click OK. FlashPoint opens. SmartFusion, IGLOO, ProASIC3 and Fusion family devices
support securing the device with a pass key as well as encrypting programming files using an AES
key. Flash devices can also be permanently locked, preventing reprogramming.

4. Check the Security Settings checkbox to secure the unsecured device.
Warning: Make a note of the security keys that you are using. Once a device is secured, it cannot

be reprogrammed without those keys.
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Figure 46 - Security Settings Dialog Box

5. Click Finish.

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Automatic Chain Construction Tutorial

This tutorial demonstrates how to automatically scan a chain of devices and construct the chain within
FlashPro. Automatic chain construction saves the effort of manually adding each device to your chain.
The software also scans the chain before constructing it, which reduces the possibilities of having errors in
the chain. This feature is fully automated if your chain is composed of only Microsemi devices. If you have
non-Microsemi devices in your chain, you can still use the Auto Chain Construction feature. However, you
will be required to either manually add the BSDL file or enter the IR length and max TCK for each non-
Microsemi device. This tutorial goes through the flow for an Microsemi-only chain first, followed by
instructions on adding Non-Microsemi devices to the database.
Note: This tutorial requires that your chain is connected to the computer you are using, via an Microsemi
programmer, and that you have suitable programming files to program the devices in your chain.

To automatically scan a chain of devices and construct the chain:
1. Start a new project in FlashPro. Select Chain as the Programming Mode.

2. Click the Configure Chain button in FlashPro.

3. From the Configuration menu, choose Construct Chain Automatically; or click the Construct the
chain from a Scan Chain operation link in the Chain Configuration Window, see below.
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Figure 47 - Construct Chain Automatically

=

4. A popup appears asking you to select the programmer you would like to use from the ones attached to
your computer. Choose the appropriate programmer (as shown in the figure below) and click OK.

X

Scan Programmer(s)

The device chain will be automatically built to match the
physical chain of one ar more programmers.,

Select the programmeris) wou wank to scan:

Frogrammer(z]
30964

Select Al | nselect Al

Help |

Figure 48 - Select Programmer Popup

Cancel

Automatic chain construction starts. The Log window documents the detection and

verification of all devices in your chain. The devices are added to the chain in the Chain
Configuration Window; see figure below for an example.

CBX
SR T T T NE e

Programmer
Name

1 30964

Programmer Prog Py
Type Port Status
ush30964 (USB 20) SCAM CHAIN PASSED

Device / Action
FlashProd

Refresh/Rescan for Programmers .|
| |

RUN =% |
x o
- Add Actel Device 14 |
—-|rn| N rnol—-no —-|r|)| 2 rnol—-lrnl 'I TDO}—- Create PDB... | Conifigure Device... | ﬂ ﬂ &
Add NorvActel Device
¥ Show Chain Ediling Inspect Device | —I
- - IR Max TCK = Enable = Enable B Serial
Device MName File Length (MHz) Device | Seral Action
1| ATPILNVAGL] B A3PILN)AGLING2S
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Figure 49 - Scan Chain Configuration Passed
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In some cases, FlashPro is not able to uniquely identify the device due to shared IDCODEs, and lists all
possible devices (ex: AGL030V2/AGL030V5). Once a programming file is loaded for that device, the device
field only shows one device, since the programming file will only be targeted to one device.

Adding Non-Microsemi Devices to the Chain

FlashPro recognizes non-Microsemi devices in the chain, but it does not contain any device information,
such as IR length or Max TCK. The figure below lists Microsemi devices and non-Microsemi devices in the
chain.

rdleww

: Add Actel Device 14 |
_.|rn| N 1|)o|_-... _-|1|)| 2 rno'—-lrm 1 TDO}—' Create PDB... | Conifigure Devlce...l il iJ il
Add Nomductel Device
[¥ Show Chain Editing Inspect Device
- = IR Max TCK = Enable = Enable c Serial
Device Name File Length (MHz) Devica | Serial Action Data HIGH-Z

1 ASPILINJAGLL B ASPILINVAGLING2S 28 10 i i

2 | AFSEO0 = | AFSEO0 g

3 MonActel B devicel 2 1

4 MonActel | device2 2 1

5  MonActel | device3 2 1

Figure 50 - Non-Microsemi Devices in a Chain

You must import the BSDL file into Microsemi's non-Microsemi device database for FlashPro to recognize
your non-Microsemi device.

To import the device BSDL into the FlashPro non-Microsemi device database and run the scan
chain:

1. From the Tools menu, choose Import Settings for Non-Microsemi Devices. This opens the Import
Settings for Non-Microsemi Devices dialog box. This dialog box enables you to import and remove
BSDL files from the database and lists all the device information contained in the BSDL file.

2. Click the Import BSDL Files button and navigate to the folder that contains your BSDL files. Select
the file and click OK. Once the BSDL is imported into the database, the original BSDL file is no longer
audited by FlashPro. If changes are made to the original source BSDL file, it will not affect the BSDL
file that has been imported into the non-Microsemi device database.

Remove BSDL files from the database by selecting the file and clicking the Remove button.

3. Once you have the appropriate BSDL files loaded to the database, you can construct the chain. To do
so, from the Configuration menu, choose Construct Chain Automatically and select the appropriate
programmer from the dialog box. FlashPro runs a scan chain, detects the devices in the chain, and
associates them with the BSDL files in the database, as shown in the figure below.

—-|'IDI N 1DO|—vu.—+IDI 2 'IDOH'IDI 'I rno}—- Create FDB... | Cnriigumﬁwice_-]_ ﬂ ﬂ H M‘

v

Add NonActel Device
Show Chain E diing ——J

IR Max TCK = Enable Enable Senal

File Length | (MHz) | Device Serial Action Data HIGH-Z
2 1
. 2y 4 ¢ 7 7 ] | |
2 1
AFSE00 | AFSE00 =] 8 10 I r
AIPILNVAGLI B A3PIUN/AGLINYZS =] ] 10 i r

Figure 51 - Non-Microsemi Devices in the Chain with Associated BSDL Files

It is possible to add multiple BSDL files to your Non-Microsemi device database that have the same
IDCODE. If the BSDL files list the same IR length but different TCK values, FlashPro automatically chooses
the file with the lowest TCK value by default and no action is required. If the IR lengths are different you
receive an error message asking you to resolve the conflict.

To resolve the issue, click the drop-down arrow adjacent to the device name. This opens the Non-Microsemi
Device Configuration dialog box (as shown in the figure below). From here you can choose the BSDL file
that you wish to use. Browse to the BSDL file or use the Data to input the IR length and Max TCK
Frequency. Once you select your data you can enter a new name or use the default.
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Figure 52 - Non-Microsemi Device Configuration Dialog Box

For a tutorial on manually adding both Microsemi and non-Microsemi devices to your chain as well as
programming the chain, refer to the Chain Programming Tutorial.

See Also
Understanding the Chain Configuration Window
Import Settings for Non-Microsemi Devices

eNVM/EFMB Client JTAG Protection Use Flow

eNVM/EFMB client JTAG protection enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

See the eNVM Client JTAG Protection Tutorial or EEFMB Client JTAG Protection Tutorial for step by step
instructions.
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Figure 53 - eNVM/EFMB Client JTAG Protection Tutorial Use Flow

eNVM Client JTAG Protection Tutorial - SmartFusion

This tutorial provides step-by-step instructions on how to enable JTAG protection for eNVM clients. The
protection can be read, write or both and it is protected with a User Pass Key (FlashLock).

The JTAG protection of eNVM clients enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

One example use is IP customization. This enables an IP vendor to allow limited visibility to eNVM clients for
IP customers. The IP vendor can protect specific clients and leave other clients unprotected for modification
by IP customers. See the eNVM/EFMB Client JTAG Protection use flow diagram for a detailed example of a
typical use case.

Before you begin this tutorial, make sure you have already installed the FlashPro software and that you are
familiar with its basic features.

JTAG READ/WRITE protection is set when you create your original eNVM in Libero SoC. You cannot
change this setting in FlashPro/FlashPoint.
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eNVM Client JTAG Protection Tutorial - SmartFusion

Importing an EFC (Embedded Flash Configuration) File with Client JTAG protection in a
Previously Unsecured PDB

1.

Create a client in eNVM configurator with JTAG read and write protect (as shown in the figure below).

If the MSS block is generated with an eNVM client with JTAG protection then FlashPro requires that
you specify a User Pass Key prior to programming or exporting programming files.

Add Data Storage Client @

" Mo contert [chent iz a placeholder)

0 | Use shsolute addressing

Start address: 0w (B0 _%I

Size of word: 8 | bitz
MNurnber of wonds: 3 [decimal)
JTAG Frotection

[¥ Prevent read W Prevent wite

| 0K

Client name: |Legr_1
U
Content:
% Memaory file: |E:‘-.da;a\anDnc$\Frog|amnhg\eNVM JTAG Pr

Format: ActelBinay - Browse...

Cancel

|

Figure 54 - Generating the EFC File with JTAG Protection

Import the EFC file with JTAG protection in FlashPoint. When the EFC file is imported the Security
Settings box is checked automatically, implying that you must set the User Pass Key (as shown in the

figure below).
The PDB file cannot be saved without specifying the pass key.
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Figure 55 - Importing the EFC File with JTAG Protection

3. Click Specify to open the Security Settings dialog box. Notice that Enable eNVM client JTAG
protection box is checked. This indicates that reading, writing, and verifying of other eNVM pages are

allowed but the reading and writing of specific eNVM clients are protected.

4. To enforce the eNVM client JTAG protection in the PDB file, enter a Pass Key or click Generate

random key (as shown in the figure below).
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eNVM Client JTAG Protection Tutorial - SmartFusion

Security Settings E|
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" High No protection
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AES ey (max length is 32 HEX chars):

Help K Cancel

Figure 56 - Setting Security

Custom Level Security Settings

If you select Custom Level security and decide to protect writing of the entire eNVM block, then the eNVM
client JTAG protection Write, if enabled, will be overridden by full block protection.

If the Read protection of the eNVM block is left open, then the eNVM client JTAG protection Read will be
enabled if a client has a read protection enabled.

If you choose to encrypt the entire eNVM block, then the eNVM client JTAG protection Write will be disabled
if enabled, due to enforced encryption. The eNVM client JTAG protection Write, if enabled, will be
overridden by full block protection.
To set Custom Level Security:

1. Click Custom Level to open the Custom Security Level dialog box (as shown in the figure below)
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Figure 57 - Setting Security for Unprotected eNVM Clients

2. Click the Set Security checkbox to secure Read, Write and Verify using Flash Lock. In this mode you

can unlock Read and Verify and only protect Write by FlashLock. The eNVM client JTAG read
protection will be enabled.

3. Click the Encrypt checkbox to secure Write using the AES Key. Read, Verify will be secured by
FlashLock in this mode. You must enter the AES key in addition to the Pass Key before saving the
PDB file.

Setting Standard Security Levels

There are two types of standard level security: High and Medium. If either of the two is selected the eNVM
client JTAG protection is overridden or disabled. You can enforce Read, Write and Verify protection of the

entire eNVM block with the Pass Key and/or AES key. JTAG protection of specific pages will not be
available.

Importing EFC (Embedded Flash Configuration) File with Client JTAG Protection in

P

reviously Secured PDB

The secure PDB file exported from FlashPro is called a secured PDB.

If you import an EFC file that has JTAG protection into a secured PDB file but does not have eNVM clients
with JTAG protection enabled then the FlashPro returns an EFC file has eNVM client JTAG protection
and cannot be loaded error, as shown in the figure below.
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EFMB Client JTAG Protection Tutorial - Fusion

EFC filz has eNYM client JTAG protection and cannot be loaded,
Security cannok be modified in a currently secured PDB.

Ok

Figure 58 - EFC File with JTAG Protection Cannot be Imported into a Secured PDB Error Message
You can import any EFC file that does not have JTAG protection.

You cannot import a new EFC with JTAG protection into a secured PDB that already has an EFC file
imported with eNVM client JTAG protection. You can update the memory content by importing MEM files for
the specific clients (as shown in the figure below).

Currently loaded EFC has eNVM client JTAG protection and
cannot be changed in a currently secured FDEB.

You can update memory content by importing

mem file For each individual client,

l.;

OK

Figure 59 - New EFC File Cannot Overwrite Existing eNVM Client JTAG Protection Error Message

EFMB Client JTAG Protection Tutorial - Fusion

This tutorial provides step-by-step instructions on how to enable JTAG protection for eNVM clients. The
protection can be read, write or both and it is protected with a User Pass Key (FlashLock).

The JTAG protection of EFMB clients enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

One example use is IP customization. This enables an IP vendor to allow limited visibility to EFMB clients for
IP customers. The IP vendor can protect specific clients and leave other clients unprotected for modification
by IP customers. See the eNVM/EFMB Client JTAG Protection use flow diagram for a detailed example of a
typical use case.

Before you begin this tutorial, make sure you have already installed the FlashPro and/or Designer software
and that you are familiar with its basic features.

JTAG READ/WRITE protection is set when you create your original EFMB in Libero SoC. You cannot
change this setting in Designer/FlashPoint or FlashPro/FlashPoint.

EFMB Client JTAG Protection in Designer/FlashPoint

If the ADB file has an EFM (Embedded Flash Memory) block with page/client JTAG protection enabled, the
EFC file appears in the FlashPoint window when you click the Programming File button in Designer.

A message indicating JTAG protection is enabled appears in the Embedded Flash Memory Block (EFMB)
tooltip, as shown in the figure below.
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Figure 60 - EFMB Client JTAG Protection

To set EFMB Client JTAG Protection:

1. Check the Security Settings or Programming previously secured devices checkbox and click
Next. The Security Settings dialog box opens.

2. Specify the appropriate security settings.

If the EFM block is generated with an EFMB client with JTAG protection then FlashPro requires that
you specify a User Pass Key prior to programming or exporting programming files.

3. Import the EFC file with JTAG protection in the FlashPoint dialog box. When the EFC file is imported
the Security Settings box is checked automatically, implying that you must set the User Pass Key (as
shown in the figure below).

The PDB file cannot be saved without specifying the pass key.
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Figure 61 - Importing the EFC File with JTAG Protection

4. Click Next to open the Security Settings dialog box. Notice that the Enable EFMB client JTAG
protection box is checked. This indicates that reading, writing, and verifying of other EFMB pages are
allowed but the reading and writing of specific EFMB clients are protected.

5. To enforce the EFMB client JTAG protection in the PDB file, enter a Pass Key or click Generate
random key (as shown in the figure below).

Security Settings - Step 2 of 2 [ %]

Security level For this device:

- | - High Mo protection ;I
- Allovs writing and verifying of the FPGA Array,
Medium
- Allows reading, writing, and verifying of the FlashROM,
I - Allows reading, writing, and verifying of the EFMB (EFME client
Mo JTAG protection is enabled),
€ Enable EFME client: ITAG pratection
EFME client JTAG protection is enabled.
IEd
Custom Level.., Default Level |
Pass Key {max length is 32 HEX chars):
Z7BECACZESSADG201509F097 1B557F11 Generate random key |
AES key (max length is 32 HEX chars):
I Generate randam key: |

Help | Back | Finish | Cancel |

Figure 62 - Setting Security
Custom Level Security Settings

If you select Custom Level security and decide to protect writing of the entire EFMB, then the EFMB client
JTAG protection Write, if enabled, will be overridden by full block protection.
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If the Read protection of the EFMB is left open, then the EFMB client JTAG protection Read will be enabled
if a client has Read protection enabled.

If you choose to encrypt the entire EFMB, then the EFMB client JTAG protection Write will be disabled due
to enforced encryption. The EFMB client JTAG protection Write, if enabled, will be overridden by full block
protection.

To set Custom Level Security:
1. Click Custom Level to open the Custom Security Level dialog box (as shown in the figure below)

e Set Security Settings
Silicon Feature Sizmomily) Encrypt Fead | Verily | Wiiie
FPGA Amay - 'l
FlashROM O o
N¥M_block_0/NVM_INST (# 1) O o

o Tao see EFME client ITAG protection information place your mouse cursor over each block

[ Permanently lock the security settings.

Help | OF I Cancel |

Figure 63 - Setting Security for Unprotected eNVM Clients
2. Click the Set Security checkbox to secure Read, Write and Verify using Flash Lock. In this mode you
can unlock Read and Verify and only protect Write by FlashLock. The EFMB client JTAG read
protection will be enabled.
3. Click the Encrypt checkbox to secure Write using the AES Key. Read, Verify will be secured by
FlashLock in this mode. You must enter the AES Key in addition to the Pass Key before saving the
PDB file.

Setting Standard Security Levels

There are two types of standard level security: High and Medium. If either of the two is selected the EFMB
client JTAG protection is overridden or disabled. You can enforce Read, Write and Verify protection of the
entire EFMB with the Pass Key and/or AES key. JTAG protection of specific pages will not be available.

EFMB client JTAG Protection via FlashPro/FlashPoint

If the PDB file was created with the EFMB client and JTAG protection is enabled you can click Modify in
FlashPro to change the settings.

Fusion Calibration Backup and Recovery Tutorial

This tutorial provides step-by-step instructions on how to backup and recover default calibration data on a
Fusion device. It assumes that you have created a new project, connected your programmer, and loaded a
Fusion PDB/STAPL file created in Designer v8.4 or above.

If you would like step-by-step instructions on how to create a new project, see the Creating a New Project
section in the FlashPro Single STAPL Basic Tutorial..

If you would like step-by-step instructions on loading a programming file, see the Loading and Configuring a
Programming File section in the FlashPro Single STAPL Basic Tutorial.

Note: This feature is only supported in STAPL and PDB programming files.
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Backing Up Default Fusion Calibration Data

A backup copy of the Fusion calibration data is created once after ANY programming ACTION, except
READ_IDCODE, is executed. The copy will be stored in the spare pages of eNVM. The FlashPro Log
window shows that a backup copy of the calibration data has been created (as shown in the figure below).

programwer '07553' : Jcan Chain...

programmer '07595' @ Scan Chain PASSED.

programoer '07893' : Executing action PROGRAM

programmer '07553' : Checking for Backup Calibration Data...
programmer '07525' : Beading Master Calibracion Data...
progremoer '07898' : Writing Calibration Backup Copy
programmer '07828' : Erase

programrer '073938' : Completed erase

progremoer '07898' : Progrewming FPGAL Array

Figure 64 - FlashPro Log Window

Recovering Default Fusion Calibration Data

1. Load the PDB/STAPL file created in Designer v8.4 or above.

2. Inthe FlashPro Configuration window, click Advanced and select RECOVER_CALIB (as shown in the
figure below).

Action

Procedures. .

Figure 65 - RECOVER_CALIB

3. Click Run to restore the original Fusion calibration data. The Log window shows the data is restored
(as shown in the figure below).

programmwer '07S28' @ Scan Chain. ..

prograrmmwer '07S8958' @ Scan Chain PASIED.

brogrammer '07395' @ Executing action RECOVER CALTE
programwmer '07598' ¢ Checking for Backup Calibration Data...
programmer '07395' ¢ Reading Master Calikbration Data...
programmer '07S95' ¢ Writing Calibration Backup Copy
prograrmmer '07S95' ¢ Checking for Backup Calibration Data...
programmer ' 073953' @ Restoring Master Calibration Data.

Figure 66 - Restoring Original Calibration Data
Note: The Calibration data can only be restored after a backup has been made.

Specify 1/0O States During Programming Tutorial

This tutorial explains how to modify the I/O states during programming within FlashPro for used and unused
1/0s. It also explains how to modify the Boundary Scan Registers (BSRs) for each 1/O to allow for more
detailed customization of the /O states during programming. Finally, it shows how to save and load these
settings with a file.

Note: This tutorial requires a design with a valid *.pdb file associated with it. If you launch FlashPro from a
Libero SoC project, a FlashPro project is created automatically and the PDB file loaded. Otherwise,
you can start a new FlashPro project and load a PDB file; refer to Single STAPL/PDB file basic
tutorial for more information.

You can also modify the individual Boundary Scan Registers; see the Modify Boundary Scan Registers
section for more information.
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To modify the state of an I/O during programming:

1. Once your PDB is successfully loaded, from the Configuration menu, choose PDB Configuration.
This brings up FlashPoint . FlashPoint is the tool that allows you to modify the PDB programming file
from within FlashPro.

2. In FlashPoint, click the Specify I/0 States During Programming button. The Specify I/0O States
During Programming dialog box appears (as shown below). This dialog box enables you to modify the
1/0 states during programming for all used and unused 1/Os.

Specify I/0 States During Programming
Load from file. .. | Save ko file... | [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTBUF ES a
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 67 - 1/0 States During Programming Window

The default view displays a grid with 4 columns: Port Name, Macro Cell, Pin Number, and I/O State
(Output Only). Port Name lists the port associated with each of theses pins, if the pin is not used in the
design, the Port Name for this pin reads Unused. The Pin Number column contains a list of all the pins
for the package associated with the design open in FlashPro.The Macro Cell column contains the
Microsemi macro associated with each pin, as with Port Names, if the pin is not used, the Macro Cell
for this pin reads Unused. The I/O State column is the only column editable in FlashPro.

3. Select an I/O State from the drop-down menu for each 1/0 you want to modify.

Please refer to Specifying 1/O States During Programming for information on sorting and selecting
multiple entries in the grid.

4. Click Save in the Specify I/O States During Programming window, then Finish in FlashPoint to return
to FlashPro. The PDB is updated with your new settings.

Congratulations, you have successfully modified the 1/O states that will be held during programming.

Modifying Boundary Scan Registers

Each 1/O in your device is comprised of an Input, Output and Output Enable Boundary Scan Register (BSR)
cell.

The BSR cells enable you to define 1/O states during programming and control the individual states for each
Input, Output, and Output Enable register.
To modify the individual Boundary Scan Registers of an 1/0 in your device:

1. Select the Show BSR Details checkbox in the Specify I/O States During Programming window.
This replaces the 1/0 State (Output Only) column with a Boundary Scan Registers column that is split
into Input, Output Enable and Output.
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2. Modify each of the registers for any 1/O to set your custom options. See the Specifying 1/O States
During Programming - I/O States and BSR Details help topic for an explanation of the individual BSR
settings.

3. (Optional) Uncheck the Show BSR Details checkbox to return to the default view.
Note: Updated I/0Os with non-default settings are displayed as User-Defined BSR in the default view.
Click OK and complete programming to save your updated settings to the ADB and programming files.

Saving and Loading I/O State Settings
Click Save to File to save your changes. This enables you to save your custom 1/O settings in an IOS file.
Click Load from File to load a previously saved *.ios file.

Note: You must click OK and complete programming to save your updated settings to the ADB and
programming files.

See Also
Specifying 1/0O States During Programming
Specifying 1/0O States During Programming - I/O States and BSR Details

FlashPro User's Guide 51



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Advanced Tutorials

Multiple Device Chain Programming

This tutorial provides step-by-step instructions on how to program multiple Microsemi devices in a chain.
You should already be familiar with the basic features of the FlashPro software.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already

installed before you begin.
In the figure below, there are three devices in a chain (two A3P250 and one A3PEG600). In this section, we

will program these three devices in the chain.

TDOD
TDI TDI TDOD TDI TDO TDI TDO
TMS TS THS — TM5
TCK . TCK TCK TCK
[ A3P250 A3PEG00 ’7 A3P250
| |

Figure 68 - APA Device Tutorial Example
First you need to create a project.
To create a new project:

1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.

3. Check the Chain box (see figure below).

New Project F§|

Project Mame:
| Tutarial

Project Location:

| D\ FlashProsS0Mult _Ackel_Chain' Browse. .. |

Programming mode
" Single STAPL file
* Chain

o 4 | Cancel Help

Figure 69 - New Project Dialog Box
4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro main window appears.
Note: The Programmer List window updates with your programmers information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain) (see figure below).
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Multiple Device Chain Programming

Programmer Programmer Programmes Programmer
MName Type Status Enabled

Edi cell

i} eing

9) Self Test

B scan Chain

* Remove
Dis:abile:

Run Salected Programmers

Refresh/Rescan for Programmers PROGRAM E%

Figure 70 - Select Programmer Window

Scan Chain shows how the devices are ordered in the chain in the log window (see figure below). In this
case, A3P250 is the first device that will be programmed in the chain since it is connected directly to TDO.

x| progravaner '01245' @ Found 24 instruction register hits.

= progravaner '01245' ¢ Checking IDCODEs. ..
prograwmer '01245' @ Device 1: ZA141CF Hfr: Actel Part: MTAIPEZSO0
progragmner '01245' @ Device 2: 123261CF Mfr: Actel Part: M7ALIPE&OO
prograganer '01245' @ Dewvice 3: 2ZA4141CF HMfr: Actel Part: A3ZPZ50
progravaner '01245' @ SJocan Chain PASSED.
£

| r‘\'AII l.’a Errors .}'\ Warnings P\Info lﬁ{

Figure 71 - Scan Chain Order in the Log Window
7. Click the Configure Chain button. The Chain Configuration window displays (see figure below).

x -
A4 Actel Device 174
—-Iml N m-o}—uu—-lml 2 moHInl 1 mal—» | | <] _I _I
Add NonAclel Device
¥ Show Chain Ediling
: " IR Max TCK  Enable  Enable - Serial
eocs L= s Length  [MHz) | Device Serial LELET Data R

Figure 72 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears (as shown in the figure below).

Add Actel Device X

" File

Prograrnrning File: | J

¥ Device

Device:

MName: | A3P250

Help Ik | Cancel

Figure 73 - Add Microsemi Device Dialog Box
9. Choose the "A3P250" device from the Device drop-down.
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10. Inthe STAPL file field, use the Browse button to locate the A3P250.stp file.

11. Inthe Name field, leave A3P250 as default. The A3P250 device is added into the Chain
Configuration window (see figure below).

x Add Actel Device I
"|1n| N 1oo}—-.»-|ro| 2 roo|—-|1o| 1 me}—. ModiyPDE. |  CorfigucDevice..| 4| 2| X| ﬂ

¥ Show Chain Editing

IR Max TCK  Enable Enable
Length [MHz] Device Serial

Senal
Data

HIGH-Z

Figure 74 - Device One Chain Configuration Window

12. Repeat the same process for A3PE600 and the other A3P250 respectively.
13. After you have finished adding all of the devices in the chain, the Chain Configuration window

updates.
E
x .

Add Actel Device 4 |

_+")| N 100]_....-{'"” 2 ‘mol_irm 1 'mol_. Create PDB... | Configure Device... | il il £|
Add NorvActel Device

[¥ Shows Chain Editing Inspect Device

Do N File IR Max TCK  Enable = Enable Action Serial HIGHZ

Length [MHz] Device Serial Data

1 AIPZ50 & 43P250 =) g 10 =
A3PEE0D E@
3 AIPZ50 [ A3F250(2) = 8 10 v
Figure 75 - Chain Configuration Window: All Devices in the Chain

14. Once all the devices have been added to the chain in the correct order, click the Run button to
program the chain.

15. When Programming is complete, the Programmer List window displays. See figure below.

Programmer Programmer Programmer Programmer
Hame Type Status Enabled

Device / Action

03173

i
el
£
=
3
g
5 Refresh/Rescan for Programmers
&
-4
x| prograrmer '03178' @ device 'L3PZ50' @ Finished: Wed Jul 05 17:15:49 2006 (Elapsed tiwme 00:01:23) ~
el programmer '03178' @ device 'A3ZPZ50' @ Executing action PROGRAM PASSED.
programmer '03178' @ Chain programming PASSED.
0o-o0-0-0-0-a0
~
< >

all 4 Errors A Warnings A Info

Figure 76 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Microsemi Device Chain Programming
tutorial.

Multiple Device Serialization Chain Programming

This tutorial provides step-by-step instructions on how to program multiple Microsemi devices with
serialization. Before you begin this tutorial, you should already be familiar with the basic features of the
FlashPro software.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already
installed before you begin.

In this tutorial you will program two devices in a chain (one device is A3P250 and the other is A3PE600).
The STAPL file for the first A3P250 device contains 10 serialization data. See figure below.
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DO
DI DI TDO DI TDO
™S ™S ™S _ |
TCK . | TCK TCK
[ A3P250 A3PEG00 ’7
‘ J

Figure 77 - APA Device Tutorial Example
First you need to create a project.

To create a new project:
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type "Tutorial" in the Project Name field.
3. Check the Chain box (as shown in the figure below).

New Project [‘$_<|

Project Mame:

| Tutorial

Project Location:

| [nFlashProws0iMolk_actel _Chain Browse, ., |

Programming mode

" Single STAPL file
{* Chain

(04 | Zancel Help

Figure 78 - New Project Dialog Box
4. If necessary, change the default location of your project in the Project Location field.

5. Click OK. The FlashPro main window appears and updates the Programmer List info with your
programmer information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer List
window, right-click, then choose Scan Chain) (as shown in the figure below).

Programmer Programmer Port Pr Progi
Name Type = Status Enabled
30964 ush30964 (USB 2.0)

Edit cell |
W ping
88 Self Test
¥ scan Chain
& remove

Disable

Run Selected Programmers

Refresh/Rescan for Programmers PROGRAM %

Figure 79 - Scan Chain Selection

Scan Chain shows how the devices are ordered in the chain in the log window (see figure below).
In this case, A3P250 is the first device will be programmed in the chain since it is connected
directly to TDO.

FlashPro User's Guide 55



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

. . when clicked. View the online help included with software to enable all linked content.
& Microsemi
x| programmer '03175' @ Found 24 instruction register bhits.
= progratemer '03178' ¢ Checking IDCODEs...
prograrmmer '03178' @ Device 1: Z4141CF Mfr: Actel Part: AIZPZ50
progratmer '03175' @ Device 2@ 123261CF Mfr: Actel Part: AIPE6OO
progratmer '03178' @ Dewvice 3: ZA141CF Mfr: Actel Part: A3ZPZ50
prograrmmer '03178' @ Scan Chain PASSED.
£
| I"-.IAII ;{' Errors .:'"'. W arnings I.‘-'-.|In|‘c: .-"[

Figure 80 - Scan Chain Order in the Log Window
7. Click the Configure Chain button . The Chain Configuration window appears (see figure below).

x_+r|)| N 1oo|—-m—-|1n| 2 rnol—-lwl 1 mol_. | [—l _I_J _I Acidm:telnmem|

Add NorrActel Device |
[¥ Show Chain E diting
- - IR Max TCK  Enable | Enable . Serial
Device MHame File Length (MHz) Device | Sensl Action Data HIGH-Z

Construct the chain from a Scan Chain operation...

Figure 81 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears.

9. Choose A3P250 device from the Device drop-down menu (as shown in the figure below).

Add Actel Device 3

" File

Prograrnming Files | J

+ Device

Device:

Mame: | A3P2S0

Help (04 | Cancel

Figure 82 - Add Microsemi Device Dialog Box
10. Inthe STAPL file field, use the Browse button to locate the A3P250.stp file.
11. Inthe Name field, leave A3P250 as default.
12. Click OK. The A3P250 device is added into the Chain Configuration window.

13. Repeat steps 8 to 11 for ASPE600 and A3P250 respectively. After you are finished adding all devices
in the chain, the Chain Configuration window updates (as shown in the figure below).

x — e AddAHeleeml
—-|r|:-| N mnl—-ou%ml 2 rD-uI—-Im: 1 TDOI—- Creats POB... | Configue Device... | 'il _1' g =

Add Nonrhcte Device
W Show Chan E diting Inspect Device
z = IR Max TCK = Enable = Enable 2 Senal
Device Name File Length [MHz) Device | Seeial Action Data HIGH-Z
1 A3FZS0 [ 43P250 =2 8 10 ~
AIPEBND =

3 AFHD & AP25012) 10 2

Figure 83 - Chain Configuration Window for all Devices
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Multiple Programmer Multiple Device Chain Programming

From the Chain Configuration Window, check the Enable Serial box. This enables the Serial Data
option in the Chain Configuration window.

Click Select in the Serial Data column, the Serial Settings dialog box displays as shown in the figure

below.
3

Serial Settings

o All

woon el M L

Hills

[v Wiew unused data
v Wiew used data
v Wiew skipped data

Filker: | *

Iv Log serial data: |Regiu:un_6_3

Help

Figure 84 - Serial Settings Dialog Box
From the Serial Settings dialog box, click the All button to select all the serial data.
Click OK.

Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Run button to program the chain.

When programming is complete, the Programmer List window appears and indicates that the devices
are ready for programming (as shown in the figure below).

L 03178

Programmer Programmer
Hame Type
03

Programmer
Status

Programmer

Enabled Device / Action

Figure 85 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Device Serialization Chain Programming
tutorial.

Multiple Programmer Multiple Device Chain Programming

This tutorial demonstrates step-by-step instructions on how to parallel program two chains using two
programmers, each with two Microsemi SoC Devices (A3P250 and A3PE600). See the figure below for an
illustration.

TDO
TDI TOI DO T TDO
TS ———=—{ TMS TS
TCK TCK TCK
A3ZP250 A3IPEGDD

Figure 86 - APA Device Tutorial Example
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You should already be familiar with the basic features of the FlashPro software before you begin this tutorial.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already
installed before you begin.

First you need to create a project.
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.
3. Check the Chain box (see figure below).

New Project ﬁl

Project Mame:

| Tutorial

Project Location:
| [ FlashProws0iMale_Pragr_Muolki_ Browse. .. |

Pragramming mode

" Single STAPL file
* Chain

Ik | Zancel Help

Figure 87 - New Project Dialog Box

If necessary, change the default location of your project in the Project Location field.

5. Click OK. The FlashPro main window appears and displays your updated programmer information (as
shown in the figure below).

Programmer Programmer Programmer Programmer

Hame Type [ Status Enabled
1 03178 FlazhPro3 uzh03178 Icd

2 01245 FlashPro3 ushi1245 I~

Device [ Action

Figure 88 - FlashPro User Interface

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain). The Select Programmer(s) dialog box displays
(see figure below).
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Multiple Programmer Multiple Device Chain Programming

Select programmer(s) §|

Select the programmer(s) vou want ko scan:

Frograrmmer(z]
03178
245

Select Al | nselect Al |

Ik | Cancel | Help |

Figure 89 - Select Programmer Window

The Programmer List window shows the Scan Chain Test was passed and how the devices are ordered in
the chain (see figure below).

Programmer Programmer Port Programmer Programmer Device / Action
Hame Type Status Enabled

1 |03178 FlashProZ

ush03178 SCAH CHAIN PASSED =2
01245 FlashPro3 5

sl

Refresh/Rescan for Programmers

|- | | [Programmer List Window

programmer '01245' @ Scan Chain. ..

A Warning: programmer '01245' @ Vpump has been selected on programeer AND an externally provided Vpump has also |
programwer '01245' @ Found 8 instruction registcer hits.

programwer '01245' @ Checking IDCCODEs...

programmer '01245' @ Device 1: 123261CF Mfr: Actel Part: AZPE&OOD

programmer '01245' @ Zcan Chain PASSED.

All A Errors f\ ‘Warnings }\Infu /
Figure 90 - Scan Chain Order in the Log Window

7. Click the Configure Chain button . The Chain Configuration window appears (as shown in the figure
below).

ES

101 [\ T00k— eee —fro1 P TDO—TD1 T T | Add Actel Device 74
-.| N }_. _.I 2 H 1°°|—' i J—I —IAdde-AoLdocm

- " IR Max TCK  Enable  Enable - Serial
ace L= 3 Length | [MHz] = Device = Serial chon Data e

¥ Show Chain Editing

Figure 91 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears.

9. Choose A3PE600 device from the Device drop-down menu (as shown in the figure below).
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Actel Device Configuration E|
« Flle:
Pragramming File: | Viikiraniprogramming_designst, ...
" Device

Device: | J

Mame: | A3PEEOD

Help QK | Cancel

Figure 92 - Add Microsemi Device Dialog Box
10. Inthe STAPL file field, use the Browse button to locate the A3PE600.stp file.
11. Inthe Name field, leave A3PE600 as default.

12. The A3PEG60O0 device is added into the Chain Configuration window (as shown in the figure below).

Add Actel Device 54
-+'DI N 1Do|—-m—-irn| pd 'IDOHTDI 1 1no|—- CrestePOB.. | Corligue Device.. | il il 5‘
Add Norvfictel Device
[¥ Show Chain Editing Inspect Device |
Device Name File IR Max TCK = Enable = Enable Serial

AIPEEDD

Length  (MHz) | Device Serial Action Data HIGHZ
[ A3PEEDD ]

Figure 93 - Device One Chain Configuration Window

13. Repeat steps 8 to 11 for A3P250. After you are finished adding all devices in the chain, the Chain
Configuration window updates (as shown in the figure below).

x -
Add Actel Device 74
—-Iml N m-c-}—uu—-[ml 2 mol—-lml 1 nol—- | | #|2| X
AddNonAclel Device
¥ Show Chain Ediing
- " IR Max TCK = Enable  Enable - Serial
peoce —— 2 Length = [MHz)  Device Serial chon Data s

Figure 94 - Chain Configuration Window for all Devices

14. Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Run button to program the chain.

15. When programming is complete, the Programmer List Window appears (as shown in the figure

below).
x
Programmer Programmer Port Programmer Programmer Device | Action
Hame Type Status Enabled
1 |03178 FlazhPro3 uzhb03178 RUH PASSED I AN
01245 FlazhPro3 01245

Figure 95 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Device Serialization Chain Programming
tutorial.
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Multiple Programmer and Multiple Device Serialization Chain Programming

Multiple Programmer and Multiple Device Serialization Chain
Programming

This tutorial demonstrates step-by-step instructions on how to parallel program two chains using two
programmers, each with two Microsemi SoC Devices (A3P250 with Serialization and A3SPE600). See the
figure below for an illustration.

TDO
TDI TDI TDO TDI TDO
TS ——e— TMS TMS
TCK TCK TCK
A3P250 A3PEROD

Figure 96 - APA Device Tutorial Example

You should already be familiar with the basic features of the FlashPro software before you begin this tutorial.
The STAPL file for the A3P250 device contains 10 serialization data.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already
installed before you begin.

First you need to create a project.
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.
3. Check the Chain box (see figure below).
New Project F§|

Project Mame:

| Tutorial

Project Location:

| [ FlashProws0iMoale_Progre_MMulk_y Browse, ., |

Programming mode

" Single STAPL file
{* Chain

o 4 | Cancel Help

Figure 97 - New Project Dialog Box
If necessary, change the default location of your project in the Project Location field.

5. Click OK. The FlashPro main window and the Programmer List window displays your updated
programmer information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain). The Select Programmer(s) dialog box appears
(as shown in the figure below).
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Select the programmer(s) vou want ko scan:
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L] o245
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Select Al | nselect Al |
Ik | Cancel | Help |

Figure 98 - Select Programmer Window

The Programmer List window shows the Scan Chain Test was passed and how the devices are ordered in

the chain (see figure below). In this example, A3PE600 will be programmed first in the chain since it is
connected directly to TDO.

Programmer Programmer Port Programmer Programmer Device / Action
Hame Type Status Enabled
1 03178 FlazhPro3 ush03176 SCAN CHAIN PASSED I
2 245 FlashPro3 ush1245 SC

CHAIN PASSED [
Figure 99 - Scan Chain Order in the Log Window
7. Click the Configure Chain button . The Chain Configuration window appears (as shown in the figure

below).
= Addmteloevicem|
—-|'rn| N ‘lDOl—-m—'I'lDI 2 rnol—-lrol 1 Too|—~ | | _J __i __J TR
W Show Chain Editing
Device Name File et B B Rl Action el HIGHZ

Construct the chain from a Scan Chain operation...

Figure 100 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Microsemi Device button to add devices to the
chain. The Add Microsemi Device dialog box appears.

9. Choose A3PE600 device from the Device drop-down menu (as shown in the figure below).
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Actel Device Configuration [‘S__<|
* File!
Programming file: | Wi lkiran\programming_designsi, ..
(" Device

Device: | J

Mame: | A3PESO0

Help Ik | Cancel

Figure 101 - Add Microsemi Device Dialog Box
10. Inthe STAPL file field, use the Browse button to locate the A3PE600.stp file.

11. Inthe Name field, leave A3PE600 as default. The A3PE600 device is added into the Chain
Configuration window.

12. Repeat the steps above to add the A3P250. After finished adding all devices in the chain, the Chain
Configuration window updates (see figure below).

= - Add Actel Device 4
_+'|]| N 1|)o|_.m _+[|)| 2 rn++'|]| 1 1|)o|_. Create PDE... I Configure Ue\ﬂ:e'...l il il 5‘
Add NorActel Device
¥ Show Chain Editing Inspect Device
- IR Max TCK  Enable Enable . Serial
File Length  (MHz) = Device Serial Action Data HIGH-Z

Figure 102 - Chain Configuration Window for all Devices
14. Inthe Chain Configuration Window, check the Enable Serial box.

15. Click Select in the Serial Data column. The Serial Settings dialog box appears (as shown in the
figure below).
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Figure 103 - Serial Settings Dialog Box
16. From the Serial Settings dialog box, click the All button to select all the serial data.
17. Click OK.

18. Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Runbutton to program the chain.

19. When programming is complete, the Programmer List window updates (as shown in the figure

below).
x
Programmer Programmer Programmer Programmer SN N
Hame Type ok Status Enabled Dz
1 03178 FlashPro3 ush03178 I AIP250PROGRAM
2 01245 FlashPro3 uzhl1245 ~ ASP2S0PROGRAM

Figure 104 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Programmer and Multiple Device
Serialization Chain Programming tutorial.

Setting Disabled Microsemi SoC Devices to HIGH-Z

This tutorial explains how to set disabled Microsemi SoC SmartFusion, IGLOO, ProASIC3, Fusion devices
in a chain to HIGH-Z during chain programming.

Note: This tutorial requires a design with valid *.pdb/*.stp files for a chain of devices. If you launch FlashPro
from a Libero SoC project, a FlashPro project is created automatically and the PDB/STP file loaded.
Otherwise, you can start a new FlashPro project and load a PDB/STP file; refer to the Chain
Programming Tutorial for more information.

1. Once all your devices have been added to the chain, from the Chain Configuration window, choose
which devices you would like disabled during programming by de-selecting the appropriate checkbox
from the Enable Device column.

Now that you have disabled devices a checkbox appears in the HIGH-Z column of the Chain
Configuration window. If the HIGH-Z column is not shown in the Chain Configuration Grid, right-click
any column header and choose HIGH-Z.

2. Select the HIGH-Z checkbox to ensure your disabled devices enter HIGH-Z mode and remains in that
mode until chain programming is complete.

64 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. C . .
> Microsemi.

Setting Disabled Microsemi SoC Devices to HIGH-Z

HIGHZ is not supported if enabled Microsemi devices are executing one of the following ACTIONS:
e PROGRAM_NVM_ACTIVE_ARRAY
e VERIFY_NVM_ACTIVE_ARRAY
e READ_IDCODE

Disabled devices 1/0s will not go to HIGHZ and the they will not tri-state. Any other ACTION will work as
expected

* - : Add Actel Device 74
—-|rn| N Tnol—ono—-{ml 2 onml 1 1Do|—- Creste FDB... | Configure Device... | il ll &I
Add Nor-Actel Device
¥ Show Chain E diting Inspect Device

IR Max TCK  Enable Enable - Serial
Length | [MHz) | Device | Seral Aclion Data

File HIGH-Z

Figure 105 - HIGH-Z Option in FlashPro
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Programming Settings and Operations

Introduction

The FlashPro software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove
and analyze the JTAG chain.

Programmer Settings

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and
FlashPro.

Note: You can set the TCK setting in the PDB/STAPL file by selecting the TCK frequency in the
Programmer Settings dialog box.

Limitation of the TCK frequency for the selected programmer:
e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro5/4/3/3X supports 1-4 MHz.
Limitation of the TCK frequency for the target device:
e |GLOO, ProASIC3, and Fusion — 10MHz to 20MHz
e ProASICPLUS and ProASIC — 10 MHz.

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file will override the
TCK frequency setting selected by you in the Programmer Settings dialog box unless the Force TCK
Frequency checkbox is selected.

To set your programmer settings:

1. From the Tools menu, choose Programmer Settings.The Programmer Settings dialog box appears
(as shown in the figure below).
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Set Defaults
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Figure 106 - Programmer Settings Dialog Box for FlashPro

2. Click a programmer tab and check the appropriate settings for your programmer.
3. Click OK.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see above figure). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.

Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.

e The Drive TRST option is unchecked to instruct the FlashPro programmer(s) NOT to drive the TRST
pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made
your selection(s), click OK.

Default Settings
e The Vpp and Vpn options are checked to instruct the FlashPro Lite programmer(s) to supply Vpp and
Vpn.

e The Drive TRST option is unchecked to instruct the FlashPro Lite programmer(s) NOT to drive the
TRST pin.
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e The Force TCK Frequency option is unchecked to instruct the FlashPro Lite to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, you have the option of choosing the Set Vpump setting or the Force TCK Frequency.
If you choose the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings,
you have the option of switching the TCK mode between Free running clock and Discrete clocking. After you
have made your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the
device.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK
frequency specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting) then the selected TCK value is set for
the programmer and the Frequency statement in the PDB/STAPL file is ignored.

Note: FlashPro Lite RevA supports only 4MHz on TCK.

Default TCK frequency

When the PDB/STAPL file or Chain does not exist, the default TCK frequency is set to 4MHz. In the Single
Device File Programming mode, FlashPro will parse through the file and search for the "freq" keyword and
the "MAX_FREQ" Note field, which are expected in all Microsemi flash device files. The FlashPro software
uses the lesser value of the two as the default TCK frequency.

In Chain Programming mode, when more than one Microsemi flash device is targeted in the chain, the
FlashPro software passes through all of the files and searches for the "freq" keyword and the "MAX_FREQ"
Note field. The FlashPro software uses the lesser value of all the TCK frequency settings and the
"MAX_FREQ" Note field values.

Ping Programmers

To ping a programmer(s):
1. From the Programmers menu, choose Ping.
2. Select the programmers you want to connect from the Select Programmer(s) dialog box.
3. Click OK.

Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

To perform a self-test:
1. From the Programmers menu, choose Self Test.
2. Select the programmer(s) you want to self-test from the Select Programmer(s) dialog box.
3. Click OK.
Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

You can also perform self-test by right-clicking on a specific programmer from the Programmer List
Window and selecting Self-Test.

Note: Self-test is not supported with FlashPro4 or FlashPro Lite programmers. These programmers are
rigorously tested at the factory during production.
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Scanning a Chain

Scanning a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have
selected.
To scan a chain:

1. From the Programmers menu, choose Scan Chain.

2. Select the programmers you want to scan from the Select Programmer(s) dialog box.

3. Click OK.
You can also perform Scan Chain by right-clicking on a specific programmer from the Programmer List
Window and selecting Scan Chain.
To scan and check a chain:

1. From the Tools menu, choose Modes > Chain Programming.

2. From the Chain Configuration window, select auto construct or add devices.
3. From the Programmers menu, choose Scan and Check Chain.
4

Select the programmers that you want to scan and check chain from the Select Programmer(s) dialog
box.

5. Click OK.

You can also perform Scan Chain and Scan and Check Chain by right-clicking a specific programmer from
the Programmer List Window and selecting Scan Chain or Scan and Check Chain.

Enabling and Disabling Programmers

Once your programmer is enabled you can connect the programmer, perform a self-test, scan the chain, or
remove it.
To enable a programmer:
1. From the View menu, choose Programmer Details Window.
2. Check the Enable programmer checkbox in the Programmer Details Window.
The Programmer Details window displays all the information about your programmer.

Note: You can also enable your programmer from the Programmer List window by checking the
checkbox in the Programmer Enabled column.

Disable your programmer by unchecking the Enable programmer checkbox from the Programmer Details
Window or by unchecking the checkbox in the Programmer Enabled column in the Programmer window.

Renaming a Programmer

Enter the new programmer name in the Programmer Details window to rename the programmer. By
default, the programmer name is the same as the programmer ID.

Removing a Programmer

To remove a programmer:
1. From the Programmers menu, choose Remove.
2. Select the programmers you want to remove from the Select Programmer(s) dialog box.
3. Click OK.

Selecting Programmers

The Select Programmer(s) dialog box gives you the option of selecting all and unselecting all of the
programmers that you want to ping. See figure below.
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Figure 107 - Selecting Programmer(s) Dialog Box
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Single Device Programming

Single Device Configuration

Single Device Programming

When devices are joined together in a JTAG chain, all of their Instruction Registers (IR) and Data Registers
(DR) are put in a long shift register from TDI to TDO. The IR length defers from device to device and the DR
length depends on the instruction that shifts into the instruction register.

When targeting Device 2 (see figure below), you need to know the IR length for Device 1 and Device 3.
Given this information, you can bypass both devices by shifting an all one pattern into their instruction
registers before and after the instruction targeted at Device 2. The humber of bits you shift before Device 2's
instruction is the pre IR length, and the number of bits you need to add after Device 2's instruction is the post
IR length. In this case, the pre IR bits are shifted into

Device 1 and post IR bits are shifted into Device 3.

Device 3 Device 2 Device 1

ToI R} { IR} { R} 100

Figure 108 - Targeting Device 2

When the bypass instruction is shifted into Device 1 and Device 3, the TDI and TDO of the two devices are
connected to the 1-bit bypass register at the Shift-DR state. To correctly shift the data in and data out of
Device 2's register, you need to shift one bit of data before and after Device 2's data.

The number of bits you need to shift into the data register for Device 1 is the pre-DR length and the number
of bits we need to shift into the data register for Device 3 is the post-DR length. With the IR and DR length
information, you can shift instructions and data into Device 2 with the correct registration.
To create the JTAG chain (shown in the above figure):

1. Connectthe TCK and TMS from the programmer to all of the devices.

2. Connect the programmer’s TDI pin to the TDI pin of device 3.

3. For all devices in the chain, connect the TDO output of one device to the TDI input of the next device.

4. Connect the TDO output of the last device to the programmer’s TDO input.

The order of devices in the chain is set by the connections of TDI to TDO.

The ChainBuilder software takes the order of the devices in a chain and their IR lengths and adds the pre-
IR, post-IR, pre-DR, and post-DR padding bits in the device you want to program, which properly aligns the
instructions and data within the IR and DR of the devices.

If you do not use the ChainBuilder software, the FlashPro software tries to find the pre-IR, post IR, pre-DR,
and post-DR values during the Analyze Chain operation.

For more information, see ProASIC programming and ProASICPLUS and ProASIC programming
introduction.

To find out how to set the IR length, see Chain Settings.

Loading a Programming File

You can either load a programming file from the Configuration menu or from the Single Device
Programming Window. The section below describes how to load a programming file from the Single
Device Programming Window.
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To Load a programming file from the Single Device Programming window:

1. From the View menu, choose Single Device Configuration to activate the Single Device
Configuration Window.

2. Click the Browse button in the Single Device Configuration Window (see figure below).

x| [~ Programming file
To continue,

Inad existing programming file Browse. ..
o create new POB file

R T

Single Device Configuration window

Figure 109 - Signal Device Configuration Window
The Load Programming File dialog box appears.

3. Navigate to your programming file, select it, and click Open. The programming file is loaded and the
Single Device Configuration Window updates.

Select Target Device

The Select Target Device dialog box is located in the Configuration menu.

The Select Target Device dialog box enables you to select the target device you want to program. If you
are only programming one device in a chain, there is no need for you to make a selection. The Select
Target Device dialog box automatically displays your device (see figure below).

Select Target Device

Target device: |FF=s

Help I | Cancel |

Figure 110 - Select Target Device (One Device in a Chain)

If you are programming more than one Flash device in a chain, you need to select the target device you
want to program. If you attempt to program your device without selecting a target device, a warning
message appears.

If the warning message appears, click OK and the Select Target Device dialog box appears. From the
Select Target Device dialog box, select the device you want to program (see figure below).

Select Target Device

Target device: |ﬂ.F5E-'I]1] @ j
i

Figure 111 - Select Target Device (Multiple Devices in a Chain)
Click the down arrow to display the list of devices in your chain. Then, make your selection and click OK.

Help

72 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. CM. .
ICIroseIni.

Chain Settings

Note: When the FlashPro software does not detect your chain configuration, you must specify the Pre/Post
IR fields by entering these values in the Set Pre/Post IR Values dialog box (see figure below).

Set Pre/Post IR values x|

FlazhPrao failed to determine the Pre and Post IR
values for the device A3PEGOO (1]

Pre IR: I ]
Post IR I ]

Ik Zancel | Help I

Figure 112 - Pre IR and Post IR Values for the Target Device
For more information, see Single STAPL file programming information.

Chain Settings

Click the Chain Parameter button in the Single Device Configuration window to set the chain settings
(see the Chain Settings dialog box below). See Single Device Programming Information for more
information about these STAPL settings.

Chain Parameter P§|

Pre IR: IEIi
Pre DR lﬂi
Post IR o
Post DR: o

Restore Defaulks |

Help | Cancel |

Figure 113 - Chain Settings Dialog Box

Serial Settings

Click the Select Serialization Indexes/Select Serialization Actions button from the Single Device
Configuration Window. The Serial Settings dialog box appears (as shown in the figure below).

Note: Depending on the STAPL file format (Microsemi format or generic format) used, you will either see
Indexes columns or Actions columns in the Serial Settings dialog box.
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Figure 114 - Serial Settings Dialog Box

Click the red arrow buttons in the center of the dialog box to move from the Actions column to the Selected
Actions column. The indexes/actions available for selection are located on the left and the indexes/actions
you choose to select are located on the right column. Viewing options are available in the checkboxes under
the Actions column. If you check Log serial data, you can select the FlashROM region name where the
serial data will be stored.
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Chain Order

Chain Programming

Chain Order

The chain order is located in the Chain Configuration Window. The devices you add to the chain must be
in the correct order and must match the physical chain to be programmed. The TDO for the first device
connects to the programmer, and the last device's TDI connects to the programmer. The devices in the
chain go in order from a device's TDI into the next device's TDO, as shown in the figure below.

]—tTDI N TDOF— #44 —TD | 2 TDOMATD I '| TDO—

Figure 115 - Chain Order

Multiple Device Chain Programming

The FlashPro software enables direct chain programming without generating a chain STAPL file. Each
device will be programmed in sequential order starting from device 1 to device N. See example below. For
more information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

You have the advantage of using the Chain Builder GUI interface to construct the target physical chain.
Therefore, you do not need to calculate the PRE/POST IR/DR value of the target device. Instead, you must
provide either a valid BSDL file or the IR length and TCK Fmax values when you add a non-Microsemi
device to the chain.

You also have the advantage of automatically generating the chain from a scan chain operation. If you
connect the target chain to your Microsemi programmer, then you can automatically construct the chain.
Refer to the Automatic Chain Construction Tutorial for more information.

Note: Even though the FlashPro software enables direct chain programming without generating a Chain
STAPL file, this functionality is still available. For more information, see Export Chain STAPL file.

Device Programming Compatibility
The following is a list of flash devices that can be programmed together in a chain.

e SmartFusion, IGLOO, ProASIC3 and Fusion, excluding ProASIC3L, families can be programmed in
the same chain.

PLUS

e ProASIC™"® can only be programmed with other ProASIC™"® devices.

e ProASIC can only be programmed with other ProASIC devices.

Programmer Support

FlashPro5/4/3/3X supports only SmartFusion, IGLOO, ProASIC3 and Fusion family devices. The Vpump on
FlashPro5/4/3/3X is designed to support the programming of only one device. Please make sure that
Vpump, Vcc and Vjtag are provided on board for chain programming. Connect the Vpump to the header as
the FlashPro software will attempt to check for all external supplies, including Vpump, to ensure successful
programming. There is no limitation to the chain length; however, ensure that the JTAG signal integrity and
the timing are preserved.

FlashPro and FlashPro Lite support both ProASIC
both devices in the same chain.

Unless all supplies are provided on board, there is a limitation of programming eight ProASIC
ProASIC devices in a chain.

PLUS and ProASIC devices. However you cannot program

PLUS or
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Multiple Device Serialization in a Chain

When you program multiple SmartFusion, IGLOO, ProASIC3 and Fusion family parts, you can use the
serialization functionality for more than one device. You must generate STAPL files with the correct
serialization data in them to use this functionality.

Each serialization enabled STAPL file may contain a different number of serialization data, but you may only
select the same number of serialization data to program in a single Serialization/Programming session.

See the example below for further explanation:

In this example, you have a chain of two devices (one device is an A3P250 and the other device is an
A3PEG600). The STAPL file for the A3P250 contains 10,000 serialization data and the STAPL file for the
A3PEG600 has 5,000 serialization data. In a single Serialization/Programming session, you are allowed to
select serialization data indexed from 1 to 1,000 for the ASPE600 device and serialization data indexed from
5,001 to 6000 for the A3P250 device. However, FlashPro errors out (at the beginning of a programming
operation) when the amount of the Serialization data you select is different from the devices.

Reuse Serial Data That Failed Programming

If any of the devices in the chain fail programming, the entire chain fails. All of the devices with serialization
enabled will fail as well. The serialization data will be reused or skipped based on your settings. See the
example below for more information:

You have a chain with three devices. Device 1 and Device 3 are serialization enabled. You have selected
Serialization Data 1 to 100 for Device 1 and 501 to 600 for Device 3, and you have set to reuse any unused
Serialization Data. Device 2 is targeted for programming without serialization. See the figure below for an

illustration.
Time ) 1 501 gt};?j;
10 Programmer U oI s ] Devz ] Dew1 | .
PAGS FEGS PAGS
. 2 502
1 Programmer L 3 ] Devz ] Devt || FALL
FAIL PASS PASS
Programmer ™ 2 =
t2 ® Dev3 ™ Devi * Devl J Fall.
N/A FAIL PASS
Programumer + 2 02
B3 » Dev3 » Devi » Devl J PASS
FASS F&SS FASS
Programumer + : 203
53 » Dev3 » Devi » Devl J PASS
FASS F&SS FASS

At time t0, all devices in the chain passed programming so the Serialization Data indexes are advance to 2
and 502 for Device 3 and Device 1 respectively. At time t1 and t2, one of the devices failed programming so
the device indexes are reused for time t3.

Note that at time t2, when Device 2 failed to program; Device 3 will not be programmed.

Multiple Device Serialization and Parallel Programming

The FlashPro software enables parallel programming for ProASIC3, excluding ProASIC3L, family devices
using multiple FlashPro5/4/3/3X programmers. The following figure illustrates how the indexes are reused in
a parallel programming environment.
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At time t0, the chain failed to program so index 2 and 502 are reassigned to Device 3 and Device 1
respectively at time t1. The failed indexes are not assigned to the programmer that previously failed. It will
always be assigned to the devices in the first programmer in the Programmer List.

Chain Configuration Window

The Chain Configuration Window displays the chain order, the chain editing options, and the chain
configuration grid (see figure below). The Chain Configuration Grid enables you to view and set options for
each of your devices. Right-click a column heading in the grid and choose a menu option to show or hide a
specific column.

The Chain Configuration Grid enables you to view, sort and/or set the following options:

Device - Device name

Name - Editable field for a user-specified device name. If you have two or more identical devices in
your chain you can use this column to give them unique names.

File - Path to programming file
IR Length - Device instruction length.

Max TCK (MHz) - Maximum clock frequency to program a specific device. FlashPro uses this
information to ensure that the programmer operates at a frequency lower than the slowest device in
the chain.

Enable Device - Select to enable the device for programming
Enable Serial- Select to enable serialization when you have loaded a serialization programming file
Action - List of programming actions for your device.

Procedures - Advanced option; enables you to customize the list of recommended and optional
procedures for the selected Action.

Serial Data - Opens the Serial Settings dialog box; enables you to set your serialization data.

Serial Status - Displays serialization status; lists serialization index(es)/action(s) that have been used
and shows the next serialization data that will be programmed.
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e HIGH-Z - Sets disabled Microsemi SoC SmartFusion, IGLOO, ProASIC3, Fusion devices in the chain
to HIGH-Z (tri-states all the 1/0s) during chain programming of enabled Microsemi devices in the daisy
chain.

The Show Chain Editing checkbox, when checked displays your chain editing options (Configure device,

Add Microsemi Device, Add Non-Microsemi Device, and organization buttons to move your device within the

grid).

Note: For information on how to Add Microsemi and Non-Microsemi devices, see Chain Editing.

Note: For information on how to use the Organize buttons (located next to the Add Microsemi and Add Non-
Microsemi buttons) in the Chain Configuration grid, see Using the Organize buttons in the Chain
Programming grid.

You can enable programming and serialization by checking the Enable Device checkbox and the Enable
Serial checkbox in the Chain Configuration grid.

—-|rn| N 1Do|—-ooo—-|1m 2 rnol—olml 1 Too;—- | ’—l _I _J _I Add.ﬁctelDevicerAl

Add Nonshctel Device |
¥ Show Chain Edting —

IR Max TCK | Emable  Enable
Length [MHz) Device Serial

Serial

Device MName File Action Data

HIGH-Z

Construct the chain from a Scan Chain operation...

Figure 116 - Chain Configuration Window

Chain Editing Options

The FlashPro software enables you to automatically construct the chain by clicking the Construct the chain
from a Scan Chain operation link, or by selecting Construct Chain Automatically from the
Configuration menu.

FlashPro also enables you to manually edit your chain by adding Microsemi and Non-Microsemi devices.
You can add devices by clicking the Add Microsemi Device button and the Add Non-Microsemi Device
button, or you can select these options from the Configuration menu.

For more information about how to edit the chain, see Chain Editing.

Editing the Chain Configuration Grid

The Chain Configuration Grid enables you to select an Action for your device, Enable Serialization, and edit
the grid using the right-click menu.
To select an Action from the Configuration Grid:

1. Choose the device you would like to program and check the Enable Device checkbox.

2. Inthe Action column, click the down arrow to expose the drop down menu (see figure below).

3. Select your desired action.

Action

FROGRAM  =|

DENVICE_INFO
ERASE
ERASE_ALL
ERASE_ARRAY
ERASE_FROM
PRCIGR & |
PROGRAM_ARRA
PROGRARM_FRCM
READ_IDCODE
WERIFY

WERIFY _&RRAY
WERIFY _FROM

Figure 117 - Drop Down Menu for Select Action
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Before you can enable serialization, you must check the Enable Device checkbox.
To enable Serialization:
1. Check the Enable Serial checkbox. By enabling serialization, the action options change.
2. Inthe Action column, click the down arrow to expose the drop down menu (see figure below).

Action

FROGRAM  =|
PROGRA,
VERIFY

VERIFY_FROM

A :
M_FROM

Figure 118 - Drop Down Menu for Select Action
3. Select your desired action.

Serial
Data

Figure 119 - Serial Data Column

4. Click the Select button from the Serial Data column, which is next to the Action column (see above
figure). The Serial Settings dialog box displays.

5. Choose your serial settings from the Serial Settings dialog box.

See Serial Settings for more information about this topic.
Note: Uncheck the Enable Serial checkbox to disable serialization.

To edit the Chain Configuration Grid:
1. Select the device you would like to edit and right click anywhere in the row of the selected device.
2. Select and click an option from the right-click menu.

Note: The Device Configuration menu (see figure below) includes options for configuring your device.

Configure, .. Ckrl+F
IT Progran ]
£ Select Action, .. Chrl+Shift+8

Serialization L

Load STAPL File... Ckrl+Shife+L

Figure 120 - Device Configuration Menu

Chain Editing

The chain order is located in the Chain Configuration Window (see figure below). The devices you add to the
chain must be in the correct order and must match the physical chain to be programmed.

x

Create PDB...
Inspect Device |
Enable Enable -
TR, Serial Action HIGH-Z
~ ~ PROGRAM = |
~ PROGRAM

Figure 121 - Chain Configuration Window

Check the Show Chain Editing checkbox to display chain editing options (Add Microsemi Device, Add
Non-Microsemi Device). See figure below.

FlashPro User's Guide 79



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

CM- f when clicked. View the online help included with software to enable all linked content.
% Add Actel Device 4
_.{'"” N YW]—‘ e _.{‘[m 2 [ponm 'I Tnol_. Create PDE... | Configure Device... | il ﬂ £|
Add Non-dctel Device
¥ Show Chain Ediing Inspect Device
" = IR Max TCK  Enable Enable : Serial
Device Name File Length  (MHz)  Device Seial Action Data HIGH-Z
1| AFSBOD = A3PEEDD @ V:\kian'\progiammin(=) 8 10 i ¥ PROGRAM =] ale
2 | AZF00M3 50 @ V:\kiran'\programmin () 8 10 [~ 1 PROGRAM hd

Figure 122 - Chain Configuration Window
You can edit the chain by adding Microsemi and Non-Microsemi Devices, for information refer to:
¢ Adding Microsemi Devices
¢ Adding Non-Microsemi Devices
e Adding Microsemi Devices from a STAPL File

e Automatic Chain Construction Tutorial

e Chain Programming Tutorial

Using the Organize Buttons in the Chain Programming Grid

The organize buttons enable you to select the order of the devices in your Chain Programming grid (see
figure below).

= .
= . Add Actel Device 4
_.{'"” N YW]—‘ e _.{‘[m 2 [ponm 'I Tnol_. Create PDE... | Configure Device... | il ﬂ £|
Add Non-&ctel Device
¥ Show Chain Ediing Inspect Device
" - IR Max TCK = Enable Enable - Serial
Device Name File Length [MHz2) Device | Serial Action Data HIGH-Z

1 AFSEOD | AZPEE00 @ V. \kian\programmin=) | 8 10 ¥ W |PROGRAM vl ale
2 | AF200M3F AP0 0 VV:\kian'\programmin 2 ] 10 WA [ PROGRAM x

Figure 123 - Chain Configuration Window (Displaying Organize Buttons)

You can move devices up and down or delete devices within the grid. See the table below for a description
of each button.

Table 4 - Organize Buttons

Button Description
Moves your device up in the Chain Programming grid.
+ | Moves your device down in the Chain Programming grid.
x Deletes your device from the Chain Programming grid.

Cutting, Copying and Pasting Devices from the Chain

If you want to make changes to your chain, you must make these changes from the spreadsheet in the
Chain Programming grid.
To copy or cut a device from the chain programming grid:

1. Select the device you would like to edit and right click anywhere in the row of the selected device. The
right-click menu appears.

2. Select Copy or Cut from the right-click menu to copy your device.

To paste a device from the chain programming grid:
1. Right-click the location where you would like to Paste the device.
2. Select Paste from the right-click menu .

80 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. . .
p & Microsemi

Removing Devices from the Chain

Removing Devices from the Chain

If you want to make changes to your chain, you must make these changes from the spreadsheet in the
Chain Programming grid.

To remove a device from the chain programming grid:

1. Select the device you would like to remove and right click anywhere in the row of the selected device.
The right-click menu appears.

2. ChooseRemove from the right-click menu to delete your device.

Moving Devices within the Chain

You can move devices within the chain by using the Organize buttons (located next to the Add Microsemi
and Add Non-Microsemi Device buttons) in the Chain Programming grid (as shown in the figure below).

+ 2| X|

Figure 124 - Organize Buttons
To move or delete a device within the chain:

1. Click a device to select it.

2. Click one of the Organize button arrows to move your device up or down the spreadsheet. Click the
delete button (red X) to remove a device.

For more information about the Organize buttons, see Using the Organize buttons in the Chain
Programming grid.

Skip Serial Data

If you are unable to perform the programming action on your device, if your device fails to program, and you
have selected the Skip Serial Data serialization setting, the software automatically uses the next serial data
when you program the next device. By default, the software is set to Skip Serial Data.

You can change the serialization setting by selecting Tools > Serialization or you can click the Skip serial
data icon or the Reuse serial data icon from the toolbar.

Reuse Serial Data

If your device fails to program, and you have selected the Reuse Serial Data serialization setting, the
software automatically reuses the current serial data when you program the next device.

Note: The FlashPro default setting is Skip Serial Data.

You can change the serialization setting by selecting Tools > Serialization or you can click the Skip serial
data icon or the Reuse serial data icon from the toolbar.

Serialization with Parallel Programming

When programming the multiple ProASIC3 devices in parallel, while performing serialization at the same
time, each target device is assigned a Serial Index/Action for each programming run. Upon each successful
completion of each programming run, a new index is assigned to the each target device for the next
programming run. This process continues until the selected Serial Indices/Actions are exhausted.

Note: If programming failure is encountered, depending on the user setting, the failed serial data may be
reused or skipped in the next programming run.

Note: If, in the last programming run, the remaining number selected Serial Indices/Actions is less than the
number of targeted ProASIC3 devices, the targeted devices without an assigned Serial Index/Action
are skipped in the final serial programming run.
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Chain Editing

Adding a Microsemi Device

To add an Microsemi device:

1. Click the Add Microsemi Device button from the Chain Programming grid. The Add Microsemi
Device dialog box appears (see figure below).

Add Actel Device x|

Programming File: | J

" Device

Device: | J

Mare : |

Help Ik | Cancel

Figure 125 - Add Microsemi Device
2. Click the Device radio button and choose your device from the Device list drop-down menu.

3. Click the File radio button, then click the Browse button in the Programming file text box to find your
PDB/STAPL file. The Use File dialog box appears.

4. Find your PDB/STAPL file and click Open. Your PDB/STAPL file name appears in the Name text box.
You can change the name by clicking in the text box.

5. Click OK. Your device displays in the Chain Programming grid.

You can also add a Microsemi device from Configuration > Add Microsemi Device.

Adding a Microsemi Device from Files

To add a Microsemi device from a file:

1. From the Configuration menu, choose Add Microsemi Devices From Files. The Add Microsemi
Devices From Files dialog box appears.

2. Locate your file and click Open. Your device displays in the Chain Programming grid.

Adding a Non-Microsemi Device

When adding a non-Microsemi device, you must choose either a BSDL file or customize the Instruction
Register (IR) length and the Max TCK frequency of the device.

IR Length

The IR length specifies the number of IR bits in a specific device.
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Adding a Non-Microsemi Device

Max TCK Frequency

Maximum clock frequency to program a specific device. FlashPro uses this information to ensure that the
programmer operates at a frequency lower than the slowest device in the chain.

BSDL File

Boundary Scan Description Language (BSDL) files describe the characteristics of a specific device. When
using a BSDL file, FlashPro extracts the IR length and TCK frequency for the specific device and uses the
information to build the FlashPro STAPL file. If you do not have a BSDL file for your specific device, you
must manually enter the IR length and Max TCK for your device. This information should be found in the
datasheet for the device.

To add a non Microsemi device using a BSDL file:

1. Click the Add Non-Microsemi Device button in the Chain Programming window. The Add Non-
Microsemi Device dialog box appears (see figure below).

Add Non-Actel Device X
" File
ESOL File: | J
(* Data

IR, length: z
Max TCK Freq.: |1 MHz

Marme: | Dervice 2

Help | Ik | Zancel

Figure 126 - Add Non-Microsemi Device Dialog Box

2. Type in the BSDL file or locate it by clicking the Browse button. If you click the Browse button to find
your BSDL file, the Use File dialog box displays.

3. Select your BSDL file from the Use File dialog box, and click Open.
4. Click OK, and your device appears in the Chain Programming grid.

When closing the Add Non-Microsemi Device window, if you specified a BSDL file, it is parsed and its IR
length and Max TCK frequency are retrieved.

Note: If you select a BSDL file, you cannot specify an IR length and Max TCK frequency.

To add a Non-Microsemi device using an IR length and a Max TCK frequency:
1. Click the Add Non-Microsemi Device button from the Chain Programming window.
2. Click the Data option from the Add Non-Microsemi Device dialog box.
3. Enter the IR length AND the Max TCK frequency in MHz.
4. Click OK.
If you decide to use custom data, you must specify both an IR length and Max TCK frequency.

Note: The IR length must be an integer greater than or equal to 2, and the Max TCK frequency must be a
float greater than or equal to 1.
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Non-Microsemi Device Configuration Dialog Box
It is possible to add multiple BSDL files to your Non-Microsemi device database that have the same
IDCODE. If the BSDL files list the same IR length but different TCK values, FlashPro automatically chooses
the file with the lowest TCK value by default and no action is required. If the IR lengths are different you
receive an error message asking you to resolve the conflict.
To resolve the issue, click the drop-down arrow adjacent to the device name. This opens the Non-Microsemi
Device Configuration dialog box (as shown in the figure below). From here you can choose the device that
you wish to use. Select the device from the dropdown menu and enter a new name or use the default.

Non-Actel Device Configuration E|
i
BSOL File: | YW kiranprogramming_designsisar J
" Data

IR, length:
Max TCK Freg.: MHz

Mame: | AFSE00FG256

Help K | Cancel

Figure 127 - Non-Microsemi Device Configuration Dialog Box
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Selecting an Action

Configuring a Programmer

Selecting an Action

The available actions are depend on what type of STAPL file you have loaded into the software.

To configure a programmer:

1. From the Configuration menu, choose Select Action. The Select Action and Procedures dialog
box appears (see figure below). You can change the procedures for each action; the procedures that
appear will vary depending on both your device and the action you have selected.

Select Action And Procedures E|
Ackion:
DEYICE_INFO |
Procedures |

VERIFY_IDCODE
READ_IMITIALIZE
CHECK_aMD_BACKEUP _CallB
READ_IDCODE_OMLY
DO_DEVICE_IMFO
DO_GUERY_SECURITY
DO_E=IT

R RRAEE

Restore Default Procedures |

Help | Ik | Cancel |

Figure 128 - Select Action and Procedures Dialog Box

2. Click the checkboxes of the available procedures or click the Restore Default Procedures button in
the Select Action and Procedures dialog box.

3. Click OK.

Click the Restore Default Procedures to return to default settings.

For example, if you wish to disable the gathering of Check and Backup calibration data:
1. Inthe Action drop-down menu, choose DEVICE_INFO.

2. Click Procedures to open the Select Action and Procedures dialog box (as shown in the figure
above).

3. Click CHECK_AND_BACKUP_CALIB to clear the checkbox and disable it.
4. Click OK to continue.

Using Serialization

To use serialization:
1. Enable serialization by checking the Serialization checkbox.
2. Select an action in the Action text box.
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3. Click the Select Serialization Indexes button. The Serial Settings dialog box displays (see figure
below).

Note: Depending on the STAPL file format (Microsemi format or generic format) used, you will either see Indexes
columns or Actions columns in the Serial Settings dialog box.

Serial Settings PS_<|

N Al =

L e B R L L )

Hillls

[v Wiew unused data
v Yiew used data
v Wiew skipped data

Filker: | *

v Log serial data: |Regin:nn_6_3 j

Help (0] 4 | Cancel |

Figure 129 - Serial Settings Dialog Box
Note: Depending on your STAPL file, you would click the Select Serialization Action button (see figure

below).
V Seriskeation

Senialization
SealAcions | State | Programmers |
PROGRAM_1 Urwized
PROGRAM_2 Urused
PROGRAM_3 Urused
PROGRAM_4 Uriszed
PROGRAM_S Urwszed

Mext Serialization Data: PROGRAM_1

Figure 130 - Select Serialization Actions Button

Modifying Programming Settings in FlashPro with a PDB File

FlashPro enables you to modify programming settings within the software by using a PDB file. This feature
is available only for PDB files generated from Designer v8.1 or greater. This feature allows modification of
features being programmed, security settings, and memory content update for FlashROM and Embedded
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Modifying Programming Settings in FlashPro with a PDB File

Flash Memory Blocks (Fusion only). Please refer to Modifying Memory Contents and Programming a Device
Tutorial (EFMB) and Modifying FlashROM Contents and Programming a Device Tutorial for an example.

Note: You cannot add or remove the FPGA feature from your PDB. If you would like to add or remove this
feature from your PDB, regenerate the PDB from Designer.

See Also
Configuring security, FlashROM and Embedded Flash Memory Block settings in FlashPro

FlashPro User's Guide 87



& Microsemi

NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

Configuring Security

Configuring Security, FlashROM and Embedded Flash Memory

Settings in FlashPro

1. From the Configuration menu, choose Load Programming File (PDB).
2. Select the PDB file and click Open, this loads the programming file.
3. From the Configuration menu, choose PDB Configuration. The Programming File Generator

appears (see figure below).

-

FlashPoint - Programming File Generator

-Step 1 of 2

,

| Security settings
E

W FlashRom

F:vadbiFrom, ufc

Silicon feature(s) ko be programmed:

Criginal FlashRoOM configuration File:

Ermbedded Flash Memory Blocks (EFME]):

Irnpart. ..

Program

Block
Mame

Block
Location

Oniginal Configuration File

1 I~

-

mvm_instAnem .

Modify IO Skates During Programming.. .

0

Silicon signature {max length is & HEX chars):

Help

P:hadbhafs2504calib. efc

exk

Modify...

| Firish | Cancel

Figure 131 - Programming File Generator

4. Select the Silicon feature(s) you want to program:

o Security settings

e FlashROM

¢ Embedded Flash Memory Block

5. Check the Programming previously secured device(s) box if you are reprogramming a device that
has been secured.

Because the SmartFusion, IGLOO, ProASIC3 and Fusion families enable you to program the Security
Settings separately from the FPGA Array and/or FlashROM, you must indicate if the Security Settings
were previously programmed into the target device. This requirement also applies when you generate
programming files for reprogramming.

6. Enter the Silicon signature (0-8 HEX characters).

7. Click Next.
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Configuring Security Settings in FlashPro

Configuring Security Settings in FlashPro

To configure the security settings:

1. From the Configuration menu, choose Load Programming File (PDB).
2. Select the PDB file and click Open, this loads the programming file.

3. Fromthe Configuration menu, choose PDB Configuration. The Programming File Generator
appears (as shown in the figure below).

-

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Feature(s) to be programmed:
6 v Security settings
-
¥ FlashRom
Criginal FlashROM configuration File:

Pihadb'from, ufc Import. ..

Embedded Flash Memory Blocks (EFME):

Program :I:;Z LE[I:::::]“ Original Configuration File
1 Ird rm_inst nvm_i.. 0 P:4adbhafs 2504 calib. efc W adify...

-

Modify /0 States During Programming. ..

Silicon signature {max length is & HEX chars):

Help Mesxt | Finish | Cancel

Figure 132 - Programming File Generator

4. Check the Security Settings checkbox and click Next. This brings up the Security Settings dialog
box (shown below).
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FlashPoint - Programming File Generator - Step 1 of 3 @

Security level For this device:

-~— - High Protect with 125-bit Advanced Encryplion Standard (AES) key A
and Pass Key o
. - Use AES key to write or werify the FPGA Array.
Iedium
- Use AES key to write or verify the FlashROM via the JTAG !
interface,
- - Mone A

Custarn Lewvel,.. Default Lewvel |

Pass Key (max length is 32 HEX chars):

| Generate random key |

AES Key (max length is 32 HEX chars):

| Generate random key |

Help Back et | Finish | Cancel |

Figure 133 - Security Settings Dialog Box

5. Move the sliding bar to select the security level for FPGA, FlashROM, and EFMB (see table for a
description of the security levels).

Table 5 - Security Level Descriptions

Security | Security Option Description
Level
High Protect with a Access to the device is protected by an AES Key and
128-hit Advanced | the Pass Key. The Write and Verify operations of the
Encryption FPGA Array use a 128-bit AES encrypted bitstream.

Standard (AES) From the JTAG interface, the Write operation of the

key and a Pass FlashROM uses a 128-bit AES encrypted bitstream.
Key Read back of the FlashROM content via the JTAG
interface is protected by the Pass Key. Read back of the
FlashROM content is allowed from the FPGA Array.

Medium | Protect with Pass | The Write and Verify operations of the FPGA Array
Key require a Pass Key. From the JTAG interface, the Read
and Write operations on the FlashROM content require
a Pass Key. You can Verify the FlashROM content via
the JTAG interface without a Pass Key. Read back of
the FlashROM content is allowed from the FPGA Array.

None No Security The Write and Verify operations of the FPGA Array do
not require keys. The Read, Write, and Verify
operations of the FlashROM content also do not require
keys.

Note: When a device is programmed with a Pass key and AES key, only the Pass key is required for
reprogramming since re-entering the correct Pass key unlocks the bits that restrict programming to
require AES encryption and also unlocks the bits that prohibit reprogramming altogether (if locked);
thus both plaintext and encrypted programming are [re-] enabled.
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Custom Security Settings

6. Enter the Pass Key and/ or the AES Key as appropriate. You can generate a random key by clicking
the Generate random key button.
The Pass Key protects all the Security Settings for the FPGA Array and/or FlashROM.
The AES Key decrypts FPGA Array and/or FlashROM programming file content. Use the AES Key if
you intend to program the device at an unsecured site or if you plan to update the design at a remote
site in the future.

7. Click Finish.

You can also customize the security levels by clicking the Custom Level button.

To change or disable your security keys you must run the ERASE_SECURITY action code. This erases your
security settings and enables you to generate the programming file with new keys and reprogram, or to
generate a programming file that has no security key.

Custom Security Settings
For advanced use, you can customize your security levels.

To set custom security levels:

1. Click the Custom Level button in the Setup Security page. The Custom Security dialog box appears
(see figure below).

Custom Security Level E]

: Securnty Sethings
Device Feature Seiﬁtrity Encrypt Rend | \::rify | ?ﬂ'rite
FPGA Array W ~ o
FlashROM ~ 3 FH
firmware\/NVM_INST [# 1) W W i R =

[ Permanently lock the security settings.

Figure 134 - Custom Security Level

2. Select the FPGA Array Security, the FlashROM Security, and Embedded Flash Memory block
levels.

The silicon features can have different Security Settings. See the tables below for a description of the
custom security option levels for FPGA Array, FlashROM, and Embedded Flash Memory block.
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Table 6 - FPGA Array

Security Option Description

Lock for both writing and verifying Allows
_ Set Security Settings writing/erasing
Device Feature Security Encrypt s | Verify | Wirite and verification
of the FPGA
FPGA Array W r E E Array via the
JTAG interface
only with a
valid Pass
Key.

Lock for writing Allows the
Set Security Seftings writing/erasing

Device Feature .. | E t
security| "YU TG T Verity | wiite | | Of e FPGA

Array only with
FPGA Arrzy ™2 r (] A y ony wi

a valid Pass
Key.
Verification is
allowed
without a valid
Pass Key.

Use the AES Key for both writing and verifying Allows the
: Set Security Settings writing/erasing
Device Feature Security Encrypt ond | Verily | Write and verification
— — of the FPGA
FPGA Array | v | W | Array only with
a valid AES
Key via the
JTAG
interface. This
configures the
device to
accept an
encrypted
bitstream for
reprogramming
and verification
of the FPGA
Array. Use this
option if you
intend to
complete final
programming
at an
unsecured site
or if you plan
to update the
design at a
remote site in
the future.
Accessing the
device security
settings
requires a valid
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Custom Security Settings

Security Option

Description

Pass Key.

Allow write and verify

Allows

Set

Device Fzature SRR

Encrypt

Security Settings writing/erasing

and verification

Read | Verify | Wirite

FPGA Array | r

of the FPGA
Array with
plain text
bitstream and
without
requiring a
Pass Key or an
AES Key. Use
this option
when you
develop your
product in-
house.

Note: The ProASIC3 family FPGA Array is always read protected regardless of the Pass Key or the AES

Key protection.

Table 7 - FlashROM

Security Option

Description

Lock for both reading and writing

Allows the writing/erasing and reading of

_ set Security Settingthe FlashROM via the JTAG interface
Device Feature Security Encrypt i [ 1IonIy with a valid Pass Key. Verification is
allowed without a valid Pass Key.
FlashROM W r i (4]
|
Lock for writing | Allows the writing/erasing of the
2 .__FlashROM via the JTAG interface only
Device Feature Seiﬁtritf Encrypt SE{:lur:!'r SEﬁlmivvith a valid Pass Key. Reading and
i erify | 1\ erification is allowed without a valid Pass
FlashROM ] r [EH] [ci] Key.
Use the AES Key for writing Allows the writing/erasing of the
_ Sat Security Setting:F1ashROM via the JTAG interface only
Device Feature Security| EMCrYPt iead | ety | yVith a valid AES Key. This configures the
device to accept an encrypted bitstream
FlashROM 1 ¥ for reprogramming of the FlashROM. Use

this option if you complete final
programming at an unsecured site or if
you plan to update the design at a remote
site in the future.

Note: The bitstream
that is read back
from the
FlashROM is
always
unencrypted
(plain text).
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Security Option Description
Allow reading, writing, and verifying Allows writing/erasing, reading and
_ gat Security Setting:verification of the FlashROM content with
Device Feature S Encrypt Read | Verity | v° plain text bitstream and without
requiring a valid Pass Key or an AES Key.
FlashROM | I
|

Note: The FPGA Array can always read the FlashROM content regardless of these Security Settings.
Table 8 - Embedded Flash Memory Block

Security Option Description
Lock for reading, verifying, and writing Allows the writing
: set | Security Settings | | and reading of the
Device Feature .. | Encrypt
‘ Security| " '"'| Read | Verify | Write | I\EﬁmbEddeBOl' F'ESU
emory Block via
firmwareUNVM_INST (# 1) | # r R A A the JTAG interface

only with a valid
Pass Key.
Verification
accomplished by
reading back and
compare.

Lock for writing Allows the writing
. Set Security Settings of the Embedded
Device Feature . | Encrypt
Security Read | Verify | Write E'IaSE Mert‘:]or%TAG
ock via the
firmwareVNVR_INST (# 1) M r ] (] 7 interface only with
a valid Pass Key.
Reading and
verification is
allowed without a
valid Pass Key.

Use AES Key for writing Allows the writing

: Set Security Settings of the Embedded
Device Feature Security Encrypt = | Verity | = E'IaSE Mer’:;?r%TAG
firmwareVNVM_INST (# 1) F [ F | & FH imoeﬁfa‘é'sonley with
a valid AES Key.
This configures the
device to accept
an encrypted
bitstream for
reprogramming of
the Embedded
Flash Memory
Block. Use this
option if you
complete final
programming at an
unsecured site or if
you plan to update
the design at a
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Custom Security Settings

Security Option Description

remote site in the
future. The
bitstream that is
read back from the
Embedded Flash
Memory Block is
always
unencrypted (plain
text), when a valid
pass key is
provided.

Allow reading, writing, and verifying Allows writing,
2 Set Security Settings reading and
Device Feature .. | Encrypt e
Security| " '"'| Read | Verify | Write ‘ée“:)'cggog ‘I):fl thﬁ
firmwareUNVM_INST (% 1) | b Mzmiryzloc ES
content with a
plain text bitstream
and without
requiring a valid
Pass Key or an
AES Key.

3. To make the Security Settings permanent, select the Permanently lock the security settings check
box. This option prevents any future modifications of the Security Setting of the device. A Pass Key is
not required if you use this option.

Note: When you make the Security Settings permanent, you can never reprogram the Silicon Signature. If you
lock the write operation for the FPGA Array or the FlashROM, you can never reprogram the FPGA Array or the
FlashROM, respectively. If you use an AES key, this key cannot be changed once you permanently lock the
device.

4. To use the Permanent FlashLock™ feature (One-time programmable or OTP), select Lock for both
writing and verifying for FPGA Array, Lock for both reading and writing for FlashROM, Lock for
reading, writing, and verifying for each Embedded Flash Memory Block (for Fusion and
SmartFusion), if present, and select the Permanently lock the security settings checkbox as shown
in the figure below. This will make your device one-time programmable.
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F o " 5
Custom Security Level lﬁ

Silicon Feature Sei"‘;ﬂy Encrypt Msm'"v;ﬂs‘:“mfme
FPGA Array ] i) i 5
AashROM B a7 (i) =
eNVM (# 0) ] ﬁ m ﬁ
eNVM (1) B A i i

|| Enable M3 debugger
Permanently lock the security settings.

o The following silicon features will not be reprogrammable:
- Security settings, AES key, and silicon signature

-FPGA Array

- FlashR.OM

- eNVM (£ 0)

-eNVM (3 1)

[ OK. l [ Cancel

Custom Security Level- Permanent Lock

4. Click the OK button. The Security Settings page appears with the Custom security setting

information.

Changing or Disabling Security Keys
To change or disable your security keys you must run the ERASE_SECURITY action code.

ERASE_SECURITY erases your security settings and enables you to generate the programming file with
new keys and reprogram, or to generate a programming file that has no security key.

Your action codes vary according to device family:

Programming File Actions - SmartFusion and Fusion Devices

Programming Actions - IGLOO and ProASIC3 Devices

Configuring FlashROM Settings in FlashPro

To configure the FlashROM settings:

1.
2.
3.

From the Configuration menu, choose Load Programming File (PDB).

Select the PDB file and click Open, this loads the programming file.

From the Configuration menu, choose PDB Configuration. The Programming File Generator
appears.

Check the FlashROM checkbox and click Browse to load a FlashROM configuration file. Click Next.
This brings up the FlashROM Settings dialog box (see figure below).
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Figure 135 - FlashROM Settings Dialog Box

5. Select the FlashROM memory page that you want to program.

6. Enter the data value for the configured regions.

7. If you selected the region with a Read From File, specify the file location.

8. If you selected the Auto Increment region, specify the Start and Max values.

9. Enter the number of devices you want to program.
10. Click the Target Programmer button. The Select Programmer Type dialog box appears.
11. Click Finish. FlashPoint generates your programming file.

Note: You cannot change the FlashROM region configuration from FlashPoint. You can only change the
configuration from the FlashROM core generator.

Express Configuration

The express configuration feature in FlashPro allows you to set the security settings as well as FlashROM
content without a design. This allows the production flow to be executed in parallel to the design effort if
needed.

For example, you can pre-program the security settings with the High Security setting and serialize the
device using FlashROM without the FPGA design in a secured programming environment. The FPGA Array
and EFMB design can be programmed in unsecured programming environment using encrypted
programming file. Refer to Programming Only Security Settings Tutorial for more information.

Note: This feature is only available for SmartFusion, IGLOO, ProASIC3 and Fusion devices.
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IGLOO and ProASIC3 Programming

98 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. . .
p & Microsemi

Express Configuration

Programming File Actions for IGLOO and ProASIC3 Devices

IGLOO and ProASIC3 devices support the following features:
o FPGA Array
e FlashROM
e Security settings

You can program these features separately or together using different programming files or by using one

programming file.

Note: When a family name is specified, it refers to the device family and all its derivatives, unless otherwise
noted. See the Supported Families topic for a complete list of families and their derivatives.

The STAPL files for IGLOO and ProASIC3, excluding ProASIC3L, devices include actions targeted at one,

two, or all three of the IGLOO and ProASIC3 features (FPGA Array, FlashROM, and Security Settings). The

combinations of the features you selected to target results in different actions that are available in the

STAPL file. See the following table.

The table indicates that if you choose the feature FPGA Array, it will be affected by the PROGRAM file
action.

If you choose the feature Security, it will be unaffected by the PROGRAM action.
Table 9 - IGLOO and ProASIC3 Device Programming Actions

Features Selected

FPGA | FlashROM | Security | FPGA FPGA | FlashROM
Array Array and | Array and
FlashROM | and Securi
Security ty

STAPL Actions Available (correspond with Features
Selected above)

PROGRAM X X X X X
VERIFY X X X X X
ERASE X X X X X
ERASE_ALL X X X X X X
DEVICE_INFO X X X X X X
READ_IDCODE X X X X X X
ERASE_FROM X X X

PROGRAM_FROM

ERASE_ARRAY X X X
VERIFY_ARRAY X X X
ENC_DATA_AUTHENTICATION | X X X
PROGRAM_SECURITY X X X
ERASE_SECURITY X X X
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Note: The ENC_DATA_AUTHENTICATION Action is only available when you choose encrypted
programming.

Programming Actions
See the table below for a list of all the actions for the programming file.
Table 10 - Programming File Actions

Action Description

PROGRAM Programs all selected family features: FPGA
Array, targeted FlashROM pages, security
setting and silicon signature (if provided).

Note: If the FPGA Array is selected, the FPGA
Array core is enabled after successful
programming.

VERIFY Verifies all selected features: FPGA Array,
targeted FlashROM pages, security setting
and silicon signature (if provided).

ERASE Erases all selected family features: FPGA
Array, targeted FlashROM pages, security
setting and silicon signature (if provided).

ERASE_ALL Erases all features in the targeted device
regardless of the features selected to generate
the STAPL file.

DEVICE_INFO Displays the IDCODE, Silicon Signature, the
design name, the checksum, and device
security settings and programming
environment information programmed into the
device.

VERIFY_DEVICE_INFO Verifies the IDCODE, silicone signature,
design name, checksum, device security
settings and programming information
programmed into the device.

READ_IDCODE Reads the device ID code from the device.

ERASE_FROM Erases only the targeted FlashROM pages, not
the entire FlashROM.

PROGRAM_FROM Programs only the targeted FlashROM pages.

VERIFY_FROM Verfies the targeted FlashROM pages.

PROGRAM_ARRAY Programs the FPGA Array and Silicon

Signature (if applicable) into the device.

Note: The FPGA Array core is enabled after
successful programming of the FPGA.

VERIFY_ARRAY Verifies the FPGA Array and Silicon Signature
(if applicable) into the device.
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Action Description
ERASE_ARRAY Erases the FPGA Array and Silicon Signature
(if provided).
DISABLE_FPGA_ARRAY Disables the FPGA Array core.

Note: The FPGA Array core is enabled after
successful programming of the FPGA.

DISABLE_FPGA_ARRAY_PROGRAM | Disables the FPGA Array core, then programs
all selected family features: FPGA Array,
targeted FlashROM pages, security setting,
and silicon signature (if provided).

Note: The FPGA Array core is enabled after
successful programming of the FPGA.

PROGRAM_SECURITY Programs only the Security Settings.

ERASE_SECURITY Erases only the Security Settings.

Note: FIX_INT_ARRAYS - This function only applies to STAPL files. Depending on the STAPL player
implementation, the indexing of an integer array may start from a different direction. The STAPL
standard did not clearly specify how it should be implemented. The FIX_INT_ARRAYS function
detects the indexing implemented by the STAPL player and flips the content of the integer array if
needed.

Note: UNLOCK_UKEY: This function unlocks a secured device if it is locked by FlashLock.

Options available in Programming Actions
The table below shows the available actions in the programming file.
Table 11 - Programming File Actions

Action Description

PROGRAM When you target the Security Setting, you have the option of not
erasing and programming the Security Setting by deselecting the
following 2 procedures before executing the action. -
SET_ERASE_SEC, - DO_PROGRAM_SECURITY. When you
perform encrypted programming, you have the option of skipping
the data authentication before programming by deselecting the
DO_ENC_AUTHENTICATION procedure before executing the
action.

ERASE When you target the Security Setting, you have the option of not
erasing the Security Setting by deselecting the
SET_ERASE_SEC procedures before executing the action.

PROGRAM_ARRAY [ When you perform encrypted programming, you have the option
of skipping the data authentication before programming by
deselecting the DO_ENC_AUTHENTICATION procedure before
executing the action.

Note: The DO_ENC_AUTHENTICATION procedure prevents you from proceeding with encrypted
programming with incorrect data due to corruption or an operator error. If incorrect data is detected
during encrypted programming, the device will not be functional after programming.
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SmartFusion and Fusion (AFS) Programming

Programming File Actions - SmartFusion and Fusion

FlashPro enables you to program security settings, FPGA Array, eNVM and embedded flash memory blocks
(EFMB), and FlashROM features for AFS device support. You can program these features separately using
different programming files or you can combine them into one programming file.

Note: If you are programming SmartFusion devices you are using eNVM. If you are programming Fusion
devices you are using the Embedded Flash Memory Block (EFMB). When referring to these elements
together we refer to them as eNVM/EFMB.

The STAPL files for SmartFusion and Fusion devices include actions targeted at one, two, or all four of the
programming features: FPGA Array and FlashROM, Security Settings, and eNVM/EFMB. The combinations
of the features you selected to target, results in different actions that are available in the STAPL file. See the
following table for an illustration.

The table indicates that if you select ERASE_ALL that it will affect any Programming Feature (or
combination of features) marked with an X. According to the table, the only Programming Feature unaffected
by ERASE_ALL is the eNVM/EFMB.

Compare that to the ERASE command: ERASE does not have any effect on the following Programming
Features: Security; Embedded Flash Memory Block; Security AND eNVM/EFMB.

Table 12 - SmartFusion and Fusion Programming File Actions

Programming Features Selected

FP | Flash | Sec |eNVM/ FP |[Flash |Sec |FPGA |FPG |Flash |FPGA | FPG | Flash
GA | ROM |urity | Embedded | GA | ROM [urity | Array |A ROM | Array, |A ROM,
Arr Flash Arr | and and |[and Arra | and Flash [ Arra | Securi
ay Memory ay |[eNVM |eNV |Flash |y Securi | ROM |y, ty and
Block and |/ M/ ROM [and |ty and Sec |eNVM/
(EFMB) eN |[EFMB | EFM Sec eNVM | urity | EFMB

VM/ B urity / and

EF EFMB [ eNV

MB M/

EFM

B

STAPL Actions Available (correspond with Features Selected above)

PROGRAM X |x X X X X X X X X
VERIFY X |x X X X X X X X |X
ERASE X |x X X X X X X X |X
ERASE_ALL X |x X X X X X X X X X X
DEVICE_INFO X |x X X X X X X X X X X X
READ_IDCODE X |x X X X X X X X X X X X
ERASE_FROM X X X X X X
PROGRAM_ARRAY | X X X X X X
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Programming Features Selected

VERIFY_ARRAY X X X X X X
ENC_DATA_AUTHE |X X X X X X
NTIFICATION

PROGRAM_SECURI X X X X X
TY

ERASE_SECURITY X X X X X
VERIFY_SECURITY X X X X X
PROGRAM_FP X X X X X X
VERIFY_FP X X X X X X
PROGRAM_NVM X X X X X X
VERIFY_NVM X X X X X X
PROGRAM_NVM_A X X X
CTIVE_ARRAY

VERIFY_NVM_ACTI X X X

VE_ARRAY

PROGRAM_NVM_A X X X
CTIVE_RSTM3

RESET_CORTEXM3 X X X X X X
(SmartFusion only)

Note: The ENC_DATA_AUTHENTICATION Action is only available when you choose encrypted
programming.
Note: PROGRAM_NVM_ACTIVE_ARRAY and VERIFY_NVM_ACTIVE_ARRAY actions are not available
when the EFMB read/write/verify is locked with FlashLock.

STAPL Actions

See the table below for a list of all the actions for the STAPL file.

Table 13 - STAPL File Actions

Action

Description

PROGRAM

Programs all selected family features: FPGA
Array, targeted FlashROM pages, security setting
and silicon signature (if provided).

SmartFusion only: Resets the CORTEX M3.

VERIFY

Verifies all selected family features: FPGA Array,
targeted FlashROM pages, security setting and

silicon signature (if provided).
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Action Description

ERASE Erases the selected family features.

ERASE_ALL Erases all features in the targeted family device
except Embedded Flash Memory Blocks,
regardless of the features selected to generate
the STAPL file.

DEVICE_INFO Displays the IDCODE, Silicon Signature, the
design name, the checksum, and device security
settings and programming environment
information programmed into the device.

READ_IDCODE Reads the device ID code from the device.

ERASE_FROM Erases only the targeted FlashROM pages, not
the entire FlashROM.

PROGRAM_FROM Programs only the targeted FlashROM pages.

PROGRAM_ARRAY Programs the FPGA Array and Silicon Signature
(if applicable) into the device.

SmartFusion only: Resets the CORTEX M3.

VERIFY_ARRAY Verifies the FPGA Array and Silicon Signature (if
applicable) into the device.

ERASE_ARRAY Erases the FPGA Array and Silicon Signature (if
provided).

PROGRAM_SECURITY Programs only the Security Settings.

ERASE_SECURITY Erases only the Security Settings.

PROGRAM_NVM Programs the targeted EFMBs.

SmartFusion only: Resets the CORTEX M3.

VERIFY_NVM Verifies the targeted EFMBs.

PROGRAM_NVM_ACTIVE_ARRAY | Programs the targeted EFMBs while the FPGA
Array remains active.

VERIFY_NVM_ACTIVE_ARRAY Verifies the targeted EFMBs while the FPGA
Array remains active.

PROGRAM_NVM_ACTIVE_RSTMS3 | SmartFusion only; programs the eNVM while the
core is active and then resets the CORTEX M3.

RESET_CORTEXM3 SmartFusion only; resets the CORTEX M3.

Options available in STAPL Actions

The table below shows the available actions in the STAPL file.
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Programming File Actions - SmartFusion and Fusion

Table 14 - STAPL File Actions

Action Description

PROGRAM When you target the Security Setting, you have the option of not
erasing and programming the Security Setting by deselecting the
following two procedures before executing the action.

- SET_ERASE_SEC,

- DO_PROGRAM_SECURITY. When you perform encrypted
programming, you have the option of skipping the data
authentication before programming by deselecting the

DO_ENC_AUTHENTICATION procedure before executing the
action.

ERASE When you target the Security Setting, you have the option of not
erasing the Security Setting by deselecting the
SET_ERASE_SEC procedures before executing the action.

PROGRAM_ARRAY [ When you perform encrypted programming, you have the option
of skipping the data authentication before programming by
deselecting the DO_ENC_AUTHENTICATION procedure before
executing the action.

Note: The DO_ENC_AUTHENTICATION procedure prevents you from proceeding with encrypted
programming with incorrect data due to corruption or an operator error. If incorrect data is detected
during encrypted programming, the device will not be functional after programming.
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Generating Programming Files

Generate a Programming File in FlashPoint

FlashPoint enables you to program security settings, FPGA Array, and FlashROM features for SmartFusion,
IGLOO, ProASIC3, Fusion family devices. You can program these features separately using different
programming files or you can combine them into one programming file. Each feature is listed as a silicon
feature in the GUI.

Note: You can generate a programming file with one, two, or all of the silicon features from the
Programming File Generator first page.

To generate a programming file:
1. Select the Silicon feature(s) you want to program.

e Security settings

o FPGA Array
e FlashROM

FlashPaint - Programming File Generator - Step 1 of 1 @

Silicon fea

be programmed:

FPGA Array

[ Flashrom

Programming previously secured device(s)

0 I Specify If0 States During Programming.. . |

Silicon signature (max length is & HEX chars):

Help Back Save PDB Cancel

Figure 136 - Programming File Generator — Step 1 of 1

Note: When FlashPoint is invoked for the first time, after netlist files are imported and the design is in
post-layout state, the software retrieves the FlashROM and EFM blocks configuration files from
the imported netlists and imports the configuration files. Otherwise, you need to import
configuration files.

2. Click the Programming previously secured device(s) check box if you are reprogramming a device
that has been secured.

Because the SmartFusion, IGLOO, ProASIC3, Fusion families enable you to program the Security
Settings separately from the FPGA Array and/or FlashROM, you must indicate if the Security Settings
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Programming File Types

were previously programmed into the target device. This requirement also applies when you generate
programming files for reprogramming.

3. Enter the silicon signature (0-8 HEX characters). See Silicon Signature for more information.
4. Click Save PDB.

Programming File Types

The table below summarizes the Microsemi SoC programming file types and programmers.

Unless otherwise noted, listing an individual device indicates the device family and all its derivatives. For
example, IGLOO indicates IGLOO, IGLOOe, IGLOO nano and IGLOO plus. See the Supported Families
topic for more information. See the list of programming file type descriptions below for more details.

Programming File Device Support Programmer
Type
PDB (*.pdb) See device FlashPro 4/3/3x
specifications
STAPL (*.stp) FlashPro 4/3/3x, FlashPro Lite, FlashPro,
Silicon Sculptor 111/11
SVF (*.svf) Third party programmer
IEEE 1532 (*.isc or Third party programmer
*.bsd)

The following programming-related files are required if you use the related functional block elements in your
enabled devices. See the appropriate sections of the FlashPro help for more information on creating these
files.

File Type Device Support Function

FDB (*.fdb) | See device specifications | Contains your FPGA array data

UFC (*.ufc) Contains your FlashROM data
EFC (*.efc) Contains your Embedded Flash Memory file
PDB Files

A proprietary Microsemi programming data file.
STAPL Files

The Standard Test And Programming Language (STAPL) is designed to support the programming of
programmable devices and testing of electronic systems, using the IEEE Standard 1149.1: “Standard Test
Access Port and Boundary Scan Architecture” (commonly referred to as JTAG) interface. As a STAPL file is
executed, signals are produced on the IEEE 1149.1 interface, as described in the STAPL file. STAPL
operates on a single IEEE 1149.1 chain. STAPL supports the programming of any IEEE 1149.1-compliant
programmable device.

STAPL has support for programming and test systems with user interface features. A single STAPL file may
perform several different functions, such as programming, verifying, and erasing a programmable device.

Bitstream Files

Proprietary Microsemi programming data file.
SVF Files

Courtesy Serial Vector Format Specification from ASSET InterTech, 1999:
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Serial Vector Format (SVF) is the media for exchanging descriptions of high-level IEEE 1149.1 bus
operations. In general, IEEE 1149.1 bus operations consist of scan operations and movements between
different stable states on the IEEE 1149.1 state diagram. SVF does not explicitly describe the state of the
IEEE 1149.1 bus at every Test Clock.

The SFV file is defined as an ASCII file that consists of a set of SVF statements. The maximum number of
characters on a line is 256, although one SVF statement can span more htan one line. Each statement
consists of a command and associated parameters. Each SVF statement is terminated by a semicolon. SVF
is not case sensitive.

IEEE 1532 Files

Courtesy ieee.org:

The IEEE 1532 files implement programming capabilities within programmable integrated circuit devices,
utilizing (and compatible with) the 1149.1 communication protocol. This standard allows the programming of
one or more compliant devices concurrently, while mounted on a board or embedded in a system, known as
In-System Configuration.

Generate a Programming File for SmartFusion

You can configure and generate a new PDB file from FlashPoint.

If you are using Single Mode, click Create to add a new PDB, or click Modify to make changes to a loaded
PDB.

In Chain Mode, if you have not already done so, construct a chain and click Create PDB to create a hew
PDB for programming, or click Modify PDB to make changes to a loaded PDB.

FlashPoint enables you to specify your security settings and silicon features when you generate your
programming file in SmartFusion. You can specify your FEPGA Array, FlashROM, and Embedded Flash
Memory by importing FDB, UFC and EFC files, respectively (as shown in the figure below). If you have
imported a FlashROM and Embedded Flash Memory file you can click Modify to configure these feature
before saving your PDB file.

Click Specify 1/0 States During Programming to set custom /O states.

Note: You must import an FDB to populate Port Name and Macro Cell columns.

FlashPoint - A2F200M3F.pdb 53

Silicon Featureds) to be programmed:

I¥ Security settings Specify,..

ER ¥ Frca array

Cihactelpritsmartfusion_sample_fpro_filestSD.Fdb Impott. ..

HR ¥ Flashrom
CiiActelpriismartfusion_sample_fpro_filesiMS5_UFROM_0.ufc Impart... | Madify. .. |

m Iv Embedded Flash Memary

/¢y SilActel_Project_Testings!SmartFusiontcomponentiwarkl,.. \M35_ENYM_0.efc Impart... | Madify. .. |

o Specify [jO States During Programming. ..

Silicon signature {max length is 8 HEX chars):

Help Save PDB | Cancel

Figure 137 - FlashPoint Programming Settings for SmartFusion
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Creating a Programming Database (PDB) File in Designer

Creating a Programming Database (PDB) File in Designer

The programming database (PDB) file supports SmartFusion, IGLOO, ProASIC3 and Fusion devices only.
This allows reconfiguration of the security settings, FlashROM, FPGA Array, and Embedded Flash Memory
Blocks. You create the file in Designer using FlashPoint and you modify the file in FlashPro.

You must create programming files for SmartFusion in FlashPro; see the Generate a Programming File for
SmartFusion topic for more information.

1. From the Designer main window, click the Programming File button. This brings up FlashPoint (see
figure below).

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featurels) to be programmed:
ﬂ IV Security settings
¥ FPGA Array
Iv Flashrom
Criginal FlashROM canfiguration File:

Embedded Flash Memory Blocks (EFMED:

Program EII:;:; LE:;:::;n Original Configuration File
1 Ird firrwsareh /M .. 1 F:\Flagh_Memary_Block. efc Madify...

[ Programming previousky secured devicels)

Modify I/C States During Pragranmming. ..

Silicon signature {max length is & HEX chars):

Help Text Firish Cancel

Figure 138 - FlashPoint Programming File Generator - PDB File

2. Select the silicon feature(s) to be programmed: Security Settings, FPGA array, FlashROM, and
Embedded Flash Memory Block. If you are programming a previously secured device, check the
Programming previously secured device(s) and enter the silicon signature.

3. Click Finish to create the PDB file.

See Also
Configuring security and FlashROM settings in FlashPro
Configuring security settings in FlashPro
Configuring FPGA array settings
Configuring FlashROM settings in FlashPro
Configuring Embedded Flash Memory Block settings in FlashPro

Programming Embedded Flash Memory Block

For more information about the Embedded Flash Memory Block, see the Flash Memory System Builder
online help.

To program the Embedded Flash Memory Block:
1. Check the Program box to enable Embedded Flash Memory Block modification.
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2. Click the Modify button to import Embedded Flash Memory Block configuration and memory content.
The Modify Embedded Flash Memory Block dialog box appears.

Modify Embedded Flash Memory Block X
Block narme: Firrnwaarel WM _INST
Block lacation: 1
Block configuration file: Ci'iprod80auditinvm_all_newinvm_sl_new.efc Import Configuration File. .,
Block content:
Select All Clignts Unselect All Clients
JTAG Protection
! ! Start Client . '
Program [Client Type | Client Name | Address depthXwidth Prevent Prevent | Original Memory Content File
(hex) Read Write
1 1= Analog Syste  ash M MZA wl W
2 = CFl Data cfiData Hi NZA r ~ Dr:hprod80auditinym_simplehinput_m Import content. .
3 I Data Storage ds 0 18 I I D:hprodB0auditsnvm_simpleinput_m Irnport cortent
4 I~ Initiglization  init1 a0 Tr8 I I D:4prodB0auditsnym_simplelinput_m Irnport cortent
5 I~ BAM Initiahizat raminit 100 51249 ml ml
Help [o]4 | Cancel |

Figure 139 - Modify Embedded Flash Memory Block Content Dialog Box

3. Click the Import Configuration File button (if available) to import the Embedded Flash Memory Block
configuration and memory content from the EFC file. This will populate the client table below. All
clients that belong to this block will be selected by default.

4. Click the Import content button if you want to change the client memory content.
5. Click OK.

Note: FlashPoint audits original configuration and memory content files and warns you if the files
cannot be located or if they have been updated.

Programming the FPGA Array
The FPGA Array contains your design; in FlashPro for SmartFusion you must have an FDB file to program
your FPGA Array.

You can program the FPGA Array by selecting the silicon feature FPGA Array in the Generate
Programming File page and clicking OK.

In FlashPro, if you are using a PDB with an FPGA Array you cannot de-select it for programming unless you
are using SmartFusion.

See Generate a programming file for more information.

Programming the FlashROM

You can program selected memory pages and specify the region values of the FlashROM.

To program FlashROM:
1. Select FlashROM from the Generate Programming File page.

2. Enter the location of the FlashROM configuration file. The FlashROM Settings page appears (see
figure below).

Select the FlashROM memory page that you want to program.

Enter the data value for the configured regions.

If you selected the region with a Read From File, specify the file location.

If you selected the Auto Increment region, specify the Start and Max values.

Click Finish.
FlashPoint generates your programming file.

Note: You cannot change the FlashROM region configuration from FlashPoint. You can only change the
configuration from the FlashROM core generator.

No oM
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Silicon Signature

Silicon Signature

With Libero SoC tools, you can use the silicon signature to identify and track Microsemi designs and
devices. When you generate a programming file, you can specify a unique silicon signature to program into
the device. This signature is stored in the design database and in the programming file, and programmed
into the device during programming.

The silicon signature is accessible through the USERCODE JTAG instruction.

Note: If you set the security level to high, medium, or custom, you must program the silicon signature along
with the Security Setting. If you have already programmed the Security Setting into the target device,
you cannot reprogram the silicon signature without reprogramming the Security Setting.

Note: The previously programmed silicon signature will be erased if:
e You have already programmed the silicon signature and
e You are programming the security settings, but you do not have an entry in the silicon signature field

Programming Security Settings

FlashPoint allows you to set a security level of high, medium, or none (SmartFusion uses radio buttons and
the option Clear Security instead of None).

To program Security Settings on the device:
1. If you choose to program Security Settings on the device from the Generate Programming File page,
the wizard takes you to the Security Settings page.

Your Security Settings page depends on your family.

2. Set the security level for FPGA, FlashROM, and EFMB (see the table below for a description of the
security levels).

Table 15 - FPGA, FlashROM, and EFMB Security Settings

Security Security Option Description
Level
High Protect with a 128- Access to the device is protected by an AES Key
bit Advanced and the Pass Key.
Encryption Standard | The Write and Verify operations of the FPGA Array
(AES) key and a use a 128-bit AES encrypted bitstream.
Pass Key From the JTAG interface, the Write and Verify

operations of the FlashROM use a 128-bit AES
encrypted bitstream. Read back of the FlashROM
content via the JTAG interface is protected by the
Pass Key.

Read back of the FlashROM content is allowed from
the FPGA Array. The Read and Verify operations of
the EFMB module are protected by Pass Key from
the JTAG interface. The Write operations of the
EFMB module use a 128-bit AES encrypted
bitstream.

Medium [ Protect with Pass The Write and Verify operations of the FPGA Array
Key require a Pass Key.

From the JTAG interface, the Read and Write
operations on the FlashROM content require a Pass
Key. You can Verify the FlashROM content via the
JTAG interface without a Pass Key.

Read back of the FlashROM content is allowed from
the FPGA Array. The Read, Write, and Verify
operations of the EFMB module are protected by
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Security Security Option Description
Level

Pass Key from the JTAG interface.

None No security The Write and Verify operations of the FPGA Array
do not require keys. The Read, Write, and Verify
operations of the FlashROM content also do not
require keys. The Read, Write, and Verify operations
of the EFMB module content do not require keys.

This option is available for SmartFusion; to choose it,
de-select the Security Settings checkbox.

Note: When a Device is programmed with a Pass key and AES key, only the Pass key is required for
reprogramming since re-entering the correct Pass key unlocks the bits that restrict programming to
require AES encryption and also unlocks the bits that prohibit reprogramming altogether (if locked);
thus both plaintext and encrypted programming are [re-] enabled.

3. Enable eNVM client JTAG protection - Enables eNVM client JTAG protection in
the event you have not set Medium or High security. Enables you to protect specific
clients with a user pass key and then leave others unprotected. This can be
advantageous if you want to protect your IP, but give another user access to the rest of
the eNVM for storage. You can also set custom security levels for your eNVM.
NOTE: EFMB (Fusion) is called eNVM for SmartFusion devices.

4. Enter the Pass Key and/ or the AES Key as appropriate. You can generate a random
key by clicking the Generate random key button.

The Pass Key protects all the Security Settings for the FPGA Array, FlashROM, and/or EFMB.

The AES Key decrypts the FPGA Array, FlashROM, and/or EFMB programming file content. Use the AES
Key if you intend to program the device at an unsecured site or if you plan to update the design at a remote
site in the future.

You can also customize the security levels by clicking the Custom Level button. For more information, see
the Custom Security Levels section.

To change or disable your security keys you must run the ERASE_SECURITY action code. This erases your
security settings and enables you to generate the programming file with new keys and reprogram, or to
generate a programming file that has no security key.

Custom Security Levels
For advanced use, you can customize your security levels.

To set custom security levels:

1. Click the Custom Level button in the Security Settings page. The Custom Security Level dialog
box appears.

2. Select the FPGA Array Security and the FlashROM Security levels. For SmartFusion and Fusion
devices, you can also choose the Embedded Flash Memory Block level of security. The FPGA Array
and the FlashROM can have different Security Settings. See the tables below for a description of the
custom security option levels for FPGA Array and FlashROM.
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Table 16 - FPGA Array

Security Option Description

Lock for both writing and verifying Allows
_ Set Security Settings writing/erasing
Device Feature Security Encrypt T | Verify | Write and verification
of the FPGA
FPGA Array W r E E Array via the
JTAG interface
only with a
valid Pass
Key.

Lock for writing Allows the
St Security Seftings writing/erasing

Device Feature . 1E t
security| "Y' TR 5 T Verity | wiite | | Of e FPGA

Array only with
FPGA Arrzy ¥ r =] 5 y onty Wi

a valid Pass
Key.
Verification is
allowed
without a valid
Pass Key.

Use the AES Key for both writing and verifying Allows the
: set Security Settings writing/erasing
Device Feature Security Encrypt y— | Verily | Write and verification
— — of the FPGA
FPGA Array | v | V¥ | Array only with
a valid AES
Key via the
JTAG
interface. This
configures the
device to
accept an
encrypted
bitstream for
reprogramming
and verification
of the FPGA
Array. Use this
option if you
intend to
complete final
programming
at an
unsecured site
or if you plan
to update the
design at a
remote site in
the future.
Accessing the
device security
settings
requires a valid
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Security Option Description

Pass Key.

Allow write and verify Allows
. Set Security Settings writing/erasing
Device Feature it Encrypt Road | Verity | Wirite and verification
of the FPGA
FPGA Array | r & Array with
plain text
bitstream and
without
requiring a
Pass Key or an
AES Key. Use
this option
when you
develop your
product in-
house.

Note: The ProASIC3 family FPGA Array is always read protected regardless of the Pass Key or the AES
Key protection.

Table 17 - FlashROM

Security Option Description

Lock for both reading and writing Allows the
: set Security Settings writing/erasing and
Device Feature Security Encrypt —- | Verify | = reading of thg
FlashROM via the
FlashROM T r i 7| (] 8 | JTAG interface
only with a valid
Pass Key.
Verification is
allowed without a
valid Pass Key.

Lock for writing Allows the
2 : writing/erasing of

Device Feature Seiﬁtritl_.r Encrypt hossulll ) ,‘j:'.ettlngs - the FI?';IShROI\% via

Read | Verify | wirite the JTAG interface
FlashROM I r (] (] a7 only with a valid
Pass Key. Reading
and verification is
allowed without a
valid Pass Key.

Use the AES Key for both writing and verifying Allows the

: : writing/erasing and
Device Feature Seiitriw Encrypt = il settmgs - verification of the

ead | Verify | Write .
— FlashROM via the

FlashROM W [ E JTAG interface
only with a valid
AES Key. This
configures the
device to accept
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Custom Security Levels

Security Option Description

an encrypted
bitstream for
reprogramming
and verification of
the FlashROM.
Use this option if
you complete final
programming at an
unsecured site or if
you plan to update
the design at a
remote site in the
future.

Note: The
bitstream that is
read back from the
FlashROM is
always
unencrypted (plain
text).

Allow reading, writing, and verifying Allows
; Set Security Settings writing/erasing,
Device Feature St Encrypt e | Verity | P rea.d.ing.and
verification of the
Jos il | i FlashROM content
with a plain text
bitstream and
without requiring a
valid Pass Key or
an AES Key.

Note: The FPGA Array can always read the FlashROM content regardless of these Security Settings.
Table 18 - Embedded Flash Memory Block

Security Option Description

Lock for reading, verifying, and writing Allows the writing
Set | Security Settings | | and reading of the

Device Feature . | Encrypt
Security | Read | 'lurerif!lrl Write | Embedded Flash

Memory Block via
firmwareUNVM_INST (# 1) 3 r R A A the JTAVG interface

only with a valid
Pass Key.
Verification
accomplished by
reading back and

compare.
Lock for writing Allows the writing
: Set Security Settings of the Embedded
Device Feature .| Encrypt
Security Read | Verify | Write || \ash Memory
Block via the JTAG

firmwareUNVM_INST (# 1) M r [l (] 7 interface only with
a valid Pass Key.
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Security Option Description

Reading and
verification is
allowed without a
valid Pass Key.

Use AES Key for writing Allows the writing

Device Feature Set it Security Settings of the Embedded
Read | Verify | Write Flash Memory

Security
firmwareUNVM_INST (# 1) ¥ |L A e = :?]Igfa\é? ;?]?yJVIQ]G
a valid AES Key.
This configures the
device to accept
an encrypted
bitstream for
reprogramming of
the Embedded
Flash Block. Use
this option if you
complete final
programming at an
unsecured site or if
you plan to update
the design at a
remote site in the
future. The
bitstream that is
read back from the
Embedded Flash
Memory Block is
always
unencrypted (plain
text), when a valid
pass key is
provided.

Allow reading, writing, and verifying Allows writing,
2 Set Security Settings reading and
Device Feature .. | Encrypt e
Security| " '"'| Read | Verify | Write ‘ée“:)'cggog ‘I):fl thﬁ
firmwareUNVM_INST (2 1) [ Ji Mzmiryzloc ES
content with a
plain text bitstream
and without
requiring a valid
Pass Key or an
AES Key.

3. To make the Security Settings permanent, select Permanently lock the security settings check box.
This option prevents any future modifications of the Security Setting of the device. A Pass Key is not
required if you use this option.

Note: When you make the Security Settings permanent, you can never reprogram the Silicon Signature. If you
Lock the write operation for the FPGA Array or the FlashROM, you can never reprogram the FPGA Array or the
FlashROM, respectively. If you use an AES key, this key cannot be changed once you permanently lock the
device.
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Custom Security Levels

4. (SmartFusion Only) Enable M3 Debugger option enables access to the M3 debugger even if security is
enforced. Select the Enable M3 debugger checkbox if you want to access the M3 debugger after
programming.

5. To use the Permanent FlashLock™ feature (One-time programmable or OTP), select Lock for both
writing and verifying for FPGA Array, Lock for both reading and writing for FlashROM, Lock for
reading, writing, and verifying each Embedded Flash Memory Block (for Fusion and SmartFusion),
if present, and select the Permanently lock the security settings checkbox as shown in the figure
below. This will make your device one-time programmable.

' " " -
Custom Security Level [ﬁ

Silicon Feature se.sc:ﬂy Encrypt Msm"'v;ﬂs;’“'"fme
FPGA Aray [l i 7 i 7
HashROM ] i (il i
eNVM (# 0) [ ﬁ ﬁ ﬁ
eNVM (& 1) ] IR i 1

[ Enable M3 debugger
Permanently lock the security settings.

6 The following silicon features will not be reprogrammable:
- Security settings, AES key, and silicon signature

-FPGA Array

- FlashROM

- eNVM (£10)

-eNVM (& 1)

[ OK ] [ Cancel

Figure 140 - Custom Security Level

6. Click the OK button. The Security Settings page appears with the Custom security settings
information as shown in the figure below.
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Security Settings - Step 2 of 2 E|

Security level For this device:

Custom security setkings

Pass Key (max length is 32 HEX chars):

Security settings For FPGA Array:
- Use AES key to write or verify the FPGA Array,

Security settings for FlashROM;
- Use AES key to write the FlashROM wia the JTaG interface.

Custarn Lewvel, .. | Default Lewvel |

| DE67BOFI6ASDTESAE 1 7EED4ALIER 116G Generate random key |

BES Key (max length is 32 HEX chars):

| GA7EESEERCCBOATF4T7E007EZF7DO7FE Generate randam key

Help Back Finish Cancel

Figure 141 - Security Settings

Reprogramming a Secured Device

You must know the previous Security Settings of the device before you can reprogram a device with
Security Settings.

Programming a Secured SmartFusion Device
After you create a PDB you may wish to export a programming file for a secured device. To do so:

1.
2.

Create a PDB file (as explained above) with security set to High or Medium. Save the PDB file.

From the File menu, choose Export Single Programming File. The Export Programming Files dialog
box appears.

Click the Export programming file(s) for currently secured device checkbox. This exports
programming files for devices that already have security settings programmed.

Choose your outputs and enter your output file Name and Location.

Click Export to create the file(s). Your updated secured programming files are in the directory you
specified.

Custom Serialization Data for FlashROM Region

FlashPoint enables you to specify a custom serialization file as a source to provide content for programming
into a Read from file FlashROM region. You can use this feature for serializing the target device with a
custom serialization scheme.

To specify a FlashROM region:

1.

From the Properties section in the FlashROM Settings page, select the file name of the custom
serialization file (see figure below). For more information on custom serialization files, see Custom
Serialization Data File Format.
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Custom Serialization Data File Format

Tl 0N setngs - Sep 21 2 =)

Figure 142 - FlashROM Settings

Custom Serialization Data File Format

Semantics

FlashPoint supports custom serialization data files that specify the data in binary, HEX, decimal, or ASCII

text. The custom serialization data files may contain multiple data with the Line Feed (LF) character as the
delimiter. You can create a file by entering serialization data into any type of text editor. Depending on the
serialization data format (hex, ASCII, binary, decimal), input the serialization data according to the size of

the region you specified in the FlashROM settings page.

Each custom serialization file has only one type of data format (binary, decimal, Hex or ASCII text). For
example, if a file contains two different data formats (i.e. binary and decimal) it is considered an invalid file.

The length of each data file must be shorter or equal to the selected region length. If the data is shorter then
the selected region length, the most significant bits shall be padded with 0’s. If the specified region length is
longer then the selected region length, it is considered an invalid file.

The digit / character length is as follows:

-Binary digit: 1 bit

-Decimal digit: 4 bits

-Hex digit: 4 bits

-ASCI1 Character: 8 bits

Note: Note the standard example below:

If you wanted to use, for example, device serialization for three devices with serialization data 123, 321, and
456, you would create file name from_read.txt. Each line in from_read.txt corresponds to the serialization
data that will be programmed on each device. For example, the first line corresponds to the first device to be
programmed, the second line corresponds to the second device to be programmed, and so on.

Hex serialization data file example

The following example is a Hex serialization data file for a 40-bit region. Enter the serialization data below
into file created by any text editor:

123AEd210
AeB1
0001242E

Note: If you enter an invalid Hex digit such as 235SedF1, an error occurs. An error will also occur if you
enter data that is out of range, i.e. 4300124EFE.

The following is an example of programming "AeB1" into Region_7_1 located on page 7, from Word 5 to
Word 1 in the FlashROM settings page. See Custom serialization data for FlashROM region for more
information.

Table 15 | ... Word 5 | Word 4 | Word 3 | Word 2 | Word 1 | Word O

Page 7

00 00 00 AE Bl
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Binary serialization data file example

The following example is a binary serialization data file for a 16-bit region:
1100110011010001

100110011010011

11001100110101111 (This is an error: data out of range)
1001100110110111

1001100110110112 (This is an error: invalid binary digit)

Decimal serialization data file example

The following example is a decimal serialization data file for a 16-bit region:
65534

65535

65536 (This is an error: data out of range)

6553A (This is an error: invalid decimal digit)

Text serialization data file example

The following example is a text serialization data file for a 32-bit region:
AESB

A e

ASE3 23 (This is an error: data out of range)

65A~

1234

AEbF

Syntax
Indentations in the syntax below indicate a wrapped line. If a line wraps and is not indented, then it should
appear on one line; you may need to expand your help window to view the syntax correctly.
Custom serialization data file =
<hex region data list> | <decimal region data list> |
<binary region data list> | <ascii text data list>
Hex region data list = <hex data> <new line> { < hex data> <new line> }
Decimal region data list = <decimal data> <new line> {<decimal data><new line> }
Binary region data list = <binary data> <new line> { <binary data> <new line> }
ASCII text region data list = < ascii text data> <new line> { < ascii text data> <new
line> }
hex data = <hex digit> {<hex digit>}
decimal data = < decimal digit> {< decimal digit>}
binary data = < binary digit> {< binary digit>}
ASCIl text data = <ascii character> {< ascii character >}
new line = LF
binary digit = “0”]“1”
decimal digit = “07|“1”]“27|“3”|“4”|“57|“6”|“7*|“8"] “9~
hex digit = <07 <17 <27 <37 <4 |57 |67 |77 1“8 <97 | “A"|“B*|“C”|“D" | “E’| “F" |
ca’] *b” | <c’| <d” | “e’| “F
ascii character = characters from SP(0x20) to“~”(OX7E).

File Format Limitations

The read from file data size cannot exceed the size of the region. The maximum size supported for each
format is described below:

HEX - limited to the size of the FlashROM page. Maximum size of 128-bits

120 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. C . .
> Microsemi.

Specifying I/O States During Programming

DEC - 32-bit unsigned numbers. Maximum decimal value is: 4294967295
BIN - limited to the size of the FlashROM page. Maximum size of 128-bits
TEXT - limited to the size of the FlashROM page. Maximum size of 128-bits

Specifying 1/0O States During Programming

You can modify the 1/O states during programming in FlashPro. In FlashPro, this feature is supported for
PDB files generated from Designer v8.5 or greater.

Note: PDB files generated from Designer v8.1 to Designer v8.4 (including all service packs) have limited
display of Pin Numbers only.

1. Load a PDB from the FlashPro GUI. You must have a PDB loaded to modify the 1/O states during
programming.

2. From the FlashPro GUI, click PDB Configuration. The FlashPoint — Programming File Generator
window appears.

3. Click Specify I/0 States During Programming to display the Specify I/0O States During Programming
dialog box.

4. Sort the pins as desired by clicking any of the column headers to sort the entries by that header.
Select the I/Os you wish to modify (as shown in the figure below).

5. Set the I/O Output State. You can set Basic 1/O settings if you want to use the default I/0O settings for
your pins, or use Custom /O settings to customize the settings for each pin. See Specifying I/0 States
During Programming - I/O States and BSR Details for more information about setting your I/O state
and the corresponding pin values. Basic 1/O state settings are:

e 1-1/0 is set to drive out logic High
e 0-1/Ois set to drive out logic Low

e Last Known State: I/O is set to the last value that was driven out prior to entering the programming mode, and

then held at that value during programming

e 7 - Tri-State: I/O is tristated

Specify I/0 States During Programming
Load from file. .. | Save ko file... | [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTBUF ES a
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS 33D ciz z
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 143 - 1/O States During Programming Window
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6. Click OK to return to the FlashPoint — Programming File Generator window.

Note: I/O States During Programming are saved to the ADB and resulting programming files after
completing programming file generation.

Custom 1/O Settings and Boundary Scan Registers

Each 1/O in your device is comprised of an Input, Output and Output Enable Boundary Scan Register (BSR)
cell..

The BSR cells enable you to define 1/O states during programming and control the individual states for each
Input, Output, and Output Enable register.

The Specify I/O States During Programming dialog box enables access to each of these BSR cells for
control over the individual states. You can use the 1/0 State (Output Only) settings to set a specific output
state and ignore the other values for the individual BSR elements, or you can click the Show BSR Details
checkbox for control over the settings for each Input, Output Enable, and Output as you exit programming.

Specifying 1/0 States During Programming - I/O States and BSR
Details

The I/O States During Programming dialog box enables you to set custom I/O states prior to programming.

I/O State (Output Only)
Sets your I/O states during programming to one of the values shown in the list below.
e 1 —1/Os are set to drive out logic High
e 0-1/Os are set to drive out logic Low

e Last Known State: I/Os are set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e 7 - Tri-State: I/Os are tristated

When you set your 1/O state, the Boundary Scan Register cells are set according to the table below. Use the
Show BSR Details option to set custom states for each cell.

Table 19 - Default I/O Output Settings

Output State Settings
Input Control (Output Output
Enable)
Z (Tri-State) 1 0 0
0 (Low) 1 1 0
1 (High) 0 1 1
Last_Known_State | Last_Known_State | Last_Known_State Last_Known_State
Table Key:

e 1 — High: I/Os are set to drive out logic High
e 0-—Low: I/Os are set to drive out logic Low

e Last Known_State - I/Os are set to the last value that was driven out prior to entering the
programming mode, and then held at that value during programming
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Boundary Scan Registers - Enabled with Show BSR Details

Sets your I/O state to a specific output value during programming AND enables you to customize the values
for the Boundary Scan Register (Input, Output Enable, and Output). You can change any Don't Care value in
Boundary Scan Register States without changing the Output State of the pin (as shown in the table below).
For example, if you want to Tri-State a pin during programming, set Output Enable to 0; the Don't Care
indicates that the other two values are immaterial.

If you want a pin to drive a logic High and have a logic 1 stored in the Input Boundary scan cell during
programming, you may set all the values to 1.

Table 20 - BSR Details 1/0 Output Settings

Output State Settings
Input Output Enable Output
Z (Tri-State) Don't Care 0 Don't Care
0 (Low) Don't Care 1 0
1 (High) Don't Care 1 1
Last Known State Last State Last State Last State

Table Key:
e 1 —High: I/Os are set to drive out logic High
e 0-—Low: I/Os are set to drive out logic Low
e Don't Care — Don'’t Care values have no impact on the other settings.

e Last Known_State — Sampled value: I/Os are set to the last value that was driven out prior to entering
the programming mode, and then held at that value during programming

The figure below shows an example of Boundary Scan Register settings.

Specify I/0 States During Programming
Load from file. .. | Save ko file... | ¥ show BSR. Details

_ Boundary Scan Registers -

Port HName Macro Cell Pin Number Input %l:.lapl;‘::g Dutput j
BIST ADLIB:INBUF T2 a 1 1
BvPASS_I0 ADLIB:INBUF K1 a 1 1
CLK ADLIB:INBUF B1 a 1 1
ENOUT ADLIB:INBUF J16 a 1 1
LED ADLIB:OUTBUF M3 1 1 a
MONITOR[O] ADLIB:OUTBUF ES 1 1 a
MOMITOR[] ADLIB:OUTBUF c7 1 a a
MOMITOR[Z] ADLIB:OUTBUF k] 1 a a
MONITOR[3] ADLIB:OUTBUF D7 1 a a
MONITOR[4] ADLIB:OUTBUF A1 1 a a
OEa ADLIB:INBUF E4 1 a a
OEb ADLIB:INBUF F1 1 a a
O5C_EN ADLIB:INBUF K3 1 a a
PAD[10] ADLIB:BIBUF_LYCMOS33U ME 1 a a
FPAD[11] ADLIB:BIBUF_LVCMOS 33D R7 1 1] 1]
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 1 a a
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 1 a a

PAD[14] ADLIB:BIBUF_LYCMOS33U RE 1 a a LI

Help | OF I Cancel |

Figure 144 - Boundary Scan Registers
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Specify 1/0 States During Programming Dialog Box

The 1/O States During Programming dialog box enables you to specify custom settings for 1/Os in your
programming file. This is useful if you want to set an 1/O to drive out specific logic, or if you want to use a
custom 1/O state to manage settings for each Input, Output Enable, and Output associated with an 1/O.

Load from file

Load from file enables you to load an I/O Settings (*.ios) file. You can use the 10S file to import saved
custom settings for all your I/Os. The exported |I0OS file have the following format:

e Used I/Os have an entry in the 10S file with the following format:

set_prog_io_state -portName {<design_port_name>} -input <value> -outputEnable <value> -
output <value>

e Unused I/Os have an entry in the IOS file with the following format:

set_prog_io_state -pinNumber {<device_pinNumber>} -input <value> -outputEnable <value> -
output <value>

Where <value> is:
e 1-1/Ois set to drive out logic High
e 0-1/0Ois set to drive out logic Low

e Last Known_State: I/O is set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e 7 - Tri-State: I/O is tristated

Save to file

Saves your I/O Settings File (*.ios) for future use. This is useful if you set custom states for your 1/Os and
want to use them again later in conjunction with a PDC file.

Port Name
Lists the names of all the ports in your design.

Macro Cell
Lists the 1/O type, such as INBUF, OUTBUF, PLLs, etc.

Pin Number
The package pin associate with the 1/0.

I/O State (Output Only)

Your custom I/O State set during programming. This heading changes to Boundary Scan Register if you
select the BSR Details checkbox; see the Specifying I/O States During Programming - I/O States and BSR
Details help topic for more information on the BSR Details option.
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Generate a DAT file

Specify I/0 States During Programming
Load from file. .. Save ko file... [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTBUF ES a
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 145 - 1/O States During Programming Dialog Box

Generate a DAT file

DAT files are generated via the Generate Programming Files dialog box.
To access the Generate Programming Files dialog box from Libero SoC and generate a DAT file:

1.

2.
3.

In the Design Flow window, expand Implement Design, right-click Generate Programming Data and
choose Open Interactively. This opens Designer.

Click Programming File to start FlashPoint.

Set your feature and 1/O options if necessary. Click Finish. This opens the Generate Programming File
dialog box, as shown in the figure below.

Generate Programming Files @

Mame: Existing programming Files in this location:
| DAT_progl| | sD1.pdb
S01.skp
Location:

| Ci\Documents and SettingstfarleyciDeskkophactel_projy |

Browse. ..

Qutput Formats:

[C]IEEE 1532 Files (*.bsd; *.isc)
[#]DirectC File {*.dat)
[¥#]Pragramming Data File (*,pdb)
[]STARL File (* stp)

[C]5erial Yector Files (*.svF)

L ]
I

[ Generate ] [ Cancel ]

Figure 146 - Generate Programing Files Dialog Box - DirectC File (*.dat)
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4. Set your output file Name and Location.
5. Set your Output Formats to DirectC file (*.dat) and Programming Data File (*.pdb).
6. Click Generate to create your file.

Parallel Port Cable Information
The FlashPro software supports the generic Parallel Port Cable.

To connect to the Parallel Port Cable:

1. From the Parallel Port Cable text box, select the Parallel Port Buffer Cable (as shown in the figure
below).

2. Select the parallel port that is connected to the cable from the Parallel Port text box.

Connect Parallel Port Cable f5_(|

Parallel port cable: |20 = N atara 10§ = e o 2

Parallel port: LPT1 ﬂ

[¥ Drive TRST pin

Help nls | Cancel

Figure 147 - Connect Parallel Port Cable

3. Click OK.
The Para2Buff programmer is added to the programmer list.
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Importing Configuration Files

Importing and Exporting Files

Importing Configuration Files

To import a configuration file:

1. From the File menu, choose Import Configuration File . The Import Configuration File dialog box
appears.

2. Navigate to your file and click Open.

Exporting Configuration Files

To export a configuration file:

1. From the File menu, choose Export and then choose Export Configuration File. The Export
Configuration File dialog box appears.

2. Navigate to your file and click Save.

Export Programming Files (SmartFusion Only)

Export Programming Files enables you to export DirectC DAT, PDB and STP programming files. Exporting
programming files is supported in both Chain and Single mode; to export programming files in Chain mode
you must select one SmartFusion device in your chain.

To export a programming file:
1. From the FlashPro File menu choose Export > Single Programming File. The Export Programming
Files dialog box appears.
2. Specify the Output format, Name and Location and click Export to create the files.
Export programming files for currently secured device enables you to generate PDB files for devices
that have already been programmed with security settings. It generates encrypted data for encrypted
features.

Target Programming Solution and STAPL file type options are available only if you have serialization.

Target Programming Solution

e Select Microsemi IHP (In House Programming) when generating STAPL or SVF files for Microsemi
IHP.

e Select Silicon Sculptor Il, BP Auto Programmer, or FlashPro5/4/3 when generating programming files
for those programmers.

e Select Generic STAPL Player when generating STAPL files for generic STAPL players.
STAPL File Type Options

e Single STAPL file for all devices: Generates one programming file with all the generated increment
values or with values in the custom serialization file.

e One STAPL file per device: Generates one programming file for each generated increment value or
for each value in the custom serialization file.
Limit file size
Some testers may have memory size restrictions for a single SVF file. The SVF limit file option enables you
to limit the size of each SVF file by either file size or vectors.
The generated SVF files append an index to the file name indicating the sequence of files. The format is:
<SVF_filename>_XXXXX.svf
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where XXXXX is the index of the SVF file. The first SVF file begins with <SVF_filename>_00000.svf and
increments by 1 until file generation is complete.

Maximum file size: Max file size limit for the SVF file; use this option to limit your SVF file size based on
number of kB.

Maximum number of vectors: Max vector limit for the SVF file; use this option to limit the size of your SVF
based on number of vectors.

When serialization is available, choose the appropriate Target Programming Solution and STAPL File Type
(if necessary) for your programming chain.

Export Programming Files F§|

Loaded PDE file: D:templ TOR. pdb
i 1
o Cubput Formats: Mame:
[WIIEEE 1532 Files (* bsd; *.isc) /oy | TOR
[WiDirectC File (*.dat)
[JPrograrmming Data File (%, pdb) Location:

[W[STAPL File (*,stp) | Diitemp
[w]3etial Yector Files (*.svf)

Browse, .,

o Existing prograrnming files in this location:
Wor o |
i
~
~
[V Limit file size
& Maximum fils size | 2000] KB
" Maximum number of vectors ’7

Help Export | Close

Figure 148 - Export Programming Files Dialog Box

Exporting a Chain STAPL File

To export a chain STAPL file:

1. From the File menu, select Export and then choose Export Chain STAPL File. The Export Chain
STAPL File dialog box appears.

2. Name your file and click Save.

Note: Chain STAPL file export is supported if all selected SmartFusion, IGLOO, ProASIC3 and Fusion
devices have STAPL or PDB files loaded.

Exporting a Chain SVF File

To export a chain SVF file:

1. From the File menu, choose Export and then choose Export Chain SVF File. The Export Chain SVF
File dialog box appears.

2. Name your file and click Save.
Note: Chain SVF file export is supported if all selected devices have STAPL or PDB files loaded.
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Exporting Single Device STAPL Files

Exporting Single Device STAPL Files

To export a single STAPL file in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, choose Export > Export Single Device STAPL File. The Export Single Device
STAPL File dialog box appears.

2. Name your file and click Save.

To export a single device STAPL file in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to Chain
programming tutorial for more information). Exporting a single device STAPL file is only supported for one
device in the chain.

1. Select only one device from the chain, and from the File menu, select Export and then choose Export
Single Device STAPL File. The Export Single Device STAPL File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device
STAPL File. The Export Single Device STAPL File dialog box appears.

2. Name your file and click Save.

Exporting Single Device SVF Files
The following steps describe how to export SVF files.

To export single device SVF files in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, select Export and then choose Export Single Device SVF File. The Export
Single Device SVF File dialog box appears.

2. Name your file and click Save.

Note: Multiple SVF files will be generated from a single PDB. Each file corresponds to a PDB action, and
will be saved in the <SVF_filename> folder as <SVF_filename>_<action name>.SVF.
To export single device SVF files in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to _Chain
programming tutorial for more information).

1. Select only one device from the chain, and from the File menu, choose Export and then choose
Export Single Device SVF File. The Export Single Device SVF File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device SVF
File. The Export Single Device SVF File dialog box appears.

2. Name your file and click Save.

Note: Multiple SVF files will be generated from a single PDB. Each file corresponds to a PDB action, and
will be saved in the <SVF_filename> folder as <SVF_filename>_<action hame>.SVF.

Exporting Single Device 1532 Files

IEEE 1532 programming files will only be exported in FlashPro for SmartFusion devices when an FDB has
been properly imported.
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To export single device 1532 files in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, choose Export Single Device 1532 File. The Export Single Device 1532 File
dialog box appears.

2. Name your file and click Save.

Note: Two files will be generated from a single PDB and will be saved in the <1532_filename>_1532
folder as

Note: IEEE 1532 BSDL file - <1532_filename>.bsd
Note: IEEE 1532 Data file - <1532_filename>.isc

To export single device 1532 files in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to Chain
programming tutorial for more information). Exporting a single device STAPL file is only supported for one
device in the chain.

1. Select only one device from the chain, and from the File menu, choose Export and then choose
Export Single Device 1532 File. The Export Single Device 1532 File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device 1532
File. The Export Single Device 1532 File dialog box appears.

2. Name your file and click Save.
Note: Two files will be generated from a single PDB and will be saved in the <1532_filename>_1532
folder as
Note: IEEE 1532 BSDL file - <1532_filename>.bsd
Note: IEEE 1532 Data file - <1532_filename>.isc

Opening an Existing FlashPro Project on a Different Machine

Opening a FlashPro project created on a different PC than it was created on causes tool problems. The
project cannot be opened and the PDB file cannot be imported. You must export the configuration file from
the original machine and import it on the new machine in order to preserve your project.

To move a FlashPro project and open it on a different machine:

1. Export configuration files on the machine where you created the original project. The configuration
files contain all FlashPro settings, including loaded programming files.

2. Send the configuration files to the new desktop
3. Open FlashPro on the new desktop and create a new FlashPro project.
4. |mport the configuration file.
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General Hot Keys

Using Hot Keys

General Hot Keys

You can use hot keys for a lot of the features of the FlashPro software. See the table below for a list of

general hot keys.

Table 21 - FlashPro Software General Hot Keys

Feature Hot Key
New Project Ctrl+N
Open Project Ctrl+O
Save Project Ctrl+S
Import Configuration File Ctrl+l
Refresh Views F5
Refresh/Rescan for Programmers Ctrl+F5

See Also
Single STAPL programming hot keys

Chain programming hot keys

Single Device Programming Hot Keys

See the table below for the hot keys for single device programming.

Table 22 - Single Device Programming Hot Keys

Feature Hot Key
Load a STAPL file Ctrl + Shift + L
Select Action and Procedures Ctrl + Shift + A
Enable Serialization Ctrl + Shift + S
Select Serialization Data Ctrl + Shift + R
View Serialization Status Ctrl + Shift + U
View Chain Parameter (Pre/Post IR/DR) Ctrl + Shift + H
Configure Target Device Ctrl + Shift + D

Run

Ctrl + Return
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Chain Programming Hot Keys

See the table below for the hot keys for chain programming.
Table 23 - Chain Programming Hot Keys

Feature Hot Key

Add Microsemi Device Ctrl + Shift + T
Add non Microsemi Device Ctrl + Shift + N
Remove Device Ctrl + R
Configure Device Ctrl + F

Load STAPL File Ctrl + Shift + L
Load BSDL File Ctrl + Shift + B
Enable Device Ctrl + E

Select Action and Procedures Ctrl + Shift + A
Enable Serialization Ctrl + Shift+ S
Select Serialization Data Ctrl + Shift + R
View Serialization Data Ctrl + Shift +u
Copy Device Ctrl + Shift + C
Cut Device Ctrl + Shift + X
Paste Device Ctrl + Shift + V
Move Device Down Ctrl + D

Move Device Up Ctrl+ U

Run Ctrl + Return

Batch Mode

Batch mode programming can be achieved by executing FlashPro TCL scripts from the command line.

The example below executes The FlashPro TCL script batch.tcl from the command line:

<location of Microsemi software>/bin/flashpro.exe script:batch.tcl

Batch.tcl contains the following script:

new_project -name {newproject} -location {./newproject} -mode {single}
set_programming_file -file {./design.stp}

set_programming_action -action {PROGRAM}

run_selected_actions

close_project
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About TCL Commands - FlashPro Tcl Command Reference

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from
the Windows command line or store and run a series of Tcl commands in a *.tcl batch file. The Tcl
commands supported by FlashPro are listed in the table below.

Note: Tcl commands are case sensitive. However, their arguments are not.

Command Action
add_actel_device Adds an Actel device to the chain
add_non_actel device Adds a non-Actel device in the chain
add_non_actel device to_database Imports settings via a BSDL file that adds

non-Actel or non-Microsemi devices to the
device database

check_flash_memory Performs diagnostics of the page status and
data information

close_project Closes the FlashPro project
compare_analog_config Compares the content of the analog block

configurations in your design against the
actual values in the device

compare_flashrom_client Compares the content of the FlashROM
configurations in your design against the
actual values in the selected device

compare_memory_client Compares the memory client in a specific
device and block

configure_flashpro_prg Changes FlashPro programmer settings
configure_flashpro3 prg Changes FlashPro 3 programmer settings
configure_flashpro4 prg Changes FlashPro 4 programmer settings
configure_flashpro5 prg Changes FlashPro 5 programmer settings
configure_flashprolLite prg Changes FlashPro Lite programmer settings
connect_cable Connects a parallel cable to a port
construct_chain_automatically Automatically starts chain construction for the

specified programmer

copy_device Copies a device in the chain to the clipboard

cut_device Removes one or more devices from the chain

dump_tcl_support Unloads the list of supported FlashPro Tcl
commands

enable_device Enables or disables a device in the chain

enable prg Enables or disables one or more

FlashPro User's Guide 133



& Microsemi

NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

Command

Action

programmers

enable_prg_type

Enables or disables all programmers of a
specified programmer type

enable_procedure

Enables/disables an optional procedure for an
action

enable_serialization

Enables/disables serialization for a device

export_config

Exports a configuration file

export_script

Exports the history in a Tcl script

export_secured pdb

Exports a single device secured PDB from
the loaded PDB

export_single 1532

Exports a single device 1532 file

export_single_dat

Exports a single device DirectC data file

export_single_stapl

Exports a single device STAPL file

export_single_svf

Exports a single device SVF file

export_stapl Exports the ChainBuilder STAPL file in chain
programming mode

import_config Imports a configuration file

new_project Creates a new FlashPro project or convert an
old ChainBuilder project into a new FlashPro
project

open_project Opens a FlashPro project

paste_device

Pastes the devices that are on the clipboard
in the chain

ing_pr

Pings one or more programmers

read_analog_block_config

Reads analog block configuration information

read device status

Compares the memory client in a specific
device and block

read flash_memory

Reads information from the eNVM modules

read_flashrom

Reads the content of the FlashROM

read id code

Reads IDCode from the device without
masking any IDCode fields

recover_flash_memory

Removes ECC2 errors due to memory
corruption by reprogramming specified flash
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Command

Action

memory (NVM) pages

refresh_prg_list

Refreshes the programmer list

remove_device

Removes the device from the chain

remove non_actel device to database

Removes settings for non-Microsemi or non-
Actel device from the device database

remove_pr

Removes the programmer from the
programmer list

run_selected actions

Runs the selected action on the specified
programmer and returns the exit code from
the action

sample _analog channel

Samples the configured analog channel with
the ADC parameters you provided

save_log

Saves the log file

save_project

Saves the FlashPro project

save_project_as

Saves the FlashPro project under a new
project name

scan_chain_prg

Runs scan chain on a programmer

select from_region_name

Enables you to select the serialization region
you want to add to the log file

select_libero design_device

Selects the Libero design device to resolve
when there are two or more identical Libero
design devices in the configured JTAG chain.
This TCL command is for Libero usage only.

select serial range

Selects the serialization data

select target device

Sets the target device for programming in
Single Device Programming mode

self_test prg Runs Self-Test on a programmer
set_bsdl_file Sets a BSDL file to a non-Actel device in the

chain

set_chain_param

Sets the chain parameters in single
programming mode

set_debug device

Identifies the device you intend to debug

set_debug programmer

Identifies the programmer you want to use for
debugging (if you have more than one)

set_device to_highz

Sets a disabled Microsemi or Actel device in
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Command

Action

Chain programming mode to HIGH-Z

set_device ir

Sets the IR length of a non-Actel device in the
chain

set_device_name

Changes the user name of a device in the
chain

set_device order

Sets the order of the devices in the chain to
the order specified

set_device tck

Sets the maximum TCK frequency of a non-
Actel device in the chain

set_device_type

Changes the family of an Actel device in the
chain

set_main_log_file

Sets the FlashPro log file

set_prg_name

Changes the user name of a programmer

set_programming_action

Selects the action for a device

set_programming_file

Sets the programming file for a device

set_programming_mode

Sets the programming mode

set_serialization log_file

Sets the log file to be used for serialization

set_serialization_mode

Sets the serialization mode

update programming_file

Updates the programming file with the
selected parameters

Running Tcl Scripts from within FlashPro

Instead of running scripts from the command line, you can use FlashPro's Run Script dialog box to run a

script.

To execute a Tcl script file within FlashPro:
1. From the File menu, choose Run Script to display the Execute Script dialog box.
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Running Tcl Scripts from the Command Line

Execute Script §|

Script File: ||

Browse

Argurnents: |

Run Cancel | Help |

Figure 149 - Execute Script Dialog Box

2. Click Browse to display the Open dialog box, in which you can navigate to the folder containing the
script file to open. When you click Open, FlashPro enters the full path and script filename into the
Execute Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a
space character. For information about accessing arguments passed to a Tcl script, see

4, Click Run.

Running Tcl Scripts from the Command Line
You can run Tcl scripts from your Windows command line.

To execute a Tcl script file in the FlashPro software from a shell command line:
1. Atthe prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon,
and then the name of the script file as follows:
<location of Microsemi software>/bin/flashpro.exe SCRIPT:<filename>
The example below executes in batch mode the script foo.tcl:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl
The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl logfile:foo.txt
The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:

<location of Microsemi software>/bin/flashpro.exe script:foo.tcl console_mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide' FlashPro executes without a console window. If
you want to leave the console window open you can run the script with the console_mode parameter set
to 'show’, as in the following example:

<location of Microsemi software>/bin/flashpro.exe script:foo.tcl console_mode:show
logfile:foo.txt

2. If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/flashpro.exe SCRIPT:<filename> SCRIPT_ARGS:"paraml
param2 param3'

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:
puts "Script name: $argv0"
puts “Number of arguments: $argc"
set i 0
foreach arg $argv {
puts "Arg $i : $arg"”
incr i
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Note: Script names can contain spaces if the script name is protected with double quotes:
flashpro.exe script:"flashpro tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro

To export a set of Tcl commands from the FlashPro history:
1. From the File menu, choose Export > Export Script.
2. Enter the filename and click Save. The Script Export Options dialog is appears (see image below).

Script Export Options

[ dnclude commands friam current project anb

Filenarme farmatting

* Relative filenames [default)

" Qualified flenarmes [full path; inchding directan nanme)]

Help k. | Cancel

Figure 150 - Script Export Options Dialog Box

Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames(absolute path, including the directory name).

4. Click OK.

add_actel _device

Adds an Actel device to the chain. Either the file or device parameter must be specified. Chain
programming mode must have been set.

add_actel_device [-File {filename}] [-device {device}] -name {name} [-ukey {ukey value}]

Arguments
Where:
-file{filename}
Specifies a programming filename.
-device{device}
Specifies the Actel device family(such as AFS600).
-name{name}
Specifies the device user name.
-ukey{ukey value}
Optional (SmartFusion only) - Specifies the ukey value.
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add_non_actel_device

Supported Families
Al

Exceptions
None

Example
add_actel_device —file {e:/design/stp/TOP.stp} —name {MyDevicel}
add_actel_device —device {A3P250} —name {MyDevice2}

add_non_actel device

Adds a non-Actel device in the chain. Either the file, or (-tck And -ir) parameters must be specified. The Chain

programming mode must have been set.

add_non_actel_device [-File {file}] [-ir {ir}] [-tck {tck}] [-name {name}]

Arguments
-file {filename}
Specifies a BSDL file.
-ir {ir}
Specifies the IR length.
-tck {tck}
Specifies the maximum TCK frequency (in MHz).

-name {name}

Specifies the device user name.

Supported Families
All

Exceptions

None

Examples
add_non_actel_device —file {e:/design/bsdl/DeviceX.bsdl } —name {MyDevice3}
add_non_actel_device —ir 8 — tck 5 —name {MyDevice4}

add_non_actel device to_database

Imports settings via a BSDL file that adds non-Actel or non-Microsemi devices to the device database so that they are

recognized during scan chain and auto-construction operations.

add_non_actel_device_to_database [-file {bsdl_filename}]
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Arguments
-File {bsdl_filename}
Specifies the path to the BSDL file and the BSDL filename add to the database.

Supported Families
All non-Microsemi and non-Actel families

Exceptions
N/A

Examples
The following example uses a BSDL file to add a non-Microsemi (1502AS J44) device to the device
database:
add_non_actel_device_to_database —file {c:/bsdl/atmel/1502AS_J44_bsd}
The following example uses a BSDL file to add a non-Microsemi (80200) device to the device database:
add_non_actel_device_to_database —file {c:/bsdl/intel/80200_v1.0.bsd}

check_flash_memory

The command performs diagnostics of the page status and data information as follows:
e Page Status — includes ECC2 check of the page status information, write count
e Page Data - ECC2 check

check_flash_memory

[-name {device name}]

[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]
[-access {all | status | data}]
[-show {summary | pages}]
[-file {filename}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_nhumber> -block <number>

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies
location of block for memory check.

-client {client_name}

Name of client for memory check.

-startpage {integer_value}

Startpage for page range; value must be an integer. You must specify a —endpage and —block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.
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close_project

-access {all | status | data}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies what
NVM information to check: page status, data or both.

Value Description

all Shows the number of pages with corruption status, data corruption and
out-of-range write count (default)

status | Shows the number of pages with corruption status and the number of
pages with out-of-range write count

data | Shows only the number of pages with data corruption

-show {summary | pages}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies
output level, as explained in the table below.

Value Description

summary Displays the summary for all checked pages (default)

pages Displays the check results for each checked page

-file {filename}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Name of output
file for memory check.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command checks the page status for block 0 from starpage 0 to endpage 2:
check_flash_memory -startpage 0O -endpage 2 -block O

The following command checks the memory status for the client 'DS8bit' and saves it to the file
‘checkFlashMemory.log":

check_flash_memory -client {DS8bit} -file {checkFlashMemory.log}

close_project

Closes the FlashPro or FlashPro Express project.

close_project

Arguments
None

FlashPro User's Guide 141



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Supported Families
All

Exceptions
None

Example
close_project

compare_analog_config

Compares the content of the analog block configurations in your design against the actual values in the
device. In a typical SoC project, this directory is located at
<project_root>/smartgen/<analog_block_core_name>.

compare_analog_config
[-name *device_name™] -mem_file_dir "mem_file_directory"
[-File "filename™]

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-mem_file_dir {mem_file_directory}
Location of memory file.

-file {filename}

Output filename.

Supported Families
Fusion

Exceptions
None

Example
The following command reads the analog block configuration in the directory F:/tmp/Analog_Block and
saves the data in the logfile compare_analogReport.log:

compare_analog_config -mem_file_dir {F:/tmp/Analog_Block} -file
{compare_analogReport.log}

The following command reads the analog block configuration information in the device 'AFS600' in the
directory F:/tmp/Analog_Block and saves the data in the log file compare_analogReport.log:

compare_analog_config —name {AFS600} -mem_file_dir {F:/tmp/Analog_Block} -file
{compare_analogReport.log}

compare_flashrom_client

Compares the content of the FlashROM configurations in your design against the actual values in the
selected device.

compare_flashrom_client [-name {device_name}] [-File {filename}]
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compare_memory_client

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
Optional file name for FlashROM compare log.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example
The following command saves the FlashROM data to the file 'FlashRomCompReport.log":
compare_flashrom_client -file {FlashRomCompReport.log}

The following command compares the data in the device 'A3P250' and saves the data in the logdfile
'FlashRomCompReport.log":

compare_flashrom_client —name {A3P250} -file {FlashRomCompReport.log}

compare_memory_client

Compares the memory client in a specific device and block.

compare_memory_client [-name {device_name}] [-block integer_value] -client {client_name}
[-file {filename}]

Arguments
-name { device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client.) Specifies location of block for memory compare.
-client {client_name}

Name of client for memory compare.

-file {filename}

Optional file name.

Supported Families
SmartFusion and Fusion

Exceptions
None

Example
The following command compares the memory in the client 'DS32' on the device 'AFS600'.
compare_memory_client -client DS32 -name AFS600
The following command compares the data at block 'O’ to the client '‘DS8bit":
compare_memory_client -block 0 -client {DS8bit}
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The following command compares the memory in the device 'AFS600' at block '0' to the memory client
'DS8hit":
compare_memory_client —name {AFS600} -block 0 -client {DS8bit}

The following command compares the memory at block '1' to the memory client ‘DS8bit' and saves the
information in a log file to F:/tmp/NVMCompReport.log:

compare_memory_client -block 1 -client {DS8bit} -file {F:/tmp/NVMCompReport.log}

configure_flashpro_prg

Changes FlashPro programmer settings.

configure_flashpro_prg [-vpp {ONJOFF}] [-vpn {ON]|OFF}] [-vddl {ON]OFF}] [-force_vddp
{ON|OFF}] [-vddp {2.-5]3-3}] [-drive_trst {ON]JOFF}] [-force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpp {ON|OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-vddl {ON]OFF}
Enables FlashPro programmer to drive VDDL; set to ON to drive VDDL.
-force_vddp {ON]OFF}
Enables FlashPro programmer to drive VDDP; set to ON to drive VDDP.
-vddp {2.5]3.3}
Sets VDDP to 2.5 or 3.3 volts.
-drive_trst {ON]|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASICPYE, proASIC

Exceptions
None

Example

The following example enables the FlashPro programmer to drive the VPP, VPN, VDDL, VDDP, sets the
drive voltage to 3.3v, disables the driver for TRST, and does not force the programmer to use the TCK
frequency specified in the software.

configure_flashpro_prg —vpp {ON} —vpn {ON} —vddl {ON} —force_vddp {ON} —vddp {3.3} —
drive_trst {OFF} —force_freq {OFF}

configure_flashpro3 prg

Changes FlashPro3 programmer settings.
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configure_flashpro4_prg

configure_flashpro3 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpump {ON]OFF}
Enables FlashPro programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
Specifies free running or discrete TCK.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example sets the VPUMP option to ON, TCK to free running, and uses the TCK frequency
specified in the programmer file (force_freq is set to OFF):

configure_flashpro3_prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{43
The following example sets VPUMP to ON, TCK to discrete, forces the FlashPro software to use the TCK
frequency specified in the software (-force_freq is set to ON) at a frequency of 2 MHz.

configure_flashpro3_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro4 prg

Changes FlashPro4 programmer settings.

configure_flashpro4 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpump {ON|OFF}
Enables FlashPro4 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
Specifies free running or discrete TCK.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion
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Exceptions
None
Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro4_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets the VPUMP option to ON, uses a discrete TCK and sets force_freq to ON at 2
MHz.

configure_flashpro4_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro5_prg

Tcl command; changes FlashPro5 programmer settings.

configure_flashpro5_prg [-vpump {ON]JOFF}] [-clk_mode {free_running_clk}]
[-force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpump {ON]OFF}
Enables FlashPro5 programmer to drive VPUMP. Set to ON to drive VPUMP. Default is ON.
-clk_mode {free_running_clk}
Specifies free running TCK. Default is free_running_clk.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file. Default is OFF.

-freq {freq}
Specifies the TCK frequency in MHz. Default is 4.

Supported Families
RT ProASIC3, SmartFusion, IGLOO, ProASIC3, Fusion, SmartFusion2, IGLOO2, RTG4

Exceptions
None

Example
The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro5 prg -vpump {ON} -clk _mode {free_running_clk} -force_freq
{OFF} -freq {4}

The following example sets the VPUMP option to ON, uses a free running TCK and sets force_freq to ON at
2 MHz.

configure_flashpro5 prg -vpump {ON} -clk _mode {free_running_clk} -force_freq
{ON} -freq {2}

configure_flashproLite prg

Changes FlashPro Lite programmer settings.
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connect_cable

configure_flashproLite prg [-vpp {ONJOFF}] [-vpn {ON]OFF}] [-drive_trst {ON|OFF}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpp {ON]OFF}

Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}

Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-drive_trst {ON]|OFF}

Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

ProASICELS

None

The following example sets the programmer to drive the VPP, drive VPN, drive the TRST and uses the
frequency set by the programmer file (sets force_freq to OFF):

configure_flashprolite_prg —vpp {ON} —vpn {ON} —drive_trst {ON} —force_freq {OFF}

connect_cable

Connects a parallel cable to a port.

connect_cable -cable_name {cable_name} -port_name {port_name} [-drive_trst {ON]|OFF}]

Arguments

-cable_name {cable_name}

Identifies the name of the parallel port cable you wish to connect.
-port_name {port_name}

Specifies the parallel port where the parallel programmer is connected.
-drive_trst {ON]|OFF}

Enables the parallel port cable to drive TRST.

Supported Families

Exceptions

All

None
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Example

The following example connects the cable named Parallel_Port_Buffer_Cable to the port LPT1 and
enables drive TRST:

connect_cable -cable_name {Parallel_Port_ Buffer_Cable} -port_name {Lptl} -drive_trst

{ON}

construct_chain_automatically

Automatically starts chain construction for the specified programmer.

construct_chain_automatically[(-name {name})+]

Arguments
-name {name}
Specifies the programmer(s) name(s).

Supported Families
Al

Exceptions
N/A

Example
Example for one programmer:
construct_chain_automatically -name {21428}
Example for two programmers:
construct_chain_automatically -name {21428} —name {00579}

copy_device

Copies a device in the chain to the clipboard. Chain programming mode must be set. See the paste_device command for

more information.

copy_device (-name {name})*

Arguments
-name {name}

Specifies the device name. Repeat this argument to copy multiple devices.

Supported Families
Al

Exceptions

None

Example
The example copies the device 'mydevicel' to the same location with a new name 'mydevice2'.
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cut_device

copy_device —name {MyDevicel} —name {MyDevice2}

cut_device

Removes one or more devices from the chain. It places the removed device in the clipboard. Chain
programming mode must be set to use this command. See the paste_device command for more
information.

cut_device (-name {name})*

Arguments
-name {name}
Specifies the device name. You can repeat this argument for multiple devices.

Supported Families
Al

Exceptions
None

Example

The following example removes the devices 'mydevicel' and 'mydevice2' from the chain.
cut_device —name {MyDevicel} —name {MyDevice2}

dump_tcl support

Unloads the list of supported FlashPro or FlashPro Express Tcl commands.

dump_tcl_support -file {file}

Arguments
-file {file}

Supported Families
Al

Exceptions
None

Example

The following example dumps your Tcl commands into the file 'tcldump.tcl'
dump_tcl_support -file {tcldump.tcl}

enable device

Enables or disables a device in the chain (if the device is disabled, it is bypassed). Chain programming
mode must be set. The device must be a Microsemi device.

enable_device -name {name} -enable {TRUE|FALSE}
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Arguments
-name {name}
Specifies your device name
-enable {TRUE|FALSE}

Specifies whether the device is to be enabled or disabled. If you specify multiple devices, this argument
applies to all specified devices. (TRUE = enable. FALSE = disable)

Supported Families

All
Exceptions
None
Example
The following example disables the device 'mydevicel' in the chain.
enable_device —name {MyDevicel} —enable {FALSE}
enable prg

Enables or disables one or more programmers.

enable_prg (-name {name})* -enable {TRUE|FALSE}

Arguments
-name {name}*
Specifies the programmer name. You can repeat this argument for multiple programmers.
-enable {TRUE|FALSE}

Specifies whether the programmer is to be enabled or disabled. If you specify multiple programmers, this
argument applies to all of them (TRUE = enable. FALSE = disable).

Supported Families
Al

Exceptions
None

Example

The following example enables the programmers 'FP300085' and 'FP300086'".
enable_prg —name {FP300085} —name {FP300086} —enable {TRUE}

enable prg_type

Enables or disables all programmers of a specified programmer type.

enable_prg_type -prg_type {prg_type} -enable { TRUE | FALSE }

Arguments
-prgType { FP | FPLite | FP3 | PP }
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enable_procedure

Specifies the programmer type to be enabled/disabled (FP—FlashPro type programmers, FPLite—FlashPro
Lite type programers, FP3—FlashPro3 type programmers, PP—Parallel port cable type programmers).

-enable {TRUE|FALSE}
Specifies whether the programmers are to be enabled or disabled (TRUE-enable, FALSE—disable).

Supported Families
Al

Exceptions
None

Example
The following example enables the FlashPro3 programmer.
enable_prog_type —prg_type{FP3} —enable{TRUE}

enable procedure

To enable/disable an optional procedure of an action. The device name parameter must be specified only
in chain programming mode. A programming file must have been loaded.

enable_procedure [-name {name}] -action {action} -procedure {procedure} -enable
{TRUE | FALSE}

Arguments
-name {name}
-action {action}
-procedure {procedure}
-enable {TRUE|FALSE}

Supported Families
All

Exceptions
None

Example
In single programming mode:
enable_procedure —action {PROGRAM} —procedure {DO_ERASE} —enable {TRUE}

In chain programming mode:

enable_serialization —name {MyDevice2} —action {PROGRAM} —procedure {DO_ERASE} —enable
{FALSE}

enable_serialization

This Tcl command enables or disables serialization programming.

enable_serialization —name {device_name} -enable {true|false}

Arguments
-name
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Specifies the device name.
-enable
Enables (true) or disables (false) serialization programming.

Exceptions
Must be a Microsemi Device

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Example
enable_serialization -name M2S/M2GLOSO{T|S|TS} -enable true

export_chain_stapl
Exports the ChainBuilder STAPL file in chain programming mode.

export_chain_stapl -file {file}

Arguments
-file {file}
Specifies the file to be exported.

Supported Families
Al

Exceptions
None

Example

The following example exports the STAPL file 'tcl_testing_chain.stp':
-export_chain_stapl -file {./tcl_testing_chain.stp}

export_chain_svf
Tecl command; FlashPro only.

export_chain_svf -file [path to svf folder] [-tck {double-value}]

Arguments
-file
Required. SVF folder name will be name_svf.

Example: If the SVF file name is top.svf, folder top_svf will be created, which will contain the individual
SVF files per PROGRAMMING action.

-tck

Optional. This is the TCK used in the exported SVF files. This value needs to be specified in MHz. The
default is 4.00 MHz.
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Supported Families
SmartFusion, IGLOO, ProASIC3, and Fusion

Example
export_chain_svf -file {d:\66316\top.svf} -tck {6.25}

export_config

Exports a configuration file.

export_config -file {file}

Arguments
-file {file}
Specifies the file to export.

Supported Families
All

Exceptions
None

Example

The following example exports the configuration file 'myconfigl’
export_config -file {myconfigl}

export_secured_pdb

Exports a single device secured PDB from the loaded PDB.

export_secured_pdb -file {file} [-name {name}]

Arguments
—file {File}
Specifies the file to export.
-name {name}

& Microsemi

export_config

Specifies the name of the device in chain mode to export a single device currently secured PDB.

Supported Families
SmartFusion, Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.

Example

In single mode, the following command exports the secured PDB 'my_design.pdb':
export_secured_pdb -file {D:/TOP/my_design.pdb}
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In chain mode, the following example exports the secured PDB 'my_design.pdb' from the A2F200M3F
device in the chain:

export_secured_pdb -name {A2F200M3F} -file {./my_design.pdb}

export_script
Exports the history in a Tcl script.

export_script -file {file} -relative_path {TRUE|FALSE}

Arguments
—file {File}
Specifies the file to export.
-relative_path {TRUE|FALSE}
Specifies whether the file path must be exported as a relative path or an absolute path.

Supported Families
All

Exceptions
None

Example

The following example exports your Tcl history to the file 'history.tcl' with absolute pathnames.
export_script —File {./history.tcl} —-relative_path {FALSE}

export_single 1532
Exports a single device IEEE 1532 file.
export_single_1532 -file {file} [-name {name}] [-pdb {pdb_file}] [-secured]

Arguments
—file {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export single device IEEE 1532 programming file.
-pdb {pdb_File}
Specifies the PDB to use for exporting a IEEE 1532 programming file. By default, the loaded PDB is used
for exporting a IEEE 1532 programming file.

-secured
Exports a IEEE 1532 programming file for a secured device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.
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export_single_dat

Example

Single Mode, exports the secured IEEE 1532 files 'my_design.isc' and 'my_design.bsd' into folder
'D:/TOP/my_design_1532" using the PDB 'my_design.pdb":
export_single 1532 -file {D:/TOP/my_design_1532) -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode example exports secured IEEE 1532 files 'my_design.isc' and 'my_design.bsd' into folder
'D:/TOP/my_design_1532' from a device in the chain named 'A2F200M3F' using the PDB 'my_design.pdb'":

export_single_ 1532 -name {A2F200M3F} -file {./my_design_1532} -pdb {./my_design.pdb} -
secured

export_single dat
Exports a single device DirectC data file.

export_single_dat -file {file} [-name {name}] [-pdb {pdb_file}] [-secured]

Arguments
—file {File}
Specifies the name of the file you are exporting.
-name {name}
Specifies the name of the device in chain mode to export a single device DirectC data file.
-pdb {pdb_File}

Specifies the PDB to use for exporting a DirectC data file. By default, the loaded PDB will be used for
exporting a DirectC data file.

-secured
Use this argument to export a secured DirectC data file.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.

Example
Single Mode, exports a secured DirectC DAT file 'my_design.dat' using the PDB file 'my_design.pdb':
export_single_dat -file {D:/TOP/my_design.dat} -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode, exports a secured DirectC DAT file 'my_design.dat' from a device in the chain named
'‘A2F200M3F', using the PDB 'my_design.pdb':

export single_dat -name {A2F200M3F} -file {./my_design.dat} -pdb {./my_design.pdb} -
secured

export_single stapl
Exports a single device STAPL file or single device chain STAPL file.
export_single_stapl -file {file} [-name {name}] [-pdb {pdb_file}] [-secured] [-chain]

Arguments
-file {file}
Specifies the file to export.
-name {name}
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Specifies the name of the device in chain mode to export a single device STAPL or single device chain
STAPL file.

-pdb {pdb_File}

Specifies the PDB to use for exporting a STAPL file. By default, the loaded PDB is used for exporting a
STAPL file.

-secured

Exports a secured STAPL file.

-chain

Indicates that you want to export a single device chain STAPL file.

Note: This parameter is only supported for SmartFusion2, IGLOO2, and RTG4 families.

Supported Families
SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example
Single Mode example exports the secured file ‘my_design.stp' using the PDB 'my_design.pdb':
export_single_stapl -file {D:/TOP/my_design.stp} -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode example exports secured STAPL file '‘my_design.stp' from device 'A2F200M3F' using the PDB
‘'my_design.pdb'":

export single_stapl -name {A2F200M3F} -file {./my_design.stp} -pdb {./my_design.pdb} -
secured

export_single svf
Exports a single device SVF programming file.

export_single_svf -file {file} [-name {name}] [-pdb {pdb_file}] [-secured]

Arguments
—file {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export a single device SVF programming file.
-pdb {pdb_File}
Specifies the PDB to use for exporting a SVF programming file. By default, the loaded PDB is used for
exporting a SVF programming file.
-secured
Exports a SVF programming file for a secured device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
"-secured' is only supported for SmartFusion devices.
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export_spi_directory

Example
Single Mode, exports the secured SVF files for each programming ACTION with the following format
'my_design_ACTION.svf' into folder 'D:/TOP/my_design_SVF' using the PDB 'my_design.pdb":
export_single SVF -file {D:/TOP/my_design_SVF) -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode example exports secured SVF files for each programming ACTION with the following format
‘'my_design_ACTION.svf' into folder 'D:/TOP/my_design_SVF' from a device in the chain named
'‘A2F200M3F' using the PDB 'my_design.pdb':

export_single_SVF -name {A2F200M3F} -file {./my_design_SVF} -pdb {./my_design.pdb} -
secured

export_spi_directory

Tcl command; exports the SPI directory that contains address and design version information for the
Golden and Update SPI images.

export_spi_directory [-golden_ver {decimal}] [-golden_addr {hex}] [-update_ver {decimal}]
[-update_addr {hex}] -file {file}

Arguments
-golden_ver {decimal}

Specifies Golden SPI Image design version where decimal is a decimal value and less than 65536
(exclusive).

-golden_addr {hex}
Specifies Golden SPI Image address where hex is 32-bit hexadecimal value with prefix Ox/0X.
-update_ver {decimal}

Specifies Update SPI Image design version where decimal is a decimal value and less than 65536
(exclusive).

-update_addr {hex}

Specifies Update SPI Image address where hex is a 32-hit hexadecimal value with prefix Ox/0X.
—file {File}

Mandatory argument; specifies the file export location.

Supported Families
SmartFusion2, IGLOO2

Examples

Both golden* options go together. The same is true for both update* options.; the file argument is required:

export_spi_directory -golden_ver {23} -golden_addr {0x40001234} -file
{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_MSS\export\m2s090t_spi_1_MSS1.spi
Dir}

export_spi_directory -update_ver {8} -update_addr {0x2000abcd} -file
{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_ MSS\export\m2s090t_spi_1_ MSS2.spi
Dir}

export_spi_directory -golden_ver {23} -golden_addr {0x40001234} -update_ver {8} -
update_addr {0x2000abcd} -file

{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_MSS\export\m2s090t_spi_1_MSS3.spi
Dir}

import_config

Imports a configuration file.
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import_config -file {file}

Arguments
-file {file}
Specifies the file to import.

Supported Families
All

Exceptions

None

Example

The following example imports the configuration file 'my_configl.ufc":

import_config -file {my_configl.ufc"}

new_project

Creates a new FlashPro project or convert an old ChainBuilder project into a new FlashPro project (the
mode parameter must be 'chain’ in this case).

new_project -name {name} -location {location} -mode {single]chain} [-convert_chb
{convert_chb}]

Arguments
-name {name}
Specifies the project name.
-location {location}
Specifies the project location.
-mode {single]chain}
Specifies programming mode; either single or chain.
-convert_chb {convert_chb}
An optional argument that specifies the ChainBuilder project to be converted.

Supported Families
All

Exceptions
None

Example
Create a new FlashPro single device project named 'FPPrjl' in a directory with the name 'FPProjectl":
new_project -name {FPPrjl} -location {./FPProjectl} -mode {single}

Create a new FlashPro project named 'FPPrjChb' in the directory 'ChbProjectl’; converts the ChainBuilder
project 'prjl.chb' project to FlashPro.
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open_project

new_project -name {FPPrjChb} -location {./ChbProjectl} -mode {chain} -convert_chb
{./chb_prj/prjl.chb}

open_project
Opens a FlashPro or FlashPro Express project.

open_project -project {project}

Arguments
-project {project}
Specifies the location and name of the project you wish to open.

Supported Families
Al

Exceptions
None

Example

Opens the 'FPPrjl.pro' project from the FPProjectl directory
open_project -project {./FPProjectl/FPPrjl._pro}

paste device

Pastes the devices that are on the clipboard in the chain, immediately above the position_name device,
if this parameter is specified. Otherwise it places the devices at the end of the chain. The chain
programming mode must be enabled.

paste_device [-position_name {position_name}]

Arguments
-position_name {position_name}
Optional argument that specifies the name of a device in the chain.

Supported Families
All

Exceptions
None

Examples

The following example pastes the devices on the clipboard immediately above the device 'mydevice3' in
the chain.

paste_device —position_name {MyDevice3}

ping_prg

Pings one or more programmers.
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ping_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer to be pinged. Repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example

The following example pings the programmers 'FP300085' and 'FP30086'.
ping_prg —nhame {FP300085} —name {FP300086}

read_analog_block config

Reads each channel configuration on your analog system, enabling you to identify iffhow each channel is
configured.

read_analog_block config [-name {device_name}] [-file {Ffilename}]

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
Fusion

Exceptions
None

Example

The following command reads the analog block configuration information in the device 'AFS600'":
read_analog_block_config —name {AFS600}

read_device_status

Displays the Device Information report; the Device Information report is a complete summary of your device
state, analog block test values, user information, factory serial number and security information..

read_device_status [-name {device_name}] [-File {filename}]
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read_flash_memory

Arguments
-name device_nhame

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following reads device info from the '"AFS600' device.
read_device_status -name AFS600

read_flash_memory

The command reads information from the NVM modules. There are two types of information that can be
read:

e Page Status — includes ECC2 status, write count, access protection

e Page Data

read_flash_memory

[-name {device name}]

[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]
[-access {all | status | data}]
[-file {filename}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client or —startpage and —endpage before use.) Specifies location of
block for memory read.

-client {client_name}

Name of client for memory read.

-startpage {integer_value}

Startpage for page range; value must be an integer. You must specify a —endpage and -block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.
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-access {all | status | data}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies what
eNVM information to check: page status, data or both.

Value Description

all Shows the number of pages with corruption status, data corruption and
out-of-range write count (default)

status | Shows the number of pages with corruption status and the number of
pages with out-of-range write count

data | Shows only the number of pages with data corruption

-file {filename}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Name of output
file for memory read.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command reads the flash memory for the client ‘DS8bit' and reports the data in a logfile
‘readFlashMemoryReport.log'":

read_flash_memory -client {DS8bit} -file {readFlashMemoryReport.log}
read_flash_memory —startpage O —endpage 2 —block 0 —access {data}

read_flashrom

Reads the content of the FlashROM from the selected device.

read_flashrom [-name {device_name}] [-mapping {logical | physical}] [-file {filename}]

Arguments
-name device_nhame

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-mapping {logical | physical}
(Optional) Specifies how the data read from the UFROM is mapped. Values are explained in the table

below.
Value Description
logical Logical mapping (default)
physical Physical mapping

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.
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read_id_code

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following reads the FROM content on the device 'AFS600' and sets to physical mapping:
read_flashrom -name {AFS600} -mapping {physical}

read_id_code

The command reads IDCode from the device without masking any IDCode fields. This is the raw IDcode
from the silicon.

Note: Being able to read the IDCode is an indication that the JTAG interface is working correctly.

read_id_code [-name {device_name}]

Arguments
-name device_name

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following command reads the IDCODE from the device 'AFS600':
read_id_code —name {AFS600}

recover_flash_memory

The command removes ECC2 errors due to memory corruption by reprogramming specified flash memory
(NVM) pages and initializing all pages to zeros. The recovery affects data blocks and auxiliary blocks.

The write counters of the corrupted pages might not be accurate due to corruption. The recovery operation
will not change state of the page write counters.

Use the check_flash_memory command to detect flash memory errors.

recover_flash_memory

[-name {device name}]
[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>
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Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client or —startpage and —endpage before use.) Specifies location of
block for memory recovery.

-client {client_name}

Name of client for memory recovery.

-startpage {integer_value}

Startpage for page range; value must be an integer.You must specify a —endpage and -block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example
The following command recovers flash memory data in the client ‘DS8bit":
recover_flash_memory -client {DS8bit}
The following command recovers flash memory from block 0, startpage 0, and endpage 3:
recover_flash_memory -block O -startpage O -endpage 3

refresh_prg_list

Refreshes the programmer list. This is most often used to have FlashPro or FlashPro Express detect a
programmer that you have just connected.

refresh_prg_list

Arguments
None

Supported Families
Al

Exceptions
None

Example
refresh_prg_list
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remove_device

Removes the device from the chain. Chain programming mode must be set.

remove_device (-name {name})*

Arguments
-name {name}

Specifies the device name. You can repeat this argument for multiple devices.

Supported Families
All

Exceptions

None

Example
Remove a device 'A3P250' from the chain:

remove_device (-name {A3P250})*

remove_non_actel device from_database

Removes settings for non-Microsemi or non-Actel device from the device database.

remove_non_actel _device_from database [-name {device name}]

Arguments
-name {device_name}
Specifies the non-Actel or non-Microsemi device name to be removed from the database. You can repeat

this argument for multiple devices.

Supported Families

Non-Microsemi and non-Actel devices

Exceptions

None

Example
The following example removes the F1502AS_J44 device from the database:

remove_non_actel_device_from_database —name {F1502AS_J44}
The following example removes the SA2_ PROCESSOR device from the database:

remove_non_actel_device_from_database —name {SA2_PROCESSOR}
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remove_prg

Removes the programmer from the programmer list.

remove_prg (-name {name})*

Arguments
-name {name}*
Specifies the programmer to be removed. You can repeat this argument for multiple programmers.

Supported Families
All

Exceptions
None

Example

The following example removes the programmer '03178' from the programmer list:
remove_prg (name {03178})*

run_selected_actions

Runs the selected action on the specified programmer and returns the exit code from the action. If no
programmer name is specified, the action is run on all connected programmers. Only one exit code is
returned, so return code cannot be used when action is run on more than one programmer. A
programming file must be loaded.

run_selected_actions [(-name {name})*]

Arguments
-name {name}

Optional argument that specifies the programmer name. You can repeat this argument for multiple
programmers.

Supported Families
All

Exceptions
None

Example
The following example runs the selected actionS on the programmers 'FP30085' and 'FP30086'".
run_selected_actions —name {FP300085} —name {FP300086%}
Example using return code:

if {[catch {run_selected_actions} return_val]} {puts "Error running Action"} else {puts
"exit code $return_val"}

Example returning exit code to the command line (returns exit 99 on script failure, otherwise returns exit
code from selected action):

if {[catch {run_selected_actions} return_val]}{exit 99} else {exit $return_val}
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sample_analog_channel

Performs analog-to-digital conversion of a selected analog channel. This command is used when debugging
the Analog Subsystem and is performed on the pre-configured analog channel with user-supplied ADC
conversion parameters. The command also performs digital filtering using a single-pole low-pass filter if you

opt to use it.

sample_analog_channel [(-name {name})*]

[-resolution {8 | 10 | 12}]

[-clock periods {int_value}]
[-clock _divider {int_value}]

[-num_samples { int_value}]

[-filtering_factor {real_value}]
[-initial_value {int_value}]

[-show_details {yes | no}]l

[-file {filename}]

Arguments

& Microsemi

sample_analog_channel

-name { name}

Specifies the analog channel to be sampled. Channel name is a combination of the channel type followed
by the channel index. Valid channel names are listed in the table below.

Family Valid Channel Name

Fusion AV<n>, AT<n>, AC<n>

SmartFusion AV<n>, AT<n>, AC<n>, ADC<n>

The maximum number of channels depends on particular device type; refer to the Analog Block
specification in the device handbook.

-resolution {8 | 10 | 12}

ADC conversion resolution. Specifies bit size of the conversion results. Selection of certain resolutions
may affect timing parameter valid ranges. See your device handbook for details.

-clock_periods {int_value }

Parameter specifying sampling time: Sampling_time = clock_periods * adc_clock_period.
-clock_divider {int_value }

Specifies clock prescaling factor.

-num_samples { int_value }

Optional argument that specifies the number of samples to be performed by the ADC. Default number of
samples is 1. Selecting multiple vs single sample will change appearance of the generated report. For the

single sample a single result is shown and if “show_details” is set to “yes” then detailed status of the ADC
register is also shown.

If multiple samples are requested then the results are printed in a table. If the digital filtering is enabled the
table also includes filtered results.

-filtering_factor {real_value}

Optional argument that specifies the filtering factor if multiple samples requested. The default value of 1.0
disables digital filtering.

-initial_value {int_value}
Optional argument that specifies the initial value for the digital averaging filter. The value is specified in

ADC register counts. Default value is set to 0. Specifying this parameter improves filtering process during
initial samples.

-show_details {yes | no}
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Optional argument that specifies the level of the report output. Detailed output includes initial user-
supplied conversion parameters. For the single-sampling case final output also includes detailed content
of ADC register after sampling.

-file {filename}
Optional argument. Specifies name of output file for conversion results.

Supported Families
SmartFusion and Fusion

Exceptions
None
Example
The following example performs single sample analog-to-digital conversion for channel AVO:
sample_analog_channel —channel AVO —resolution 8 —clock_periods 4 —clock_divider 4
Example with multiple sampling and digital signal filtering for AVO:
sample_analog_channel —channel AVO —resolution 10 —clock_periods 4 —clock_divider 4 —
num_samples 10 —Filtering_factor 2.5
save log

Saves the log file.

save_log -file {file}

Arguments
—file {File}
Specifies the log filename.

Supported Families
All

Exceptions
None

Example

The following example saves the log file with the name 'my_logdfilel.log'":
save_log -file {my_logfilel.log}

save_project

Saves the FlashPro or FlashPro Express project.

save_project

Arguments
None
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Supported Families
Al

Exceptions
None

Example
save_project

save_project_as

Saves the FlashPro project under a new project name.

save_project_as -name {name} -location {location}

Arguments
-name {name}
Specifies the project name.
-location {location}
Specifies the project location.

Supported Families
All

Exceptions
None

Example

The following example saves the FlashPro project 'FPPrj2' to the directory 'FPProject2":
save_project_as -name {FPPrj2} -location {./FPProject2}

scan_chain_prg
In single mode, this command runs scan chain on a programmer.

In chain mode, this command runs scan and check chain on a programmer if devices have been added in
the grid.

scan_chain_prg [(-name {name})+]

Arguments
-name {name}
Specifies the programmer name.

Supported Families
All

Exceptions
None
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Example
The following example runs scan chain on a single programmer (single mode) named '21428":
scan_chain_prg -name {21428}

select_from_region_name

Enables you to select the serialization region you want to add to the log file.

select_from_region_name —enable {1]0} —-region_name {name}

Arguments
-enable {1]0}
Enable serialization region logging. '1' enables serialization region logging; '0' disables it.
-region_name {name}
The name of the target serialization/client within FlashRom you wish to log.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example enables select_from_region_name and adds the serialization region 'afs090_b' to the
log file:
select_from_region_name -enable {1} -region_name {afs090_b}

select_libero_design_device (SmartFusion2, IGLOO2, RTG4,
PolarFire)

FlashPro-specifc Tcl command. This command selects the Libero design device for the Programming
Connectivity and Interface tool within Libero. This command is needed when the tool cannot automatically
resolve the Libero design device when there are two or more identical devices that match the Libero
design device in the configured JTAG chain.

Syntax

select_libero_design_device -name {device_name}

Arguments
-name {device_name}
Specifies a user-assigned unique device name in the JTAG chain.

Supported Families
SmartFusion2, IGLOO2, RTG4, PolarFire

Exceptions
None
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Example
select_libero_design_device —name {M2S050TS (2)}
select_libero_design_device —name {my_design_device}

Note

This Tcl command is typically used in a Flashpro Tcl command script file that is passed to the Libero
run_tool command.

run_tool —name {CONFIGURE_CHAIN} -script {<flashPro_cmd>.tcl}

select_serial_range

This Tcl command selects the range of indexes to program.

select_serial_range -name device_name -from_data start_index_to_program -to_data
end_index_to_program

Arguments
-name
Specifies the device name.
-from_data
Specifies the start index to program.
-to_data
Specifies the end index.

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Exceptions
Must be a Microsemi Device

Example
select_serial_range -name M2S/M2GLO50{T|S|TS} -from_data 3 -to_data 5

select_target_device

Enables you to set a target device for programming in Single Device Programming mode. The command
is identical to the Select Target Device dialog box in FlashPro.

Select_target_device -name {device_name}

Arguments
-name {device_name}
Specifies the name of the target device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion
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Exceptions
None
Examples

The following example targets the A3P(L) / AGL1000 device for programming:
select_target_device —name {A3P(L)/AGL1000 (1)}

self test prg

Runs Self-Test on a programmer.

self_test_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer name. You can repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example

The following examples runs the self test on the programmer '30175"
self_test_prg (-name {30175})*

set bsdl file

Sets a BSDL file to a non-Microsemi device in the chain. Chain programming mode must have been set.
The device must be a non-Microsemi device.

set_bsdl_file -name {name} -file {file}

Arguments
name {name}
Specifies the device name.
—file {File}
Specifies the BSDL file.

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None

Example
The following example sets the BSDL file /design/bsdl/NewBSDL2.bsdl to the device 'MyDevice3"
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set_bsdl_file —name {MyDevice3} —file {e:/design/bsdl/NewBSDL2_bsdl}

set_chain_param

Sets the chain parameters in single programming mode. Single programming mode must be set .

set_chain_param [-pre_ir {pre_ir}] [-pre_dr {pre_dr}] [-post_ir {post_ir}] [-post_dr
{post_dr}]

Arguments
-pre_ir {pre_ir}
Specifies the pre IR length.
-pre_dr {pre_dr}
Specifies the pre DR length.
-post_ir {post_ir}
Specifies the post IR length.
-post_dr {post_dr}
Specifies post DR length.

Supported Families
All

Exceptions
None

Example

The following example sets the chain parameters for pre IR length to 2, pre DR length to 3, post IR length
to 4, and post DR length to 5:

set_chain_param —pre_ir {2} —pre_dr {3} —post_ir {4} —post _dr {5}

set _debug_device

Identifies the device you intend to debug.

set_debug_device -name {device_name}

Arguments
name {device_name}
Device name. The device name is not required if there is only one device in the current configuration.

Supported Families
SmartFusion2, IGLOO2, SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example identifies the device 'A3P250' for debugging:
set_debug_device —name {A3P250}
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set _debug_programmer

Identifies the programmer you want to use for debugging (if you have more than one). The name of the
programmer is the serial number on the bar code label on the FlashPro programmer.

set_debug_programmer -name {programmer_name}

Arguments
-name {programmer_name}
Programmer name is the serial number on the bar code label of the FlashPro programmer.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example selects the programmer 10841
set_debug_programmer -name {10841}

set_device _ir

Sets the IR length of a non-Microsemi device in the chain. Chain programming mode must be set. The
device must be a non-Microsemi device.

set_device_ir -name {name} -ir {ir}

Arguments
-name {name}
Specifies the device name.
-ir {ir}
Specifies the IR length.

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None

Example

The following example sets the IR length to '2' for the non-Microsemi device 'MyDevice4'":
set_device_ir —name {MyDeviced} —ir {2}

set_device_name

Changes the user name of a device in the chain. Chain programming mode must be set .

set_device_name -name {name} -new_name {new_name}
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Arguments
-name {name}
Identifies the old device name.
-new_name {new_name}
Specifies the new device name.

Supported Families
All

Exceptions
None

Example
The following example changes the user name of the device from '‘MyDevice4' to 'MyDevice5":
set_device_name —name {MyDeviced4} —new_name {MyDevice5}

set_device order

Sets the order of the devices in the chain to the order specified. Chain programming mode must have
been set. Unspecified devices will be at the end of the chain.

set_device_order (-name {name})*

Arguments
-name {name}

Specifies the device name. To specify a new order you must repeat this argument and specify each
device name in the order desired.

Supported Families
All

Exceptions
None

Example

The following example sets the device order for 'MyDevicel', 'MyDevice2', 'MyDevice3', and 'MyDevice4'.
‘MyDevice2' is unspecified so it moves to the end of the chain.

set_device_order —name {MyDevice3} —name {MyDevicel} —name {MyDeviced}
the new order is:
MyDevice3 MyDevicel MyDevice4 MyDevice2

set _device_tck

Sets the maximum TCK frequency of a non-Microsemi device in the chain. Chain programming mode
must be set. The device must be a non-Microsemi device.

set_device_tck -name {name} -tck {tck}
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Arguments
-name {name}
Specifies the device name.
-tck {tck}
Specifies the maximum TCK frequency (in MHz).

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None

Example

The following example sets the maximum TCK frequency of the non-Microsemi device 'MyDevice4'":
set_device_tck —name {MyDevice4d4} —tck {2.25}

set_device to_highz

Sets a disabled Microsemi or Microsemi device in Chain programming mode to HIGH-Z. This Tcl
command is related to the Set Device to HIGH-Z GUI command.

set_device_to_highz -name {device_name} —-highz {1]0}

Arguments
-name {device_name}
Target device name in chain mode.
-highz {1]0}
Sets disabled device to HIGH-Z. '1' sets the device to HIGH-Z, '0' removes the setting.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example
The following example sets the AFS090 device to HIGH-Z:
set_device_to_highz —name {AFS090} —-highz 1
The following example removes the HIGH-Z setting from the AFS1500 device:
set_device_to_highz —name {AFS1500} —highz O

set_device_type
Changes the family of a Microsemi device in the chain. The device must be a Microsemi device. The
device parameter below is now optional.

set_device_type -name {name} -type {type}
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Arguments
-name {name}
Identifies the name of the device you want to change.

-type {type}
Specifies the device family.

Supported Families
Any Microsemi device supported by FlashPro.

Exceptions
None

Example
The following example sets the device 'MyDevice2' to the type ASPEG00.
set_device_type —name {MyDevice2} —type {A3PE600}

set_main_log_file
Sets the FlashPro log file.

set_main_log_file -file {file}

Arguments
-file {file}
Specifies the log file.

Supported Families
Al

Exceptions
None

Example
The following example sets the FlashPro log file to 'log1000.txt'.
set_main_log_file —file {e:/10g/10g1000.txt}

set_prg_name

Changes the user name of a programmer.

set_prg_name -name {name} -new_name {new_name}

Arguments
-name {name}
Identifies the old programmer name.
-new_name {new_name}
Specifies the new programmer name.

& Microsemi
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Supported Families
All devices supported by FlashPro.

Exceptions
None

Example
The following example changes the name of the programmer 'FP300086' to 'FP3Prg2":
set_prg_name —name {FP300086} —new_name {FP3Prg2}

set_programming_action

Selects the action for a device. The device name parameter must be specified only in chain programming
mode. A programming file must be loaded. The device must be a Microsemidevice.

set_programming_action [-name {name}] -action {action}

Arguments
-name {name}
Specifies the device name.
-action {action}
Specifies the action.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device

Example
The following example sets the programming action in single programming mode:
set_programming_action —action {PROGRAM}
And in chain programming mode:
set_programming_action —name {MyDevicel} —action {ERASE}

set_programming_file

Sets the programming file for a device. Either the file orthe no_file flag must be specified. A
programming file must be loaded. The device must be a Microsemi device .

set_programming_Ffile [-name {name}] [-file {file}] [-no_Ffile { }]

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
—file {File}
Specifies the programming file.
-no_File
Specifies to unload the current programming file.
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Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device.

Examples
In single programming mode:
set_programming_file —file {e:/design/pdb/TopA3P250.pdb}
In chain programming mode:
set_programming_file —name {MyDevice2} —file {e:/design/pdb/TopA3P250.pdb}
set_programming_file —name {MyDevicel} —no_Tfile

set_programming_mode

Sets the programming mode.

set_programming_mode -mode {single]chain}

Arguments
-mode {single]chain}
Specifies the mode, either single programming or chain programming.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example sets the programming mode to 'single":
set_programming_mode -mode {single}

set_serialization_log_file

This Tcl command sets the path and name of the serialization log file.

set_serialization_log_file -file {log_file_path}

Arguments
-file
Specifies the serialization log file path and name

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Exceptions
Must be a Microsemi Device
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Example
set_serialization_log_file -file {C:/local_z_folder/work/my_serial_log}

set_serialization_mode

Sets the serialization mode.

set_serialization_mode -mode {skip]reuse}

Arguments
-mode {skip]reuse}

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example sets the serialization mode to 'skip":
set_serialization_mode -mode {skip}

update programming_file
Updates the programming file with the selected parameters.

update_programming_File

[(-name {name})*]

-feature {value}

-signature {value}

-from_content {name}

-from_config_file {name}
-number_of_devices {value}
-from_program_pages {value}
-custom_security {value}
-security_permanent {value}
-fpa_security_level {value}
-from_security_level {value}
-efm_block_security{location:X;security_level: value}
-pass_key {value} -aes key {value}
-efm_content {location:X;source: value}
-efm_block {location:X;config_file: value}
—efm_client {location:X;client:value; mem file: value}
-tie_off_arch {value}

-set_io_state {value}

-pdb_file {name}

-enable_m3debugger {value}

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
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-feature {value}

Select the silicon feature(s) you want to program. Possible values for this option are listed in the table
below, or the instance-specific program options available only for specific families (as shown in the table
below). Microsemi recommends that you specify your program parameters for each Embedded Flash
Memory Block (EFMB) instance, from 0-3. The instance specific program options replace [-feature
{value}].

value Family

{setup_security:on/off}

SmartFusion

{prog_fpga:on/off}

SmartFusion

{prog_from:on/off}

SmartFusion

{prog_nvm:on/off}

SmartFusion

{setup_security}

Fusion

{prog_from}

Fusion

{all}

IGLOO; ProASIC3

To program the Embedded Flash Memory Block, use the following EFM arguments: -efm_block, -
efm_client, and -efm_block security.

-signature {value}
Optional argument that identifies and tracks Microsemi designs and devices.
-from_content {name}

Optional argument that identifies the source file for the FlashROM content. The file type is UFC or PDB
(default). This argument only applies when programming the FlashROM (prog_from option).

-from_config_file {name}

Optional argument that specifies the location of the FlashROM configuration file. This argument only
applies when programming the FlashROM (prog_from option) and the from_content is set to UFC.
-number_of_devices{value}

Optional argument that specifies the number of devices to be programmed. This argument only applies
when FlashROM has serialization regions. This argument only applies when programming the
FlashROM (prog_from option).

—-from_program_pages {value}

Optional argument that identifies the program pages in FlashPoint. This argument only applies when
programming the FlashROM (prog_from option).

-custom_security {value}

Optional argument that specifies the security level. This argument only applies when programming the
security settings (setup_security) or programming previously secured devices. The following table shows
the acceptable values for this argument:

Value Description

Yes

Custom security level

No

Standard security level

-security_permanent {value}
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Optional argument that specifies whether the security settings for this file are permanent or not. This
argument only applies when programming the security settings (setup_security) or programming
previously secured devices. The following table shows the acceptable values for this argument:

Value Description
Yes Permanently disables future modification of security settings
No Enables future modifications of security settings

-fpga_security_level {value}

Optional argument that specifies the security level for the FPGA Array. This argument only applies when
programming the security settings (setup_security) or programming previously secured devices. Possible
values:

Value Description

write_verify_protect | The security level is medium (standard) and the FPGA Array
cannot be written or verified without a Pass Key

write_protect The security level is write protected. The FPGA Array cannot be
written without a Pass Key, but it is open for verification (custom
FPGA)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption

none The FPGA Array can be written and verified without a Pass Key

-from_security_level {value}

Optional argument that specifies the security level for the FlashROM. This argument only applies when
programming the security settings (setup_security) or programming previously secured devices. Possible
values:

Value Description

write_verify_protect | The security level is medium (standard) and the FlashROM cannot
be read, written or verified without a Pass Key

write_protect The security level is write protected. The FlashROM cannot be
written without a Pass Key, but it is open for reading and
verification (custom FlashROM)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption
none The FlashROM can be written and verified without a Pass Key

-efm_block_security{location:X;security_level: value}

This option is available only for SmartFusion and Fusion; this argument only applies when
programming the security settings (setup_security) or programming previously secured devices.

X' identifies an Embedded Flash Memory Block instance from 0-3.
Possible values for security_level:
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Value Description

clients_jtag_protect | Enables eNVM client JTAG protection; a pass key is required for
this option.

write_verify_protect | The security level is medium (standard) and the Embedded Flash
Memory Block cannot be read, written or verified without a Pass
Key

write_protect The security level is write protected. The Embedded Flash
Memory Block cannot be written without a Pass Key, but it is open
for reading (custom FB)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption
none The Embedded Flash Memory Block can be written and read

without a Pass Key

-pass_key {value}

Protects all the security settings for FPGA Array, FlashROM, and Embedded Flash Memory Block. The
maximum length of this value is 32 characters. You must use hexadecimal characters for the pass key
value.

-aes_key {value}

Decrypts FPGA Array and/or FlashROM and Embedded Flash Memory Block programming file content.
Max length is 32 HEX characters.

-efm_content {location:X;source: value}

This option is available only for SmartFusion and Fusion; X identifies an Embedded Flash Memory Block
from 0-3. Option identifies the source file for the Embedded Flash Memory Block configuration content,
either an EFC or PDB file. If you specify EFC as your source, you need to specify the -efm_block
parameter. Possible values:

Value Description

PDB | Embedded Flash Memory Block configuration and content is taken from your
PDB

EFC | FlashPoint uses the Embedded Flash Memory Block configuration and content
from the EFC file specified in -efm_block parameter

-efm_block {location:X;config_file: value}

This option is available only for SmartFusion and Fusion; X identifies an Embedded Flash Memory Block
(EFMB) from 0-3.

Config_file specifies the location of the EFMB configuration file (must be an EFC file with full pathname).
-efm_client {location:X;client:value; mem _file: value}
This option is available only for SmartFusion and Fusion; X identifies an EFMB from 0-3.

You must specify the client name and its memory content file for each client of EFMB you wish to
program.
Mem_file specifies the file with the memory content for the client. If you want to program a client with a
PDB or EFC file memory content (as defined by the -efm_content argument), the mem_file path should be
empty (see example 3); but if a mem_file path is specified, the memory content from this file will overwrite
the client content in PDB or EFC (as defined by the -efm_content argument).

-tie_off_arch {value}
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This optional argument is used only for IT6X6M2 and M7IT6X6M2 devices. Possible values:

Value Description

pull-down | Pull-down resistor: reduced quiescent power consumption

pull-up Pull-up resistor: compatible behavior for migrated ProASIC™"® designs

-set_io_state {value}

Sets the I/O state during programming by port name or pin number.

To set the I/O by port name, use -set_io_state {portName:<port name>; state:<state>}.
To set the I/O by pin number, use -set_io_state {pinNumber:<pin number>; state:<state>}.
To set all I/Os to the specified state, use -set_io_state {all; state:<state>}.

Possible state values:

Value Description
Tri-State Sets the I/O state to tristate
Last Known State Sets the 1/O state to last known state
High Sets the I/O state to high
Low Sets the I/O state to low

-pdb_file {name}

Optional PDB filename; if not specified the default is ‘expresspdbX'.
-enable_m3debugger {yes | no}

SmartFusion only; .enables the M3 debugger.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

Fusion example 1:
update_programming_file \
-feature {setup_security} \

-feature {prog_from} \
-from_content {ufc} \

-from_config_file {D:/from_ah.ufc} \
-number_of_devices {1} \

-from_program_pages {1 2 3456 7 } \
-custom_security {no} \

-security_permanent {no} \
-fpga_security_level {write_verify protect} \
-from_security_level {write_verify protect} \

-efm_block_security {location:1;security_level:write_verify protect} \
-efm_content {location:1;source:efc} \
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-efm_block {location:1;config_file:{D:\ nvm_all_new.efc}} \
-efm_client {location:1;client:asb;mem_file:{}} \
-efm_client {location:1;client:cfiData;mem_Ffile:{D:\cfid.mem}} \
-efm_client {location:1;client:ds;mem_file:{D:\ds.hex}} \
-efm_client {location:1;client:initl;mem Ffile:{D:\initl.hex}} \
-efm_client {location:1;client:raminit;mem_Ffile:{}}
Update loaded PDB file: use ufc file for FlashROM configuration and content; use efc file for block 1
configuration; efc memory content will be overwritten by memory content from specified mem files for
each client.
Fusion example 2:
update_programming_file \
-feature {prog_from} \
-from_content {pdb} \
-from_program_pages {1} \
-efm_content {location:1;source:pdb} \
-efm_client {location:1;client:cfiData;mem_Ffile:{D:\cfid.mem}}
Update loaded PDB file: use pdb data for FlashROM; program only page 1; use pdb data for block 1;
program only client cfiData; overwrite memory content for this client with memory content from the
specified file.
Fusion example 3:
update_programming_file \
-efm_content {location:1;source:pdb} \
-efm_client {location:1;client:cfiData;mem_Ffile:{D:\cfid.mem}} \
-efm_client {location:1;client:initl;mem_file:{}}
Update loaded PDB file: use pdb data for block 1; program client cfiData using memory content from the
specified file; program client initl using memory content from pdb (no mem_file path is specified) .
SmartFusion example:
update_programming_file \
update_programming_file \
-feature {setup_security:on} \
-feature {prog_fpga:off} \
-feature {prog_from:off} \
-feature {prog_nvm:on} \
-custom_security {no} \
-security_permanent {no} \
-fpga_security_level {none} \
-from_security_level {none} \
-efm_block_security {location:0;security_level:clients_jtag protect} \
-efm_block_security {location:1;security_ level:clients_jtag protect} \
-pass_key {73F09973E792EC9F462AE5A446FB6C77} \
-efm_content {location:0;source:pdb} \
-efm_block

{location:0;config_Ffile:{./eNVM_client_JTAG_protection_A2F500/allClients_Read ON_Write_O
N.efc}}

\
-pdb_file {./fpro_jtag/fpro_jtag 30.pdb} \
-enable_m3debugger {no}
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Troubleshooting

Loopback Test

The console software supports all JTAG functions and a diagnostic loopback test. Note that loopback is not
supported on all boards.
To perform the diagnostic test

1. Connect the loopback test board to the FlashPro.

2. Connect the FlashPro to the parallel/USB port of the PC.
3. Power-on the FlashPro.
4

From the Start menu, choose Programs > Microsemi FlashPro > Diagnotics. This opens the
diagnostics console program.

5. Connect to the FlashPro by entering openport Iptl or openport usb. The parallel port number depends
on the port used to connect the FlashPro.

6. Enter test. The unit runs into self-test mode. Do not interrupt the unit during self-test mode.

Note: To see a complete list of all functions, enter help. To get a more detail description of each function,
enter help <command>.

Exit Codes (SmartFusion2 and IGLOQO2)

Error Code Exit Exit Message Possible Cause Possible Solution
Code
0 Passed (no error) - -
0x8001 -24 Failure to read DSN Device is in System TRSTB should be driven High
Controller Suspend Mode or disable "System Controller
Check board connections Suspend Mode".
0x8002 5 Failure to configure device Unstable voltage level Monitor related power
programming at 1.2/1.0 VCC Signal integrity issues on supplies that cause the issue
voltage JTAG pins during programming; check

for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

0x8032 5 Device is busy Unstable VDDIx voltage level | Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
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Exit Codes (SmartFusion2 and IGLOO?2)

Error Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

specifications.

0x8003

Failed to enter programming
mode

Unstable voltage level

Signal integrity issues on
JTAG pins

DEVRST_N is tied to LOW

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

Tie DEVRST_N to HIGH prior
to programming the device.

0x8004

Failed to verify IDCODE

Incorrect programming file
Incorrect device in chain

Signal integrity issues on
JTAG pins

Choose the correct
programming file and select
the correct device in the
chain.

Measure JTAG pins and
noise for reflection. If TRST is
left floating then add pull-up
to pin.

Reduce the length of Ground
connection.

0x8
005
0x8
006

10

Failed to program eNVM

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

0x8007

11

Failed to verify FPGA Array

Failed to verify Fabric
Configuration

Failed to verify Security

Device is programmed with a
different design or the
component is blank.

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Verify the device is
programmed with the correct
data/design.

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x8008 11 Failed to verify eNVM Device is programmed with a | Verify the device is
0x8009 different design. programmed with the correct
Unstable voltage level. data/design.
Signal integrity issues on Monitor related power
JTAG pins. supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x8010 -35 Failed to unlock User Pass Pass key in file does not Provide a programming file
Key 1 match device with a pass key that matches
pass key programmed into
the device.
0x8011 -35 Failed to unlock User Pass Pass key in file does not Provide a programming file
Key 2 match device with a pass key that matches
pass key programmed into
the device.
0x8012 -35 Failed to unlock debug pass | Pass key in file does not Provide a programming file
key match device with a pass key that matches
pass key programmed into
the device.
0x8013 -18 Digest request from Digest request from Provide a programming file
SPI/JTAG is protected by SPI/JTAG is protected by with a pass key that matches
User Pass Key 1 user pass key 1. Lock bit has | pass key programmed into
been configured in the Debug | the device.
Policy within SPM (Security
Policy Manager)
0x8014 -19 Failed to verify digest Unstable voltage level Monitor related power
Signal integrity issues on supplies that cause the issue
JTAG pins during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.
Monitor JTAG supply pins
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Exit Codes (SmartFusion2 and IGLOO?2)

Error Code Exit Exit Message Possible Cause Possible Solution
Code
during programming;
measure JTAG signals for
noise or reflection.
0x8015 -20 FPGA Fabric digest Programming bitstream Use the same programming
verification: FAIL components do not match file that was used to program
components programmed the device.
FPGA Fabric is either erased
or the data has been
corrupted or tampered with
0x8016 -20 eNVM_0 digest verification: Programming bitstream Use the same programming
FAIL components do not match file that was used to program
components programmed the device.
eNVM_0 data has been
corrupted or tampered with
0x8017 -20 eNVM_1 digest verification: Programming bitstream Use the same programming
FAIL components do not match file that was used to program
components programmed the device.
eNVM_1 data has been
corrupted or tampered with
0x8018 -20 User security policies Programming bitstream Use the same programming
segment digest verification: components do not match file that was used to program
FAIL components programmed the device.
User security policy segment
data has been corrupted or
tampered with
0x8019 -20 User key set 1 segment Programming bitstream Use the same programming
digest verification: FAIL components do not match file that was used to program
components programmed the device.
User key set 1 segment data
has been corrupted or
tampered with
0x801A -20 User key set 2 segment Programming bitstream Use the same programming
digest verification: FAIL components do not match file that was used to program
components programmed the device.
User key set 2 segment data
has been corrupted or
tampered with
0x801B -20 Factory row and factory key Programming bitstream Use the same programming
segment digest verification: components do not match file that was used to program
FAIL components programmed the device.
Factory row and factory key
segment data has been
corrupted or tampered with
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
0x801C -20 Fabric configuration segment | Programming bitstream Use the same programming
digest verification: FAIL components do not match file that was used to program
components programmed. the device.
Fabric configuration segment
data has been corrupted or
tampered with
0x8 |-21 Device security prevented The device is protected with Run DEVICE_INFO to view
01D operation user pass key 1 and the security features that are
0x8 bitstream file does not contain | protected.
01E user pass key 1. Provide a bitstream file with a
User pass key 1 in the user pass key 1 that matches
bitstream file does not match | the user pass key 1
the device. programmed into the device.
Ox801F -22 Authentication Error eNVM has been locked by a | Release the lock on the
0x8020 Bitstream or data is corrupted master in your design eNVM after your master has
or noisy Running VERIFY action on a | completed its access
blank device. operations. Write 0x00 to
. ) "REQACCESS" register in
Sgﬁtre?erz file has been eNVM Control Registers
up (address 0x600801FC) to
Bitstream was incorrectly release the access.
generated Program the device prior to
running VERIFY action
Regenerate bitstream file.
0x8021 -23 Authentication Error File contains an encrypted Provide a programming file
0x8022 Invalid/Corrupted encryption key that does not match the with an encryption key that
key device matches that on the device.
Attempting to erase a device | Run DEVICE_INFO action to
with no security using master | verify that the device has no
security file security. If the device does
File contains user encryption | N0t have secuirty, you cannot
key, but device has not been | €rase it.
programmed with the user First program security with
encryption key master programming file, then
Device has user encryption | Program with user encryption
key 1/2 enforced and you are | 1/2 field update programming
attempting to reprogram files.
security settings You must first ERASE
security with the master
security file, then you can
reprogram new security
settings.
0x8 |-24 Authentication Error Design version is not higher | Generate a programming file
023 Back level not satisfied than the back-level with a design version higher
0x8 programmed device than the back level version.
024
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Exit Codes (SmartFusion2 and IGLOO?2)

Error Code Exit Exit Message Possible Cause Possible Solution
Code

0x8025 -25 Authentication Error DSN specified in Use the correct programming

0x8026 DSN binding mismatch programming file does not file with a DSN that matches
match the device being the DSN of the target device
programmed being programmed.

0x8027 -26 Authentication Error Device does not support the | Generate a programming file

0x8028 Insufficient device capabilities capabilities specified in with the correct capabilities
programming file for the target device.

0x8029 -27 Authentication Error Incorrect programming file Choose the correct

0x802A Incorrect DEVICEID Incorrect device in chain programming file and select

. . _ the correct device in chain.

Signal integrity issues on ]

JTAG pins Measure JTAG pinsand
noise or reflection. If TRST is
left floating, then add pull-up
to pin.

Reduce the length of ground
connection.
0x802B -28 Authentication Error Programming file version is Generate programming file
0x802C Programming file is out of out of date with latest version of Libero
date, please regenerate SoC.
0x802F -30 JTAG interface is protected Invalid or no UPK1 is User needs to provide correct
by UPK1 provided UPKZ1 to unlock device.
0x8030 -31 Authentication Error M2S090 Rev. A or M2S150 User can program a valid
0x8031 Invalid or inaccessible Device | Rev. A: Either certificate is application code. This can be
Certificate corrupted or the user hasn't done with SoftConsole.
provided the application code | FAB_ RESET_N should be

in the eNVM or provided tied to HIGH.

invalid application code

FAB_RESET_N is tied to

ground

0x8032 -32 Instruction timed out Unstable voltage level Monitor related power
0x8033 Signal integrity issues on supplies that cause the issue
0x8034 JTAG pins during programming; check
0x8035 for transients outside of
0x8036 Microsemi specifications. See
0x8037 your device datasheet for
0x8038 more information on transient
0x8039 specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x8040 -22 Authentication Error eNVM has been locked by a | Release the lock on the
Bitstream or data is corrupted | Master in your design eNVM after your master has
or noisy Running VERIFY action on a | completed its access
operations. Write 0x00 to
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Code
blank device. "REQACCESS" register in
Bitstream file has been eNVM Control Registers
corrupted (address 0x600801FC) to
. . release the access.
Bitstream was incorrectly ) ]
generated Prog_ram the device prior to
running VERIFY action
Regenerate bitstream file.
0x8041 -23 Authentication Error File contains an encrypted Provide a programming file
Invalid/Corrupted encryption key that does not match the with an encryption key that
key device matches that on the device.
File contains user encryption | Run DEVICE_INFO action to
key, but device has not been | verify that the device has no
programmed with the user security. If the device does
encryption key not have secuirty, you cannot
Attempting to erase a device |€raseit
with no security using master | First program security with
security file master programming file, then
Device has user encryption | Program with user encryption
key 1/2 enforced and you are | 1/2 field update programming
attempting to reprogram files.
security settings You must first ERASE
security with the master
security file, then you can
reprogram new security
settings.
0x8042 -24 Authentication Error Design version is not higher | Generate a programming file
Back level not satisfied than the back-level with a design version higher
programmed device than the back level version.
0x8043 -25 Authentication Error DSN specified in Use the correct programming
DSN binding mismatch programming file does not file with a DSN that matches
match the device being the DSN of the target device
programmed being programmed.
0x8044 -26 Authentication Error Device does not support the | Generate a programming file
Insufficient device capabilities | capabilities specified in with the correct capabilities
programming file for the target device.
0x8045 -27 Authentication Error Incorrect programming file Choose the correct
Incorrect DEVICEID Incorrect device in chain programming file and select
. . o the correct device in chain.
Signal integrity issues on
JTAG pins Measure JTAG pins and
noise or reflection. If TRST is
left floating, then add pull-up
to pin.
Reduce the length of ground
connection.
0x8046 -28 Authentication Error Old programming file Generate programming file
Unsupported bitstream with latest version of Libero
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Exit Codes (SmartFusion2 and IGLOO?2)

Error Code Exit Exit Message Possible Cause Possible Solution
Code
protocol version SoC.
0x8048 -31 Authentication Error M2S090 Rev. A or M2S150 User can program a valid
Invalid or inaccessible Device | Rev. A: Either certificate is application code. This can be
Certificate corrupted or the user hasn't done with SoftConsole.
provided the application code | EAB RESET N should be
in the eNVM or provided tied to HIGH.
invalid application code
FAB_RESET_N is tied to
ground
0x8049 11 Failed to verify eNVM Device is programmed with a | Verify the device is
different design. programmed with the correct
Unstable voltage level. data/design.
Signal integrity issues on Monitor related power
JTAG pins. supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
8x804A 10 Failed to program eNVM Unstable voltage level. Monitor related power
Signal integrity issues on supphes that cause the issue
JTAG pins. during programming; check
for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x804B -21 Device security prevented The device is protected with Run DEVICE_INFO to view
operation user pass key 1 and the security features that are
bitstream file does not contain | protected.
user pass key 1. Provide a bitstream file with a
User pass key 1 in the user pass key 1 that matches
bitstream file does not match | the user pass key 1
the device. programmed into the device.
0x804C 11 Failed to verify FPGA Array Device is programmed with a | Verify the device is
Failed to verify Fabric different design or the programmed with the correct
Configuration component is blank. data/design.
Monitor related power
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Error Code Exit Exit Message Possible Cause Possible Solution
Code

Failed to verify Security Unstable voltage level. supplies that cause the issue
Signal integrity issues on during programming; check
JTAG pins. for transients outside of
Microsemi specifications. See
your device datasheet for
more information on transient
specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

0x804D -36 <HSM related error message | HSM communication error. Check if HSM the

based on scenario> HSM call returns error. communication path to HSM
is up. Make sure project is
loaded properly and that HSM
tickets have not been
cleaned.

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for
Software v8.6 and Above

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in software v8.6
and ABOVE only. See the Device Exit Codes for pre-v8.6 Software help topic for exit codes for older
versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.
Table 24 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in Software
v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message

0 Passed (no
error)
1 A physical | Physical chain configuration has

chain does | been altered. Something has
not match | become disconnected in the
the chain.

expected The specific IR length of non-
set up from | Microsemi devices may be

the STAPL | incorrect.

file. The order of the specified chain
Also known | may be incorrect.

as
Checking
Chain
Error.

0x8052 5 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message

enter the issue during programming; check for

programmi | Unstable VCC transients outside of Microsemi

ng mode. specifications. See your device datasheet
Signal integrity issues on JTAG for more information on transient
pins. specifications.
Device is in FlashFreeze mode Monitor VJTAG during programming;
(ProASICL or IGLOO devices) measure JTAG signals for noise or

reflection.

Older software or programming
file used. Disble the FlashFreeze pin (ProASICL or

IGLOO devices)

Generate STAPL file with the latest

version of Designer/FlashPro.

Use latest version of FlashPro software.
0x801D 6 Failed to Incorrect programming file Choose the correct programming file and
0x8053 verify select the correct device in chain.

IDCODE Incorrect device in chain
Measure JTAG pins and noise or
Signal integrity issues on JTAG reflection. If TRST is left floating then add
pins pull-up to pin.

Reduce the length of ground connection.
0x8005 6 Failed to Programming file generated with | Generate STAPL file with the latest
0x8009 verify AES | an older version of software version of Designer/FlashPro. Use latest
0x800B Sec. version of FlashPro software.

Try again at a slower TCK.

Contact Microsemi Technical Support.
0x8008 6 Failed to File is not for M7, but target Check that the target device is M7

verify device is M7 enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the programming file you
Target is pins. generated is for an M7-enabled device.
an M7
device Measure JTAG pins, noise and reflection.
0x800A 6 Failed to Files not for M1, but target device | Check that the target device is M1
verify is M1. enabled.
IDCODE
Signal integrity issues on JTAG Make sure the programming file
Target is pins generated is for an M1-enabled device.
an M1
device Monitor VJTAG during programming;
measure JTAG signals for noise or
reflection.
0x800C 6 Failed to File is not for target device. Check the target device; make sure the
verify programming file generated is matches
IDCODE. Signal integrity issues on JTAG the target device.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
pins
Core Monitor VITAG during programming;
enabled measure JTAG signals for noise or
device reflection.
detected
0x800D 6 Failed to File is for M7 but target device is | Check that the target device is not M7
verify not M7. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the programming file
The target | pins. generated is for non-M7 enabled device.
is not M7
device Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x800E 6 Failed to File is for M1, but target device is | Check that the target device is not M1
verify not M1. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the generated
Target is pins programming file is for non-M1 enabled
not an M1 device.
device
Monitor VJTAG during programming;
measure JTAG signals for noise or
reflection.
0x8006 6 Failed to File is not for P1, but target device | Check that the target device is P1
verify is a P1 device. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure programming file generated is
Target is pins for M1 enabled device.
not a P1
device Monitor VJTAG during programming;
measure JTAG signals for noise or
reflection.
Ox801E 6 A3PE600 Contact Microsemi Technical Support
Engineerin
g Sample
Device
Detected.
This device
is
supported
with pre-
v8.3 SP1
STAPL
files only
0x8057 8 Failed Unstable VPUMP voltage level. Monitor related power supplies that cause
Erase the issue during programming; check for
Operation. | Unstable VCC transients outside of Microsemi

Unstable VCC_OSC (Fusion only)

specifications. See your device datasheet
for more information on transient
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VIJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8058 10 Failed to Monitor related power supplies that cause
program Unstable VPUMP voltage level. the issue during programming; check for
FPGA transients outside of Microsemi
array at Unstable VCC specifications. See your device datasheet
row <row for more information on transient
number>. | Unstable VCC_OSC (Fusion only) | specifications.
Unstable VCC_ROSC voltage Monitor VIJTAG during programming;
level (SmartFusion only) measure JTAG signals for noise or
reflection.
Signal integrity issues on JTAG
pins.
0x805D 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
Ox805E enable the issue during programming; check for
0x807B FPGA Unstable VCC transients outside of Microsemi
Array. specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x80 |10 Failed to Monitor related power supplies that cause
95 disable Unstable VPUMP voltage level. the issue during programming; check for
0x80 FPGA transients outside of Microsemi
96 Array. Unstable VCC specifications. See your device datasheet
0x80 . for more information on transient
97 Unstable VCC_OSC (Fusion only) | specifications.
Unstable VCC_ROSC voltage Monitor VIJTAG during programming;
level (SmartFusion only) measure JTAG signals for noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8061 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8062 program the issue during programming; check for
FlashROM. | Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
pins.
0x801B 10 Error Unstable VCC_NVM/VCC_0OSC Monitor related power supplies that cause
0x801C programmi | voltage level (Fusion only) the issue during programming; check for
0x806C ng transients outside of Microsemi
0x806D Embedded | Unstable specifications. See your device datasheet
Ox806E Flash VCC_ENVM/VCC_RCOSC for more information on transient
Memory voltage level (SmartFusion only) specifications.
Block
(EFMB) Signal integrity issues on JTAG Monitor VITAG during programming;
pins measure JTAG signals for noise or
reflection.
NVM corruption is possible when
writing from your design; check Reset signal is not properly tied off in
the NVM status for confirmation. your design.

Inspect device using Device Debug.
0x807D 10 Error Unstable VCC Monitor related power supplies that cause
0x807E programmi the issue during programming; check for

ng system [ Unstable VCC_OSC (Fusion only) | transients outside of Microsemi
init and specifications. See your device datasheet
boot clients | Unstable VCC_ROSC voltage for more information on transient
level (SmartFusion only) specifications.
Signal integrity issues on JTAG Monitor VIJTAG during programming;
pins measure JTAG signals for noise or
reflection.

Inspect device using Device Debug.
0x8069 10 Error Programming file generated with | Generate STAPL file with the latest
0x806A programmi | an older version of software version of Designer/FlashPro; use the
0x806B ng latest version of FlashPro software

Embedded

Flash Try again at a slower TCK

Memory

Block Inspect device using Device Debug.
(EMFB)

Contact Microsemi Technical Support
Ox808E 10 Error Try reprogramming
0x808F programmi
0x8090 ng Contact Microsemi Technical Support
0x8091 Embedded

Flash
Memory
Block
(EFMB)
0x807F 10 Error Programming file generated with | Generate STAPL file with the latest
0x8080 programmi | an older version of software version of Designer/FlashPro; use the
ng system latest version of FlashPro software
init and
boot clients Try again at a slower TCK
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& Microsemi

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8059 11 Verify 0 Unstable VPUMP voltage level. Monitor related power supplies that cause
0x805B failed at the issue during programming; check for
row <row Unstable VCC transients outside of Microsemi
number> specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
Verify 1 specifications.
failed at Unstable VCC_ROSC voltage
row <row level (SmartFusion only) Monitor VJTAG during programming;
number>. measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8060 11 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
Failed to different design. device is programmed with the correct
verify data/design.
FlashROM [ Unstable VPUMP voltage level.
at row Monitor related power supplies that cause
<FlashRO | Unstable VCC the issue during programming; check for
M row transients outside of Microsemi
number>. | Unstable VCC_OSC (Fusion only) | specifications. See your device datasheet
for more information on transient
Unstable VCC_ROSC voltage specifications.
level (SmartFusion only)
Monitor VJTAG during programming;
Signal integrity issues on JTAG measure JTAG signals for noise or
pins. reflection.
0x8075 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8076 verify different design. correct data/design.
0x8077 Embedded
Flash Unstable VCC Monitor related power supplies that cause
Memory the issue during programming; check for
Block Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(EFMB) (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins, and noise or
reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the
target EFMB block is locked with
The EFMB data was modified in FlashLock (pass key). If the target EFMB
your FPGA design after block is locked, then you must unlock it
programming. This could have by erasing the security and then
occurred during standalone verify. | reprogramming with the desired security
settings. After unlocking the target EFMB
The target EFMB is locked with block attempt to rerun the target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARR | Inspect device using Device Debug.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
AY or
VERIFY_NVM_ACTIVE_ARRAY.
0x8085 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8086 verify different design. correct data/design.
system init
and boot Unstable VCC Monitor related power supplies that cause
clients the issue during programming; check for
Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins, and noise or
reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the
target EFMB block is locked with
The EFMB data was modified in FlashLock (pass key). If the target EFMB
your FPGA design after block is locked, then you must unlock it
programming. This could have by erasing the security and then
occurred during standalone verify. | reprogramming with the desired security
settings. After unlocking the target EFMB
The target EFMB is locked with block attempt to rerun the target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARR | Inspect device using Device Debug.
AY or
VERIFY_NVM_ACTIVE_ARRAY.
0x8072 11 Failed to Programming file generated with | Generate STAPL file with the latest
0x8073 verify an older version of software version of Designer/FlashPro; use the
0x8074 Embedded latest version of FlashPro software
Flash
Memory Try again at a slower TCK
Block
(EFMB) Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8083 11 Failed to Programming file generated with | Generate STAPL file with the latest
0x8084 verify an older version of software version of Designer/FlashPro; use the
system init latest version of FlashPro software
and boot
clients Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8014 11 Failed to Unstable VCC Monitor related power supplies that cause
0x8015 verify the issue during programming; check for
calibration | Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
data (Fusion only) specifications. See your device datasheet

Unstable

for more information on transient
specifications.
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& Microsemi

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins
Try reprogramming.
Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x805A 11 Verify 0 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
0x805C failed at different design device is programmed with the correct
row <row data/design.
number> . | Unstable VPUMP voltage level.
Monitor related power supplies that cause
Verify 1 Unstable VCC the issue during programming; check for
failed at transients outside of Microsemi
row <row Unstable VCC_OSC (Fusion only) | specifications. See your device datasheet
number> for more information on transient
Unstable VCC_ROSC voltage specifications.
level (SmartFusion only)
Monitor VJTAG during programming;
Signal integrity issues on JTAG measure JTAG signals for noise or
pins reflection.
0x8063 14 Failed to Signal integrity issues on JTAG Monitor related power supplies that cause
program pins. the issue during programming; check for
Silicon transients outside of Microsemi
Signature. specifications. See your device datasheet
Failed to for more information on transient
program specifications.
security
lock Monitor VIJTAG during programming;
settings. measure JTAG signals for noise or
reflection.
0x8068 -18 Failed to Incorrect AES key. Generate a programming file with the
authenticat correct AES key.
e the Signal integrity issues on JTAG
encrypted | pins. Monitor VIJTAG during programming;
data. measure JTAG signals for noise or
reflection.
Ox805F -20 Failed to Programming file generated with | Generate STAPL file with the latest
verify an older version of software version of Designer/FlashPro; use the
FlashROM latest version of FlashPro software.
at row Device is programmed with a
<FlashRO | different design. Program with the correct data/design.
M row
number>. | Unstable VPUMP voltage level. Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8065 -22 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
pass key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8066 -23 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
AES key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8055 -24 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8056 program the issue during programming; check for
UROW. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
Make sure you mounted 0.01pF and
0.33uF caps on Vpump (close to the pin).
0x802A -27 FlashROM | File contains no passkey and Provide a programming file with a
Write/Eras | device is secured with a passkey. | passkey that matches the passkey
eis programmed into the device.
protected Passkey in the file does not
by the match device.
passkey.
A valid
passkey
needs to
be
provided.
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& Microsemi

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
0x8025 -28 FPGA File contains no passkey and Provide a programming file with a
Array device is secured with a passkey. | passkey that matches the passkey
Write/Eras | Passkey in the file does not programmed into the device.
eis match device.
protected
by the
passkey.
A valid
pass key
needs to
be
provided.
0x802B -29 FlashROM | File contains no passkey and Provide a programming file with a pass
0x802D Read is device is secured with a passkey. | key that matches the passkey
protected Passkey in the file does not match | programmed into the device
by device.
passkey.
A valid
passkey
needs to
be
provided.
0x8024 -30 FPGA File contains no passkey and Provide a programming file with a
0x8026 Array device is secured with a passkey. | passkey that matches the passkey
verification | Passkey in the file does not programmed into the device.
is match device.
protected
by a
passkey.
A valid
passkey
needs to
be
provided.

-31 Failed to AES key in the file does not match | Provide a programming file with an AES
0x804B verify AES | the device. key that matches the AES key
0x8001 key. programmed into the device.
0x8007 Unstable VCC

Monitor related power supplies that cause

Unstable VCC_OSC (Fusion only) [ the issue during programming; check for
transients outside of Microsemi

Unstable VCC_ROSC voltage specifications. See your device datasheet

level (SmartFusion only) for more information on transient
specifications.

Unstable JTAG/VPUMP voltage

level. Monitor VJTAG during programming;
measure JTAG signals for noise or
reflection.

0x8000 -31 Failed to Programming file generated with | Generate STAPL file with the latest
verify AES | an older version of software version of Designer/FlashPro; use the
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ERROR_CODE

Exit
Code

Exit
Message

Possible Cause

Possible Solution

key.

latest version of FlashPro software.
Try again at a slower TCK

Contact Microsemi Technical Support

0x8020
0x8022
0x8028

FPGA
Array
encryption
is
enforced. A
programmi
ng file with
encrypted
FPGA
array data
needs to
be
provided.

File contains unencrypted array
data, but device contains AES
key.

Provide a programming file with an
encrypted FPGA Array data.

0x802C
0x802F

FlashROM
encryption
is
enforced. A
programmi
ng file with
encrypted
FlashROM
data needs
to be
provided.

File contains unencrypted
FlashROM data, but the device
contains an AES key.

Provide a programming file with an
encrypted FlashROM data.

0x801F
0x804A

Failed to
match pass
key.

Pass key in file does not match
pass key in device.

Provide a programming file with a pass
key that matches the pass key
programmed into the device.

0x802E
0x8030

FlashROM
Encryption
is not
enforced.

Cannot
guarantee
valid AES
key
present in
target
device.

Unable to
proceed
with
Encrypted
FlashROM
programmi

File contains encrypted
FlashROM, but device encryption
is not enforced for FlashROM

Regenerate security programming file
with proper AES key.

Program device security.

Retry programming FlashROM with
encrypted programming file.
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
ng.
0x8021 -37 FPGA File contains encrypted FPGA Regenerate security programming file
0x8023 Array Array, but the device encryption is | with proper AES key.
0x8027 Encryption | not enforced for FPGA Array.
0x8029 is not Program device security.
enforced.
Retry programming FPGA Array with
Cannot encrypted programming file.
guarantee
valid AES
key
present in
target
device.
Unable to
proceed
with
Encrypted
FPGA
Array
verification.
0x8067 -38 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
pass key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
Bad device.
0x806F -39 ERROR: 2 | Unstable VCC_NVM/VCC_OSC Monitor related power supplies that cause
0x8070 or more voltage (Fusion only) the issue during programming; check for
0x8071 errors transients outside of Microsemi
0x8081 found on Unstable specifications. See your device datasheet
0x8082 this page VCC_ENVM/VCC_ROSC for more information on transient
0x8089 (SmartFusion only) specifications.
NVM reset signal is floating in Bias NVM reset to a logic state in user
user design design.
2 or more ECC errors found when | Try reprogramming.
reading the eNVM
0x8010 -39 ERROR: 2 |2 or more ECC errors found when | The master calibration data has been
or more reading the master calibration corrupted. Try restoring master
errors data calibration from backup, if it exists, by
found on running RECOVER_CALIB.
this page.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Workaround: Disable optional procedure
CHECK_ AND _BACKUP_CALIB
0x8013 -39 ERROR: 2 |2 or more ECC errors found when | Rerun action to attempt to write backup
or more verifying the backup calibration calibration again.
errors
found on Workaround: Disable optional procedure
this page. CHECK_ AND_ BACKUP_CALIB
0x8078 -40 Embedded [ Data in the file is encrypted with a | Verify the programming file is generated
0x8079 Flash different AES key than the device. | from the latest version of
0x807A Memory Designer/FlashPro.
0x8087 Block MAC
0x8088 Failure.
0x8002 -42 Failed to File security settings do not match | Provide a programming file with security
0x8003 verify device. setting that match the security settings
security programmed into the device.
settings.
0x8093 -42 Failed to Device eNVM/EFMB client JTAG | Verify the device is programmed with the
verify protection settings are not correct eNVM/EFMB client JTAG
eNVM/EF | programmed or are programmed | protection settings
MB client [ with different settings
JTAG
protection
settings
0x8004 -43 Failed to File checksum and design name | Verify the device is programmed with the
verify do not match the device. correct data and design.
design
information
0x8049 -44 Failed to The AES key in the file does not Provide a programming file with an AES
verify AES | match the AES key in the device. | key that matches the AES key
key. File does not contain an AES key [ programmed into the device.
and the device is secured with an
AES key.
0x8054 -45 Device Programming file was generated | Generate STAPL file with the latest
package with an older version of software | version of Designer/FlashPro; use the
does not latest version of FlashPro software.
match the
programmi
ng file.
0x8033 -46 Embedded | File contains no pass key or Provide a programming file with the
0x8038 Flash incorrect pass key but EFMB read | correct pass key.
0x803D Memory is secured with a pass key.
0x8042 Block X
0x8045 Read is
0x8046 protected
0x8047 by pass
0x8048 key. A valid
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ERROR_CODE

Exit
Code

Exit
Message

Possible Cause

Possible Solution

pass key
needs to
be

provided.

0x8034
0x8039
0x803E
0x8043

Embedded
Flash
Memory
Block
(EFMB)
block X
Read is not
protected
by pass
key.

EFMB
content is
not secure
after
encrypted
programmi

ng.

Unable to
proceed
with
encrypted
NVM
programmi

ng.

File contains encrypted EFMB for
block X but the device encryption
is not enforced for EFMB block X.

Regenerate security programming file
with the proper AES key.

Program device security. Retry
programming with EFMB block X with
encrypted programming file.

0x8032
0x8037
0x803C
0x8041

Embedded
Flash
Memory
Block
(EFMB)
block X
encryption
is
enforced. A
programmi
ng file with
encrypted
EFMB data
needs to
be
provided.

The programming EFMB data is
not encrypted, but the device
contains an AES key with
encryption enforced.

Provide a programming file with
encrypted EFMB data.

0x8031
0x8036
0x803B
0x8040

Embedded
Flash
Memory
Block
(EFMB)
block X

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming file with a
passkey that matches the passkey
programmed into the device.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message

Write is
protected
by pass
key.

A valid
pass key
needs to
be
provided.

0x8035 -49 Embedded | File contains encrypted EFMB for | Regenerate security programming file
0x803A Flash block X, but the device encryption | with proper AES key.

0x803F Memory is not enforced for EFMB block X.
0x8044 Block Program device security. Retry
(EFMB) programming EFMB block X with
block X encrypted programming file.
Encryption
is not
enforced.

Cannot
guarantee
valid AES
key
present in
target
device.

Unable to
proceed
with
Encrypted
EFMB
programmi

ng.

0x801A -50 No backup [ No backup calibration copy has If master copy is still intact, rerun Action
calibration | been made or the backup copy to create backup calibration copy.

data found | has been corrupted
or backup Workaround: Disable optional procedure
calibration CHECK_AND_BACKUP_CALIB

data has
been
corrupted

8x804E -51 Failed to This version of the silicon does If programming the EFMB while the
access not support programming of the FPGA is active is not required, then use
Embedded | Embedded Flash Memory Block actions PROGRAM_NVM or

Flash while the FPGA Array is active. VERIFY_NVM. Otherwise, use latest
Memory. revision of silicon.

(AFS600

only)

0x804F -52 Failed to This version of the silicon does If programming the EFMB while the
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
access not support programming of the FPGA is active is not required, then use
Embedded | Embedded Flash Memory Block actions PROGRAM_NVM or
Flash while the FPGA Array is active. VERIFY_NVM. Otherwise, use latest
Memory. revision of silicon.
(AFS1500
only)
0x8050 -53 Failed to This version of the silicon does If programming the EFMB while the
access not support programming block 3 | FPGA is active is not required, then use
Embedded | of the EFMBs while the FPGA actions PROGRAM_NVM or
Flash Array is active. VERIFY_NVM. Otherwise, use EFMB
Memory. blocks 0, 1, or 2, but do not use block 3.
(AFS1500
only)
0x8051 -54 Failed to FPGA Array is accessing the If programming the EFMB while the
access target EFMB block while FPGA is active is not required, then use
Embedded [ attempting programming. actions PROGRAM_NVM or
Flash VERIFY_NVM. Otherwise, check the
Memory. NVM reset signal is stuck in FPGA design or use a different EFMB
design. block that is not being accessed. Check if
target EFMB block logic is tied to reset.
Unstable VCC
Monitor related power supplies that cause
MSS Clock is disabled during the issue during programming; check for
programming. transients outside of Microsemi
specifications. See your device datasheet
MSS Clock is not properly routed | for more information on transient
to the correct pin. specifications.
Verify that the NVM reset signal in the
design is not stuck.
Verify the MSS clock is enabled during
programming.
If the MSS clock is defined as an external
I/O, then verify that it is properly routed to
the correct pin.
0x808A -55 Failed to Programming file generated with | Generate STAPL file with the latest
0x8094 read an older version of software version of Designer/FlashPro; use the
Embedded latest version of FlashPro software
Flash
Memory Try again at a slower TCK
Block
(EFMB) Inspect device using Device Debug
Contact Microsemi Technical Support
0x808B -55 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
read the issue during programming; check for
Embedded | Unstable VCC transients outside of Microsemi
Flash specifications. See your device datasheet
Memory Unstable VCC_OSC (Fusion only) | for more information on transient
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Block specifications.
(EFMB) Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VIJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins
0x808C -55 Failed to Internal errror Contact Microsemi Technical Support
read
Embedded
Flash
Memory
Block
(EFMB)
0x8011 -56 Failed to Try reprogramming.
read
calibration Workaround: Disable optional procedure
data CHECK_AND_BACKUP_CALIB
0x8012 -56 Failed to Unstable VCC Monitor related power supplies that cause
read the issue during programming; check for
calibration | Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
data (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG voltages, noise, and
reflection.
Signal integrity issues on JTAG
pins Try reprogramming.
Workaround: Disable optional backup
procedure CHECK_BACKUP_CALIB
0x808D -57 eNVM/EF | File contains no Pass Key and Provide a programming file with a Pass
0x8092 MB is device is secured with a Pass Key | Key that matches the Pass Key
protected programmed into the device
by a Pass | Pass Key in the file does not
Key; you match device
must
provide a
valid Pass
Key

SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for
pre-v8.6 Software

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in pre-v8.6 software
only. This includes v8.5 SP2, v8.5 SP1, v8.5, etc. See the Device Exit Codes for Software v8.6 and Above
help topic for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.
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& Microsemi
SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for pre-v8.6 Software

Table 25 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in pre-v8.6

Software

Exit Exit Message Possible Cause Possible Solution

Code

0 Passed (no error).

1 A physical chain Physical chain configuration has
does not match the | been altered. Something has
expected set up become disconnected in the chain.
from the STAPL The specific IR length of non-
file. Microsemi devices may be
Also known as incorrect.

Checking Chain The order of the specified chain

Error. may be incorrect.

5 Failed to enter Monitor VPUMP voltage
programming Unstable VPUMP voltage level. during programming
mode.

Signal integrity issues on JTAG Measure JTAG

pins. voltages, noise, and
reflection.

Older software or programming file

used. Generate STAPL file
with the latest version of
Designer/FlashPro.
Use latest version of
FlashPro software.

6 Failed to verify Measure JTAG pins,
IDCODE. Signal integrity issues on JTAG noise and reflection.

pins.

8 Failed Erase Signal integrity issues on JTAG Monitor VPUMP voltage
Operation. pins. during programming.

Measure JTAG
voltages, noise, and
reflection.

10 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage
FPGA array at row | pins. during programming.

", rowNumber,"." Measure JTAG
voltages, noise, or
reflection.

10 Failed to enable Signal integrity issues on JTAG Monitor VPUMP voltage
FPGA Array. pins. during programming.

Measure JTAG
voltages, noise, or
reflection.

10 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage
FlashROM. pins. during programming.

Measure JTAG
voltages, noise, and
reflection.
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Exit Exit Message Possible Cause Possible Solution

Code

11 Verify O failed at Device is programmed with a Run
row",rowNumber,"." | different design. VERIFY_DEVICE_INFO
Verify 1 failed at to verify the device is
row",rowNumber,"." | Signal integrity issues on JTAG programmed with the

Failed to verify pins. correct data/design.
FlashROM at Monitor VPUMP voltage
row",from during programming.
rowNumber-1. Measure JTAG

voltages, noise and
reflection .

14 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage
Silicon Signature. | pins. during programming.
Failed to program Measure JTAG
security lock voltages, noise, and
settings. reflection.

-18 Failed to Incorrect AES key. Generate a
authenticate the programming file with
encrypted data. Signal integrity issues on JTAG the correct AES key.

pins.
Measure JTAG
voltages, noise and
reflection

-20 Failed to verify Device is programmed with a Program with the
FlashROM at row | different design. correct data/design.
FRomRowNumber- | Signal integrity issues on JTAG Monitor VPUMP level
1. pins. during programming.

Measure JTAG pins and
noise or reflection.

-22 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage
pass key. during programming.

Signal integrity issues on JTAG

pins. Measure JTAG
voltages, noise, and
reflection.

-23 Failed to program Unstable VPUMP voltage level. Monitor VPUMP
AES key. voltage during

Signal integrity issues on JTAG programming.

pins.
Measure JTAG pins
and noise or reflection.

-24 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage
UROW. during programming.

Signal integrity issues on JTAG

pins. Measure JTAG
voltages, noise, and
reflection.
Make sure you mounted
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Exit Exit Message Possible Cause Possible Solution

Code

0.01iF and 0.33iF caps
on Vpump (close to the
pin).

-25 Failed to enter Signal integrity issues on JTAG Measure JTAG
programming mode | pins. voltages, noise, and

reflection.

-26 Failed to enter Signal integrity issues on JTAG Measure JTAG
programming mode | pins. voltages, noise, and

reflection.

-27 FlashROM File contains no passkey and device | Provide a programming
Write/Erase is is secured with a passkey. file with a passkey that
protected by the Passkey in the file does not match | matches the passkey
passkey. device. programmed into the
A valid passkey device.
needs to be
provided.

-28 FPGA Array File contains no passkey and device | Provide a programming
Write/Erase is is secured with a passkey. file with a passkey that
protected by the Passkey in the file does not match | matches the passkey
passkey. device. programmed into the
A valid pass key device.
needs to be
provided.

-29 FlashROM Read is | File contains no passkey and device | Provide a programming
protected by is secured with a passkey. file with a pass key that
passkey. Passkey in the file does not match matches the passkey
A valid passkey device. programmed into the
needs to be device
provided.

-30 FPGA Array File contains no passkey and device | Provide a programming
verification is is secured with a passkey. file with a passkey that
protected by a Passkey in the file does not match | matches the passkey
passkey. device. programmed into the
A valid passkey device.
needs to be
provided.

-31 Failed to verify AES key in the file does not match | Provide a programming
AES key. the device. file with an AES key that

matches the AES key
Unstable JTAG/VPUMP voltage programmed into the
level. device.

Monitor

VPUMP/VVJITAG voltage

during programming.

Measure JTAG

voltages, noise, and
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Exit Exit Message Possible Cause Possible Solution
Code
reflection.
-32 Failed to verify File is not for M7, but target device | Check that the target
IDCODE. is an M7. device is M7 enabled.
Target is an M7 Make sure
device Signal integrity issues on JTAG programming file
pins. generated is for M7
enabled device.
Measure JTAG pins ,
noise, and reflection.
-32 Failed to verify File is not for M1, but target device | Check that the target
IDCODE. is an M1 device. device is M1 enabled.
Target is an M1 Make sure programming
device Signal integrity issues on JTAG file generated is for M1
pins. enabled device.
Measure JTAG pins,
noise, and reflection.
-32 Failed to verify File is not for target device. Check the target device.
IDCODE. Make sure programming
Core enabled Signal integrity issues on JTAG pins | file generated for target
device detected device.
Measure JTAG
voltages, noise, and
reflection.
-32 Failed to verify File is for M7, but target device is Check that the target
IDCODE. not M7. device is not M7
The target is not enabled.
an M7 device Signal integrity issues on JTAG Make sure programming
pins. file generated is for non
M7 enabled device.
Measure JTAG
voltages, noise, and
reflection.
-32 Failed to verify File is for M1, but target device is Check that the target
IDCODE. not an M1 device. device is not M1
The target is not an enabled.
M1 device Signal integrity issues on JTAG Make sure
pins. programming file
generated is for non M1
enabled device.
Measure JTAG
voltages, noise and
reflection.
-33 FPGA Array File contains unencrypted array Provide a programming
encryption is data, but device contains AES key. | file with an encrypted
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Exit Exit Message Possible Cause Possible Solution

Code
enforced. A FPGA Array data.
programming file
with encrypted
FPGA array data
needs to be
provided.

-34 FlashROM File contains unencrypted Provide a programming
encryption is FlashROM data, but the device file with an encrypted
enforced. A contains an AES key. FlashROM data.
programming file
with encrypted
FlashROM data
needs to be
provided.

-35 Failed to match Pass key in file does not match Provide a programming
pass key. pass key in device. file with a pass key that

matches the pass key
programmed into the
device.

-36 FlashROM File contains encrypted FlashROM, | Regenerate security
Encryption is not but device encryption is not programming file with
enforced. enforced for FlashROM proper AES key.
Cannot guarantee Program device
valid AES key security.
present in target
device. Retry programming

FlashROM with
Unable to proceed encrypted programming
with Encrypted file.
FlashROM
programming.

-37 FPGA Array File contains encrypted FPGA Regenerate security
Encryption is not Array, but the device encryption is programming file with
enforced. not enforced for FPGA Array. proper AES key.
Cannot guarantee Program device
valid AES key security.
present in target
device. Retry programming

FPGA Array with
Unable to proceed encrypted programming
with Encrypted file.
FPGA Array
verification.

-38 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage

pass key. during programming.
Signal integrity issues on JTAG
pins. Measure JTAG pins
Bad device. and noise or reflection.
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Exit
Code

Exit Message

Possible Cause

Possible Solution

Failed to verify
Embedded Flash
Memory Block
(EFMB).

Device is programmed with a
different design.

Signal integrity issues on JTAG
pins.

The EFMB data was modified
through user FPGA design after
programming; this could occur
during standalone verify.

The target EFMB block is locked
with FlashLock when running
ACTION
PROGRAM_NVM_ACTIVE_ARRAY
or VERIFY_NVM_ACTIVE_ARRAY.

Verify the device is
programmed with the
correct data/design.

Monitor VPUMP
voltage during
programming.

Measure JTAG pins
and noise or reflection.

Run DEVICE_INFO to
confirm if the target
EFMB block is locked
with FlashLock (pass
key). If the target EFMB
block is locked, then
you must unlock it by
erasing the security and
then reprogramming
with the desired security
settings. After unlocking
the target EFMB block
attempt to rerun the
target ACTION.

Embedded Flash
Memory Block
MAC Failure.

Data in the file is encrypted with a
different AES key than the device.

Verify the programming
file is generated from
the latest version of
Designer/FlashPro.

Error programming
Embedded Flash
Memory Block.
(EFMB)

Signal integrity issues on JTAG
pins.

Measure JTAG pins and
noise or reflection.

Failed to verify
security settings.

File security settings do not match
device.

Provide a programming
file with security setting
that match the security
settings programmed
into the device.

Failed to verify
design information.

File checksum and design name do
not match the device.

Verify the device is
programmed with the
correct data and design.

Failed to verify
AES key.

The AES key in the file does not
match the AES key in the device.
File does not contain an AES key
and the device is secured with an
AES key.

Provide a programming
file with an AES key that
matches the AES key
programmed into the
device.

Device package
does not match the
programming file.

216

FlashPro User's Guide




NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi
SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for pre-v8.6 Software

Exit
Code

Exit Message

Possible Cause

Possible Solution

Embedded Flash
Memory Block X
Read is protected
by pass key. A
valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key but EFMB read is
secured with a pass key.

Provide a programming
file with the correct pass
key.

Embedded Flash
Memory Block,
block X encryption
is enforced. A
programming file
with encrypted
EFMB data needs
to be provided.

The programming EFMB data is not
encrypted, but the device contains
an AES key with encryption
enforced.

Provide a programming
file with encrypted
EFMB data.

Embedded Flash
Memory Block
(EFMB) block X
Write is protected
by pass key.

A valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming
file with a passkey that
matches the passkey
programmed into the
device.

Embedded Flash
Memory Block
(EFMB) block X
Encryption is not
enforced.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed
with Encrypted
EFMB
programming.

File contains encrypted EFMB for
block X, but the device encryption is
not enforced for EFMB block X.

Regenerate security
programming file with
proper AES key.

Program device
security. Retry
programming EFMB
block X with encrypted
programming file.

Failed to access
Embedded Flash
Memory.
(AFS600 only)

This version of the silicon does not
support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use latest
revision of silicon.

Failed to access
Embedded Flash

This version of the silicon does not
support programming of the

If programming the
EFMB while the FPGA
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Exit Exit Message
Code

Possible Cause

Possible Solution

Memory.
(AFS1500 only)

Embedded Flash Memory Block
while the FPGA Array is active.

is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use latest
revision of silicon.

-53 Failed to access
Embedded Flash
Memory.
(AFS1500 only)

This version of the silicon does not
support programming block 3 of the
EFMBs while the FPGA Array is
active.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use EFMB
blocks 0, 1, or 2, but do
not use block 3.

-54 Failed to access
Embedded Flash
Memory.

FPGA Array is accessing the target
EFMB block while attempting
programming.

NVM reset signal is stuck in design.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, check the
FPGA design or use a
different EFMB block
that is not being
accessed. Check if
target EFMB block logic
is tied to reset.

Verify that the NVM
reset signal in the
design is not stuck.

ProASICP"Y® and ProASIC Exit Codes

The table below lists the exit codes for ProASIC

PLUS

and ProASIC family devices.

Table 26 - ProASIC ™“® and ProASIC Family Devices Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

0 This message
means passed.
This does not
indicate an error.

A physical chain
does not match the
expected set up
from the STAPL
file.

Physical chain
configuration has been
altered. Something has
become disconnected in
the chain.
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Exit Code

Exit Message

Possible Cause

Possible Solution

Also known as
Checking Chain
Error.

The specific IR length of
non-Microsemi devices
may be incorrect.

The order of the
specified chain may be
incorrect.

algorithm: alg=x,
prev=x Invalid data
read from device

STAPL files when the
revision written into the
factory row is not rev 1
for ProASICPLUS or rev
2 for ProASIC devices.
The STAPL files from last
year may "exit 7" with
newer devices or the
older revision may cause
this failure if the STAPL
file used is from latest
version.

It can occur if you are
using Engineering
Sample parts that are no
longer supported, such

2 There is a reading | The device either does Check the device ID.

device ID failure. not have a valid device
ID or the data cannot be
read correctly.

3 This occurs when | Connect was set up for a | Set up for a
using ProASIC™"® | ProASIC device and the | ProASIC™"® device.
devices. device is actually

ProASIC™"®,

5 Programming set | The A500K device Power the VDDL
up problem. Also senses the VDDL power | down during
known as Entering | supply as being on. programming. Check
ISP Failure. the device has the

correct voltages on
VDDP, VDDL, VPP,
and VPN.

6 The IDCODE of The device targeted in Choose the correct
the target device the STAPL file does not | STAPL file and select
does not match the | match the device being the correct device.
expected value in | programmed. Measure JTAG pins
the STAPL file. User selected wrong and noise or
This is a JEDEC device. reflection. TRST
standard message. | Device TRST pin is should be floating or

grounded. tied high.
Noise or reflections on Cut down the extra
one or more of the JTAG | length of ground
pins caused by the IR connection.
Bits reading it back
incorrectly.

7 Unknown This occurs with current | Re-generate STAPL

file from Designer 6.1
SP1.

Replace A500K ES
parts with
commercial parts.
Double check VPP
and VPN
connections.

Make sure VPP and
VPN have correct
bypass caps.

Make sure that your
power supply can
deliver the correct
current during
programming.
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Exit Code

Exit Message

Possible Cause

Possible Solution

as ProASIC Engineering
Sample parts.

This error can also occur
if the programmer has
trouble reading the
factory row due to signal
noise, crosstalk, or
reflections on the JTAG
signal and clock lines.

It can occur if you
program an -F
ProASICPLUS device
with an old STAPL file.
This error occurs if you
connected VPP and VPN
the wrong way.

It occurs if there are no
bypass Caps on VPP
VPN, which damaged the
device.

This error may occur if
your power supply
cannot source the correct
current for programming.

FPGA failed during
the erase
operation.

The device is secured,
and the corresponding
STAPL file is not loaded.
The device has been
permanently secured and
cannot be unlocked.

Load the correct
STAPL file.

11

FPGA failed verify

The device is secured
and the corresponding
STAPL file is not loaded.
You used the Libero IDE
software v2.3 or earlier or
the Designer R1-2003
software or earlier to
generate the STAPL file.
VPN caps were soldered
in the wrong polarity.

Load the correct
STAPL file.

Use later software
versions —at least
Libero v2.3 SP1 and
Designer R1-2003
SP1.

Double-check the
VPN bypass caps
polarity.

12

Security is
enabled.

The device is secured
and the wrong
key/STAPL file was
entered.

The device is damaged.
The verification was
interrupted and therefore
fails, causing the
software to think the
device is secure.
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Exit Code

Exit Message

Possible Cause

Possible Solution

14

Program security
failure.

15

This is a factory
Calibration Data
CRC error.

During program, erase,
or verify, you must read
back Calibration Data
from the FPGA. The data
contains a CRC. You use
the CRC to ensure the
data is not
corrupted/wrong.

Device is damaged.
Noise on the FTAL
signals causes the
programmer to read back
wrong data.

17

The device has
been secured.
Write-security is
enabled.

The device is secured
and the wrong key or
STAPL file was entered.
The device is damaged.

Load the correct
STAPL file.

Failed to access
Embedded Flash
Memory

Analog power supplies
(Vccl5A, Vee33A,
GNDAQ and GNDA) are
not connected.

Connect the analog
power supplies
(Vccl5A, Vee33A,
GNDAQ and GNDA)

Error code results
from STAPL files

for A500K devices.

An internal calibration
(based on DDP and
VPP) failed.

Check voltages on
the device pins.
Check voltages on
the VDDP and VPP
pins.

Unexpected RCK
detected.

Noise on the RCK signal.
You connected a CLK
source to the RCK signal.
The polarized bypass
capacitors on VPP or
VPN are reversed-biased
and are affecting the
programmer’s VPP or
VPN output voltage. This
causes programming to
fail. Several FlashPros
are programming at the
same time and are too
close to each other.
Programmer not properly
installed by Admin.

Disconnect the RCK
and make sure TCK
has a clean signal.
Separate FlashPros
away from each other
while they are
programming Internal
ISP.

Connect programmer
as an Admin in
FlashPro.

Calibration data
parity error.

Device is damaged.

Replace the device.

Null

Several FlashPros are
programming at the

ProASICPLUS and ProASIC Exit Codes
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Exit Code Exit Message Possible Cause Possible Solution
same time and are too
close to each other.
FlashPro connects to PC
parallel port through a
dongle key.
Data length mismatch
when performing
DRSCAN on STAPL file.
Cable to target is When the Analyze Confirm the
not connected command is executed, connection between
properly. the FlashPro looks for the header to the
target devices. If the device. If the board
cable connection is supplies the power to
wrong, FlashPro the device, make
assumes that nothing is | sure the voltage level
connected at all. is correct.
Chain integrity test | The connection between | Secure the
failed: xx the FlashPro connections.
programmer and the Check the JTAG pins
device is broken. for signal activity.
The programmer cable Check for broken
might not be securely TDO, TMS, and TCK
inserted into the header. | pins.
The header is not After checking all
connected to the JTAG type of connections if
pins of the FPGA the failure exists, you
correctly. may need to replace
The configuration setting | the first device (the
(ProASIC/ProASICPLUS) | devices closest to the
does not match the TDO of the
target device. programming header)
Noise or reflections on in the chain.
the JTAG pins has Remove the dongle.
caused communication
between the programmer
and the device to fail.
A dongle is plugged in
between the PC parallel
port and the FlashPro
parallel port cable.
Could not connect | The remote device does | Make sure the port is
to programmer on | not respond to the connected.
port Ip1 or parallel | negotiation protocol, for a | Make sure the
port device does variety of reasons. connected device is a
not support IEEE- FlashPro/Lite
1284 negotiation programmer.
protocol Turn the programmer
on.
Check parallel port
setting in BIOS.
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Exit Code Exit Message Possible Cause Possible Solution

Make sure that there
are no dongles in
between the parallel
port and the FlashPro
connection.

Try another parallel
cable, the parallel
cable might be
defective.

Check to see if the
programmer is
damaged.

Make sure the
FlashPro Lite has
power. The FlashPro
Lite is powered from
the target board
through the Vdd pin
of the programming
header.

Make sure the Vvdd
pin is connected and
the target board is
powered up.

Secure the
connection between
the cable connector
and the programming
header.

Before you program
any devices, you
should run the self-
diagnostic test. The
diagnostic software
can be found on the
Microsemi web site. If
the test fails, please
contact Microsemi
Customer Technical
Support at
tech@Microsemi.com
for credit and
replacement.

Note: The Self-test is
only available for
FlashPro, not
FlashPro Lite.

External voltage The voltage supply for Set appropriate
detected on the FPGA is driven by options in the
<Supply> another source (board, Connect menu.

external power-supply),
but the user forgot to turn
off the supply in the
Connect menu.
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Exit Code

Exit Message

Possible Cause

Possible Solution

VDPP
Disconnected.

There is no Vddp voltage
supply to the FPGA.

You accidentally turned
off the Vddp supply in the
Connect menu.

The Vddp supply on the
board is not functioning.

Check the Vddp
supply on the board
for appropriate
voltages and correct
the Connect menu.

More than one unidentified device.

If you want to
perform an
operation on the
ProASIC device,
the rest of the
devices in the
chain must be in
bypass mode.

To put devices in
bypass mode,
select
Configuration >
Chain Parameter
(or click the Chain
Parameter button
in the Single
STAPL
Configuration
window), then set
the Pre IR, Pre DR,
Post IR or Post
DR.

STAPL settings of Pre
IR, Pre DR, Post IR, and
Post DR do not match
the chain configuration.
One or more of the
devices in the chain is
damaged and the ID
CODE cannot be read
back.

Make sure you have
set Pre IR, Pre DR,
Post IR, and Post DR
to match the chain
configuration. If you
are still experiencing
the failure, it is likely
that the device's ID
CODE cannot be
read and you need to
replace the device.

Cannot find the
programmer with
ID xxx

The programmer is
removed from the PC.

Delete programmer
(or reconnect
programmer) and
select the Refresh
Programmer button.
See Connecting
Programmers for
more information.

Fatal Error: Please
check programmer
set up.

Software cannot resolve
the error encountered in
the programmer.

Save the project file,
restart the software,
and power cycle the
programmer.

External voltage
Xxx mV is detected
on XXxX.

You have specified the
programmer to drive the
Xxx but external xxx is
detected.

Deselect the xxx in
the programmer
setting.

Executing action
xxx failed.

The STAPL runtime
failed.
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Exit Code Exit Message Possible Cause Possible Solution

Executing action The STAPL runtime

xxx with serial failed.

index/action xx

failed.

No Vpump voltage Select the Vpump in

source is detected. the Programmer
setting. Make sure
the external Vpump
is properly turned on.

Vpump short Use a different

detected. programmer. If the
problem persists,
check the board
layout.

xxx Mhz TCK Check FlashPro Lite

frequency in this version being used.

STAPL file is not Use FlashPro Lite

supported by the Rev C or modify the

FlashPro Lite STAPL file to 4 MHz.

detected. It

supports only 4

MHz TCK

frequency.

xxx Mhz TCK Modify STAPL file to

frequency in this 1, 2, or 4 MHz.

STAPL file is not

supported by the

FlashPro Lite

RevC detected. It

supports only 1, 2

or 4 Mhz TCK

frequency.

Cannot find the Mismatch between Make sure the

serial Index/Action [ STAPL file and the STAPL file was not

xxx in STAPL file. | Index/Action selection. overwritten. Save the
project with updated
serial/action
selection.

Duplicated serial Mismatch between Make sure the

Index/Action xxx STAPL file and the STAPL file was not

was removed. Index/Action selection. overwritten. Save the
project with updated
serial/action
selection.

Using local backup | Cannot find original copy. | Check for available

COpY XXX space on the disk.
Check that write
permissions are
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Exit Code

Exit Message

Possible Cause

Possible Solution

enabled.

FlashPro cannot
rename the
programmer/device
with an existing
name.

Name is already in use.

Create a new name.

FlashPro cannot
rename the
programmer/device
with an invalid
character.

Invalid character used in
programmer/device
name.

Do not use invalid
characters.

Automatic check
for updates.

FlashPro can check
the Microsemi
website to find if an
updated version of
the software is
available. If you
would like to have
FlashPro
automatically check
for software updates,
choose Preferences
from the File menu.
From the Updates
tab, you can choose
your automatic
software update
settings. You can
also select Software
Updates from the
Help menu for
updates to the
FlashPro software.

FlashPro parse
error.

FlashPro software failed
to parse the file.

FlashPro does not
support STAPL
files for xxx.

STAPL file not allowed.

Use a STAPL file for
your device that is
supported by
FlashPro.
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Electrical Parameters

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming. However,
if there is only one ProASIC3 device on the target board, the FlashPro5/4/3/3X can provide the
VPUMP power supply via the USB port.

Note: The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to
configure the internal input and output buffers to the same IO Voltage levels. The VITAG pin is only
an input pin to the programmer.

Table 27 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VJTAG |V
Input high voltage, TDO VIH 0.65*VJTAG | 3.6 \%
Input current, TDO lIL, IH | -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, VPP +3.0 +3.6 \Y
operating
Output current, VPUMP IPP 250 mA
VJITAG = 1.5V
Output low voltage, TCK, TMS, |VOL 0.0 0.2 \%
TDI, 100pA load
Output low voltage, TCK, TMS, |VOL 0.0 0.30*VJTAG |V
TDI, 4mA load
Output high voltage, TCK, TMS, |V VJIJTAG-0.2 [ VJITAG \Y
TDI, 100pA load
Output high voltage, TCK, TMS, | VOH 0.70*VJTAG | VITAG \Y,
TDI, 4mA load
Output current, TCK, TMS, TDI 10L, -4 +4 mA

IOH

VJITAG = 1.8V
Output low voltage, TCK, TMS, |VOL 0.0 0.2 \Y
TDI, 100pA load
Output low voltage, TCK, TMS, |VOL 0.0 0.3 \%
TDI, 6mA load
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Description Symbol Min Max Unit

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VIJTAG \Y

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.25 VITAG \%

TDI, 6mA load

Output current, TCK, TMS, TDI 10L, -6 +6 mA
IOH

VITAG = 2.5V

Output low voltage, TCK, TMS, |VOL 0.0 0.2 \%

TDI, 100pA load

Output low voltage, TCK, TMS, |VOL 0.0 0.6 \Y

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.8 VITAG \Y

TDI, 8mA load

Output current, TCK, TMS, TDI | IOL, -8 +8 mA
IOH

VITAG = 3.3V

Output low voltage, TCK, TMS, |VOL 0.0 0.2 \%

TDI, 100pA load

Output low voltage, TCK, TMS, |VOL 0.6 \%

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VIJTAG \Y

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 2.4 VITAG \%

TDI, 8mA load

Output current, TCK, TMS, TDI 10L, -8 +8 mA
IOH

DC Characteristics for FlashPro Lite

Table 28 - DC Characteristic for FlashPro Lite

Description Symbol Min Max | Unit
Input low voltage, TDO VIL -0.5 0.7 \%
Input high voltage, TDO VIH 1.7 5.0 \%
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DC Characteristics for FlashPro

Description Symbol Min Max | Unit
Input current, TDO 1L, 1IH -10 +10 uA
Input capacitance, TDO 40 pF
Input voltage, VDD, operating (see note) +2.3 |+3.5 \%
Input voltage, VDD, power off -1.0 +1.0 \%
Input current, VDD IVDD 500 mA
Output voltage, VPP, operating VPP +15.9 | +16.5 |V
Output voltage, VPN, operating VPN -13.8 | -134 | V
Output current, IPP IPP 0 35 mA
Output current, IPN IPN 0 -15 mA
Output low voltage, TCK, TMS, TDI, 100uA load VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 1mA load VOL 0.0 0.5 \Y
Output low voltage, TCK, TMS, TDI, 2mA load VOL 0.0 0.8 \Y
Output high voltage, TCK, TMS, TDI, 100uA load VOH 2.1 2.5 \%
Output high voltage, TCK, TMS, TDI, 1mA load VOH 1.9 2.5 \Y
Output high voltage, TCK, TMS, TDI, 2mA load VOH 1.6 2.5 \Y
Output current, TCK, TMS, TDI, nTRST IOL, IOH | -2 +2 mA

Note: Up to 3.5 V can be supplied to the FlashPro Lite on the VDD pin. However, if the VDD supply for the
FlashPro is also connected to the APA VDD supply, the voltage for the VDD pin cannot exceed 2.7 V.

DC Characteristics for FlashPro

Table 29 - DC Characteristic for FlashPro

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.30* \%
VDDP
Input high voltage, TDO VIH 0.70 * 5.5 \%
VDDP
Input current, TDO 1L, HH -10 +10 UA
Input voltage, VDDP, VDDL 0 5.25 \Y
Input voltage, VPP 0 21.0 \%
Input voltage, VPN -21.0 \%
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Input current, VDDP, VDDL, VPN, VP IVCC 5.0 mA
Output voltage range, VDDP VDDP 15 3.3 \%
Output voltage range, VPP VPP 15.0 18.0 \%
Output voltage range, VPN VPN -16.0 -12.0 \%
Output voltage resolution / Acccuracy 100/ £50 mV
Output current, IDDP IDDP -135* +135 mA
Output current, IDDL IDDL -135* +135 mA
Output current, IPP IPP -2701* +270 mA
Output current, IPN IPN -270 +270" mA
Output low voltage, TCK, TMS, TDI, OUTO, | VOL 0.0 0.4 \%
NnTRST
Output high voltage, TCK, TMS, TDI, OUTO, | VOH 0.85* +0.3 \Y
NTRST VDDP VDDP
Output current, TCK, TMS, TDI, OUTO, 0L, -12 +12 mA
NTRST IOH

Note: Note (1): When power supply mode is set to ABI_GROUND.

Note: * - If you want to power-up the device from the board power supply, clear the checkboxes for VDDL
and VDDP. VPP and VPN are required during programming only and are supplied by the FlashPro
programmer.

Note: (2) Microsemi does not have operating temperature information for the FlashPro programmer.
FlashPro is intended to be used as lab or production equipment and not tested at extreme
temperatures. All devices in the unit are commercial temp. FlashPro4 went through a burn-in cycle
operating at 100C for 250 hours during quality testing. This involved repeatedly powering the
programmers and then programming after the burn in; they are not actively programming during the
burn in.
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FlashPro5

Electrical Specifications

FlashPro5

The FlashPro5 is a JTAG and a SPI based programmer for flash based Microsemi devices.

The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro5 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro5 10-pin connector are shown in the figure below.

TCK/SCK | 9 2 |GND o T
———=TDO/SDO | 3 4 |PROG_MODE —=
*—msf*ss#[ 5 6 |VITAG =-——
a— Vpoump |7 g8 |nTRST ——
IR E 10 |GND @ =-—»

Figure 151 - FlashPro5 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 30 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during
programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.
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FlashPro4

Electrical Specifications

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro4 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version..

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-~ TCK|1 2 |GND  =——
— TDO|3 4 |PROG_MODE ———=
-— TMS[E 6 |VITAG =—
- Veume |7 8 |nTRST —
- TDI|9 10 |GND —8m

Figure 152 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 31 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2.family - Used for switching from VCC 1.2V to 1.5V during
programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
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state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro3

Note: FlashPro3 is not supported on Windows 8.1.

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use
the 10 pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-—  TCK|1 2 |GgND =-—
—  TDO|3 4 |N/C

*—TMS[S 6 |VITAG =—
- Voume |7 g& |nTRST ——»
-~ TDI|9 10 |GND & —<—H8m

Figure 153 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 32 - FlashPro3 Signal Description

Signal Description

VPUMP | 3.3V Programming voltage

GND Signal reference

TCK JTAG clock

TDI JTAG data input to device
TDO JTAG data output from device
TMS JTAG mode select

NnTRST | Programmable output pin may be set to off, toggle, low, or high level

VITAG Reference voltage from the target board

N/C Programmer does not connect to this pin
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FlashPro Lite

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the

JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro Lite

For FlashPro Lite, the existing 26-pin connector is shown in the figure below.

N/C|1 2 |IN/C

N/C|3 4 IN/C
N/C|5 6 |Vep —
-~ GND|7 8 | Ve —
- GNDlg 10 [SENSE S
-— GND| 11 12 |TCK —
N/C| 13 14 |TDI —
N/C LJ15 16 |TDO S —
— GND17 18 |TMS —
- - GND[19 20 |OUTO/RCK ——
N/C|21 22 InTRST —
N/C|23 24 Voo S —
N/C 25 26 Voo —

Figure 154 - 26-pin Connector for FlashPro Lite

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The appropriate SAMTEC micro connector target cable for this is:
Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board and reducing
the inductance will help compared with 18 inches, which is supplied by the default with FlashPro Lite.

See the table below for a description of the signals.

Table 33 - FlashPro Lite Signal Description

Signal Description
VDDP VDD supply for logic I/O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5V)
VPN Negative programming supply(-13.8V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to ground
TCK JTAG clock
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Signal Description
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
RCK/OUTO | Programmable output pin may be set to off, toggle, low, or high level
N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the

JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro

For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the connections are
shown in the figure below.

-—  2.5V/3.3V| 2 |Vooe —
- 2.5\//3.3V|3 4 [Vooe -
-~  2.5V/3.3V|5 6 |[Vee —_—
- GND|7 8 |Veu —
— GNDJo 10 |SENSE -—
- GND| 11 12 |[TCK -

N/C| 13 14 | TDI -

N/CL 15 16 |[TDO I
-~ GND17 18 |[TMS -
- GND|19 20 |RCK/OUTO —
-~ 2.5V |21 22 InTRST -
-— 2.5V |23 24 |Voou —
- 2.5V |25 26 |VooL —

Figure 155 - 26-pin connections for FlashPro

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows the signal pin descriptions for FlashPro.
Table 34 - FlashPro Signal Description

Signal Description

VDDP VDD supply for logic I/O pads

VDDL VDD supply for core
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FlashPro 5/4/3/3X Characteristics

Signal Description

VPP Positive programming supply (+16.5 V)

VPN Negative programming supply (-13.8 V)

GND Signal reference

SENSE Input from target board to programmer to indicate connection to
ground

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

NTRST Programmable output pin may be set to off, toggle, low, or high
level

RCK/OUTO Programmable output pin may be set to off, toggle, low, or high
level

2.5V, 2.5V/3.3V, Programmer does not connect to these pins

N/C

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro 5/4/3/3X Characteristics

Table 35 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min | Max | Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VJITAG=3.3 TTDOTCK |12 ns
TDO setup time before TCK rising, VITAG=1.5 TTDOTCK |14.5 ns
TDO hold time after TCK rising TTCKTDO |0 ns
TCK period TTCK 41.7 | 10667 |ns
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FlashPro and FlashPro Lite Characteristics

The table below shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the
programmer end of the JTAG cable.

Table 36 - JTAG Switching Characteristics for FlashPro and FlashPro Lite

Description Symbol Min | Max [ Unit
Output delay from TCK falling to TDI, | TTCKTDI 2 |2 ns
T™MS
TDO setup time before TCK rising TTDOTCK 5.0 ns
TDO hold time after TCK rising TTCKTDO | 0 ns
TCK period TTCK 40 |10240|ns

lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

TCK \_/ \

[Tk B

TMS, TDI ><

Troxto —=

TTDCTCK—D‘

TrckToo—m
Figure 156 - JTAG Switching Characteristics

Device Debug

Device Debug / SmartDebug enables you to use JTAG to interrogate and view embedded silicon features

and device status (FlashROM, Security Settings, Embedded Flash Memory (NVM) and Analog System).

It provides tools to help troubleshoot some of the common issues related to the Embedded Flash Memory

and Analog System.

Device Debug supports IGLOO, ProASIC3, SmartFusion and Fusion devices. SmartDebug supports

SmartFusion2 and ProASIC3 devices.

The user support is separated into two sections:

e Using Device Debug to Find Solutions to Common Issues - Contains common issues and

troubleshooting instructions that will enable you to solve your problems as quickly as possible.

e Frequently Asked Questions - Answers to the most frequently asked questions about the tools and
silicon features related to your solution.
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Getting Started with SmartDebug

If you are unfamiliar with Device Debug, you may find it helpful to review the Getting Started with
SmartDebug topic. You can view descriptions of the Device Debug interface in the Reference section of the

help.

Getting Started with SmartDebug

Note: SmartDebug is referred to as Device Debug in some older families.

This topic introduces the basic elements and features of SmartDebug. If you are already familiar with the
user interface, proceed to the Solutions to Common Issues Using SmartDebug or Frequently Asked
Questions sections.

SmartDebug (Device Debug for some older families) enables you to use JTAG to interrogate and view
embedded silicon features and device status (FlashROM, Security Settings, Embedded Flash Memory
(NVM) and Analog System). SmartDebug is available as a part of the FlashPro programming tool.

See the Using SmartDebug topic for an overview of the use flow.

You can use the debugger to:

Get device status and view diagnostics

Use the FlashROM debug GUI to read out and compare content

Use the Embedded Flash Memory Debug GUI to read out and compare your content with your original
files

Use the Analog System Debug to read out and compare your analog block configuration with your
original file

Using SmartDebug with SmartFusion and Fusion

Note: SmartDebug is referred to as Device Debug in some older families.

The most common flow for SmartDebug is:

1.
2.

Start FlashPro. If necessary, create a new project.

Set up your FlashPro Project with or without a PDB file. If you are in single-device mode you will need
a PDB file. You can create a PDB file in both Single Device and Chain mode.

With a PDB, you will get additional information such as FlashROM and Embedded Flash Memory
partitions when debugging the silicon features. Best practice is to use a PDB with a valid-use design to
start a debug session.

Select the target device from your chain and click Inspect Device.
Click Device Status to get device status and check for issues

Examine individual silicon features (FlashROM, Embedded Flash Memory Block and Analog System)
on the device.
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Solutions to Common Issues Using
SmartDebug

Embedded Flash Memory (NVM) - Failure when
Programming/Verifying
If the Embedded Flash Memory failed verification when executing the PROGRAM_NVM, VERIFY_NVM or

PROGRAM_NVM_ACTIVE_ARRAY action, the failing page may be corrupted. To confirm and address this
issue:

1. Inthe Inspect Device window click View Flash Memory Content.

2. Select the Flash Memory block and client (or page range) to retrieve from the device.
3. Click Read from Device; the retrieved data appears in the lower part of the window.
4. Click View Detailed Status to check the NVM Status.

Note: You can use the check_flash_memory and read_flash_memory Tcl commands to perform
diagnostics similar to the commands outlined above.

5. Ifthe NVM is corrupted you must reset the affected NVM pages.
To reset the corrupted NVM pages, either re-program the pages with your original data or ‘zero-out’
the pages by using the Tcl command recover_flash_memory.

If the Embedded Flash Memory failed verification when executing a VERIFY_NVM or
VERIFY_NVM_ACTIVE_ARRAY action, the failure may be due to the change of content in your design. To
confirm this, repeat steps 1-3 above.

Note: NVM corruption is still possible when writing from user design. Check NVM status for confirmation.

Analog System Not Working as Expected

If the Analog System is not working correctly, it may be due the following:
1. System supply issue. To troubleshoot:

e Physically verify that all the supplies are properly connected to the device and they are at the proper
level. Then confirm by running the Device Status.

e Physically verify that the relevant channels are correctly connected to the device.
2. Analog system is not properly configured. You can confirm this by examining the Analog System.

ADC Not Sampling the Correct Value

If the ADC is sampling all zero values then the wrong analog pin may be connected to the system, or the
analog pin is disconnected. If that is not the case and the ADC is not sampling the correct value, it may be
due to the following:

1. System supply issues - Run the device status to confirm.

2. Analog system is not configured at all - To confirm, read out the ACM configuration and verify if the
ACM content is all zero.

3. Analog system is not configured correctly - To confirm, read out the ACM configuration and verify that
the configuration is as expected .

Once analog block configuration has been confirmed, you can use the sample_analog_channel Tcl
command for debug sampling of the analog channel with user-supplied sampling parameters.
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ADC Not Sampling the Correct Value

If you have access to your Analog System Builder settings project (<Libero IDE
project>/Smartgen/AnalogBlock), you may use the compare function provided by the tool.
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Frequently Asked Questions

How do |

How do |

How do |

unlock the device security so | can debug?

You must provide the PDB file with a User Pass Key in order to unlock the device and continue debugging.

If you do not have a PDB with User Pass Key, you can create a PDB file in FlashPro (if you know the Pass
Key value).

export a report?

You can export three reports from the SmartDebug GUI: Device Status, Client Detailed Status from the
NVM, or the Compare Client Content report from the NVM. Each of those reports can be saved and printed.
If using a Tcl command, you can use the —File <filename> option for the following commands:
read_flash_memory

check flash_memory

compare_memory client

read_device_status

read_flashrom
read_analog_block config
sample_analog_channel
compare_flashrom_client
compare_analog_config

For example, you can use the following command to export the content of the client 'datastorel’ in NVM
block 0 to the report file datastorel_content.txt:
read_flash_memory —client “datastorel” —file {C:\temp\datastorel_content.txt}

For more information about Tcl commands supported by SmartDebug, see SmartDebug Tcl Commands.

generate diagnostic reports for my target device?

A set of diagnostic reports can be generated for your target device depending on which silicon feature you
are debugging. A set of Tcl commands are available to export those reports. The following is a summary of
those Tcl commands based on the silicon features.

When using the —file parameter, ensure that you use a different file name for each command so you do not
overwrite the report content. If you do not specify the —file option in the Tcl, the output results will be directed
to the FlashPro log window.

For the overall device:

read device_status
read_id_code

For FlashROM:

compare_flashrom_client
read_flashrom

For Embedded Flash Memory (NVM):

compare_memory_client
check flash_memory
read_flash_memory

For Analog Block:
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Where can | find files to compare my contents/settings?

read_analog_block config
compare_analog_config
sample_analog_channel

To execute the Tcl command, from the File menu choose Run Script.

Where can | find files to compare my contents/settings?

FlashROM

You can compare the FlashROM content in the device with the data in the PDB file. You can find the PDB in
the <Libero IDE project>/Designer/Impl directory.

Embedded Flash Memory (NVM)

You can compare the Embedded Flash Memory content in the device with the data in the PDB file. You can
find the PDB in the <Libero IDE project>/Designer/Impl directory.

Analog System

You can compare the Analog System configuration in the device with the data in the loaded PDB file or in
the Analog System folder. Go to:

e Fusion devices - <Libero IDE project>/Smartgen/AnalogBlock
e SmartFusion devices - <Libero IDE Project>/component/<SmartDesign Project>/MSS_ACE_0
The tool automatically identifies the necessary files in the selected folder for comparison.

What is a UFC file? What is an EFC file?

UFC is the User FlashROM Configuration file, generated by the FlashROM configurator; it contains the
partition information set by the user. It also contains the user-selected data for region types with static data.

However, for AUTO_INC and READ_FROM_FILE, regions the UFC file contains only:
e Start value, end value, and step size for AUTO_INC regions, and
e File directory for READ_FROM_FILE regions

EFC is the Embedded Flash Configuration file, generated by the Flash Memory Builder in the Project
Manager Catalog; it contains the partition information and data set by the user.

Both UFC and EFC information is embedded in the PDB when you generate the PDB file.

Is my FPGA fabric enabled?

When your FPGA fabric is programmed, you will see the following statement under Device State in the
Device Status report:

FPGA Array Status: Programmed and Enabled
If the FPGA fabric is not programmed, the Device State shows:
FPGA Array Status: Not Enabled
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Embedded Flash Memory (NVM) Frequently
Asked Questions

Is my Embedded Flash Memory (NVM) programmed?
To figure out if your NVM is programmed, read out and view the NVM content or perform verification with the
PDB file.
To examine the NVM content, see the FlashROM Memory Content Dialog Box.
To verify the NVM with the PDB select the VERIFY or VERIFY_NVM action in FlashPro.

How do | display Embedded Flash Memory (NVM) content in the
Client partition?
You must load your PDB into your FlashPro project in order to view the Embedded Flash Memory content in
the Client partition. To view NVM content in the client partition:
1. Load your PDB into your FlashPro project.
Click Inspect Device.
Click View Flash Memory Content.
Choose a block from the drop-down menu.
Select a client.

Click Read from Device. The Embedded Flash Memory content from the device appears in the Flash
Memory dialog box.

o gk wn

See the Flash Memory Dialog Box topic for more description on viewing the NVM content.

How do | know if I have Embedded Flash Memory (NVM)
corruption?
When Embedded Flash Memory is corrupted, checking Embedded Flash Memory may return with any or all
of the following page status:
e ECC1/ECC2 failure
e Page write count exceeds the 10-year retention threshold

e Page write count is invalid
e Page protection is set illegally (set when it should not be)
See the How do | interpret data in the Flash Memory (NVM) Status Report? topic for details.

If your Embedded Flash Memory is corrupted, you can recover by reprogramming with original design data.
Alternatively, you can ‘zero-out’ the pages by using the Tcl command recover_flash_memory.

Why does Embedded Flash Memory (NVM) corruption happen?

Embedded Flash Memory corruption occurs when Embedded Flash Memory programming is interrupted due
to:

e Supply brownout; monitor power supplies for brownout conditions. For SmartFusion monitor the
VCC_ENVM/VCC_ROSC voltage levels; for Fusion, monitor VCC_NVM/VCC_OSC.

e Reset signal is not properly tied off in your design. Check the Embedded Memory reset signal.
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How do | recover from Embedded Flash Memory corruption?

How do | recover from Embedded Flash Memory corruption?

Reprogram with original design data or ‘zero-out’ the pages by using the Tcl command
recover_flash_memory.

What is a JTAG IR-Capture value?

JTAG IR-Capture value contains private and public device status values. The public status value in the value
read is ISC_DONE, which indicates if the FPGA Array is programmed and enabled.

The ISC_DONE signal is implemented as part of IEEE 1532 specification.

What does the ECC1/ECC2 error mean?

ECC is the Error Correction Code embedded in each Flash Memory page.
ECC1 - One bit error and correctable.
ECC2 — Two or more errors found, and not correctable.

How can | tell if my FlashROM is programmed?

To verify that your FlashROM is programmed, read out and view the FlashROM content or perform
verification with the PDB file by selecting the VERIFY or VERIFY _FROM action in FlashPro.

Can | compare serialization data?

To compare the serialization data, you can read out the FlashROM content and visually check data in the
serialization region. Note that a serialization region can be an AUTO_INC or READ_FROM_FILE region.
For serialization data in the AUTO_INC region, check to make sure that the data is within the specified
range for that region.

For READ_FROM_FILE region, you can search for a match in the source data file.

Can | tell what security options are programmed in my device?

To determine the programmed security settings, run the Device Status option from the Inspect Device dialog
and examine the Security Section in the report.

This section lists the security status of the FlashROM, FPGA Array and Flash Memory blocks.

Is my analog system configured?

To determine if the analog block is configured, run the Device Status option from the Inspect Device dialog
and examine the Analog Block Section in the report. For example, the excerpt from the Device Status report
below shows that the analog block status is operational:

Analog Block:
OABTR Register (HEX): 0dbe37b
3.3V (vdd33): PASS
1.5V (vdd15): PASS
Bandgap: PASS
-3.3V (vddn33): PASS
ADC Reference: PASS
FPGA_Good: PASS
Status: Analog Block is operational

If you read out an all zero value when examining the Analog System Configuration, it is possible that the
Analog System is not configured.
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You need to compare your analog system configuration with the design configuration from the Analog
System Builder.

The -3.3V (vddn33) voltage is optional.

How do | interpret data in the Device Status report?

The Device Status Report generated from the FlashPro SmartDebug Feature contains the following
sections:

e IDCode (see below)

e User Information

¢ Device State

e Analog Block (SmartFusion and Fusion only)

e Factory Data
e Security Settings

Device Status Report: IDCode

The IDCode section shows the raw IDCode read from the device. For example, in the Device Status report
for an AFS600 device, you will find the following statement:

IDCode (HEX): 233261cf
The IDCode is compliant to IEEE 1149.1. The following table lists the IDCode bit assignments:

Table 37 - IDCode Bit Assignments

Bit Field (little Example Bit Value for Description
endian) AFS600 (HEX)
Bit [31-28] (4 bits) |2 Silicon Revision
Bit [27-12] (16 3326 Device ID
bits)
Bit [11-0] (12 bits) | 1cf IEEE 1149.1 Manufacturer ID for
Microsemi

Device Status Report: User Info

The User Information section reports the information read from the User ROW (UROW) of IGLOO,
ProASIC3, SmartFusion and Fusion devices. The User Row includes user design information as well as
troubleshooting information, including:

e Design name (10 characters max)

e Design check sum (16-bit CRC)

e Last programming setup used to program/erase any of the silicon features.

e FPGA Array / Fabric programming cycle count

For example:

User Information:

UROW data (HEX): 603a04e0alc2860e59384af926fe389F
Programming Method: STAPL

Programmer: FlashPro3

Programmer Software: FlashPro vX.X

Design Name: ABCBASICTO
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Device Status Report: Device State

Design Check Sum: 603A
Algorithm Version: 19
Array Prog. Cycle Count: 19

Table 38 - Device Status Report User Info Description

Category Field Description

User Row Data | (Example) Raw data from User Row
UROW data (HEX): (UROW)
603a04e0a1c2860e59384af926fe389f

Programming (Example) Known programming setup

Troubleshooting | Programming Method: STAPL used. This includes:

Info Programmer: FlashPro3 Programming method/file,
Programmer Software: FlashPro v8.6 | programmer and software. It
Algorithm Version: 19 also includes programming

Algorithm version used.

Design Info (Example) Design name (limited to 10
Design Name: ABCASICTO characters) and check sum.
Design Check Sum: 603A
Design check sum is a 16-
bit CRC calculated from the
fabric (FPGA Array)
datastream generated for
programming. If encrypted
datastream is generated
selected, the encrypted
datastream is used for
calculating the check sum.

Device Status Report: Device State

The device state section contains:.

e IR-Capture register value, and
e The FPGA status
The IR-Capture is the value captured by the IEEE1149.1 instruction register when going through the IR-

Capture state of the IEEE 1149.1 state machine. It contains information reflecting some of the states of the
devices that is useful for troubleshooting.

One of the hits in the value captured is the ISC_DONE value, specified by IEEE 1532 standard. When the
value is ‘1’ it means that the FPGA array/fabric is programmed and enabled. This is available for IGLOO,
ProASIC3, SmartFusion and Fusion devices.

For example:

Device State:

IRCapture Register (HEX): 55

FPGA Array Status: Programmed and enabled

For a blank device:

Device State:

IRCapture Register (HEX): 51

FPGA Array Status: Not enabled
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Device Status Report: Analog Block

The Analog block of the SmartFusion and Fusion devices monitors some of the key power supplies needed
by the device to function. These power supply status is captured in the OABTR test register in the Analog
block.

For example, if you run Device Status when the Fabric and Analog configuration is programmed and
powered up successfully the report indicates:

Analog Block:

OABTR Register (HEX): 0dbe3bb

3.3V (vdd33): PASS

1.5V (vdd15): PASS

Bandgap: PASS

-3.3V (vddn33): PASS

ADC Reference: PASS

FPGA_Good: PASS

Status: Analog Block is operational

Table 39 - Device Status Report - Analog Block Description

Analog Block Status Description
OABTR Register RAW data captured from the device
3.3V (vdd33) Vcc33a supply status
1.5V (vdd15) Vcenvm supply status
Bandgap Internal bandgap supply status
ADC Reference ADC reference voltage status
-3.3V (vddn33) Vddn33 supply status (optional voltage)
FPGA Good FPGA array or Fabric status

If the Fusion device is erased, the report indicates:
Analog Block:
OABTR Register (HEX): 188e3ba
3.3V (vdd33): PASS
1.5V (vdd15): PASS
Bandgap: PASS
-3.3V (vddn33): FAIL
ADC Reference: FAIL
FPGA_Good: FAIL
Status: Analog Block is non-operational
Analog Block is not programmed

Device Status Report: Factory Data

The Factory Data section lists the Factory Serial Number (FSN).
Each of the IGLOO, ProASIC3, SmartFusion and Fusion devices has a unique 48-bit FSN.

248

FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. . .
p & Microsemi

Device Status Report: Security

Device Status Report: Security

The security section shows the security options for the FPGA Array, FlashROM and Flash Memory (NVM)
block that you programmed into the device.
For example, using a Fusion AFS600 device:

Security:

Security Register (HEX): 0000000088c01b

FlashROM

Write/Erase protection: Off

Read protection: OFf

Encrypted programming: Off

FPGA Array

Write/Erase protection: Off

Verify protection: Off

Encrypted programming: OFF

FlashMemory Block O

Write protection: On

Read protection: On

Encrypted programming: OFf

FlashMemory Block 1

Write protection: On

Read protection: On

Encrypted programming: OFF

Table 40 - Device Status Report - Security Description

Security Description
Status Info
Security Raw data captured from the device's security status register

Register (HEX)

Write/Erase Write protection is applicable to FlashROM, FPGA Array (Fabric)and
Protection Flash Memory (NVM) blocks. When On, the Silicon feature is
write/erase protected by user passkey.

Read Read protection is applicable to FlashROM and Flash Memory (NVM)

Protection blocks. When On, the Silicon feature is read protected by user
passkey.

Verify Verify Protection is only applicable to FPGA Array (Fabric) only. When

Protection On, the FPGA Array require user passkey for verification.

Reading back from the FPGA Array (Fabric) is not supported.

Verification is accomplished by sending in the expected data for
verification.

Encrypted Encrypted Programming is supported for FlashROM, FPGA Array
Programming (Fabric) and Flash Memory (NVM) blocks. When On, the silicon
feature is enable for encrypted programmed. This allows field design
update with encrypted datastream so the user design is protected.
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Encrypted Programming
To allow encrypted programming of the features, the target feature cannot be Write/Erase protected by user
passkey.

The security settings of each silicon feature when they are enabled for encrypted programming are listed
below.

FPGA Array (Fabric)
Write/Erase protection: Off
Verify protection: OFf
Encrypted programming: On
Set automatically by Designer or FlashPro when you select to enable encrypted programming of the FPGA

Array (Fabric). This setting allows the FPGA Array (Fabric) to be programmed and verified with an encrypted
datastream.

FlashROM

Write/Erase protection: Off

Read protection: On

Encrypted programming: On
Set automatically by Designer or FlashPro when you select to enable encrypted programming of the
FlashROM. This setting allows the FlashROM to be programmed and verified with an encrypted datastream.
FlashROM always allows verification. If encrypted programming is set, verification has to be performed with
encrypted datastream.

Designer and FlashPro automatically set the FlashROM to be read protected by user passkey when
encrypted programming is enabled. This protects the content from being read out of the JTAG port after
encrypted programming.

Flash Memory (NVM) Block
Write/Erase protection: Off
Read protection: On
Encrypted programming: On
The above setting is set automatically set by Designer or FlashPro when you select to enable encrypted
programming of the Flash Memory (NVM) block. This setting allows the Flash Memory (NVM) block to be
programmed with an encrypted datastream.

The Flash Memory (NVM) block does not support verification with encrypted datastream.
Designer and FlashPro automatically set the Flash Memory (NVM) block to be read protected by user

passkey when encrypted programming is enabled. This protects the content from being read out of the
JTAG port after encrypted programming.

How do | interpret data in the Flash Memory (NVM) Status Report?

The Embedded Flash Memory (NVM) Status Report generated from the FlashPro SmartDebug feature
consists of the page status of each NVM page. For example:

Flash Memory Content [ Page 34 to 34 ]

FlashMemory Page #34:

Status Register(HEX): 00090000

Status ECC2 check: Pass

Data ECC2 Check: Pass

Write Count: Pass (2304 writes)

Total number of pages with status ECC2 errors: 0

Total number of pages with data ECC2 errors: O

Total number of pages with write count out of range: O

FlashMemory Check PASSED for [ Page 34 to 34 ]

The "check_flash_memory® command succeeded.
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Create Standalone SmartDebug Project

The Execute Script command succeeded.

Table 41 - Embedded Flash Memory Status Report Description

Flash Description
Memory
Status Info

Status Raw page status register captured from device
Register
(HEX)

Status Check for ECC2 issue in the page status
ECC2
Check

Data ECC2 | Check for ECC2 issue in the page data
Check

Write Count | Check if the page-write count is within the expected range.
The expected write count is greater than or equal to:

6,384 - SmartFusion devices
2,288 - Fusion devices

Note: Write count, if corrupted, cannot be reset to a valid value within the
customer flow;invalid write count will not prevent device from being
programmed with the FlashPro tool.

The write count on all good eNVM pages is set to be 2288 instead of 0 in
the manufacturing flow. The starting count of the eNVM is 2288. Each
time the page is programmed or erased the count increments by one.
There is a Threshold that is set to 12288, which equals to 3 * 4096.

Since the threshold can only be set in multiples of 4096 (2712), to set a
10,000 limit, the Threshold is set to 12288 and the start count is set to
2288; and thus the eNVM has a 10k write cycle limit. After the write count
exceeds the threshold, the STATUS bit goes to 11 when attempting to
erase/program the page.

Create Standalone SmartDebug Project

A standalone SmartDebug project can be configured in two ways:
e Import DDC files exported from Libero
e Construct Automatically

From the SmartDebug main window, click Project and choose New Project. The Create SmartDebug
Project dialog box opens.
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3 Create SmartDebug Project it |

Narme: M2GLO10_test

Location: E:\Captures\SmartDebug\SASD\11_7_0_19_main

Construct JTAG chain for the project

Connected Programmers(s): 293536 'J[ Refresh ]

@ Import from DDC File: Standalone_SD/DOC_files/Cap_19/M2GLO10T_PCle_Demo.ddc | ... J

Design debug data wil be imported with JTAG chain

Construct Automatically

Help oK | Ccancel

Figure 157 - Create SmartDebug Project Dialog Box

Import from DDC File (created from Libero)

When you select the Import from DDC File option in the Create SmartDebug Project dialog box, the Design
Debug Data of the target device and all hardware and JTAG chain information present in the DDC file
exported in Libero are automatically inherited by the SmartDebug project. The programming file information
loaded onto other Microsemi devices in the chain, including ProAsic3/E, SmartFusion, and Fusion devices,
are also transferred to the SmartDebug project.

Debug data is imported from the DDC file (created through Export SmartDebug Data in Libero) into the
debug project, and the devices are configured using data from the DDC file.

Construct Automatically

When you select the Construct Automatically option, a debug project is created with all the devices
connected in the chain for the selected programmer. This is equivalent to Construct Chain Automatically in
FlashPRO.

Configuring a Generic Device

For Microsemi devices having the same JTAG IDCODE (i.e., multiple derivatives of the same Die—for
example, M2S090T, M2S090TS, and so on), the device type must be configured for SmartDebug to enable
relevant features for debug. The device can be configured by loading the programming file, by manually
selecting the device using Configure Device, or by importing DDC files through Programming Connectivity
and Interface. When the device is configured, all debug options are shown.

For debug projects created using Construct Automatically, you can use the following options to debug the
devices:

e Load the programming file — Right-click the device in Programming Connectivity and Interface.
e Import Debug Data from DDC file — Right-click the device in Programming Connectivity and Interface.

The appropriate debug features of the targeted devices are enabled after the programming file or DDC file is
imported.
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Programming Connectivity and Interface

Connected FlashPRO Programmers

Import from

The drop-down lists all FlashPro programmers connected to the device. Select the programmer connected
to the chain with the debug device. At least one programmer must be connected to create a standalone
SmartDebug project.

Before a debugging session or after a design change, program the device through Programming
Connectivity and Interface.

See Also

Programming Connectivity and Interface

View Device Status
Export SmartDebug Data (from Libero)

DDC File (created from Libero)

When you select the Import from DDC File option in the Create SmartDebug Project dialog box, the Design
Debug Data of the target device and all hardware and JTAG chain information present in the DDC file
exported in Libero are automatically inherited by the SmartDebug project. The programming file information
loaded onto other Microsemi devices in the chain, including ProAsic3/E, SmartFusion, and Fusion devices,
are also transferred to the SmartDebug project.

Debug data is imported from the DDC file (created through Export SmartDebug Data in Libero) into the
debug project, and the devices are configured using data from the DDC file.

Construct Automatically

Configuring

When you select the Construct Automatically option, a debug project is created with all the devices

connected in the chain for the selected programmer. This is equivalent to Construct Chain Automatically in
FlashPRO.

a Generic Device

For Microsemi devices having the same JTAG IDCODE (i.e., multiple derivatives of the same Die—for
example, M2S090T, M2S090TS, and so on), the device type must be resolved for SmartDebug to enable
relevant features for debug. The device can be resolved by loading the programming file, manually selecting
the device using Configure Device, or by importing DDC files through Programming Connectivity and
Interface. When the device is resolved, all debug options are shown.

For debug projects created using Construct Automatically, you can use the following options to debug the
devices:

¢ Load the programming file — Right-click the device in Programming Connectivity and Interface.
e Import Debug Data from DDC file — Right-click the device in Programming Connectivity and Interface.

The appropriate debug features of the targeted devices are enabled after the programming file or DDC file is
imported.

Programming Connectivity and Interface

To open the Programming Connectivity and Interface dialog box, from the standalone SmartDebug Tools
menu, choose Programming Connectivity and Interface. The Programming Connectivity and Interface
dialog box displays the physical chain from TDI to TDO.
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Figure 158 - Programming Connectivity and Interface Dialog Box — Project created using Import from DDC File

All devices in the chain are disabled by default when a standalone SmartDebug project is created using the
Construct Automatically option in the Create SmartDebug Project dialog box.

J+ Programming Connectivity and Interface b D S
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Figure 159 - Programming Connectivity and Interface window — Project created using Construct Automatically
The Programming Connectivity and Interface dialog box includes the following actions:
e Construct Chain Automatically - Automatically construct the physical chain.

Running Auto-Construct in Programming Connectivity and Interface removes all existing
debug/programming data included using DDC/programming files. The project is the same as a new
project created using the Construct Automatically option.

e Scan and Check Chain — Scan the physical chain connected to the programmer and check if it
matches the chain constructed in the scan chain block diagram.

¢ Run Programming Action — Option to program the device with the selected programming procedure.

When two devices are connected in the chain, the programming actions are independent of the device.
For example, if M2S090 and M2GL010 devices are connected in the chain, and the M2S090 device is to
be programmed and the M2GL010 device is to be erased, both actions can be done at the same time
using the Run Programming Action option.

e Zoom In — Zoom into the scan chain block diagram.
e Zoom Out — Zoom out of the scan chain block diagram.

Hover Information

The device tooltip displays the following information if you hover your cursor over a device in the scan chain
block diagram:

e Name: User-specified device name. This field indicates the unique name specified by the user in the
Device Name field in Configure Device (right-click Properties).

e Device: Microsemi device name.
e Programming File: Programming file name.
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Programming Connectivity and Interface

e Programming action: The programming action selected for the device in the chain when a
programming file is loaded.

¢ |R: Device instruction length.

e TCK: Maximum clock frequency in MHz to program a specific device; standalone SmartDebug uses
this information to ensure that the programmer operates at a frequency lower than the slowest device

in the chain.
iRTacIS0ES e~ ‘
i [RT4G150_ES] =
© 100 | oI 2
S 7¥00 | TS
i [Name: [RT4G150_ES
|Device: |RT4G150_ES

|Programmrng File: |

|ngrammmg action: |
|IR: |8
| TCK: | 10000000

Device Chain Details
The device within the chain has the following details:
e User-specified device name
e Device name
e Programming file name

e Programming action — Select Enable Device for Programming to enable the device for programming.
Enabled devices are green, and disabled devices are grayed out.

Right-click Properties

Configure Device...

v Enable Device for Programming...
Load Pregramming File...
Select Program Procedure/Actions...
Import Debug Data from DDC File...

Configure Device - Ability to reconfigure the device.
e Family and Die: The device can be explicitly configured from the Family, Die drop-down.
e Device Name: Editable field for providing user-specified name for the device.
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Enable Device for Programming - Select to enable the device for programming. Enabled devices are
shown in green, and disabled devices are grayed out.

Load Programming File - Load the programming file for the selected device.

Select Programming Procedure/Actions- Option to select programming action/procedures for the devices
connected in the chain.

e Actions: List of programming actions for your device.

e Procedures: Advanced option; enables you to customize the list of recommended and optional
procedures for the selected action.

Import Debug Data from DDC File - Option to import debug data information from the DDC file.

The DDC file selected for import into device must be created for a compatible device. When the DDC file is
imported successfully, all current device debug data is removed and replaced with debug data from the
imported DDC file.

The JTAG Chain configuration from the imported DDC file is ignored in this option.

If a programming file is already loaded into the device prior to importing debug data from the DDC file, the
programming file content is replaced with the content of the DDC file (if programming file information is
included in the DDC file).

Debug Context Save

Debug context refers to the user selections in debug options such as Debug FPGA Array, Debug SERDES,
and View Flash Memory Content. In standalone SmartDebug, the debug context of the current session is
saved or reset depending on the user actions in Programming Connectivity and Interface.

The debug context of the current session is retained for the following actions in Programming Connectivity
and Interface:

e Enable Device for Programming

e Select Programming Procedure/Actions
e Scan and Check Chain

e Run Programming Action

The debug context of the current session is reset for the following actions in Programming Connectivity and
Interface:

e Auto Construct — Clears all the existing debug data. You need to reimport the debug data from DDC
file.

e Import Debug Data from DDC file

e Configure Device — Renaming the device in the chain
e Configure Device — Family/Die change

e Load Programming File

Selecting Devices for Debug

Standalone SmartDebug provides an option to select the devices connected in the JTAG chain for debug.
The device debug context is not saved when another debug device is selected.
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Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

€ SmantDebug - EACapty

Project  View Tools

Programmer: 33535 (usb33535) -
ID code read from device: 1FE071CF
| View Device Status... l [ Debug FPGA Array... |
[ View Flash Memary Content... I I Debug SERDES... |

Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

Introduction
Probe insertion is a post-layout debug process that enables internal nets in the FPGA design to be routed to
unused I/Os. Nets are selected and assigned to probes using the Probe Insertion window in SmartDebug.
The rerouted design can then be programmed into the FPGA, where an external logic analyzer or
oscilloscope can be used to view the activity of the probed signal.

—_—

Pre-Synthesis
Simulation

Design Implementation ~ Synthesis

- Post-Synthesis
' Simulation
——
Insert probes into design | R
mgm r _.-'""”'""'"""""""";""{E lO‘ 1 - I Il:l 0 u" .
Incrementally I
routed net for i

Figure 160 - Probe Insertion in the Design Process

The Probe Insertion debug feature is complementary to Live Probes and Active Probes. Live Probes and
Active Probes use a special dedicated probe circuitry.

Probe Insertion
1. Double-click SmartDebug Design in the Design Flow window to open the SmartDebug main window.
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Note: FlashPro Programmer must be connected for SmartDebug.

2.

i Debug FPGA Amay

®

Probe Insertion Data Selection & x

Hierarchical View

Filter:

Instance(s):

Instance Tree
B primitives
£ anoz 0
& p_ibuf
£ Fooc o
& Mux_SEL
& m20
T Reset
& stop
£ uImaG_o
T User QK
I count 0

Select Debug FPGA Array and then select the Probe Insertion tab.

FPGA Array debug data
Netist View Live Probes | Active Probes | MemoryBlacks | Probe Insertion
[ search | Delete | Delate st
Add MNet Driver Package Pin Port Name

AND2_0_Y AND2_DUO:Y |Unassigned ¥ |Probe_lnsertd

D¢ UUITAG_O/INST_UITAG_SYSRESET_FF_IP:UDRLPD |Unassigned  ~ |Probe _Insert1

Insert probe(s) and program the device Run

[ Close

Figure 161 - Probe Insertion Tab

In the left pane of the Probe Insertion tab, all available Probe Points are listed in instance level hierarchy in
the Hierarchical View. All Probe Names are shown with the Name and Type in the Netlist View.

3.

Select probe points from the Hierarchical View or Netlist View, right-click and choose Add to add them
to the Active Probes Ul. You can also add the selected probe points by clicking the Add button. The
probes list can be filtered by using the Filter box.

Each entry has a Net and Driver name which identifies that probe point.

The selected net(s) appear in the Probes table in the Probe Insertion tab, as shown in the figure
below. SmartDebug automatically generates the Port Name for the probe. You can change the Port
Name from the default if desired.

Assign a package pin to the probe using the drop-down list in the Package Pin column. You can assign
the probe to any unused package pin (spare 1/O).
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Active Probes (SmartFusion2, IGLOO2, and RTG4)

5] Debug FPGA Array L= B

®

Probe Insertion Data Selection B X FrGA Array debug data

Hesarchical View | Nefist View Live Probes | Active Probes | Memory Blocks | Frobe Insertion
e e )

Instance(s): [ aed ] Net Driver Package Pn Port Name

0] t_0fq[0]: |1 v | Probe_tnsertd
Instance Tree <[] count 0 IQ ! 2 | il

T primitves qel1] count_0fa[1]:Q 15 v [Testz
i AND2 0 = .
B 0 tuf e count_0fal3):Q |36 + | Probe_Insert2
& Fecc_o I
| MU SEL
=/ Mm20
IF Reset
T stop
W UITAG_0
T User QK
4 I count_0
4 1B Primitives

Insert probe(s) and program the device | Run

Figure 162 - Debug FPGA Array > Probe Insertion > Add Probe
5. Click Run.

This triggers Place and Route in incremental mode, and the selected probe nets are routed to the
selected package pin. After incremental Place and Route, Libero automatically reprograms the device
with the added probes.

The log window shows the status of the Probe Insertion run.

Probe Deletion
To delete a probe, select the probe and click Delete. To delete all the probes, click Delete All.

Note: Deleting probes from the probes list without clicking Run does not automatically remove the probes
from the design.

Reverting to the Original Design
To revert to the original design after you have finished debugging:
1. In SmartDebug, click Delete All to delete all probes.
2. Click Run.

3. Wait until the action has completed by monitoring the activity indicator (spinning blue circle). Action is
completed when the activity indicator disappears.

4. Close SmartDebug.

Active Probes (SmartFusion2, IGLOOZ2, and RTG4)

In the left pane of the Active Probes tab, all available Probe Points are listed in instance level hierarchy in
the Hierarchical View. All Probe Names are listed with the Name and Type (which is the physical location of
the flip-flop) in the Netlist View.
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Select probe points from the Hierarchical View or Netlist View, right-click and choose Add to add them to the
Active Probes Ul. You can also add the selected probe points by clicking the Add button. The probes list
can be filtered by using the Filter box.

)

5] Debug FPGA Array scsslalE)
=
Live Active Probes Selection & X rpga Array debug data
| Feerarchucal view :__m[ktm '_ ) Live Probes | Active Prabes I Memary Bocks |
Filter:  Seach | Delete ]
er ( | E - (g (¥ Save.e J[ Load J [ osewm |
Instance{s): [ ﬁda Eme Type maad Value El'lte Value
. 8 Count_Reset:Count_Reset/o:Q DFF 0 =1
Instance Tree MUX,_SEL_Q:MUN_SELAI0:Q DFF 0 izl
B Count Reset User_CLK_QiUser CLEAO:Q OFF 0 2]
g EEg LeneD) + |FIFO_Lane0_out_c[3:0] DFF 10h000 ioh
_Lane |
e FIFO,_Lane1 out c[3:0] DFF 10h000 10h
Eso [ 7 lanetofie) O T
I User QLK
| count_0
Read Active Probes Write Active Prok
[Cho | [ e ]

Figure 163 - Active Probes Tab in SmartDebug FPGA Array Dialog Box

When you have selected the desired probe, points appear in the Active Probe Data chart and you can read
and write multiple probes (as shown in the figure below).

You can use the following options in the Write Value column to modify the probe signal added to the Ul:
e Drop-down menu with values ‘0’ and ‘1’ for individual probe signals
o Editable field to enter data in hex or binary for a probe group or a bus
FPGA Array debug data

| Live Prabes | Active Probes | Memory Blodks |

EC@® ) ) [ e ) (]|

Name b4 {Type Read Value [write Value |
Count_Reset:Count_Reset/U0:Q DFF Unread | ;Il
MUX_SEL_Q:MUX_SEL/J0:Q DFF Unread -
User_CLK_Q:User_CLK/UD:Q DFF Unread 1
SB_sb_0_SDIFO_INIT_APB_PEMABLE:SB_sb_0/CORECONFIGP_0/SDIF0_PEMABLE:Q DFF Unread - |
FIFO_Laned_out_c[5:0] DFF Unread 10b0101010101

b |FIFO_Lanel_out_c[5:0] DFF Unread 10'h3FF
[ Read Active Probes ] [ Write Active Probes l

Figure 164 - Active Probes Tab - Write Value Column Options

Live Probes (SmartFusion2, IGLOO2, and RTG4)

The Live Probes tab displays a table with the probe name and pin type.
Note: SmartFusion2 and IGLOO2 support two probe channels, and RTG4 supports one probe channel.
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Live Probes (SmartFusion2, IGLOO2, and RTG4)

SmartFusion2 and IGLOO2

Two probe channels (ChannelA and ChannelB) are available. When a probe name is selected, it can be
assigned to either ChannelA or ChannelB.

You can assign a probe to a channel by doing either of the following:
¢ Right-click a probe in the table and choose Assign to Channel A or Assign to Channel B.

e Click the Assign to Channel A or Assign to Channel B button to assign the probe selected in the
table to the channel. The buttons are located below the table.

When the assignment is complete, the probe name appears to the right of the button for that channel, and
SmartDebug configures the ChannelA and ChannelB I/Os to monitor the desired probe points. Because
there are only two channels, a maximum of two internal signals can be probed simultaneously.

Click the Unassign Channels button to clear the live probe names to the right of the channel buttons and
discontinue the live probe function during debug.

Note: At least one channel must be set; if you want to use both probes, they must be set at the same time.
The Active Probes READ/WRITE overwrites the settings of Live Probe channels (if any).
'+ | Debug FPGA Array :

=

Live/Active Probes Selection g x

FPGA Array debug data

<al View Netlist View ‘1‘1 Live Probes | Active Probes Memory Blocks
Filter: | search | | elete | [ peletesn |
Net(s): Add i |

4 :Inst_CLKO_Top/Inst_CLK0_B2/Inst_CLK0_B3/Inst_CLKD_B4/Inst_CLKO_B11/Inst_CLK0_|

Assign to Channel A
Assign to Channel B

:Inst_CLK0_Top/Inst_CLK(
:Inst_CLKD_Top,/Inst_CLK(
:Inst_CLKO_Top/Inst_CLK(
:Inst_CLKO_Topy/Inst_CLK( L 1 b |
:Inst_CLKD_Top/Inst_CLK( [ Assign to Channel & | ->

:Inst_CLKO_Top/Inst_CLK( r Acsign to Channel B ]
:Inst_CLKO_Top/lnst_CLKC _ | | | ——————— .

4 m 3

Figure 165 - Live Probes Tab (SmartFusion2 and IGLOO2) in SmartDebug FPGA Array Dialog Box

RTGA4

One probe channel (Probe Read Data Pin) is available for RTG4 for debug. When a probe name is selected,
it can be assigned to the Probe Channel (Probe Read Data Pin).

You can assign a probe to a channel by doing either of the following:
e Right-click a probe in the table and choose Assign to Probe Read Data Pin.

e Click the Assign to Probe Read Data Pin button to assign the probe selected in the table to the
channel. The button is located below the table.

Click the Unassign probe read data pin button to clear the live probe name to the right of the channel
button and discontinue the live probe function during debug.

The Active Probes READ/WRITE overwrites the settings of Live Probe channels (if any).
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Hierarchical View MNetlist View Live Probes Active Probes Memory Blocks
Filter: I Delete ] I Delete Al
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SR LED _cirl_0/pb1_regl:LED_ctrl_0/pb1_regl:Q
4 I LED _ctrl_0 LED_ctrl_0/pb1_reg2:LED_ctrl_0/pb1_reg2:Q Assign to probe read data pin
4 I0F Primitives . - . -
> B counter LED _ctrl_0/pb2_reg1:LED_ctrl_0/pb2 _reg1:Q DFF
B pbl regl
B pb1_reg2 LED_ctrl_0/pb2_reg2:LED_ctrl_0/pb2_reg2:Q DFF
B pb2_regl
B pb2_regz
> B rot_Ift
> 1B rot_rgt
Assign to probe read data pin | -3

Figure 166 - Live Probes Tab (RTG4) in SmartDebug FPGA Array Dialog Box

Inspect Device Dialog Box (SmartFusion, Fusion, and ProASIC3
Only)

Inspect Device is available as a part of the FlashPro programming tool. Refer to Using SmartDebug for
information about how to configure FlashPro to access this feature.

In the Inspect Device dialog box, you can access all SmartDebug features, such as the FlashROM,
Embedded Flash Memory (NVM), and Analog Block. If you have multiple devices and programmers
connected, choose your target device/programmer from the drop-down menu, and use the ID code to verify
that you are inspecting the correct device.

View Device Status - Displays the Device Status Report. The Device Status Report is a summary of your
device state, analog block test values, user information, factory data, and security information. You can save
or print your information for future reference.

View Analog Block Configuration - Opens the Analog Block Configuration dialog box. You can view the
channel configuration for your analog block and compare the channel configuration with any other analog
block file.

View Flash Memory Content - Opens the Flash Memory dialog box. You can view the details for each flash
memory block in your device.

View FlashROM Content - Opens the FlashROM data dialog box. You can view a list of the physical blocks
in your FlashROM and the client partitions in FlashROM configuration files.
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Analog Block Configuration Dialog Box (SmartFusion and Fusion Only)

Y Inspect Device E]E]

=0y S H ACF 200M3F (AZF200M3F)

Programemer: |S1538 (ush51538) A

ID code read from device: SAL31CF

| view Device Status | |view Analog Block Configuration | | view Flash Memory Content | |view FlashROM Content |

Figure 167 - Inspect Device Dialog Box

Analog Block Configuration Dialog Box (SmartFusion and Fusion
Only)

In the Analog Block Configuration dialog box, you can:

e View the channel configuration on your analog system and identify if/how the channels are configured.

e Compare with the design configuration from the Analog System Builder for Fusion and SmartDesign
MSS Configurator for SmartFusion.

The values displayed for each channel vary depending on the device family and channel you select; the
Channel configuration register read from the ACM is shown for each analog channel. Individual, decoded bit
fields of the register are listed immediately beneath (as described in the Fusion and SmartFusion
handbook). The dialog box may display the following values:

Fusion Device:

e Analog MUX select

e Internal chip T monitor

e Scaling factor control

e Current monitor switch

e Current monitor drive control

e Direct analog input switch

e Pad polarity - G, T, V, C pad polarity, positive or negative

e Select low/high drive

e Prescaler op amp mode
SmartFusion Device:

e Gain select

e Channel state

e Direct Input state

e Current Monitor state

e Current monitor strobe state

e Comparator state

e Hysteresis select

e Analog MUX select

e DAC input select
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e Temperature monitor state
e Temperature monitor strobe state
e Vref switch state

To use the compare feature, select the Compare with checkbox. If the loaded PDB file contains Analog
Block configuration information, the comparison appears automatically.

To use a specific Project File, click Browse and navigate to the Analog System Builder directory for Fusion
or SmartDesign for SmartFusion. In a typical IDE project, this directory is located at:

e Fusion - <project_root>/smartgen/<analog_block_core_name>
e SmartFusion - <project root>/component/work/<SmartDesign project>/MSS_ACE_0

After specifying the compare directory, the differences (if any) are indicated in red on a channel by channel
basis, as shown in the figure below.

1 Analog Block Configuration ? @
Channel configuration Compare with:  as15
Found 32 mismatched channals
a2
Channel Byte lo AV
\ g
oo e Cortr
ACO 000 .r_ﬁ | Byte 051 38
Analog MUX select Prescaler Direct inpuk
A N 3
Akl ! scaling Factor control 0.3125 (8v) 0. 15625 (16¥)
ATO Oxz0 .ﬂ Current monitor switch Off on
0x02 Direct analog input switch OF on
AVl ¥-pad polarity Pusitive Positive
ACL Dx10 Prescaler op amp mode  Operational Powerdown
AGL D00 | 4y
AT1 Oxe0 L\,
A2 Owsz2 i\’
AC2 Ox10 ]

Figure 168 - Analog Block Configuration Dialog Box for a Fusion Device (Differences in Red)

View Device Status (SmartFusion2, IGLOOZ2, and RTG4 Only)

Click View Device Status in the standalone SmartDebug main window to display the Device Status Report.
The Device Status Report is a complete summary of IDCode, device certificate, design information,
programming information, digest, and device security information. Use this dialog box to save or print your
information for future reference.

Note: This information is available for SmartFusion2 and IGLOO2 devices only. For RTG4 devices, View
Device Status displays IDCode information only.
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View Device Status (SmartFusion2, IGLOO2, and RTG4 Only)

> Device Status Report »

Device: M2S090T (M25090T) Programmer: S201YPVOZC (S201YPVOZC) Save | &= Print |

Device Status:
IDCode (read from the device) (HEX): 113071cf

Device Certificate

Family SmartFusion?
Die: M25090
Design Information
Design Name: SYS_SERDES
Design checksum (HEX): 53AA
Design Version: 0
Back Level: i]
Operating voltage: 1.2V
Internal Oscillator: 50MHz

Digest Information
Fabric Digest (HEX): 8d5382634b0%94bc52a0667 T15f342dfa
0000f7T8130faBla31dcb45cbbl1cf159

eNVM_0 Digest (HEX): 90d743000bb62aBbacabab52cldbbibe
e3f809034344d1a26624180728507254

Device Security Settings
ARM CortexM3 access to eSRAM module 0 read is protected.
ARM CortexM3 access to eSRAM module 0 write is protected.
ARM CortexM3 access to eSRAM module 1 read is protected.
ARM CortexM3 access to eSRAM module 1 write is protected.
ARM CortexM3 access to eNVM_D read is protected.
ABRM CortexM3 access to eNVM_0 write is protected.
ARM CortexM3 access to DDR bridge read is protected,
ARM CortexM3 access to DDR bridge write is protected.
Factory test mode access: Allowed.
Power on reset delay: 100ms
System Controller Suspend Mode: Disabled.

Programming Information

Cycle count: 333

VPP Range: HIGH { VPP >= 3.3V )
Temp Range: HOT

*Algorithm Version: 2

* Programmer: FlashPro 5
* Software Version: FlashPro v11.6

* Programming Software: FlashPro
* Programming Interface Protocol: |TAG
* Programming File Type: STAPL

NOTE: * - The above Information is only relevant if the device was programmed through JTAG or 5P| Slave mode.
| Help x Close |

I[dCode

IDCode read from the device under debug.

Device Certificate
Device certificate displays Family and Die information if device certificate is installed on the device.

If the device certificate is not installed on the device, a message indicating that the device certificate may not
have been installed is shown.

Design Information
Design Information displays the following:
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e Design Name

e Design Checksum
e Design Version

e Back Level

e Operating Voltage
e Internal Oscillator

Digest Information

Digest Information displays Fabric Digest, eNVM_0 Digest and eNVM_1 Digest (for M2S090 and M2S150
devices only) computed from the device during programming. eNVM digest is shown when eNVM is used in
the design.

Device Security Settings

Device Security Settings indicate the following:
e Factory test mode access
e Power on reset delay
e System Controller Suspend Mode

In addition, if custom security options are used, Device Security Settings indicate:
e User Lock segment is protected
e User Pass Key 1/2 encrypted programming is enforced for the FPGA Array
e User Pass Key 1/2 encrypted programming is enforced for the eNVM_0 and eNVM_1
e SmartDebug write access to Active Probe and AHB mem space
e SmartDebug read access to Active Probe, Live Probe & AHB mem space
e UJTAG access to fabric

Programming Information
Programming Information displays the following:
e Cycle Count
e VPP Range
e Temp Range
e Algorithm Version
e Programmer
e Software Version
e Programming Software
e Programming Interface Protocol
e Programming File Type

Embedded Flash Memory (NVM) Content Dialog Box
(SmartFusion and Fusion Only)

You can do the following in the NVM content dialog box:
¢ View content of Flash Memory pages (as shown in the figure below)
e Compare device content with original design content (requires a PDB that contains your EFC data)

e Check page status and identify if a page is corrupted or if the write count limit has exceeded the 10-
year retention threshold
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Embedded Flash Memory: Browse Retrieved Data (SmartFusion and Fusion Only)

Fusion Devices: Choose your block from the From block drop-down list This action populates the Select
drop-down list with the names of the clients in the selected block that is configured in the Flash Memory
System Builder.

SmartFusion Devices: Block selection is unused and unavailable.

Choose a client name from the Select drop-down list and click Read from Device to view the values. You
can also view a specific page range by selecting the <Page Range> option in the Select drop-down list and
then specifying the start page and the end page.

You must click Read from Device each time you specify a new page range to update the view.

If you do not have your original design programming database (PDB) file, you can examine and retrieve a
range of pages. Specify a page range if you wish to examine a specific set of pages. Page Status
information appears to the right.

l Flash Memory ri ﬁ'

Retrieve Flash Memory Content from Device:

From block. {
Select ACTEL PPE_MERGE CONFIG (p) = 2) Read from Device *
Sart address: (page 2044)
Cherit size: 4 bytes (1 page)
Latest Content Retrieved from Device: Mo Jun 06 1611601 2011

Retrieved Content: Chent “ACTEL_PPE_MERGE_CONFIG®, 48 bytes starting from address D IFEDD

View Detaded Status| [Compare Chent Content

Go to Address (hex)

Page Number | Address S

o |1+ J2]3af4)lsfe]?]oa]losfalefjc]ole]cr
2044 | FEOOjO0 03 00 00 10 00 10 10 00 @ W0 @ 0 ™ 10 220
2044 | ¥EIOjO1 ©3 40 00 10 00 10 10 01 03 0 0 43 ©o 10 220
2044 FE20| 11 00 1] ol o L) 20 18 10 00 ] 0 o0 o 20 1]
2044 | FENj00 00 00 00 00 00 00 00 00 00 00 00 00 00 0 W
2044 | ¥E40j00 00 00 00 00 00 00 00 00 0 ©00 00 00 00 00 OO
2044 FESO| 00 00 o o0 00 o0 o0 o0 0 o0 o 0 oo oo o o0
2044 | WESOlO0 00 00 00 00 00 00 00 00 0 00 00 00 00 0 W
2044 IFET0| 00 i 1] o0 00 00 (1] i) 0o 00 00 0o 00 00 0o 00 00

[ ] = ]

Figure 169 - Flash Memory Content Dialog Box for a SmartFusion Device (SmartDebug)

Embedded Flash Memory: Browse Retrieved Data (SmartFusion

and Fusion Only)

The retrieved data table displays the content of the selected client or the page range selection. Corrupted

page content is displayed in red. Read-only page content, corresponding to clients defined with the Prevent
read option in Flash Memory System Builder, is displayed with a gray background. If content cannot be read
(for example, pages are read-protected, but security has been erased), the content is displayed as XX. The
mouse tooltip summarizes abnormal content status (as shown in the figure below).
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The corresponding page number and address (relative to the current block) are displayed in the left column.
The client size specified in the Flash Memory System Builder is shown at the top of the content table.

In the Retrieved Data View, you can enter an Address value (such as 0010) in the Go to Address field and
click the corresponding button to go directly to that address.

Click View Detailed Status for a detailed report on the page range you have selected.

For example, if you want to view a report on pages 1-3, set the Start Page to 1, set the End Page to 3, and
click Read from Device. Then click View Detailed Status The figure below is an example of the data for a
specific page range.

X Flash Memory Details

In EBlock 1, from Page 1 to Page 3, 354 bytes starting from address 0x80 as of Wed Jan 20 15:40:57 2010 [ H Save l l & Frint l

.

Flash Memory Content [ Page L to 3]
FlashMemory Page #1:
Skatus Regisker{HEX): 000SF000
Skatus ECCZ check:  Pass
Data ECC2 Check:  Pass
Wyrite Count: Pass (2288 writes)
FlashMemory Page #2:
Skatus RegisterHEX): 000SF000
Skatus ECCZ check:  Pass
Data ECC2 Check:  Pass
\Write Counk: Pass (2288 writes)
FlashMemory Page #3:
Skatus RegisterHEX): 000SF000
Skatus ECCZ check:  Pass
Data ECC2 Check:  Pass
\Write Count: Pass (2288 writes)
Total number of pages with status ECCZ errars: O
Total number of pages with data ECCZ errors; O
Total number of pages with write count ouk of range: 0
Flashtemory Check PASSED For [ Page 1o 3 ]

Figure 170 - Flash Memory Details Dialog Box (SmartDebug)
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Embedded Flash Memory: Compare Memory Client (SmartFusion and Fusion Only)

I Flash Memary E| El

Retrieve Flash Memory Content from Device:

From block. |3 - newCore.efc |

{address 0xDO000)

Select | <Page RARgEs W
Start Page: |0
End Page: |3 (4 pages, 512 bytes)

Latest Content Retrieved from Device: Wed Jan 20 1033117 2010

Retrieved Content: In Block 3, from Page 0 to Page 3, 512 bytes starting From address 0w

View Detailed Status

Pmmrmmu|||2[3|+|5|a[§uTia|-a|A|a|c[o|E[F
o [ o000 ™ 00 b0 o0 o0 o0 00 b0 00 00 00 o0 o0 00 o0~
o |oow|oo 00 00 o0 00 00 00 00 o 0 0o
. el COR T T T A o ol T If.'cnruptnd; R:qdﬁqtﬁtcd;! o
o |owx|oo o o0 o0 o0 00 00 00 00 00 00 00 00 00 00 00
o | 00|00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
o | o00s{oo o0 o0 o0 00 00 00 00 00 00 00 00 00 00 00 00
o | ooosooc 00 00 o0 00 0 00 00 D0 00 00 00 00 00 00 00
s | o070 o0 o0 o0 00 00 00 00 00 00 00 00 00 00 00 00
. | o000 0 o o0 o0 00 0 00 00 00 00 00 00 00 00 00
i |oow|oo o0 o0 o0 00 00 00 00 00 00 00 00 00 00 00 00

W

H

Figure 171 - Flash Memory Browse Retrieved Data

Embedded Flash Memory: Compare Memory Client (SmartFusion
and Fusion Only)

After you retrieve the data from the device, the Compare Client Content button lets you compare the content
of the selected client from the device with the original programming database (PDB) file. The differences are

shown in the Compare Memory Client dialog box (as shown in the figure below).
Note: This option is not available when you select to retrieve the data based on a page range.
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1 Compare Memory Client

In Block 0, Client "DSBbIX", 256 bytes starting from address 0x0 as of Sun Jan 17 12:12:06 2010 | fdsave || &pint |

Flash Memory Client Compare [DS8bit - Block 0] ~|

Difference at byte 0.
Byte Design Device
0 |xFA |0x00

Difference at bytes 2 to 4.
Byte Design Device
2 O3f, (D00
3 OxAE | Ox00
4 OxB8 | OO0

Difference at bytes 6 to 255,
Byte Design Device
& OeFF | OeliD
7 CD (000
& Oefd, | OwD0
9 s, D00
10 |0xAR | Ox00
11 DR | O
12 Imcas [mnn |

Figure 172 - Compare Memory Client Dialog Box

FlashROM Content Dialog Box (Fusion and SmartFusion Only)

In the FlashROM Content dialog box, you can view the physical blocks in your FlashROM and the client
partitions specified in the original design content (requires a PDB that contains your UFC data). If the
project's PDB does not contain UFC data, only the physical blocks are displayed.

Scroll through the table to view the Words and Pages for your physical blocks.

The Client Partitions section lists the names and configuration details of the clients set up in the FlashROM
Builder. It automatically finds all mismatched client regions. To view the differences between a client and the
device content, select a region row in the Client Partitions table. This action highlights the corresponding
device content in the Physical Blocks table. The mismatch details are displayed below the Client Partitions
table.

To copy the content of the Physical Blocks table to clipboard, select one or more cells in the table and type
Ctrl+C.
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Device Debug / SmartDebug Tcl Commands (SmartFusion, IGLOO, ProASIC3, and Fusion Only)

1 FlashROM

Phesical Blocks

1514131211 w| o e z|e|ls|4a]a]z]1]o
7FF |78 |0 FC 78 P& |F3 78 77 |F& FS |74 F3 |72 |71 |FO
62z |2z |z 22 2z B2 |Z2 22 B (P2 22 |22 z2 |22 |22 %2
5/SF DE D0 5 DB SA4 59 D§ D7 56 55 D4 53 Dz DL |50
Pages 4 IENNEIIGEEEIES o r0 4 C0 EF 0A BC DE FO AB (D

%/3F BE BD 3C BB 34 |39 BG B7 |3 35 B4 33 B2 Bl |30
o0 o0 |00 o0 o0 OO0 00 OF BB |FA FA FA FA |FA |FA BB
1/o0 oo oo oo oo (oo (oo oo oo oo 00 00 00 |00 |00 |00
ool |23 45 67 89 Ol |23 45 &7 89 AA AB BB | CC |CD DD

Client Partitions

FlashRiOM configuration File: D:\tempifromzifrom_File_core\from_File_core.ufc

Found 2 client regions that do not match with device content,

Region Mame Region Type Page Start Ward Size (words)
Reqgion_3_11 Read fram File 3 11 5
Reqgion_4_11 Static 4 11 5 &
Region_5_11 Auko Inc 5 11 1 F

Content details for selected region

From device: ABCDEFOAEC
Fromn config File: 0000000000

Shown as: HEXADECIMAL

& Mismatch between configuration file content and device content.

Figure 173 - FlashROM Content Dialog Box

Device Debug / SmartDebug Tcl Commands (SmartFusion,
IGLOO, ProASIC3, and Fusion Only)

Note: Tcl commands in this section may not be supported by all device families listed above. See the
individual commands for specific device support.

The following table lists the Tcl commands related to Device Debug / SmartDebug for SmartFusion and
Fusion). Click the command to view more information.

Table 42 - Device Debug / SmartDebug Tcl Commands

Command Action Type
check_flash_memory Performs diagnostics of the page status and | Embedded
data information. Flash
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Command Action Type

Memory
(NVM)

compare_analog_config Compares the content of the analog block Analog Block
configurations in your design against the
actual values in the device.

compare_flashrom_client [ Compares the content of the FlashROM FlashROM
configurations in your design against the
actual values in the selected device.

compare_memory_client Compares the memory Embedded
client in a specific device | Flash
and block. Memory
(NVM)
read_analog_block_config Reads each channel Analog Block

configuration on your
analog system, enabling
you to identify iffhow each
channel is configured.

read_device_status Displays a summary of the selected device.

read flashrom Reads the content of the FlashROM from FlashROM
the selected device.

read flash _memory Reads information from the NVM modules Embedded
(page status and page data). Flash
Memory
(NVM)
read id code Reads IDCode from the device without

masking any IDCode fields.

recover_flash_memory Removes ECC2 errors due to memory Embedded
corruption by reprogramming specified flash | Flash
memory (NVM) pages and initializing all Memory
pages to zeros. (NVM)

sample_analog_channel [ Samples analog channel; enables you to
debug ADC conversion of the preconfigured
analog channel (you must provide ADC
conversion parameters ).

set_debug_device Identifies the device you intend to debug.

set_debug_programmer Identifies the programmer you want to use
for debugging (if you have more than one).

Using SmartDebug with SmartFusion2, IGLOO2, and RTG4

The most common flow for SmartDebug is:
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Device Status Report (SmartFusion and Fusion Only)

1. Create your design. You must have a FlashPro programmer connected to use SmartDebug.

2. Expand Debug Design and double-click Smart Debug Design in the Design Flow window.
SmartDebug opens for your target device.

3. Click View Device Status to view the device status report and check for issues.

4. Examine individual silicon features, such as FPGA debug.

Device Status Report (SmartFusion and Fusion Only)

This dialog box displays the Device Information report. The Device Information report is a complete
summary of your device state, analog block test values, user information, factory serial number, and security
information. Use this dialog box to save or print your information for future reference.

Y Device Status Report

Device: AFS600 (AFS600) Programmer: 10868 (usb10866) | Hsee || &@pit |
Device Status:
IDCode (HEX): 233261cf
User Information:
UROW data (HEX): 2308004 1020408102045FdBT66803461
Programming Method: FOEB
Progr amirer ; FlashPro3
Programmer Software: FlashPro v8.6
Dresign Marme: kop
Design Check. Sum: 2308
Algorithem ersion: 19
Array Prog. Cyde Count: 1
Device State:
IRCapture Register (HEX): 55
FPGA Array Stabus: Programmed and enabled
Analog Block:
OABTR Regester (HEX): 1dbe3bb
3.3 (wdd23): PASS
1.5¥ (vdd15): PASS
Bandgap: PASS
-3.3¥ (vddn33): PASS
ADC Refersnce: PASS
FPGA_Good: PASS
Status: Analog Block is operational
Factory Data:
Factory Serial Number (HEX): Ble00486060
Security:
Device has no security enforced.
(o]

Figure 174 - Device Status Report
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Debug SERDES (SmartFusion2, IGLOOZ2, and RTG4)

You can examine and debug the SERDES blocks in your design in the Debug SERDES dialog box (shown
in the figure below).

To Debug SERDES, expand SmartDebug in the Design Flow window and double-click Debug SERDES.

Debug SERDES Configuration is explained below. See the PRBS Test and Loopback Test topics for
information specific to those procedures.

SERDES Block identifies which SERDES block you are configuring. Use the drop-down menu to select
from the list of SERDES blocks in your design.

Debug SERDES - Configuration

Configuration Report

The Configuration Report output depends on the options you select in your PRBS Test and Loopback Tests.
The default report lists the following for each Lane in your SERDES block:

Lane mode - Indicates the programmed mode on a SERDES lane as defined by the SERDES system
register.

PMA Ready - Indicates whether PMA has completed its internal calibration sequence for the specific lane
and whether the PMA is operational. See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces User
Guide on the Microsemi website for details.

TxPIl status - Indicates the loss-of-lock status for the TXPLL is asserted and remains asserted until the PLL
reacquires lock.

RxPLL status - Indicates the CDR PLL frequency is not grossly out of range of with incoming data stream.

Click Refresh Report to update the contents of your SERDES Configuration Report. Changes to the
specified SERDES register programming can be read back to the report.

SERDES Register Read or Write

Script - Runs Read/Write commands to access the SERDES control/status register map using a script.
Enter the full pathname for the script location or click the browse button to navigate to your script file. Click
Execute to run the script.
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Debug SERDES — PRBS Test

> Debug SERDES )

SERDES Block: |SERDESIF 0 ~

2 Lane 0 Lane 1 Lane 2 Lane 3
SERDES Lanes: — —— —
Lane 0 Reset | |Lane lR.eset! |Lane 2Reset | |Lane 3Reset |
| Debug sERDES | configuration Report:
Configuration | T+] [Refresh Rewort]
4 Tests Serdes Blodk SERDESIF_0 :
v Pleemode:  EPCS (aston)
ane mode : cus
Loopback Test PMA Ready 1 True
TxPLL status : Locked
RxPLL status : Lodked
Lane 1:
Lane mode : EPCS (custom)
PMA Ready : True
TxPLL status Locked
RoPLL status : Lodked
Lane 2 @
Lane made : EPCS (oustom)
PMA Ready : True
TyFLL status : Locked
RxPLL status : Lodked
Lane 3:
Lane mode : EPCS (custom)
PMA Ready : True
THPLL status : Lodked
RxPLL status : Lodked
SERDES Register Read or Write:
Help Clase

Figure 175 - Debug SERDES - Configuration
Note: The PCle and XAUI protocols only support PRBS7. The EPCS protocol supports PRBS7/11/23/31.

Debug SERDES — PRBS Test

PRBS data stream patterns are generated and checked by the internal SERDES block. These are used to
self-test signal integrity of the device. You can switch the device through several predefined patterns.

View Loopback Test settings in the Debug SERDES - Loopback Test topic.

SERDES Block identifies which SERDES block you are configuring. Use the drop-down menu to select
from the list of SERDES blocks in your design.

SERDES Lanes

Select the Lane and Lane Status on which to run the PRBS test. Lane mode indicates the programmed
mode on a SERDES lane as defined by the SERDES system register.

Test Type

Near End Serial Loopback (On-Die) enables a self test of the device. The serial data stream is sent from
the SERDES TX output and folded back onto the SERDES RX input.

Serial Data (Off-Die) is the normal system operation where the data stream is sent off chip from the TX
output and must be connected to the RX input via a cable or other type of electrical interconnection.
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The SERDESIF includes an embedded test pattern generator and checker used to perform serial
diagnostics on the serial channel, as shown in the table below.

Pattern

Type

PRBS7

Pseudo-Random data stream of 277 polynomial sequences

PRBS11

Pseudo-Random data stream of 2711 polynomial sequences

PRBS23

Pseudo-Random data stream of 2723 polynomial sequences

PRBS31

Pseudo-Random data stream of 2731 polynomial sequences

Cumulative Error Count

Lists the number of cumulative errors after running your PRBS test. Click Reset to reset to zero. 1. By
default, Cumulative Error Count = 0, the Data Rate text box is blank, and Bit Error Rate = NA.

€ Debug SERDES

[ 7 o)

Debug SERDES
Configuration
4 Tests
PRBS Test
Locpback Test

SERDES Block: |SERDESIF.0 =

@ Lane 0 Lane 1 Lane 2 Lane 3
SERDES Lanes: : .- . .
Lane O Reset | | Lane 1Reset | |Lane 2Reset | [La'.e 3Reset |
Lane O status: RaPLL TwPLL Lok to data
Test Type:
@ Near End Serial Loopback (On-Die) Serial Data (Off-Die)
Pattern:
@ PRBS7
PRES11 i'
PRBS 23 .
PRBS 31
Cumudative Error Count  Data Rate Bit Error Rate
] 1 Gbps  NA [ Reset

Start

Figure 176 - Debug SERDES - PRBS Test

Note: If the design uses SERDES PCle, PRBS7 will be the only option shown for PRBS tests..

Bit Error Rate

Displays the Bit Error Rate (BER) for the PRBS test in progress.
The formula for calculating the BER is as follows:

BER = (#bit errors+1)/#bits sent

#bits sent = Elapsed time/bit period
When clicked on Start:
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Debug SERDES - Loopback Test

e The BER is updated every second for the entered data rate and errors observed.
e If no data rate is entered by the user, the BER is set to the default.
When clicked on Stop:
e The BER resets to default.
When clicked on Reset:
e The BER is reset to default.
e If notestisin progress, the BER remains in the default value.
e Ifthe PRBS test is in progress, the BER calculation restarts.

Debug SERDES — Loopback Test

Loopback data stream patterns are generated and checked by the internal SERDES block. These are used
to self-test signal integrity of the device. You can switch the device through predefined tests.
See the PRBS Test topic for more information about the PRBS test options.

SERDES Block identifies which SERDES block you are configuring. Use the drop-down menu to select
from the list of SERDES blocks in your design.

SERDES Lanes

Test Type

Select the Lane and Lane Status on which to run the Loopback test. Lane mode indicates the programmed
mode on a SERDES lane as defined by the SERDES system register.

PCS Far End PMA RX to TX Loopback- This loopback brings data into the device and deserializes and
serializes the data before sending it off-chip. This loopback requires OPPM clock variation between the TX
and RX SERDES clocks.

See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces User's Guide on the Microsemi website for
details.

Near End Loopback (On Die) - To enable, select the Near End Loopback (On Die) option and click Start.
Click Stop to disable. Using this option allows you to send and receive user data without sending traffic off-
chip. You can test design functionality without introducing other issues on the PCB.

See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces User's Guide on the Microsemi website for
details.
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SER0ES Hock: (SERDESIE_O 7]
@ Lane 0 © Lane 1 D lane2 ) Lane3
(Lane 0Reset ] [Lane 1Reset | [Lane 2Reset | |Lane 3Reset

SERDES Lanes:

Debug SERDES Lane 0 status: RxPLL ® &

Configuration Tast Type:

4 Tests
PRES Test (@ PCS Far End PMA Rx to Tx Loopback

|Loopback Test i () Mear End Serial Loopback (On Die)

Figure 177 - Debug SERDES - Loopback Test
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Debug FPGA Array (SmartFusion2, IGLOO2, and RTG4 Only)

Debugging

Debug FPGA Array (SmartFusion2, IGLOO2, and RTG4 Only)

In the Debug FPGA Array dialog box, you can view your Live Probes, Active Probes, and Memory Blocks,
and Insert Probes (Probe Insertion).

The Debug FPGA Array dialog box includes the following four tabs:
e Live Probes
e Active Probes

e Memory Blocks
e Probe Insertion

Live Probes (SmartFusion2, IGLOOZ2, and RTG4)

The Live Probes tab displays a table with the probe name and pin type.
Note: SmartFusion2 and IGLOO2 support two probe channels, and RTG4 supports one probe channel.

SmartFusion2 and IGLOO2

Two probe channels (ChannelA and ChannelB) are available. When a probe name is selected, it can be
assigned to either ChannelA or ChannelB.

You can assign a probe to a channel by doing either of the following:
¢ Right-click a probe in the table and choose Assign to Channel A or Assign to Channel B.

e Click the Assign to Channel A or Assign to Channel B button to assign the probe selected in the
table to the channel. The buttons are located below the table.

When the assignment is complete, the probe name appears to the right of the button for that channel, and
SmartDebug configures the ChannelA and ChannelB I/Os to monitor the desired probe points. Because
there are only two channels, a maximum of two internal signals can be probed simultaneously.

Click the Unassign Channels button to clear the live probe names to the right of the channel buttons and
discontinue the live probe function during debug.

Note: At least one channel must be set; if you want to use both probes, they must be set at the same time.
The Active Probes READ/WRITE overwrites the settings of Live Probe channels (if any).
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Live/Active Probes Selection g x

FPGA Array debug data

alView | MetiistView | 4| F Lwe Probes | Active Probes | Memory Blocks | )
Filter: Search Delete Delete All
Net(s): Add

T :Inst_CLKD_Top/Inst_CLKO_B2/Inst_CLKO_B3/Inst_CLK0_84/Inst_CLKO_B11/Inst_CLKD_| -
Assign to Channel A

:Inst_CLKO_Top,/Inst_CLK( Assign to Channel B
:Inst_CLK0_Top/Inst_CLK(
:Inst_CLKO_Top/Inst_CLK(
:Inst_CLKO_Top/Inst_CLK( i-_ I »
:Inst_CLKO_Top/Inst_CLK( [ Assign to Channel A ] >
. :Inst_CLKO_Top/Inst_CLK( [ -Assisn R 5
:Inst_CLKO_Topy/Inst_CLK( _ e
Unassign Channels H
T 3 | i e

Figure 178 - Live Probes Tab (SmartFusion2 and IGLOO2) in SmartDebug FPGA Array Dialog Box

RTGA4

One probe channel (Probe Read Data Pin) is available for RTG4 for debug. When a probe name is selected,
it can be assigned to the Probe Channel (Probe Read Data Pin).

You can assign a probe to a channel by doing either of the following:
¢ Right-click a probe in the table and choose Assign to Probe Read Data Pin.

e Click the Assign to Probe Read Data Pin button to assign the probe selected in the table to the
channel. The button is located below the table.

Click the Unassign probe read data pin button to clear the live probe name to the right of the channel
button and discontinue the live probe function during debug.

The Active Probes READ/WRITE overwrites the settings of Live Probe channels (if any).

- ~
&1 Debug FPGA Array B RER >
Live [Active Probes Selection F X FPGA Array debug data
Hierarchical View Metlist View Live Probes Active Probes Memory Blocks
Filters Search ’ Delete ] ’ Delete Al
— e e

SNFRe LED_ctrl_0/pb1_regl:LED_ctrl_0/pb1 _regl:Q

4 I LED cwl 0 LED_ctrl_0/pb1_regZ:LED_ctrl_0/pb1 reg2:Q
4 I Primitives
b 10 counter LED_ctrl_0/pb2_regL:LED_ctrl_0/pb2 reql:Q DFF
pbl_regl
pbl reg2 LED_ctrl_0/pb2_reg2:LED_ctrl_0/pb2 req2:Q DFF
pb2_regl
pb2_reg2
rot_Ift
rot_rgt

Assign to probe read data pin

L1 1111

Assign to probe read data pin | -3
Unassign probe read data pin

Figure 179 - Live Probes Tab (RTG4) in SmartDebug FPGA Array Dialog Box
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Active Probes (SmartFusion2, IGLOO2, and RTG4)

Active Probes (SmartFusion2, IGLOO2, and RTG4)

In the left pane of the Active Probes tab, all available Probe Points are listed in instance level hierarchy in
the Hierarchical View. All Probe Names are listed with the Name and Type (which is the physical location of
the flip-flop) in the Netlist View.

Select probe points from the Hierarchical View or Netlist View, right-click and choose Add to add them to the
Active Probes Ul. You can also add the selected probe points by clicking the Add button. The probes list
can be filtered by using the Filter box.

)

5| Debug FPGA Array icsslalEl
Live/Active Probes Selection B X Fpga Array debug data
[ vierarchical view | Netist view | ) Live Probes | Active Probes | Memory Bocks |
e [ J E - 4 ¥ Save... J[ Load... J Delate | Deetzal |

e [ ﬁda Mme Type maad Value Er’ne Value

e " Count_Reset:Count_Reset/U0:Q DFF 0 =]

Instance Tree MUY, SEL_Q:MUN_SELAIO:Q DFF 0 xl
B Count_Reset User_CLK_Qr:User CLKAO:Q DFF [1] =]
g FEg JoveD + |FiFO_tanen_out_c[s:0] oFF 10h00 ioh

_Lane w

= wx s FIFO _Lane1 out cfs:0] DFE 10h000 10h
M 50 | & |g_pet_0[19:0] DFF 20h
I User Q1K
| count 0

Figure 180 - Active Probes Tab in SmartDebug FPGA Array Dialog Box

When you have selected the desired probe, points appear in the Active Probe Data chart and you can read
and write multiple probes (as shown in the figure below).

You can use the following options in the Write Value column to modify the probe signal added to the Ul:
e Drop-down menu with values ‘0’ and ‘1’ for individual probe signals
e Editable field to enter data in hex or binary for a probe group or a bus
FPGA Array debug data

[ live robes | actve Proves | Memary Blods |

"Elo o) () [ oo (]|

Name - Type |Read Value [Write Value ]
Count_Reset:Count_Reset/U0:Q DFF Unread | Jl
MUX_SEL_Q:MUX_SEL/U0:Q DFF Unread .
User_CLK_Q:User_CLK/UD:Q DFF Unread 1
SB_sb_D_SDIFO_INIT_APB_PENABLE:SB_sb_0/CORECONFIGP_0/SDIF0_PENABLE:Q DFF Unread S
FIFO_Lane0_out_c[9:0] DFF Unread 1050101010101

b |FIFQ_Lanel out c[9:0] DFF Unread 10h3FF
[ Read Active Probes ] [ Wiite Active Probes ]

Figure 181 - Active Probes Tab - Write Value Column Options
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Memory Blocks (SmartFusion2, IGLOO2, and RTG4)

The left pane in the Memory Blocks tab shows the list of defined memory blocks that are specified in your
design. Select a memory block and add it to the Ul. After you select a memory block, you can click Read
Block to show the current content of the memory or write to individual memory locations. Each field is
editable, and multiple memory locations can be written at the same time.

Each field is a 9-bit memory word (for SmartFusion2 and IGLOO2 devices) and 9-bit or 12-bit memory word
(for RTG4 devices, depending on the memory configuration). Valid inputs are hexadecimal values between
0x0 and Ox1FF (for SmartFusion2, IGLOO2, and RTG4 devices in 9-bit mode) and 0x0 and OxFFF (for
RTG4 devices only in 12-bit mode), as shown in the figure below.

11 Debug FPGA Aray b & e
Memory Blocks Selection X ey Array debug data
Memory Blodss: seect | LiveProbes | ActiveProbes | MemaryBads |
R Frcbe_Fabde_ 0N _Prebe_LRAL 7L FOCORET FAGAIEE. » Curent Memory Block:  RAM _Probe Fabric_O/RAM Probe_LRAM_73_URAM ROCO/INST RAMG4x 18 P
| | RAM_Probe_Fabric_0/RAM_Probe_LRAM_35_URAM_ROCD/INST RAM6AIBIP [ Data bit Mode: ]
RAM_Probe_Fabric_0/RAM_Probe_DPSRAM_21_DPSRAM_ROCH/INST_RAMIKIS [P |= )
RAM_Probe_Fabric_0[RAM_Probe_DPSRAM_75_DPSRAM ROCD/INST_ RAMIKIE_IP 0000 183 OSE 080 180 002 O2A DOS 000 100 020 00A 168 OAD 101 020 1CO
RAM_Probe_Fabric_0RAM_Probe_DPSRAM_53_DPSRLAM_ROCO/INST_RAMIKIS [P
RAM_Probe_Fabric_0/RAM_Probe_URAM_38_URAM_ROCO/INST_RAMS4x18_IP o 5
D e e e oot 000 004 108 020 010 024 000 140 000 00 00 130 W00 03 G065 04
RAM Probe Fabric 0RAM Probe DPSRAM_75 DPSRAM ROCO/INST RAMIKIS 1P 0020 110 190 004 OEO 012 00D 040 000 004 033 00D 00O 100 01 002 000
RAM_Probe_Fabric_0/RAM_Probe_URAM_17_URAM_ROCO/INST_RAMS4x13_IP
RAM Probe Fabric 0/RAM Probe DPSRAM 56 DPSRAM_ROCO/INST RAMIKIE [P 0030 003 000 DI 010 003 000 00O 000 00D 001 0DO 01 061 100 122 OD4
RAM_Probe_Fabric_0/RAM_Probe_URAM_86_URAM_ROCO/INST_RAMS4x13_IP |
RAM_Pmbe_Fdx?c_n,Rm_m_m_ﬂ_m_ﬂocam_mmw_m 0040 000 020 004 040 000 001 000 144 CBC 0IC 020 000 000 003 0COD 000
RAM_Probe_Fabric_0/RAM_Probe_URAM_32_URAM_ROCO/INST_RAMS4x13_IP
RJM_PN(!_FW?C_Um_m_m_@_m_ﬂwm_m]xw_ﬂ’ 0050 000 000 000 020 002 000 OCL 040 101 080 011 009 010 O 008 100
RAM_Probe_Fabric_0/RAM_Probe_DPSRAM_25_DPSRAM_ROCO/INST RAMIX18_IP |
RAM _Probe_Fobric 0/RAM_Probe_DPSRAM 63 DPSRAM ROCOINST_RAMIXIS 1P 0060 OIE 100 041 000 018 002 040 008 001 002 000 004 00D 001 000 001
RAM_Probe_Fabric_0/RAM_Probe_URAM_84 URAM_ROCH/INST RAMS4x18_IP
RAM_Probe._Fabric_0/RAM_Probe_DPSRAM_38_ DPSRAM_ROCO/INST_RAMIXIS 1P 0070 120 002 002 004 050 038 00O 004 008 000 000 DO 00D 100 044 080
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| RAM_Probe_Fabric_0/RAM Probe_URAM_S8_LRAM_ROCO/INST RAMEXIS P~ |

b |  oom

Figure 182 - Debug FPGA Array - Memory Blocks Tab

Fields that have changed but have not yet been written appear in red text until you click Write Block to
initiate a memory write (as shown in the figure below).
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Memory Blocks Selection
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RAM_Probe_Fabric_0/RAM_Probe_URAM_55_URAM_ROCO/INST _RAMS4x18_IP
RAM_Probe_Fabric_0/RAM Probe URAM_106_URAM_ROCO/INST RAMS4x15_IP
RAM_Probe_Fabric_0/RAM_Probe_URAM_100_URAM_ROCO/INST_RAMS4x18_IP
RAM_Probe_Fabric_0/RAM_Probe_URAM_104_URAM_ROCO/INST_RAMG4x15_IP
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[[wveprobes [ Actve Probes | MemoryBiods |
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Figure 183 - Memory Blocks with Updated Values

Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

Introduction

Probe insertion is a post-layout debug process that enables internal nets in the FPGA design to be routed to
unused I/Os. Nets are selected and assigned to probes using the Probe Insertion window in SmartDebug.
The rerouted design can then be programmed into the FPGA, where an external logic analyzer or
oscilloscope can be used to view the activity of the probed signal.

User —
RTL Pre-Synthesis
Simulation
lementation -
Design Imp ~ Synthesis b
' Simulation
Insert probes into design ; |.
Originel e \ <R 10 Lm&m
Signal . l
Route - -—'D Incrementally :
B routed net for !
probing - Program
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Probe Insertion in the Design Process

The Probe Insertion debug feature is complementary to Live Probes and Active Probes. Live Probes and
Active Probes use a special dedicated probe circuitry.

Probe Insertion
1. Double-click SmartDebug Design in the Design Flow window to open the SmartDebug main window.
Note: FlashPro Programmer must be connected for SmartDebug.
2. Select Debug FPGA Array and then select the Probe Insertion tab.

5] Debug FPGA Armray o B8 B
Probe Insertion Data Sslection & X FPGA Array data

Herarchical View | Ietlist View Live Probes | Active Probes | Memory Blacks | Probe Insertion
Fiter: [ search | Delet | et
Futancelg): [ A MNet Diriver Padkage Pin Port Name

f

- | - I
Instance Tree AND2. 0¥ AND2_OMIO:Y |Unassigned | Probe_lnsertd

& Primitives AG_SY FF_IP: | * | Probe_Insert1
i D UJTAG_O/INST_UJTAG_SYSRESET_FF_IP:UCRUFD  |Unassgned ¥ |Prabe,Insert
B D_buf

i FCCC 0

B MUK_SEL

& mMx20

T Reset

B Stop

B/ umG_0

T User_OK

& count_0 Insért probe(s) and program the device Run

Figure 184 - -
Figure 185 - Probe Insertion Tab

In the left pane of the Probe Insertion tab, all available Probe Points are listed in instance level hierarchy in
the Hierarchical View. All Probe Names are shown with the Name and Type in the Netlist View.

3. Select probe points from the Hierarchical View or Netlist View, right-click and choose Add to add them
to the Active Probes Ul. You can also add the selected probe points by clicking the Add button. The
probes list can be filtered by using the Filter box.

Each entry has a Net and Driver name which identifies that probe point.

The selected net(s) appear in the Probes table in the Probe Insertion tab, as shown in the figure
below. SmartDebug automatically generates the Port Name for the probe. You can change the Port
Name from the default if desired.

4. Assign a package pin to the probe using the drop-down list in the Package Pin column. You can assign
the probe to any unused package pin (spare 1/O).
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5] Debug FPGA Array L= B

®

Probe Insertion Data Selection g X FPGA Array debug data

Hesarchical View | Nefist View Live Probes | Active Probes | Memory Blocks | Frobe Insertion
Filter: ;_Seufh [ Delete Al

Instance(s): Il Add Net Driver _ PadkagePn Port Mame

[ 0! count_0/q[0]: H: * | Probe_tnsert
Instance Tree a_¢[o] _0fa[0]:Q | 5 | ]

& Primitrves q_£[1] count_0fq[1]:Q :H6 . I'I'esti’
i AND2 0 | |

) [ 1
D bt a.<03) count_0/al3):Q 3 - | Probe_Insertz
B Feac_o e
| mux_seL
- miz0
IF Reset
i Stop
B UITAG_0
T User QK
4 I count_0

» W qs

Insert probe(s) and program the device i Run

Figure 186 - Debug FPGA Array > Probe Insertion > Add Probe
5. Click Run.

This triggers Place and Route in incremental mode, and the selected probe nets are routed to the
selected package pin. After incremental Place and Route, Libero automatically reprograms the device
with the added probes.

The log window shows the status of the Probe Insertion run.

Probe Deletion
To delete a probe, select the probe and click Delete. To delete all the probes, click Delete All.

Note: Deleting probes from the probes list without clicking Run does not automatically remove the probes
from the design.

Reverting to the Original Design
To revert to the original design after you have finished debugging:
1. In SmartDebug, click Delete All to delete all probes.
2. Click Run.

3. Wait until the action has completed by monitoring the activity indicator (spinning blue circle). Action is
completed when the activity indicator disappears.

4. Close SmartDebug.
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SmartDebug Tcl Commands

SmartDebug Tcl Support (SmartFusion2, IGLOOZ2, and RTGA4)

The following table lists the Tcl commands related to SmartDebug for SmartFusion2, IGLOO2, and RTGA4.
Click the command to view more information.

Table 43 - SmartDebug Tcl Commands

Command Action

DDR/MDDR

ddr_read Reads the value of specified configuration registers
pertaining to the DDR memory controller (MDDR/FDDR)

ddr_write Writes the value of specified configuration registers
pertaining to the DDR memory controller (MDDR/FDDR)

Probe

add_to probe_group Adds the specified probe points to the specified probe
group

create_probe_group Creates a new probe group

delete_active probe Deletes either all or the selected active probes.

load_active probe_list Loads the list of probes from the file.

move_to probe group Moves the specified probe points to the specified probe
group.

set_live_probe Set Live probe channels A and/or B to the specified probe

point (or points).

select_active_probe Manages the current selection of active probe points to be
used by active probe READ operations.

read_active probe Reads active probe values from the device.

remove from_probe group | Move out the specified probe points from the group.

save_active probe_list Saves the list of active probes to a file.

select_active_probe Manages the current selection of active probe points to be
used by active probe READ operations.

ungroup Disassociates the probes as group.

unset_live_probe Discontinues the debug function and clears live probe
channels.

write_active probe Sets the target probe point on the device to the specified
value.
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Customizing the Toolbar

LSRAM

read_Isram Reads a specified block of large SRAM from the device.

write _Isram Writes a seven bit word into the
specified large SRAM location.

USRAM
read usram Reads a uSRAM block from the device.
write _usram Writes a seven bit word into the

specified uSRAM location.

SERDES

prbs_test Starts, stops, resets the error counter and reads the error
counter value in PRBS tests.

loopback_test Starts and stops the loopback tests.
serdes lane_reset In EPCS mode, this command resets the lane. In PCI

mode, this command resets the lane, all other lanes in the
link, and the corresponding PCle controller.

serdes_read_regqister Reads the SERDES register value and displays the result
in the log window/console.

serdes_write_register Writes the value to the SERDES register.

Additional Commands

export_smart debug_data | Exports debug data for the SmartDebug application.

Customizing the Toolbar

Display the tools and commands you frequently use in the toolbar by customizing it.

To customize the toolbar:

1. From the Customize menu, choose Toolbars. The Customize dialog appears.

2. Click the Toolbar tab and check the tools you want to display by checking their respective boxes, (see
figure below).

Note: You can remove tools from your toolbar by deselecting tools from the Toolbar field.
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Figure 187 - Customize Dialog Box

3. Click inside the Show Tooltips checkbox for assistance in identifying icons on your toolbar when you
scroll across them with your mouse.

4. Click inside the Cool Look checkbox to change the look of your toolbar.
5. Click OK.

You can create multiple toolbars and assign names to them. Click the New button and type in a name
in the New toolbar dialog box to create a new toolbar. The name of your toolbar will display in the
Toolbar field. Reset your toolbar to the default settings by clicking the Reset button.

To customize commands:

1. From the Customize menu, choose Toolbars. The Customize dialog appears.
2. Click the Commands tab.
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Figure 188 - Customize Dialog Box

3. Select a category by clicking one of three options (File, Tools, or Programmers). As you click an
option, the buttons to the right of the category area change accordingly.

4. Click and drag a button to your toolbar.
5. Click OK after you have customized your toolbar.

You can also remove commands from your toolbar by reversing the click and drag method described

in the steps above. Click and drag tools from your toolbar to the Buttons field in the Customize dialog
box.

Customizing the Programming Window

The FlashPro software also enables you to customize the programmer window by right-clicking on the
programmer window's header (see figure below).

Programmer Programmer Programmer Port Programmer Programmer
10 Hame Type Status Enabled

Figure 189 - Programming Window Header
The following right-click menu displays (see figure below).
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Set 'Programmer Mame' Default Colurn Size
Set All Default Sizes

Sort ‘Programmer Name' Ascending
Sort ‘Programmer Name' Descending

Programmer ID
v Programmer MName
v Programmer Type
v Port
v Programmer Sktatus
v Programmer Enabled

Customize Columns. ..

Figure 190 - Right-click Menu

The Customize right-click menu (as shown above) is divided into three sections. Click an item in the first
section to set default sizes. Click an item in the second/middle section to add that item to the programmer
window, and click the Advanced or last section to customize the columns in the Programmer window from
the Customize Columns dialog box (see figure below).

Customize Columns

Check the calurmns that wau would like visible in Ehis
wiew, |se the Up and Down buttons ko reorder the
columns however vou like.

WFrogrammer 1D []s] +
[w]Prograrmmer Mame

[wlProgrammer Type Lo Jv
[w]Part

[wIProgrammer Skakus Hide
[wlProgrammer Enabled

[w]Current Serial Data Shiow

Default

(] 4 I Cancel |

Figure 191 - Customize Columns Dialog Box

Note: Follow the instructions in the Customize Columns dialog box to customize the programming window.
Use the Up and Down buttons to move through the list. Use the Show and Hide buttons to hide or
show columns in the programmer window.

ErLE

FlashPro Preferences

The Preferences dialog box includes three tabs: Log Window, Display Mode, and Updates (see figure
below). You can access the Preferences dialog box by choosing File > Preferences.
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Figure 192 - Preferences Dialog Box

Log Window

The Log Window tab includes options for you to choose color settings for the various messages (Errors,
Warnings, Information, Links) displayed in the Log window (see figure above).

Display Mode

The Display Mode tab describes the two display modes available in the FlashPro software (as shown in the
figure below). Read each option carefully and choose the mode that will meet your programming needs. As
the Preferences dialog box indicates, the Classic Mode is designed for multiple programming runs when it is
not necessary for you to change your device settings. The Advanced Mode differs from the Classic Mode
because displays both windows (Programmer List and Device Configuration) in the same GUI. Use this
mode when you need to change device settings frequently.
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Figure 193 - Preferences Dialog Box- Display Mode

Software Updates

The Updates tab lists the FlashPro software setting options. You can choose to have the FlashPro software

automatically check for updates at startup (from the Microsemi website) or remind you to check for updates

at startup (requires you to go to the Microsemi SoC website). If you want to decline both options, choose the
last option: Do not check for updates or remind me at startup.

Preferences x|

Log Window | Dizplay Mode  Updates

Automatic Software Update:

S ettingz
" Automatically check for updates at startup
" Femind me to check for updates at startup

€+ Do not check for updates o remind me at startup

To keep vour zoftware up-to-date, you can autornatically
check for available updates at startup. To manually check
for updates, from the Help menu, chooze Check for
Software Updates.

T hiz feature requirez an |nternet connection.

] I Cancel Help

Figure 194 - Preferences Dialog Box- Updates

Software version is up to date

This informational message notifies you that there are no software updates available from Microsemi at this
time. You can set your update preferences to automatically check for software updates.

292 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

FlashPro File Menu

FlashPro File Menu

In the Chain Programming mode, the Edit menu and the Configuration menu changes. The table notes

these changes.

Command

Ilcon

Shortcut

Sub-menu

Function

New Project

Ctrl+ N

Create a new project

Open Project

Ctrl + O

Opens the FlashPro Open Project
dialog box

Restore
Chainbuilder
Project

Restores a ChainBuilder project in
FlashPro

Close Project

Closes the current project

Save Project

Ctrl+ S

Saves the current project

Save Project As

Opens the Save As dialog box;
enables you to save your project
in a different directory or with a
different name

Import
Configuration
File

Ctrl + 1

Opens the Import Configuration
File dialog box; enables you to
import configuration files for your
device(s)

Set Project Log
File >

Main Log File

Opens the Set Log File dialog
box; sets the location of your main
log file

Serialization
Log File

Opens the Set Serialization Log
File dialog box; sets the location
of your serialization log file

Run Script

Opens the Execute Script dialog
box; enables you to run Tcl
Scripts with arguments

Export >

Configuration
File

Opens the Export Configuration
File dialog box; enables you to
export configuration file(s)

Script

Opens the Save As dialog box;
enables you to export your
actions as a Tcl script

Chain STAPL
File

Opens the Export Chain STAPL
File dialog box; enables you to
export and save your Chain
STAPL file

Chain SVF File

Opens the Export Chain SVF File
dialog box; enables you to export
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Command

Icon | Shortcut

Sub-menu

Function

and save your Chain SVF file

Single Device
STAPL File

Opens the Export Single Device
STAPL File dialog box; enables
you to export and save your
single device STAPL file

Single Device

Opens the Export Single Device

SVF File SVF File dialog box; enables you
to export and save your single
device SVF file

Single 1532 Opens the Export Single 1532

File File dialog box; enables you to

export and save your single 1532
file

Preferences

Opens the Preferences dialog
box; enables you to set your Log
window, Display Mode and
Update preferences for FlashPro

Exit

Exits FlashPro

Command Shortcut Function

Cut Devices Ctrl + Shift + | Removes (cuts) devices from the project
X

Copy Devices Ctrl + Shift + | Copies the selected device(s) to your Clipboard
C

Paste Devices Ctrl + Shift + | Pastes the devices from your Clipboard into the
\% project

Clear Log Clears the Log window (deletes all Log window

Window content)

FlashPro View Menu

The View menu shows or hides the FlashPro GUI elements.

Command

Sub-menu

Function

Status Bar

Shows/hides the FlashPro Status Bar
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FlashPro Tools Menu

Command Sub-menu Function
Programmer List Window Shows/hides the Programmer List Window
Programmer Details Shows/hides the Programmer Details
Window Window
Single Device Shows/hides the Single Device Configuration
Configuration Window Window
Log Window Shows/hides the Log window
Single Device Basic View | Enables the Basic view for the Single Device
Configuration > Configuration window
Advanced Enables the Advanced view for the Single
View Device Configuration window

FlashPro Tools Menu

Command Icon | Shortcut Sub-menu Function
Mode > |m Single-Device | Sets FlashPro to Single-Device
Programming | Programming mode
= Chain Sets FlashPro to Chain
Programming | Programming mode
Serialization > % | Skip Serial Sets FlashPro to skip serial data
Data during programming
e Reuse Serial Sets FlashPro to reuse serial
e Data data during programming
Programmer Q‘i Opens the Programmer Settings
Settings : dialog box; enables you to set

options for all FlashPro
programmer types

Import Settings Opens the Import Settings for
for Non- Non-Microsemi Devices dialog
Microsemi box; enables you to import your
Devices settings for non-Microsemi

devices you wish to program
with FlashPro

Connect i"ﬂ | Opens the Connect Parallel Port
Parallel Port Cable dialog box; enables you
Cable to connect your parallel port
buffer cable
Run m ‘ Ctrl + Programs your device
! Enter
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FlashPro Programmers Menu

Command Icon | Shortcut Function
Ping | E Pings a selected programmer(s)
Self Test ‘ % Runs a self-test on the selected programmer(s)
Scan Chain $ Runs scan chain on the selected programmer(s)
Remove i Removes the selected programmer(s) from
FlashPro
Refresh/Rescan Ctrl + F5 | Refreshes FlashPro and rescans for programmers

FlashPro Configuration Menu

Command Icon | Shortcut | Sub-menu Function
Select Action s | Ctrl + Shift
S A
Serialization > Ctrl + Shift | Use Enables you to use Serialization in
+S Serialization | FlashPro
Ctrl + Shift | Select Enables you to set your
+R Range Serialization range

Ctrl + Shift | View Status | Enables you to view your

+U Serialization status
Load Ctrl + Shift Opens the Load Programming File
Programming +L dialog box
File
Unload Removes (unloads) your
Programming programming file from FlashPro
File
PDB Ctrl + Shift Opens the PDB Configuration
Configuration +P dialog box; enables you to set

your PDF configuration options

Select Target Ctrl Shift + Opens the Select Target Device
Device D dialog box; enables you to set

your target device for
programming
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FlashPro Customize Menu

Command Icon | Shortcut | Sub-menu Function

Chain Ctrl + Shift Opens the Chain Parameter dialog

Parameter +H box; enables you to set
parameters for your programming
chain

FlashPro Customize Menu
Command Function
Toolbars Opens the Customize dialog box to the Toolbars tab; enables you to

show/hide toolbars and tooltips

Commands | Opens the Customize dialog box to the Commands tab; enables you to
add/remove individual commands to your toolbars

FlashPro Help Menu

Command

Icon

Sub-menu

Function

Help >

Help Topics

Opens the help

Programmer View

Opens the help to the FlashPro
Programmer List Window topic

Details on
Programmer View

Opens the help to the Programmer
Details Window topic

Single Device
Programming

Opens the Single Device Programming
help topic

Chain
Programming

Opens the Chain Configuration Window
help topic

Microsemi Web
Site

Opens the Microsemi website in your
default browser

Check for
Software Updates

Checks for software updates (works
only if you are connected to the
internet)

About FlashPro

Lists the FlashPro release information
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FlashPro Flow Window

The Flow window (located between the toolbar and Log window in the FlashPro GUI)consists of the
following buttons: New Project, Open Project, Configure Device, View Programmers, and Run. See the
table below for a description of these features.

Mew Prniecté ;lﬁ Configure Device

Open Project Dﬁ' Wiew Programmers

RUM

Figure 195 - Flow Window
Table 44 - Flow Window Button Description

Button Description
New Project Creates a new project. Opens the New Project dialog box.
Open Project Opens a new project. Opens the Open Project dialog box.
Configure Device Opens the Single Device Configuration

window to configure your file.

View Programmers Opens the Programmer List Window for you to view your
programmers.

Refresh/Rescan for Rescans for programmers.

Programmers

Run Executes programming.

FlashPro Log Window

The Log window displays errors, warnings, and basic information about your device. Click the tabs at bottom
of the Log window to toggle between messages or click the All tab to display all of the messages.

You can access the Log window from the View menu.

Setting Log window preferences

From the Preferences dialog box, you can change the text color of the messages that appear in the Log
window.

To set Log window preferences:
1. From the File menu, choose Preferences.
2. Follow the directions in the Color Settings area or click the Restore Defaults button.

298 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

FlashPro Status Bar

Preferences x|

Log *indow | Display M-:u:lel Updatesl

— Color Settings

Choosze the color uzed to dizplay a mezzage bype by
clicking the color rectangle.

Emars Infos I -
Warnings [ |~ | Linkz I -

Restore Defaults |

[ Clear log window autarnatically

k. Carnicel | Help |

Figure 196 - Preferences
3. Click OK to apply settings.

Note: You can clear the Log window by choosing Clear Log window from the Edit menu or you can
automatically erase the information by checking the Clear Log Window Automatically checkbox.

FlashPro Status Bar

The Status bar displays the program status, the programmer information (the file name for single device
programming and number of devices for chain programming), and the programming mode (single or chain).

FlashPro Programmer List Window

To activate the Programmer List Window, select View > Programmer List Window. The FlashPro
Programmer List Window consists of a spreadsheet with the programmer name, programmer type, port
number, programmer status, programmer enable check box, and a Refresh/Rescan for New
Programmers button as shown in the figure below.

Note: Double-clicking any of the spreadsheet columns opens the_Programmer Details window.

Programmer Programmer Prog Prog g E
Name Type it Status Enabled Device / Action

Refresh/Rescan for Programmers

Programmer List Window

Figure 197 - Programmer List Window

Changing the Name of your Programmer

You can change the name of your programmer by double-clicking in the spreadsheet cell or you can choose
Edit Cell from the right-click menu.

Connecting New Programmers

You can connect new programmers by clicking the Refresh/Rescan for Programmers button.
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Accessing Right-Click Menus

If you have checked the Programmer Enabled checkbox, you can right-click on any of the spreadsheet
fields to access the menu in the figure below.

%) Ping

8 Self Test
@ Scan Chain

?& Remowve

Disable

Run Selecked Programmers

Right-Click Menu

If you have not checked the Programmer Enabled checkbox, you can right-click in the on any of the
spreadsheet fields, to access a menu to remove or enable the programmer (see figure below).

ﬁ‘& Remove

Enable

Figure 198 - Right-Click Menu

Programmer Details Window

The Programmer Details Window displays your programmer ID, port, type, name, and programming status
(see figure below). Use this window to check the status and access common commands (ping, self-test,
scan chain) and to enable/disable or remove the programmer from the chain.

Programmet Details Window x

[v Enable programmer

Programmer I 01236

Port: usb01236

Type: FlashPro3
Prograrmer name: 01236

Skakus: SCAN CHAIM PASSED
Action: PROGRAM

Current Senalization D ata:

Mext Serialization [ ata:

Fing Self-test Scan chain | Remove |

Figure 199 - Programmer Details Window
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FlashPro Single Device Configuration Window

You can access this window from the View menu or you can double click any of the fields in the
Programmer List Window (Programmer Name, Programmer Type, Port, Programmer Status, and
Programmer Enabled).

Click the Enable Programmer checkbox to enable your programmer and activate the Programmer Details
Window.

From the Programmer Details Window, you can ping a programmer, perform a self-test, scan a programmer,
Or remove a programmer.

FlashPro Single Device Configuration Window

Single Device Configuration indow

To access the Single Device Configuration Window click the Configure Device button in the Flow window.
The Single Device Configuration window displays PDB/STAPL file and serialization information (see figure
below). You can also deactivate serialization by clicking the Serialization checkbox.

Programming File
To continue,

load existing prograrmming File Browse. ..
or create new POB file

T |t |

Figure 200 - Single Device Configuration Window

Loading the PDB/STAPL File

You can load your PDB/STAPL file from the Configuration menu by choosing Load Programming File or
by clicking the Browse button in the Single Device Configuration Window.

You can set chain parameter settings by clicking the Chain Parameter button.

Selecting Serialization Indexes

To select the serialization indexes:

1. Check the Serialization checkbox to activate serialization.

2. Click the Select Serialization Indexes button. The Serial Settings dialog box appears (as shown in
the figure below).
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Figure 201 - Serial Settings Dialog Box
3. Click to select an index in the Indexes column.

4. Click the red arrow button that is pointing toward the Selected Indexes column to move an index to
the Selected Indexes column.

5. If you want to move all the Indexes to the Selected Indexes column, click the All button.
6. Click OK. Information about your serial indexes displays.

You can move indexes from the Selected Indexes column to the Indexes column by clicking the red arrow
buttons pointing toward the Indexes column.

You can set your indexes by choosing the following check boxes: View unused data, View used data, and
View skipped data.

Selecting Action and Procedures
You can select actions from the Basic mode and the Advanced mode. The Basic mode is provided for users
that only require the Program, Verify and Erase actions. In Basic mode, other actions are not visible, and the
Procedures run by an Action cannot be modified.
bMode: * Baszic { Advanced

Actian

f« PROGRAM
" WERIFY
" ERASE

Figure 202 - Basic Mode

The Advanced mode enables you to select an action and modify the procedures for the selected action. In
Advanced mode, actions are determined by the stapl standard used.
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FlashPro Single Device Configuration Window

Maode; ¢ Basic * Advanced

Actian

PROGRAM j

Frocedures...

Figure 203 - Advanced Mode

To select an action (Advanced Mode):
1. Click the down arrow in the Action menu and select and action (see figure below).

Actian

PROGRAM =]

(PRLI
PROGRAM_ARRAY
PROGRAK_FRORM
PROGRAM_SECURITY
READ_IDCODE

WERIFY X

Figure 204 - Action Menu
2. Click the Procedures button. The Select Action and Procedures dialog box appears.

Select Action And Procedure x|

Action:

Procedures

INITIALIZE

DO_ERASE
DO0_PROGRAM
DO_WERIFY_BOL
DO_PROGRAM_FROM
DO_YERIFY_FROM
DO_PROGRAM_SECURITY
DO_EXIT

ERAEEEERE

Restore Default Procedures |
| (0.4 I Cancel | Help |

Figure 205 - Select Action And Procedures Dialog Box

3. Select a procedure or click the Restore Default Procedures button. Gray checkboxes indicate that
the procedure is mandatory.
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Note: The procedures in the Select Action And Procedures dialog box are determined by the
STAPL standard. The Recommended procedures are selected by default and the Optional
procedures are unselected by default.
4. Click OK.

Note: You can also click the Select Action and Procedures dialog box from the toolbar.

Chain Configuration Window

The Chain Configuration Window displays the chain order, the chain editing options, and the chain
configuration grid (see figure below).

The Show Chain Editing checkbox, when checked, displays your chain editing options (Configure device,
Add Microsemi Device, Add Non-Microsemi Device, and organization buttons to move your device within the
grid).

For information on how to add Microsemi and Non-Microsemi devices, see the Chain Editing help topic.

For information on how to use the Organize buttons, see Using the Organize Buttons in the Chain
Programming Grid.

You can enable programming and serialization by checking the Enable Device checkbox and the Enable
Serial checkbox in the Chain Configuration grid.

—-|rn| N 1Do|—-ooo—-|1m 2 rnol—olml 1 Too;—- | ’—l _I _J _I Add.ﬁctelDevicerAl

Add Nonshctel Device |
¥ Show Chain Edting —

IR Max TCK = Enable  Enable Serial

Device Mame File Length (MHz) s Serial Action Data HIGH-Z

Construct the chain from a Scan Chain operation...

Figure 206 - Chain Configuration Window

Auto-Construction of Chain from Scan Chain

When in chain programming mode, the FlashPro software enables you to automatically construct the chain
by clicking the Construct the chain from a Scan Chain operation link, or by selecting Construct Chain
Automatically from the Configuration menu.

This enables you to scan a chain of devices and automatically construct the chain within FlashPro. If you are
using non-Microsemi devices, you will need to import the device settings into the database by using the
Import Settings for Non-Microsemi Devices dialog box. The software also scans the chain before
constructing it, which reduces the possibilities of having errors in the chain. For more information on how to
automatically construct a chain from scan chain, refer to the Automatic Chain Construction Tutorial.

Chain Editing Options

The FlashPro software enables you to edit your chain by adding Microsemi and Non-Microsemi devices.
You can add devices by clicking the Add Microsemi Device button and the Add Non-Microsemi Device
button or you can select these options from the Configuration menu.

Note: For more information about how to edit the chain, see Chain Editing.

Editing the Chain Configuration Grid
The Chain Configuration Grid enables you to select an Action for your device, Enable Serialization, and
edit the grid using the right-click menu.
To select an Action from the Configuration Grid:
1. Choose the device you would like to program and check the Enable Device checkbox.
2. Inthe Action column, click the down arrow to expose the drop-down menu (see figure below).
3. Select your desired action.
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Chain Configuration Window

Action

PROGRAM =

DENVICE_INFO
ERASE
ERASE_ALL
ERASE_ARRAY

PROGRAM_ARRA
PROGRARM_FRCM
READ_IDCODE
WERIFY

WERIFY _SRRAY
WERIFY _FROM

Figure 207 - Drop-Down Menu for Select Action
To enable Serialization:
1. Check the Enable Serial checkbox. By enabling serialization, the action options change.
Note: Before you can enable serialization, you must check the Enable Device checkbox.
2. Inthe Action column, click the down arrow to expose the drop-down menu (see figure below).

Action

FROGRAM  =|
PROGRAM
PROGRAM_FROM
VERIFY
VERIFY_FROM

Figure 208 - Drop-Down Menu for Select Action

3. Select your desired action.
4. Choose Select button from the Serial Data column, which is next to the Action column (see figure
below).

Serial

Data

Figure 209 - Serial Data Column
The Serial Settings dialog box appears.
5. Choose your serial settings from the Serial Settings dialog box.
See Serial Settings for more information about this topic.
Note: Uncheck the Enable Serial checkbox to disable serialization.

To edit the Chain Configuration Grid:

1. Select the device you would like to edit and right click anywhere in the row of the selected device. The
right-click menu below displays.

2. Select and click an option from the right-click menu.
Note: The Device Configuration menu includes options for configuring your device.
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Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices. This
appendix contains information about contacting Microsemi SoC Products Group and using these support
services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060

From the rest of the world, call 650.318.4460

Fax, from anywhere in the world 650. 318.8044

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled engineers
who can help answer your hardware, software, and design questions about Microsemi SoC Products. The
Customer Technical Support Center spends a great deal of time creating application notes, answers to
common design cycle questions, documentation of known issues and various FAQs. So, before you contact
us, please visit our online resources. It is very likely we have already answered your questions.

Technical Support

For Microsemi SoC Products Support, visit http://www.microsemi.com/products/fpga-soc/design-
support/fpga-soc-support.

Website

You can browse a variety of technical and non-technical information on the Microsemi SoC Products Group
home page, at http://www.microsemi.com/soc/.

Contacting the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be contacted
by email or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email,
fax, or phone. Also, if you have design problems, you can email your design files to receive assistance. We
constantly monitor the email account throughout the day. When sending your request to us, please be sure
to include your full name, company name, and your contact information for efficient processing of your
request.

The technical support email address is soc_tech@microsemi.com.

My Cases

Microsemi SoC Products Group customers may submit and track technical cases online by going to My
Cases.
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Chain Configuration Window

Outside the U.S.

Customers needing assistance outside the US time zones can either contact technical support via email
(soc_tech@microsemi.com) or contact a local sales office. Visit About Us for sales office listings and
corporate contacts.

ITAR Technical Support

For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR), contact us via soc_tech@microsemi.com. Alternatively, within My Cases, select Yes in the ITAR
drop-down list. For a complete list of ITAR-regulated Microsemi FPGAs, visit the ITAR web page
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